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Model Repository

Enterprise Architect is a rich modeling platform that can be used in a wide range of modeling and design situations, from
a single user accessing a file based repository to a large and distributed team of thousands of modelers working all over
the world using a Cloud Based Repository. The repositories can be scaled up and down, and a project that started with a
single user can be seamlessly scaled up to a large multi-user repository.

Enterprise Architect has been built to support inter-disciplinary modelers collaborating to create a single and unified
view of a system or enterprise, and the platform has numerous built in features to support this team development. By
taking advantage of the base UML modeling language, in addition to the numerous extension languages such as BPMN
and SysML, plus highly effective frameworks such as TOGAF and UAF/UPDM, modelers, designers, managers and
others can build comprehensive, inter-connected models that fully expresses the capabilities, structure and behavior of
fully functioning, multi-layered, complex systems and/or enterprises.

In addition, there are features that allow modelers to discuss the model, such as the Collaborate window, and review
work that has been in progress in the Team Library window. Modelers can even send Model Mail to communicate ideas.
Model Security can be implemented, which facilitates collaboration and prevents work accidentally being overridden.

There are a range of project management features, such as tasks and resource allocation and a Gantt Chart to view
progress on tasks over time, and a Project Calendar that keeps track of important project events.

Integration is so easy and the feature sets so powerful that strategic thinkers, business managers, architects, information
and data modelers, testers, software engineers and many others will derive great benefit from using the tool and
incorporating their models into the overall vision.

Key Concepts

Repository Format Enterprise Architect models are stored in standard relational databases. This
approach has been built into Enterprise Architect from the very first version.
Using a relational database provides a huge advantage over other tools that are
limited in scope and capability by relying on a simple text file based model storage
system. With support for two file based repository formats (MS JET and Firebird)
plus a number of industry standard DBMS servers (such as SQL Server, MySQL
and Oracle) plus Cloud based storage, Enterprise Architect provides fast, scalable,
flexible and transparent access to models in a wide range of deployment scenarios.

Modeling Languages Enterprise Architect is based on industry standard UML, a specification
maintained by the Object Management Group (OMG). Although initially
conceived as a modeling language primarily for software development, over the
years the capabilities and formal (standard) extensions have allowed the UML to
develop into a rich set of constructs and modeling behaviors that provide very rich
and detailed support for everything from software, to business processes,
embedded software, enterprise architecture, organizational charts, strategic model,
mind mapping, requirements management and much more. The success of UML
has been proven over and over again in the real world and the number of new
technologies and modeling profiles that use UML as the underlying
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'meta-language' are tribute to the power and effectiveness of UML.

Team Development From the very first version of Enterprise Architect the goal has been to provide the
best and most accessible support for Team based development. A wealth of tools
and capabilities have been designed into the platform over the years to support
security, scalability, information sharing, concurrent access, management,
reporting and querying. With the growth of the internet and distributed
development scenarios, Enterprise Architect has evolved to be the pre-eminent
platform for developing models and designs in a globally distributed situation. The
Cloud Server based deployment offers high availability, excellent performance
and simple configuration to rapidly bring diverse and distributed teams into a
single, living repository where work can be easily shared, reviewed, discussed and
managed.

Scalability By leveraging the power of today's DBMS servers and Cloud Based technologies,
Enterprise Architect can be easily scaled up to truly epic proportions. Millions of
objects can be stored and accessed by large and dispersed teams in real time. The
level of scalability is limited solely by the choice of DBMS or Cloud Technology
and the capabilities of the network and server infrastructure the model is deployed
on. In practice, over the many years that Enterprise Architect has been used in
industry, modelers and designers have taken advantage of the powerful in-built
scalability to construct stunning and often huge models that capture an enormous
amount of information about complex and highly inter-connected systems and
enterprises.

Security Due to the nature of the Repository used by Enterprise Architect and the possible
deployment scenarios, security can be managed in a number of ways. In the
Corporate, Unified and Ultimate editions of Enterprise Architect, there is built-in
support for defining users and groups that permit locking and management of
elements and Packages within the model. This will be discussed later in the section
on Security. In addition, it is also possible to restrict general access to models by
using file-based security access for the MS JET and Firebird-based models (.EAP
and FDB) and DBMS server authentication and access for the larger database
server-based systems. As a further refinement it is also possible to restrict access
to a model using the HTTPS protocol when connecting to a Cloud Based server.

Versioning Enterprise Architect uses industry standard XMI (XML Interchange) format files
to store and version model Packages. By integrating the import and export of XMI
model fragments into a Version Control system (such as SVN) supported by
Enterprise Architect, you can maintain multiple versions of the same model in
different repositories and exercise fine control over the development and design
process. Given the nature of this versioning system, there are several different
scenarios that can be used to maintain different models and how teams access
information. For example, where the versioning system is used as the single point
of truth and de-facto Repository, it could be convenient to use many workgroup or
single user based Repositories that reflect the actual model at a particular point in
time. In contrast, where the versioned files are mainly held for backup and
baseline purposes only, a larger, Team based DBMS server would be used to
provide the model sharing and collaboration capabilities. So whatever the actual
needs are, Enterprise Architect has a number of solution scenarios that can be
adapted to provide the right level of change management and collaborative
development.

Example Repository Tasks
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Task

Create a project in a simple, file-based repository (.EAP and .FEAP files)

Create the project in one of a range of DBMS repositories - these provide for larger models with more concurrently
connected users (Corporate and extended editions)

Manage change within the model

Maintain the integrity of the project data

Share the reference data used across the project, between models and between projects

Allow each user to configure their personal preferences for how project tools display and behave on their
workstation

Document your model through document or web reports, which you can tailor to your purposes
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Repository Overview

An Enterprise Architect repository is stored in a relational database; this can be a file based database such as MS Access
or Firebird, or a database management system (DBMS) such as Oracle or MS SQL Server. Enterprise Architect can
connect to DBMS based repositories via a direct connection or with the use of the Pro Cloud Server, such repositories are
referred to as Cloud Based Repositories. It is common to start with a File Based Repository and, when the project gets
some momentum and there are a number of modelers accessing the repository, to transfer it to a DBMS. Whichever type
of repository is implemented, the user interface remains the same and users can seamlessly move from one type of
repository to another and continue to contribute as a team member on this powerful modeling platform.

Concepts

Concept Description

Repository as a File In any version of Enterprise Architect you can store a project in a single file with a
.eap or .feap extension.

A .eap file is a Microsoft JET database, so you can also open it using MS·
Access 97, 2000, 2003 or 2013, or any other reporting tool that can work with
JET databases

A .feap file is a Firebird project file·

Repository in a DBMS
(Database Management
System)

In the Enterprise Architect Corporate, Unified and Ultimate editions you can also
use a suitable DBMS repository for projects.

DBMS projects have the same logical structure as .eap and .feap files, but provide
much greater scalability and concurrent access. You connect to a DBMS using
ADO/ODBC (see Connect to a Data Repository). Note that when configuring an
ODBC data source on a 64 bit machine, you should access the ODBC data manager
using the 'Configure > User Tools > ODBC Data Sources' ribbon option, as this will
load the correct ODBC manager to access 32 bit data sources as used by Enterprise
Architect.

Repository in the Cloud In the Corporate, Unified and Ultimate editions of Enterprise Architect you can
further enable the distributed capabilities of Enterprise Architect and use the
Internet or local network to connect to a Pro Cloud Server on which one or more
Repositories have been installed and configured for access. The Pro Cloud Server is
free software available from Sparx Systems, and is relatively simple to set up and
configure on a suitable Windows-based machine. Firebird files or any DBMS
server are the required Repository types supported by the Pro Cloud Server, and
these can reside on the same machine for best performance, or on another machine
to maximize local and network access. Cloud-based repositories provide the
ultimate in distributed development and minimal client configuration. It is, in fact,
much easier to deploy a Firebird-based repository on a Pro Cloud Server for
distributed development than to set up and manage a full DBMS solution.

Models Enterprise Architect uses this terminology when discussing Repositories and their
contents.

A Model is a related group of content that expresses some focused aspect of a1.
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system or enterprise that is related by the modeling tools and paradigm used.
For example, you might build a 'Usecase Model' that describes behavior and
scenarios using UML Use Cases. Process models, architectural models,
behavioral models, structural models, Class models and so on are all Models
within the current Project.

A Project is a group of models that has a single unifying purpose. For example,2.
a Project to design the navigation systems for a new aircraft or automobile
would be considered a single Project. Within this Project there would be
multiple models. Projects typically define levels of security, necessary types of
view and model, necessary procedures and other management tasks to deliver
the product. Project management capabilities in Enterprise Architect are very
rich and allow for resource management, security, change management, testing
and other typical project management tasks.

A Repository is a single File, DBMS database or Cloud Server address that3.
contains one or more Projects. Typically, file based repositories such as MS
JET and Firebird models contain a single Project with multiple models that can
be shared by a small workgroup or only accessed by a single modeler. DBMS
and Cloud based Repositories will often contain more than one Project,
especially where the Projects are in some way inter-related or co-dependent.

Adding Initial Content After creating and accessing your new project in whatever form the Repository
takes, you can now use the Model Wizard to create Model Packages that range from
generic and simple views to more complex and pattern based content.

You can add Models to a project from the Browser window by:

Right-clicking on an existing model and selecting the 'New Model' or 'Add a·
New Model using Wizard' options

Right-clicking on a Package and selecting the 'Add | Add a New Model using·
Wizard' option

Clicking on an existing model, pressing the Insert key and selecting the 'New·
Model' or 'Add a New Model using Wizard' menu options

Clicking on a Package, pressing the Insert key and selecting the 'Add a New·
Model using Wizard' menu option

Opening Existing Projects Existing Projects are accessible via the 'Recent Documents' list under the 'File

Management' icon ( ), the 'Recent' list on the Start Page, and through the
'Open Project' option under the 'File Management' icon.

Connecting to an existing DBMS or Cloud based Repository is discussed in more
detail under the relevant sections on working with those Repository types.

For new users, you can use the 'Start > Help > Help > Open the Example Model'
ribbon option to open and explore the Enterprise Architect Example Repository
supplied with Enterprise Architect. This example is not so much a fully worked
example as a collection of models that show how you can leverage the power of the
Enterprise Architect platform and the UML to create a wide range of visual and text
based models.

DBMS Repositories You can connect to any of these data repositories:

MS Access 2007 onwards·

Firebird·

SQL Server 2000 onwards·

SQL Server Express 2005 onwards·

MySQL·

MariaDB·

Oracle 9i, 10g, 11g and 12c·
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PostgreSQL·

In brief, to create a new database repository, you first create a new database with
the DBMS management software, then run supplied scripts to create the logical
structure.

You then use Enterprise Architect data transfer functions to move a project from a
.eap, .feap or DBMS model into the new project. Details are available under the
Server Based Repositories section.
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Projects Defined

An Enterprise Architect Project is a repository for storing, manipulating and managing one or more Models. A single
repository can contain many models, and a Repository can be either file based, hosted in a larger DBMS system or based
in the Cloud.

Concepts

Concept Detail

Project A project can contain a single model, or a number of models, each of which defines
a particular system or process. A model contains the diagrams, elements,
relationships and associated metadata that define the structure and function of the
system or process. These components are organized into a hierarchy of Packages,
which help to group and manage related components.

Model Different aspects of the process or system - or their development - are defined by
Model Packages, which you generate from templates specifically structured to
support the aspects that the Model Packages represent, such as requirements or
deployment. You can generate these templated Packages at any level of the
hierarchy, but as they are created with their own content they are more useful at the
top levels.

View The top-level Packages in a model can also be Views, which represent partitions of
the model that you define yourself.

You can start with standard Views such as Class or Component, or create whatever
partitions are appropriate to your model.

Example Project Structure

Each View or Model Package contains Packages; the Use Case Model Package
contains:

Actors and·

Primary Use Cases·

It also contains the Use Case diagram, which could be an overview of the Package
structure or function.

Each Package itself can contain one or more diagrams, one or more Packages, and
several elements; the Primary Use Cases Package contains the:

Primary UCDiagram·

Customer Setup Package·
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Use Case1 element·

Use Case2 element·

Each subordinate Package also contains diagrams, elements and (if necessary)
further Packages; the elements are related by connectors created in the diagrams,
and each element and connector has properties, attributes, operations and
extensions defined in the respective 'Properties' dialogs.

Note that models do not have to be constructed this way. Depending on the
methodology you are following and information you need to model, the project
structure might look completely different. In addition, many architectural
frameworks such as TOGAF and ArchiMate specify their own project structure as
part of their overall solution architecture.
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Managing Connections to Projects

An Enterprise Architect project is used for storing and managing the components of one or more UML models. The
Professional edition of Enterprise Architect works on file-based projects (.eap files). If you are using the Corporate
edition (or above), you can also use one of a number of DBMSs such as Oracle or MySQL, or a Cloud Based server to
host the project repository.

When you select to open a project, you can:

Select a shortcut to a recent project, to open it·

Browse for another existing project to open·

Remove a shortcut from the list of recently-opened projects·

Specify connection details for opening a project hosted on a DBMS·

Connect to a project via the Cloud·

Create a new Enterprise Architect project file·

Access

Ribbon
 > Open Project

Keyboard Shortcuts Ctrl+O

Other Start Page | New | Manage projects

Options

Field/Button Action

Local File Click on this button to open a file browser dialog, and locate and select an existing
.EAP, .EAPX or .FEAP file; the .EAP file can be a project file or a shortcut to a
project hosted on a DBMS. Alternatively, click on the drop-down arrow and select
the 'New Project' option to create a new project.

Connect to Server Click on this button to specify connection details for opening an Enterprise
Architect project that is hosted on a DBMS. The 'Windows Data Link Properties'
dialog displays; start to define the connection to the project's server-based
repository.

You can also click on the drop-down arrow and select:

'Connection Wizard' - the 'Data Link Properties' dialog again displays·

'Connection String' - the 'Connection String' dialog displays; type in or paste·
the connection string and click on the OK button to connect directly to the
project

Connect to Cloud Click on this button to connect to a project through the Cloud. The 'Cloud
Connection' dialog displays, on which you specify the server, URL and model name
to access via the Cloud.
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Recent Projects This panel lists the most recently opened projects, up to a maximum of ten. To open
one of these projects either double-click on the name, or click on it and then click
on the Open button.

Each project name is shown with its access path. You can edit the access path by
right-clicking on it and selecting the 'Edit Connection String' context menu option;
make the changes on the 'Connection String' dialog, and click on the OK button.

Similarly, if the project has a connection string (not a shortcut), you can change the
name of the project by right-clicking on it and selecting the 'Edit Project Name'
menu option; type a new name in the 'Edit Project Name' dialog and click on the
OK button.

The list of recent projects is also displayed:

On the Start Page, under the 'Recent' heading·

As a drop-down menu under the Open Project button on the Default Tools·
toolbar

With the  list of options·

Remove Selection from
List

Click on a project name and click on this button to remove that project name from
the 'Recent' list.

Show this Dialog at Startup Select the checkbox to show this 'Open Enterprise Architect Project' dialog
automatically upon starting Enterprise Architect. Deselect the checkbox to hide the
dialog.

Default Project to Open Click on a project name in the 'Recent' list and select this checkbox to open the
selected project automatically whenever you start up Enterprise Architect.

Open Click on this button to open the currently selected project in the 'Recent Projects'
list.

Cancel Click on this button to close this dialog without any further action.

Help Click on this button to display this Help topic.

Notes

Use of a DBMS and/or Cloud for hosting the model repository is available in the Corporate, Unified and Ultimate·
editions of Enterprise Architect

Enterprise Architect supports these DBMS products for hosting model repositories:·
     -  SQL Server and SQL Server Express;
     -  MySQL
     -  Oracle 9i, 10g, 11g or 12c
     -  Postgre SQL and
     -  ASA
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Obtain Repository Connection String

A 'connection string' defines all the connection information that Enterprise Architect requires to open a repository.

Connection strings are typically only available from 'Manage Projects'.

You can open the 'Manage Projects' dialog by:1.
     -  Pressing Ctrl+O, or

     -  Clicking on  > Open Project...  or
     -  Selecting Start Page | New | Manage projects

Find the repository in the 'Recent Projects' list. Note the 'Path' column will show the connection string; however, if it2.
is too long for the screen it will be abbreviated and '...' shown.

Right-click on the repository and select the 'Edit Connection String' context menu option. This will show the3.
'Connection String' dialog.

When the 'Connection String' dialog is first shown the complete text of the connection string will be automatically
selected. Press Ctrl+C to copy it to the clipboard.

It is usually a good idea to include this connection string in communications with Sparx Systems as it provides useful
information about how you connect to the model, which can help Sparx Systems understand your environment.
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Project Shortcuts

Enterprise Architect enables you to create a desktop shortcut (or proxy file) to an Enterprise Architect project (Cloud,
DBMS or file-based). Each shortcut is a file containing the connection string for the model. In addition, the shortcut also
defines views that Enterprise Architect should open when it opens the model, as outlined here. In this manner it is a
convenient and customizable way of quickly sharing a connection to a Cloud based model without requiring other users
to know the details of the connections string, model name and other parameters.

Access

Ribbon
 > Save As Shortcut

Topics

View Detail

Diagrams Define one or more specific diagram(s) to be loaded on opening the project.

Model Search Open the Model Search with a specific text string and search type.

For searches operating on the current tree selection, a diagram in the target Package
must be opened first.

If you use a custom SQL search, the SQL must include ea_guid AS CLASSGUID
and the object type.

You specify a single Model Search to open.

The Relationship Matrix
with a saved profile

Open the Relationship Matrix with a saved profile.

You specify a single Relationship Matrix profile to open.

The default Team Library Open the default Team Library document.

You specify the Team Library once.

Working Set Open a working set.

You specify a single Working Set to open.

This is very similar to the shortcut itself, opening a defined set of diagrams and
views. However, the working set can also open source code editors, therefore
widening the capabilities of the shortcut alone.

Working sets make it easy to customize the main views you want to open without
having to resave your project shortcuts. The working set is easy to tailor to your
changing requirements, adding greater flexibility to any shortcut that calls the
working set.

Also, working sets provide the capability of storing the currently-engaged files
when closing a model, and reopening them in the context in which you were last
using them. The basic project shortcut can also do this, but once the work
environment is captured the shortcut returns to the same set up each time you use it.
The working set always captures the current work environment each time the model
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closes.

This option can be very useful in, for example, a coding environment when you
want to return to the last files you were editing.

Workspace Layout Apply a selected Workspace Layout, which opens and sets out the appropriate
screens and windows for a specific area of work, such as model simulation.

You specify a single Workspace Layout to open. However, by creating and using
separate shortcuts you can open Enterprise Architect in exactly the configuration
you need for the work you want to do - modeling, coding, or debugging, for
example.

An example shortcut You might create a shortcut to open, in sequence:

A Development module·

The Model Search for a simple search on the term Issue·

The module Issues diagram·

The module 'Changes' diagram·

Enterprise Architect opens the appropriate windows in the sequence in which you
list the options, displaying the last view in the list as the active view.

In this example, the project opens with the Enterprise Architect work area showing
the two diagram tabs and the 'Model Search' tab, and with the 'Changes' diagram
displayed in the Diagram View.

Notes

If specified, the shortcut views override any default diagram defined for the model or current user·

A shortcut does not affect the original Enterprise Architect .exe file or icon, or any other shortcut you might have·
defined; you can use all of these independently

If you are using a database repository other than MS Access 97, 2000, 2003 or 2013, you can configure the shortcut·
to encrypt the password used to set up the connection between Enterprise Architect and the repository; the
Enterprise Architect user does not have the real password, thereby preventing them from accessing the repository
using other tools such as Query Analyzer or SQLPlus
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Create Project Shortcut

You can create a shortcut to an Enterprise Architect project (either a DBMS project or file based project). The shortcut
can specify additional windows and diagrams to open up automatically every time the shortcut is run, to create a working
environment in advance for other users.

Shortcuts are stored with a .EAP extension, but are actually small text files that tell Enterprise Architect what project to
open and what initial views and windows to display.

Access

Ribbon
: Save as Shortcut

Create a project shortcut

Step Action

1 Open Enterprise Architect.

2 Open the required project.

3
Select the '  |Save as Shortcut' option.

The 'Save Project Shortcut' dialog displays.

4
Click on the  button at the end of the 'Target File' field.

The 'Save Project As' dialog displays.

5 Browse for the appropriate file location and, in the 'File name' field, type an appropriate filename.

All shortcuts are .EAP files, regardless of whether the model itself is a .EAP file or a DBMS model.

6 Click on the Save button to return to the 'Save Project Shortcut' dialog.

7 Click on the Add Other button and select the required option to define:

A diagram to open·

A Relationship Matrix profile to open·

The Team Library·

A Model Search to perform·

A working set to apply·

A workspace layout to apply·

8 The appropriate browser or dialog displays to define the view to display; enter the details and click on the
OK button.

The view is added to the 'Actions when model is opened' field; the entry is automatically selected, with a
tick in the checkbox.
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9 Repeat steps 7 and 8 for as many additional views as you require.

10 Review the items in the 'Actions when model is opened' field.

If you decide not to have an item in the shortcut, deselect its checkbox·

If you want to clear all selected items, click on the Include None button·

Unselected entries are deleted when you save the shortcut.

11 If you decide to change the sequence and/or make a different view display first in the Diagram View:

Click on the appropriate entry·

Click on the 'Up Hand' or 'Down Hand' buttons·

12 Click on the OK button to save the shortcut.

Notes

When you subsequently open the 'Save Project Shortcut' dialog, it lists the currently-opened views in the order in·
which they were opened; you can add further views or remove them from the shortcut
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Capture Current Work Environment

You can capture the current Enterprise Architect work environment in your shortcut. This maintains the work
environment from that point, and is useful if you intend to close and re-open the model and return to the same
configuration many times.

If you simply want to return to whatever work environment you happen to be in each time you close the model, you
should use a work set that captures the current environment, either by itself or as part of a broader project shortcut.

Access

Ribbon
: Save as Shortcut

Capture your current work environment

Step Action

1 Open Enterprise Architect.

2 Open the required project and work in it.

3 At the point at which you decide to capture your work environment in a shortcut, ensure that:

You have opened all diagrams you require·

If necessary, you have opened the Team Library, Model Search (with appropriate search term and·
type) and/or Relationship Matrix (at the appropriate profile)

The view you want to resume work on is the last one opened·

4 Select the 'Save As Shortcut' menu option.

The 'Save Project Shortcut' dialog displays, showing a list of actions derived from the views you currently
have open.

5 If you accessed Enterprise Architect via a shortcut, the 'Target File' field displays the file location of that
shortcut.

Otherwise, click on the  button at the end of the 'Target File' field.

The 'Save Project As' dialog displays.

6 Browse for the appropriate file location and, in the 'File name' field, type an appropriate filename.

All shortcuts are .EAP files, regardless of whether the model itself is a .EAP file, .FEAP file or DBMS
model.

7 Click on the Save button to return to the 'Save Project Shortcut' dialog.

8 In the 'Actions when model is opened' field, click on the Include All button.

9 If you also want to save current window positions click 'Add Other' followed by 'Add Workspace Layout'.

(c) Sparx Systems 2019 Page  24 of 654 Created with Enterprise Architect



Model Repository - Model Repository 20 January, 2020

The dialog shown allows you to select an existing layout or save the current layout.

10 Click on the OK button to save the shortcut.

(c) Sparx Systems 2019 Page  25 of 654 Created with Enterprise Architect



Model Repository - Model Repository 20 January, 2020

Encrypt Repository Password

If your model is developed on a DBMS repository, the 'Save Project Shortcut' dialog has an 'Encrypt Connection String'
checkbox.

You can create the shortcut actions and, if necessary, select the checkbox to encrypt the database connection string.

You distribute the shortcut file to the database users who are to access the model. The users then have an encrypted
string that prevents them from directly accessing the database using other tools.
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File Based Projects

Enterprise Architect provides a convenient light-weight, low-barrier and portable file-based repository out-of-the-box,
which is ideal for modelers who want to start work immediately; with the file-based repository you can be modeling
within a few minutes. When a number of colleagues want to contribute to the models, the file can be moved to a
file-share and it is possible to work with this setup even when the model becomes quite large and the number of users
increases to ten or more. All editions of Enterprise Architect support this type of repository in the form of a .eap file in an
Access database, or a .feap file in a Firebird repository.

You can create your own repository from scratch, but a default repository (EABase.eap) is conveniently supplied, located
in the Enterprise Architect installation directory. The file acts as a template for creating new projects and can be copied
to give you a head start in creating a repository. You can tailor this repository to suit your organization or create your
own base repository. A File Based Repository can be easily transferred to a DBMS based repository using the Project
Transfer feature, allowing a project to be scaled up when the team increases in size or when organizational policy
dictates it.

File-based project tasks

Task Detail

Create .EAP Project Files Select one of:

 > New Project menu option·

'Local File | New Project' option on the 'Manage Projects' dialog, or·

'Create a new project' option on the Start Page·

All of these options display the 'New Project' dialog; select a directory and enter a
file name for your project (.eap under JET 3 or .eapx under JET 4).

Once the project has been saved, the Model Wizard displays, which makes a
selection of Model Patterns available; select the Model Patterns to use.

Enterprise Architect adds a model containing the selected Model Packages to the
Browser window.

Create .FEAP Project Files As for a .eap/.eapx file, except that in the 'New Project' dialog, in the 'Save as Type'
field, click on the drop-down arrow and select the .feap file extension.

Enterprise Architect will check your input and display an error message if:

Your Firebird repository is not located on the local drive; a Firebird repository·
is not appropriate for a network shared project

The file path contains characters that are not in the system codepage·

Location of default
(EABase.eap) repository
template

The default installation directories, depending on which version you have installed,
are:

Registered Edition: C:\Program Files\Sparx Systems\EA·

Trial Edition: C:\Program Files\Sparx Systems\EA Trial·

Lite Edition: C:\Program Files\Sparx Systems\EA Lite·

A base project contains templates and reference data from which you can quickly
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develop your own project.

Note that in addition to deriving a new model from EABase.eap. it is also possible
to start a new project by copying an existing one. While it is possible to simply
'copy' the .EAP file at the file system level, this results in two identical models and
should only be used when that is the required behavior; for example, when
distributing a model to a client for verification. If you use the built in functions of
Enterprise Architect to create a new model based on an existing one, Enterprise
Architect will modify the unique identifiers (GUIDs) for all elements and related
constructs so that the new model is essentially unique, and not a simple copy of the
existing one.

Configure Project Having created your project, you can set a range of project parameters to define
defaults, tailor the project to particular coding languages, and ensure consistent
development and use of the project.

Create Custom Templates You can customize any Enterprise Architect project as a template project with
company standards, tutorials, frameworks and any other common piece of modeling
already in-built; with careful planning you can save yourself many hours of work at
project start-up.

Best Practices for File Based Repositories

Single User Simple file based repositories (.eap and .feap files) are best suited to single user
development with the model file placed on the modelers local drive. This is fast,
very efficient and provides a powerful means of getting started in modeling a
particular solution. Many models will start out as single user repositories and only
later be migrated into a DBMS or Cloud based scenario for larger team access. If
you need to quickly start work on a project and do some exploratory work, or you
are working alone as a consultant, the .eap or .feap file format is ideal.

Small Workgroup With all versions of Enterprise Architect it is possible to share a .eap file at the
network file level. This is really only a suitable solution for small workgroups (up
to, say, five members) who are collaborating on a shared model. This solution is
very much at the mercy of the quality of the network connection and could be less
than ideal if collaborating users increase in number and/or the model grows very
large. As Enterprise Architect on the user's machine is still running all the queries
and performing all database operations on a network file, a slow network will result
in less than ideal performance. As team size and model size increase it is best to
upsize to either a DBMS or Cloud-based architecture.

In Conjunction with
Version Control

One additional scenario in which file based repositories can be used to great effect
is with a Version Control system such as SVN. If the SVN system holds the master
content, then individual developers/modelers can check out the material of interest
to them into a local .eap or .feap file. When they have made their changes they can
migrate their work back into the shared master. This style of development is quite
effective, and as the import and export of model material from the Version Control
system works best with single user local project files, it is a good match and a good
use of the two technologies.

Copy of Repository for
Storage or Review

A further use of the single file repository is for distribution to clients and others for
review and comment, where the original model(s) is located in a DBMS or Cloud
that the recipient would not have access to. As it is relatively easy to bulk copy a
DBMS model to a local .eap file, this is a good method for passing on a model to a
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client or another interested party. If some of the material is restricted, it is possible
to delete sections from this single file repository after the bulk copy is complete and
before passing it on.

Replication If network access is limited and DBMS and Cloud based solutions are not possible,
another (less than optimal but still effective) team based solution is to use the built
in replication features of the .EAP file format. By creating a design master and
distributing replicas to other modelers, it is possible to effectively share and
contribute to a model without having direct shared access to the common model.
On the down side, someone will have to perform the model merges as required and
if there are replication conflicts (two changes to the same item) this will require
manual resolution.

Notes

You can also add Model Packages to a project by clicking on the Browser window header bar and selecting the 'New·
Model From Pattern' menu option
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Copy a Base Project

When you create a new project, you can use the Model Wizard to define the structure and contents. Alternatively, you
can copy an existing template or base project which is already largely set up, containing company standards, tutorials,
frameworks and any other common modeling structures. You can also copy an operational .EAP or .FEAP project file to
a new file location under a new name to, for example:

Provide separate copies for individual team members·

Create an evaluation or distribution version of the project·

If you intend to use an existing project file as the template for a new project, it is important to use this method rather than
simply copying the .EAP file using Windows Explorer. This process provides the option to reset all the unique identifiers
for Packages and elements, so that your new project is truly unique - otherwise you create an exact copy of the original
project.

Access

Open the template project or existing operational project then;

Ribbon
: Save Project As

Create a new project from a base project

Option Action

Target Project Type the new project filename.

You can either type in the file path as well, or click on the Browse button and
browse for the required file path.

If this is to be a shared project, store the file on a shared network resource such as a
Network Server or Workgroup Server.

Source Project Defaults to the path and name of the currently-open template or project.

Reset New Project GUIDs If the target project is to be a different project from the source (such as when you
copy a base template), select this checkbox to replace all GUIDs from the base
model with fresh GUIDs in the new model.

However, if the new project is to be a direct copy of the source, or based on a
project that is under Version Control, we recommend that you deselect this
checkbox to prevent duplication of Packages when the 'Get Latest' facility is used.

Save As Click on this button to save and open the new project.
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Sharing File Based Projects

Enterprise Architect offers a diverse range of functionality designed specifically for sharing projects in team-based and
distributed development environments, through network deployment of model repositories, DBMS based repositories,
Cloud based models, replication and XMI Import/Export.

Features

Feature Detail

Network Deployment Network deployment is possible under three different schemas:

File based repositories·

DBMS server based repositories, or·

Cloud based deployment (recommended)·

DBMS server based repositories offer better:

Response times than files on networks, due to the inherent structure of the·
DBMS

Solutions when networking problems are encountered, as they have the ability·
to backtrack transactions caused by external breakdowns

Replication Replication enables data interchange between .EAP based repositories and is
suitable for where many different users work independently in parallel
development.

Modelers merge their changes into a Design Master only as required; it is
recommended that a backup is carried out prior to replication.

Replication cannot be performed on repositories stored on a DBMS server.

XMI Import and Export XMI Import/Export can be used to export and share discrete Packages between
developers; XMI enables the export of Packages into XML files that can then be
imported into any model.

Package control can be used to set up Packages for Version Control and to enable
batch export of Packages using XMI; Version Control enables a repository to be
maintained by a third-party source code control application that is used to control
access and record revisions.

Notes

DBMS Repository support is available with the Corporate, Unified and Ultimate editions of Enterprise Architect·
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Share Enterprise Architect Projects

The most efficient way of using Enterprise Architect to manage a team development is to share a project amongst a team
of designers, developers and analysts.

Facilities

Facility Detail

By Sharing a project Many people can work on the model at the same time and contribute their·
particular skill

Team members can always see what the latest changes are, keeping the team·
informed and up to date with the project status

You can share a project in
three ways

Place the project in a shared network directory·

Use replication·

Use a shared DBMS-based repository·

Notes

Project Sharing and Replication are available in the Professional, Corporate, Unified and Ultimate editions of·
Enterprise Architect

DBMS repositories are supported in the Corporate, Unified and Ultimate editions of Enterprise Architect·
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Refresh View of Shared Project

When a user of a shared model checks out a Package and makes changes, other users can see those changes by refreshing
their view of the Package or the changed diagram within the Package, in a number of ways.

Refresh the view

Object Options

Project Right-click on the Package name in the Browser window and select the·
'Contents | Reload Current Package' option, or

Press F5 to refresh the Package, or·

Select the  (Reload Project) icon in the Project Tools toolbar, or·

Press Ctrl+Shift+F11, or·

Close the project and reopen it·

Diagram Select the 'Start > Desktop > Workspaces > Manage Views > Reload View'·
ribbon option, or

Right-click on the opened diagram tab in the Diagram View, and select the·
'Reload <diagram name>' option
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Share a Project

The easiest way to share a project amongst a work group of developers and analysts is to place the project file on a
shared network drive, to which people connect from their workstations.

Individual developers and analysts can then open and work on the project concurrently.

Network Issues

Enterprise Architect accepts a number of concurrent connections without issue; however, there are points you should
consider:

Issue Description

Lock Outs There can be occasional 'lock-outs' when one user tries to access or update
something another user is in the process of modifying.

Other Changes Changes to the Browser window (and other project views) are not automatically
updated; to compensate for this, users must occasionally reload their project to see
changes made by other users.

Diagrams If two or more people work on the same diagram concurrently, unexpected results
can occur; it is best to allow only one analyst to work on a diagram at a time.

System crashes (.EAPX/.EAP files only) If a user's machine crashes, the network suffers an outage
or a machine is turned off unexpectedly, the project file might require repair to
compensate for the sudden inconsistency; a repair facility is provided ('Configure >
Model > Integrity > Manage .EAPX/.EAP File > Repair .EAPX/.EAP File') to carry
out this task.

Notes

Firebird-based projects (.feap files) are not suitable for sharing over a network·
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Distributed Development

Enterprise Architect supports distributed development using two different techniques.

Replication

Using replication, geographically separated analysts can update and modify parts of the model in replicas, then merge
these back together at a central location.

XMI Import/Export

Using XML-based import/export, you can export discrete Packages to XML to share among the development team; this
has several benefits over replication:

You can assemble a model from only the parts necessary to get your job done·

You can assemble a full model if required·

You can assemble a model from different Package versions for different purposes (such as customer visible, internal·
release only)

You can roll-back parts of a model as required·

There is less chance of 'collisions' between developers if each works on a discrete Package·

The process is controllable using a Version Control system, or through Package control·

XML-based import/export is UML1.3 / XMI1.1 compliant; you can also write XML based tools to manipulate and
extract information from XML files to enhance the development process.

XML-based Import/Export is accessed through the 'Publish > Model Exchange > Export-XML' and 'Import-XML' ribbon
options.
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Replication

Apart from sharing Enterprise Architect projects in real time over a network, you can also share projects using
replication.

Guide

Facility Detail

Replication Replication is a powerful means of sharing projects between isolated or mobile
users; it enables different users to work independently of one another, and to merge
their changes at a later time.

In Replication:

A project is converted to a design master, then replicas are made of the master·

Users take the replicas away, modify the project, then bring their replicas back·
to be synchronized with the master file

Use Replication To use replication:

Convert the base project to a design master.1.

Create replicas from the design master.2.

Take the replica away and work on it as required, then bring it back for3.
synchronization with the design master.

Synchronize the replicas, during which all changes to both the master and the4.
replica are propagated in both directions, so they both finally contain the same
information.

Enterprise Architect Merge
Rules

Enterprise Architect follows these rules in merging:

Additions are cumulative; that is, two replicas each creating three new Classes·
result in six new Classes after merging

Deletions prevail over modifications; if one replica changes a Class name and·
other deletes the Class, merging replicas results in both files losing the Class

Conflicting modifications appear in the 'Resolve Replication Conflicts' dialog.

Upgrades and Replicas When you upgrade your version of Enterprise Architect, you must not open a
replica until you have opened the design master and then synchronized the replicas
with the master; you cannot directly upgrade a replica.

Avoid Change Collisions If two or more people make changes to the same element, Enterprise Architect
arbitrarily overwrites one person's change with the other's; to avoid this, different
users should work on different Packages.

However, since Enterprise Architect does not enforce this rule, it is possible for
users' work to conflict; to minimize difficulties, please note these guidelines:

If users are likely to have worked in the same area of the model, they should·
both witness the synchronization and confirm that they are happy with the net
result

If small pieces of information have been lost, they should be typed into one of·
the merged models after synchronization

If a large piece of information has been lost (for example, an overwritten large·
Class note) use the 'Resolve Replication Conflicts' dialog
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Disable or Remove
Replication Features

If you have converted a project to a design master but now want to disable the
replication features, you can remove Replication; ensure that you back up all your
files first.
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Design Masters

A design master is the first converted Enterprise Architect project that supports replication. You create the master project
from which you create replicas that can be modified independently of the master project and re-merged later.

Access

Ribbon Configure > Model > Integrity > Manage .EAPX/.EAP File > Make Design Master

Create a design master

Step Action

1 Take a back-up of the required Enterprise Architect project.

2 Select the project in the Browser window.

3 Select the 'Make Design Master' menu option and follow the on-screen instructions.
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Create Replicas

A replica is one of several copies of the design master of an Enterprise Architect project. You create the copy of the
master project for you or another user to modify independently and re-merge later.

Access

Ribbon Configure > Model > Integrity > Manage .EAPX/.EAP File > Create New Replica

Create a replica

Step Action

1 First create a design master, then select the 'Create New Replica' menu option and follow the on-screen
instructions.

2 Edit the replica over time and, when required, return the file for merging with the design master.

Notes

In the Corporate, Unified and Ultimate editions of Enterprise Architect, if security is enabled you must have·
'Manage Replicas' permission to create a replica
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Synchronize Replicas

Synchronizing replicas combines the changes made to each file. You can:

Merge the changes made to each replica with the design master, so that a new set of replicas with all changes can be·
generated and distributed

Combine the changes made to two replicas, should it be necessary for two team members to combine their work·

Access

Ribbon Configure > Model > Integrity > Manage .EAPX/.EAP File > Synchronize Replicas

Synchronize replicas

Step Action

1 Open the design master project file (or the first required replica).

2 Select the 'Synchronize Replicas' menu option.

3 Locate and select the (second) required replica to merge the open project and the replica.

Notes

Information is copied both ways, including deletes, updates and inserts; both projects end up containing identical·
information

If this process generates 'conflicting changes' errors, you should review and, if necessary, resolve these conflicts·

In the Corporate, Unified and Ultimate editions of Enterprise Architect, if security is enabled you must have·
'Manage Replicas' permission to create a replica
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Remove Replication

Replication makes many changes to the database structure of your model, so the model file becomes considerably larger
with additional information; you might, therefore, decide not to use the replication feature any more.

Access

Ribbon Configure > Model > Integrity > Manage .EAPX/.EAP File > Remove Replication

Remove replication from your model

Step Action

1 Open a .EAP file (any .EAP file, other than the one having replication removed) - the menu option is not
available if no file is open.

2 Select the 'Remove Replication' menu option.

The 'Remove Replication Wizard' dialog displays.

3 Enter the full path and file name of the project to have replication removed.

Click on the Next button.

If the project displays Version Number 7.0 this indicates that Auditing is enabled. Auditing should be
disabled before proceeding (see Notes).

4 Enter the full path and file name of the base Enterprise Architect model (with no replication) to act as
template.

Click on the Next button.

5 Enter the full path and required file name for the output file.

Click on the Next button.

6 Select whether to have a log file created and, if so, enter a file name for the log file.

7 Click on the Run button to begin removing replication.

Enterprise Architect creates a new project containing all the model information.

Your model has now had replication removed, and should be considerably smaller.

Notes

You cannot remove replication from a model with Auditing enabled - if you want to remove replication:·

Disable Auditing.1.

If prompted to do so, allow Enterprise Architect to roll back the database version.2.
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Remove replication.3.
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Upgrade Replicas

A new release of Enterprise Architect might contain changes to the underlying project structure, such as more tables or
changed queries. If you use Replication, you must take care with your upgrade.

Considerations

Consideration Detail

Open Design Master
Project first

After installing the new version of Enterprise Architect, it is very important that
you open the design master before opening any of the replicas with the updated
version.

Changes to the database
design

Changes to the database design in a replicated project can ONLY be done to the
design master; trying to update a replica at best does nothing, and at worst causes
the update of the master to fail.

Propagate Changes Design changes are propagated through to the replicas the next time the replicas are
synchronized with the master.

Alternatively One other strategy is to remove replication from a copy of the replica set, upgrade
that project and convert it into a new design master from which new replicas are
created.
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Resolve Conflicts

If two or more people each work on the same model object in their respective replicas between synchronizations, the
replication engine has problems in resolving which change is the master. You need to select which of two conflicting
changes you should save to the Design Master and/or replicas, where a substantial piece of information has been
overridden by a user and you want to retrieve it.

Access

Ribbon Configure > Model > Integrity > Manage .EAPX/.EAP File > Resolve Replication
Conflicts

Considerations

Consideration Detail

Avoid the problem Ensure that each team member always works in a separate area of the model within
their replica.

Check for conflicts After synchronizing replicas, open the 'Resolve Conflicts' dialog (see next table)
and check if there were any conflicts.

Response to conflicts When a project record has been modified in different ways by different users, the
replication engine selects one of the conflicting values based on rules within the
JET replication manager.

However, the replication engine stores the discarded changes and flags the conflict
on the 'Resolve Conflicts' dialog so that you can choose to roll in the discarded
change instead.

Normally it is not necessary or desirable to examine conflicts, since they represent
relatively inconsequential pieces of information that can very easily be modified
through the normal Enterprise Architect interface; for example, by moving a
diagram element.

The only case in which the 'Resolve Conflicts' dialog should be used is where a
substantial piece of information has been overridden by a user, and you want to
retrieve it.

Resolve conflicts in changes to the same model object in two separate replicas

Step Action

1 Synchronize a replica with the Design Master, and display the 'Resolve Conflicts' dialog.

2 In the 'Table with Conflicts' list, click on the entry that is likely to contain the lost information.
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3 Click on each entry in the Conflicting Records list.

When the lost information appears in the Conflict Details list, click on the Overwrite with Conflict button.

4 In the 'Conflicting Records' list, you can also copy each Row ID to the clipboard by right-clicking on the
row and selecting the 'Copy to Clipboard' menu option.

You can locate the object that is in conflict in the Browser window or diagrams, by right-clicking on it
and selecting the 'Find in Project Browser' or 'Find in Diagrams' option.
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Server Based Repositories

As an Enterprise Architect repository becomes larger, or the number of concurrent users increases or as organizational
policy dictates, it might be more appropriate to use a database management system (DBMS) to store the repository. A
File Based Repository can be created and used in any edition of Enterprise Architect; however, if you decide to use a
DBMS based repository you will need to use the Corporate, Unified or Ultimate editions. Enterprise Architect has a
function to transfer your repository from a file based repository to a server based one, helping you to get started quickly
and with no changes in the user interface.

Note that the performance of the Repository as experienced by end users will depend very much on the quality and
power of the server machine and the network infrastructure on which the DBMS and user are located. Using a DBMS
over a very high latency (10ms or higher) network can result in significant delays and visibly inferior performance.
When network latency is an issue, Sparx Systems recommends using a Cloud Based Server as the interactions are
optimized to reduce the effect of network latency.

Also it is important to note that all models are quite different and although Sparx Systems does its best to maximize
performance based on what is expected to be held in a repository, sometimes this is not quite sufficient. In these rare
cases a review of the database indexes would be good practice to maximize data retrieval and access. This will ensure
that end users receive the best possible performance even when models contain millions of constructs.

Set up a Project on a DBMS repository

To set up your project on a DBMS repository, you work through these stages:

Set up your DBMS software and create a database.1.

Create the required tables in your database, by running a script supplied on the Sparx Systems website.2.

(For certain DBMS products) Set up an ODBC driver to enable connection to the repository.3.

Transfer the project from the source file to the DBMS repository; the source file can be:4.
     -  a .EAP or .FEAP base model, to begin a new project from scratch, or
     -  a previously-developed project file, to move an existing project into the DBMS repository

Connect to your repository.5.

DBMS Products you can use

You can set up your project on a repository in:

Firebird from v2·

MySQL from v5·

MariaDB·

Microsoft SQL Server from 2005, all editions including Express and Azure·

Microsoft Access from 2007·

Oracle from 9i (all editions)·

PostgreSQL from v8·

For information on creating a project on a specific DBMS from this list, see Learn more.
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Notes

You cannot move a model from a source .eap file of an Enterprise Architect version earlier than 3.5.0 without·
updating it first

Before proceeding, you must have MDAC 2.6 or higher installed on your system·

(Optional, but recommended) before actually transferring the project structure from the file to the repository,·
perform a Project Data Integrity Check on the file
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Create a Project in a MariaDB Database

To create a project in a MariaDB repository, you work through these stages:

Stage 1: Create an empty database repository and set up the data tables·

Stage 2: Set up the ODBC Driver·

Stage 3: Set up initial model data·

Prerequisites

A machine with MariaDB version 10.1.2 or higher installed and running·

MySQL ODBC·

1. Create a MariaDB Repository

Step Action

1.1 Create a new empty database and configure it to your installation's defaults.

1.2 Open your SQL management console of choice (such as HeidiSQL) and connect to the new database.

1.3 Load the EASchema_1220_MySQL.sql file from the Sparx Systems website.

1.4 Run EASchema_1220_MySQL.sql  to create the required database schema.

2. Set up the ODBC DSN

Step Action

2.1 Create a suitable ODBC Data Source (using the MySQL ODBC driver and NOT the MariaDB driver), to
the new database.

Make sure you select the extended option:

'Return matched rows instead of affected rows'·

3. Set up Initial Data

Enterprise Architect repositories require a basic amount of reference data to function correctly.

You can set up this initial data in one of two different ways:

Transfer the entire contents of an existing model into the new database, or·

Load initial data using a SQL Script·
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3.1. Load Initial Data - Transfer existing model

If you choose to set up your new database with the contents of an existing model then Sparx Systems recommend that a
Project Integrity check is performed on the existing model to ensure it is 'clean' and free from data-related errors before
being copied into the new database.

The Enterprise Architect installation provides a model called EABase.eap, which is copied into the installation folder
specifically for the purpose of providing basic data for a new model. However, if you have customized the various
drop-down lists in another model then you might prefer to use that. Regardless of what model you choose to use, the
process is the same and is outlined here.

Step Action

3.1.1 In Enterprise Architect, open the existing repository and select the 'Configure > Model > Integrity >
Project Integrity' ribbon option.

3.1.2 In the 'Action' panel select the 'Report Only' radio button, and in the 'Checks to Run' panel select all check
boxes. Click on the Go button.

3.1.3 If Enterprise Architect detects that the existing model contains integrity issues, they will be listed in the
main panel at the bottom of the dialog. These issues should be resolved before continuing with the project
transfer.

3.1.4
With Enterprise Architect open, ensure that there is no project loaded, by clicking on the 
button and selecting 'Close Project'.

3.1.5 Select the 'Configure > Model > Transfer > Project Transfer' ribbon option.

The 'Project Transfer' dialog displays.

3.1.6 In the 'Transfer Type' panel, select 'File to DBMS'.

3.1.7
In the 'Source Project' field, click on the  button and browse for the name of the project file to copy to
the repository.

If the .EAP file has Replication enabled, this must be removed before performing the transfer.

3.1.8
At the right of the 'Target Project' field, click on the  button.

The 'Datalink Properties' dialog displays.

3.1.9 Select 'Microsoft OLE DB Provider for ODBC Drivers' from the list.

Click on the Next button.

3.1.1
0

In the 'Use Data source name' field, click on the drop-down arrow and select the ODBC Data Source you
configured to point to your new database.

Click on the OK button. The 'Project Transfer' dialog redisplays.

3.1.1
1

If required, select the 'Logfile' checkbox and type a path and filename for the data transfer log file.

3.1.1
2

Click on the Transfer button to begin the data transfer process.
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3.1.1
3

When the process is complete, you have created a project on a MariaDB database and can now connect to
it and open it from Enterprise Architect.

3.2. Load Initial Data - SQL Script

The Sparx Systems website provides a SQL Script that contains a series of INSERT statements that will load an empty
database with all the data needed by Enterprise Architect.

Step Action

3.2.1 Open your SQL management console of choice (such as HeidiSQL) and connect to the new database.

3.2.2 Load the EABase_1220_MySQL.sql file from the Sparx Systems website.

3.2.3 Run EABase_1220_MySQL.sql  to create the required database schema.
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Create a MariaDB Repository

Creating a MariaDB database is fully documented in the product information provided with your MariaDB installer or on
the MariaDB website.

There are many ways to create a new MariaDB database. One common method is to use a SQL-based Management
Console such as HeidiSQL, which provides a convenient graphical user interface to enable  creating databases, executing
scripts, and performing backups and restores. However, the exact method used is not important to this discussion,
therefore you are free to use the most convenient or familiar method at your disposal.

Having created your MariaDB database, use the MySQL SQL script provided by Sparx Systems to create the required
table definitions for Enterprise Architect. The EASchema_1220_MySQL.sql script is freely available on the DBMS 
Based Repositories page on the Sparx Systems website.

Notes

Ensure that the collation is set to the alphabet you use, such as Latin or Cyrillic·
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Set up a MariaDB ODBC Driver

After you have created a MariaDB database, you will need to set up an ODBC DSN to the new database in order for
Enterprise Architect to connect to it.  Sparx Systems recommend that the MySQL ODBC driver is used to connect to
MariaDB-based repositories, as the native MariaDB ODBC driver is not fully compatible with connection methods
employed by Enterprise Architect.

Prerequisites

Install:

MariaDB DBMS and repository·

MySQL ODBC driver software·

Set up the ODBC Driver

Step Action

1 Under both 32-bit and 64-bit operating systems, Enterprise Architect requires 32-bit ODBC drivers to
connect to a repository through ODBC. You can quickly load the correct 32-bit ODBC Data Source
Administrator by selecting the 'Configure > User Tools > ODBC Data Sources' ribbon option.

The ODBC Data Source Administrator window displays.

2 Click on the Add button.

The 'Create New Data Source' dialog displays, enabling you to add a new DSN.

3 Select the appropriate MySQL ODBC Driver from the list.

4 Click on the Finish button.

The 'MySQL Connector/ODBC' dialog displays.

5 Enter these configuration details:

A data source name for the connection·

A description (optional)·

The host address of the DBMS server·

User name and password·

The database name on the selected server·

6 To set the advanced options, click on the Details>> button.

7 Select these checkboxes (where provided):

'Return matched rows instead of affected rows' ('Connection' or 'Cursors/Results' tab)·

'Allow big result sets' ('Connection' tab)·

8 Click on the Test Connection button to confirm that the details are correct.

9 If the test succeeds, click on the OK button to complete the configuration.
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If the test does not succeed, review your settings.

Notes

Connecting to DBMS based Repositories is available in the Enterprise Architect Corporate, Unified and Ultimate·
editions
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Connect to a MariaDB Repository

To access your MariaDB repository, you must provide the connection details to Enterprise Architect.

Prerequisites

The MariaDB repository and the project already exist·

You know the database user credentials that have SELECT, INSERT, UPDATE, DELETE, EXECUTE and SHOW·
VIEW access permissions

The MySQL ODBC driver has been set up·

Access

Ribbon
: Open Project

Keyboard Shortcuts Ctrl+O

Connect to the repository

Step Action

1 In the 'Open Project' dialog, select the 'Connect to Server' checkbox.

2
Click on the  button.

The 'Data Link Properties' dialog displays.

3 Select 'Microsoft OLE DB Provider for ODBC Drivers' from the list.

4 Click on the Next>> button.

The 'Connection' tab displays.

5 Click on the 'Use data source name' radio button and on the drop-down arrow in its field.

From the list, select the ODBC driver you have set up to connect to your MariaDB repository.

6 If required, type in a user name and password.

7 If required, type in an initial catalog.

8 Click on the Test Connection button to confirm that the details are correct.

9 If the test does not succeed, revise your settings.

If the test succeeds, click on the OK button; the 'Connection Name & Type' dialog displays.
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10 Give the connection a suitable name so that you can recognize it in the 'Recent Projects' panel on the
'Open Project' dialog.

11 If required, select the 'Encrypt Connection String' checkbox.

This encrypts and hides the connection details of the database from the users that the connection string is
given to.

12 If required, select the 'Lazy Load' checkbox to not load the full project view when the model is loaded;
instead, only the parts that are necessary to display the visible portion of the tree are loaded.

With this setting, the model loads faster and users can begin work sooner, but at the expense of later small
delays as Enterprise Architect loads specific portions of the model.

13 If required, select the 'Use WAN Optimization' checkbox.

Note: this option is only included for historical reasons, the WAN Optimizer product has been replaced by
the vastly improved Pro Cloud Server.

The WAN Optimizer was originally created to improve performance over a Wide Area Network by
compressing all database requests from Enterprise Architect to reducing transfer times.

If you select this checkbox, complete the next three fields (see your administrator for the correct values);
otherwise go to step 17.

14 In the 'Server' field, type the network name or address of the optimizer server.

15 In the 'Port' field, type the Port on which the server is running on the remote machine.

16 In the 'DSN' field, type the data source name of the database as it appears on the remote machine.

17 Click on the OK button to complete the configuration and open the project.

This also adds the project name to the 'Recent' list on the 'Start Page'; from now on, you can open the
project again just by clicking on this name.

Notes

Connecting to DBMS based Repositories is available in the Corporate, Unified and Ultimate editions of Enterprise·
Architect
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Create a Project in an MS Access 2007 Database

Setting up a project in a Microsoft Access 2007 repository typically involves the conversion of an existing .EAP or
.EAPX file, which can be achieved in two different ways:

You have a working copy of MS Access 2007 itself, in which case you can convert your existing .EAP/.EAPX·
project directly to an MS Access 2007 (.ACCDB) file, or

The existing repository can be transferred into an empty MS Access 2007 database·

In either case, before you convert or transfer your existing project, you should perform a project integrity check on the
source model to ensure that is 'clean' and free from data related errors.

Prerequisites

The 'Microsoft Office 12.0 Access Database Engine OLE DB Provider' ODBC driver is installed·

1. Perform a Project Integrity Check

While this step is optional, Sparx Systems do recommend that it is performed.

Step Action

1.1 Using Enterprise Architect, open the source project .EAP/.EAPX file.

1.2 Select the 'Configure > Model > Integrity > Project Integrity' ribbon option.

1.3 Ensure that in the 'Action' panel 'Report Only' is selected, and that all checkboxes in the 'Checks to Run'
panel are selected, then click on

the Go button.

1.4 If Enterprise Architect detects that the existing model contains integrity issues, they will be listed in the
main panel at the bottom of the dialog. These issues should be resolved before continuing with the project
transfer.

2a. Convert source project with MS Access 2007

Step Action

2a.1 Open MS Access 2007 and load the source .EAP/.EAPX file within this product.

Allow Access to convert the source project to a .ACCDB file. Once this process is complete your project
will be an MS Access 2007 repository.

2b. Transfer source project to an empty .ACCDB file
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Step Action

2b.1 Open Enterprise Architect.

(If the 'Open Project' dialog displays, click on the Cancel button to open with no project loaded.)

2b.2 Select the 'Configure > Model > Transfer > Project Transfer' ribbon option.

The 'Project Transfer' dialog displays.

2b.3 In the 'Transfer Type' panel, select 'File to DBMS'.

2b.4 In the 'Source Project' field, type the name of the .EAP/.EAPX file to copy to the repository.

If the .EAP file has Replication enabled, this must be removed before performing the transfer.

2b.5
At the right of the 'Target Project' field, click on the  button.

The 'Datalink Properties' dialog displays.

2b.6 Select 'Microsoft Office 12.0 Access Database Engine OLE DB Provider' from the list.

Click on the Next button.

2b.7 Obtain an empty MS Access 2007 base project from the Sparx Systems DBMS Based Repositories web
page, and rename the file to suit the intended purpose.

2b.8 On the 'Data Source Details' page of the 'Datalink Properties' dialog, type in the full path to the Access
2007 .ACCDB file.

Click on the OK button to return to the 'Project Transfer' dialog.

2b.9 If required, select the 'Logfile' checkbox and type a path and filename for the data transfer log file.

2b.1
0

Click on the Transfer button to begin the data transfer process.

When the process is complete, you will have created your project in an Access 2007 database and can
open it directly from Enterprise Architect, browsing for the .ACCDB file location in the 'Open Project'
dialog.

3. Set up the ODBC DSN

Step Action

3.1 Create a suitable ODBC Data Source to point to your new database.

Notes

Connecting to DBMS based Repositories is available in the Enterprise Architect Corporate, Unified and Ultimate·
editions

If you do not have Access 2007, you can download the Access Database Engine from the Microsoft downloads site·
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Ensure that the collation is set to the alphabet you use, such as Latin or Cyrillic·
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Create a Project in a MySQL Database

To create a project in a MySQL repository, you work through these stages:

Stage 1: Create an empty database repository and set up the data tables·

Stage 2: Set up the ODBC Driver·

Stage 3: Set up initial model data·

Prerequisites

A machine with MySQL version 5 or higher installed and running·

MySQL 32bit ODBC driver, between versions 5.2.4 and 5.3.6 (other versions are not recommended)·

1. Create a MySQL Repository

MySQL supports two different storage engines - InnoDB and MyISAM. In older versions of MySQL, MyISAM was the
default storage engine, but from MySQL v5.5 onwards InnoDB is the default. As of Enterprise Architect v13, Sparx
Systems will no longer provide updates to the MyISAM script and we recommend all users to choose InnoDB, as it
supports transactions and UTF8.

Step Action

1.1 Create a new empty database and configure it to your installation's defaults.

1.2 Open your SQL management console of choice (such as MySQL Workbench) and connect to the new
database.

1.3 Load the EASchema_1220_MySQL.sql file from the Sparx Systems website.

1.4 Run EASchema_1220_MySQL.sql  to create the required database schema.

2. Set up the ODBC DSN

Step Action

2.1 Create a suitable ODBC Data Source (using the MySQL ODBC driver) for the new database.

Make sure you select these extended options:

'Return matched rows instead of affected rows'·

'Allow big result sets'·

3. Set up Initial Data

Enterprise Architect repositories require a basic amount of reference data to function correctly.
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You can set up this initial data in one of two different ways:

Transfer the entire contents of an existing model into the new database, or·

Load initial data using a SQL Script·

3.1 Load Initial Data - Transfer existing model

If you choose to set up your new database with the contents of an existing model then Sparx Systems recommend that a
Project Integrity check is performed on the existing model to ensure it is 'clean' and free from data-related errors before
being copied into the new database.

The Enterprise Architect installation provides a model called EABase.eap, which is copied into the installation folder
specifically for the purpose of providing basic data for a new model. However, if you have customized the various
drop-down lists in another model then you might prefer to use that. Regardless of what model you choose to use, the
process is the same and is outlined here.

Step Action

3.1.1 In Enterprise Architect, open the existing repository and select the 'Configure > Model > Integrity >
Project Integrity' ribbon option.

3.1.2 In the 'Action' panel, select the 'Report Only' radio button, and in the 'Checks to Run' panel select all
checkboxes. Click on the Go button.

3.1.3 If Enterprise Architect detects that the existing model contains integrity issues, they will be listed in the
main panel at the bottom of the dialog. These issues should be resolved before continuing with the project
transfer.

3.1.4
With Enterprise Architect open ensure that there is no project loaded, by clicking on the  button
and selecting 'Close Project'.

3.1.5 Select the 'Configure > Model > Transfer > Project Transfer' ribbon option.

The 'Project Transfer' dialog displays.

3.1.6 In the 'Transfer Type' panel, select 'File to DBMS'.

3.1.7
In the 'Source Project' field, click on the  button and browse for the name of the project file to copy to
the repository.

If the .EAP file has Replication enabled, this must be removed before performing the transfer.

3.1.8
At the right of the 'Target Project' field, click on the  button.

The 'Datalink Properties' dialog displays.

3.1.9 Select 'Microsoft OLE DB Provider for ODBC Drivers' from the list.

Click on the Next button.

3.1.1
0

In the 'Use Data source name' field, click on the drop-down arrow and select the ODBC Data Source you
configured to point to your new database.

Click on the OK button. The 'Project Transfer' dialog redisplays.

3.1.1 If required, select the 'Logfile' checkbox and type a path and filename for the data transfer log file.
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1

3.1.1
2

Click on the Transfer button to begin the data transfer process.

3.1.1
3

When the process is complete, you have created a project on a MySQL database and can now connect to it
and open it from Enterprise Architect.

3.2 Load Initial Data - SQL Script

Step Action

3.2.1 Open your SQL management console of choice (such as MySQL Workbench), and connect to the new
database.

3.2.2 Load the EABase_1220_MySQL.sql file from the Sparx Systems website.

3.2.3 Run EABase_1220_MySQL.sql  to create the required database schema.
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Create a MySQL Repository

Creating a MySQL database is fully documented in the product information provided with your MySQL installer.

There are many ways to create a new MySQL database. A common method is to use an SQL-based Management
Console such as MySQL Workbench, which provides a convenient graphical user interface for the creation of databases,
the execution of scripts, and backups and restores.  However, the exact method used is not important to this discussion,
and you can use the most convenient or familiar method at your disposal.

Having created your MySQL database, use the SQL script provided by Sparx Systems to create the required table
definitions for Enterprise Architect. The EASchema_1220_MySQL.sql script is freely available on the DBMS Based 
Repositories page on the Sparx Systems website.

Notes

Ensure that the collation is set to the alphabet you use, such as Latin or Cyrillic·
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Set up a MySQL ODBC Driver

After you have created a MySQL database, you will need to set up an ODBC DSN to the new database in order for
Enterprise Architect to connect to it.

Prerequisites

Install:

MySQL DBMS and repository·

MySQL 32bit ODBC driver, between versions 5.2.4 and 5.3.6·

Set up the ODBC Driver

Step Action

1 Under both 32-bit and 64-bit operating systems, Enterprise Architect requires 32-bit ODBC drivers to
connect to a repository through ODBC. You can quickly load the correct 32-bit ODBC Data Source
Administrator by selecting the 'Configure > User Tools > ODBC Data Sources' ribbon option.

The ODBC Data Source Administrator window displays.

2 Click on the Add button.

The 'Create New Data Source' dialog displays, enabling you to add a new DSN.

3 Select the appropriate MySQL ODBC Driver from the list.

4 Click on the Finish button.

The 'MySQL Connector/ODBC' dialog displays.

5 Enter these configuration details:

A data source name for the connection·

A description (optional)·

The host address of the DBMS server·

User name and password·

The database name on the selected server·

6 To set the advanced options, click on the Details>> button.

7 Select these checkboxes (where provided):

'Return matched rows instead of affected rows' ('Connection' or 'Cursors/Results' tab)·

'Allow big result sets' ('Connection' tab)·

8 Click on the Test Connection button to confirm that the details are correct.

9 If the test succeeds, click on the OK button to complete the configuration.

If the test does not succeed, review your settings.
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Notes

Connecting to DBMS based Repositories is available in the Enterprise Architect Corporate, Unified and Ultimate·
editions
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Connect to a MySQL Repository

To access a project in your MySQL data repository, you must connect to the data repository from Enterprise Architect.

Prerequisites

The MySQL repository and the project already exist·

You know the database user credentials that have SELECT, INSERT, UPDATE, DELETE, EXECUTE and SHOW·
VIEW access permissions

The MySQL ODBC driver has been set up·

Access

Ribbon
: Open Project

Keyboard Shortcuts Ctrl+O

Connect to the repository

Step Action

1 In the 'Open Project' dialog, select the 'Connect to Server' checkbox.

2
Click on the  button.

The 'Data Link Properties' dialog displays.

3 Select 'Microsoft OLE DB Provider for ODBC Drivers' from the list.

4 Click on the Next>> button.

The 'Connection' tab displays.

5 Click on the 'Use data source name' radio button and on the drop-down arrow in the corresponding field.

From the list, select the ODBC driver you have set up to connect to your MySQL repository.

6 If required, type in a user name and password.

7 If required, type in an initial catalog.

8 Click on the Test Connection button to confirm that the details are correct.

9 If the test does not succeed, revise your settings.

If the test succeeds, click on the OK button; the 'Connection Name & Type' dialog displays.
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10 Give the connection a suitable name so that you can recognize it in the 'Recent Projects' panel on the
'Open Project' dialog.

11 If required, select the 'Encrypt Connection String' checkbox.

This encrypts and hides the connection details of the database from the users that the connection string is
given to.

12 If required, select the 'Lazy Load' checkbox to not load the full project view when the model is loaded;
instead, only the parts that are necessary to display the visible portion of the tree are loaded.

With this setting, the model loads faster and users can begin work sooner, but at the expense of later small
delays as Enterprise Architect loads specific portions of the model.

13 If required, select the 'Use WAN Optimization' checkbox.

Note: this option is only included for historical reasons, the WAN Optimizer product has been replaced by
the vastly improved Pro Cloud Server.

The WAN Optimizer was originally created to improve performance over a Wide Area Network by
compressing all database requests from Enterprise Architect to reducing transfer times.

If you select this checkbox, complete the next three fields (see your administrator for the correct values);
otherwise go to step 17.

14 In the 'Server' field, type the network name or address of the optimizer server.

15 In the 'Port' field, type the number of the Port on which the server is running on the remote machine.

16 In the 'DSN' field, type the data source name of the database as it appears on the remote machine.

17 Click on the OK button to complete the configuration and open the project.

This also adds the project name to the 'Recent' list on the Start Page; from now on, you can open the
project again just by clicking on this name.

Notes

Connecting to DBMS based Repositories is available in the Corporate, Unified and Ultimate editions of Enterprise·
Architect
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Create a Project in an Oracle Database

To create a project in a repository on Oracle 9i, 10g, 11g or 12c, you work through these stages:

Stage 1: Create a new Oracle database user to own the Enterprise Architect tables·

Stage 2: Connect to the Oracle repository; Sparx Systems recommends using Oracle Provider for OLE DB -·
connecting with either Microsoft OLE DB Provider for ODBC or Microsoft OLE DB Provider for Oracle could
cause unexpected behavior or performance issues due to known limitations of those drivers

Stage 3: Set up initial model data·

Prerequisites

A machine with Oracle 9i, 10g, 11 g or 12c installed and running·

Oracle Client installed on the client machine, please ensure that the OLE/DB drivers are installed (you can download·
the drivers from the Oracle Technology Network web site, as part of the Oracle Data Access Components (ODAC)
package; see Learn more)

1. Create Database Repository

Step Action

1.1 Create a new Oracle database user to own the Enterprise Architect tables.

1.2 Open your SQL management console of choice (such as Oracle SQL Developer) and connect to the newly
create Enterprise Architect repository.

1.3 Load the EASchema_1220_Oracle.sql file from the Sparx Systems website.

1.4 Run the script to create the required database schema.

2. Set up Oracle connection

2.1 In order for an OLE/DB connection to connect to an Oracle based Enterprise Architect repository, an
entry in each user's local TNSNAMES.ORA needs to be defined, stating the server name, Port and other
details of the Oracle server.

3. Set up Initial Data

Enterprise Architect repositories require a basic amount of reference data to function correctly.

You can set up this initial data in one of two different ways:

Transfer the entire contents of an existing model into the new database, or·
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Load initial data using a SQL Script·

3.1 Load Initial Data - Transfer existing model

If you choose to set up your new database with the contents of an existing model then Sparx Systems recommend that a
Project Integrity check is performed on the existing model to ensure it is 'clean' and free from data-related errors before
being copied into the new database.

The Enterprise Architect installation provides a model called EABase.eap, which is copied into the installation folder
specifically for the purpose of providing basic data for a new model. However, if you have customized the various
drop-down lists in another model then you might prefer to use that. Regardless of what model you choose to use, the
process is the same and is outlined here.

Step Action

3.1.1 In Enterprise Architect, open the existing repository and select 'Configure > Model > Integrity > Project
Integrity' in the ribbon.

3.1.2 Ensure that the 'Action' panel is set to 'Report Only' and that all items in 'Checks to Run' are enabled, then
click on the Go button.

3.1.3 If Enterprise Architect detects that the existing model contains integrity issues, they will be listed in the
main panel at the bottom of the dialog. These issues should be resolved before continuing with the project
transfer.

3.1.4 With Enterprise Architect open, ensure that it there is no project loaded, by selecting 'Close Project' from

the   button.

3.1.5 Select the 'Configure > Model > Transfer > Project Transfer' ribbon option.

The 'Project Transfer' dialog displays.

3.1.6 In the 'Transfer Type' panel, select 'File to DBMS'.

3.1.7
At the right of the 'Source Project' field, click on the  button and browse for the name of the project
file to copy to Oracle.

If the .EAP file has Replication enabled, this must be removed before performing the transfer.

3.1.8
At the right of the 'Target Project' field, click on the  button.

The 'Datalink Properties' dialog displays.

3.1.9 Select 'Oracle Provider for OLE DB' from the list.

Click on the Next button.

3.1.1
0

On the 'Connection' page of the 'Datalink Properties' dialog, enter the Oracle service name in the 'Data
Source' field, and the user name and password as required.

Click on the OK button. The 'Project Transfer' dialog redisplays.

3.1.1
1

If required, select the 'Logfile' checkbox and type a path and filename for the data transfer log file.

3.1.1 Click on the Transfer button to begin the data transfer process.
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2

3.1.1
3

When the process is complete, you have created a project on an Oracle database and can now connect to it
and open it from Enterprise Architect.

3.2. Load Initial Data - SQL Script

3.2.1 Open your SQL management console of choice (such as SQL Developer) and log in as the owner of the
newly created Enterprise Architect repository.

3.2.2 Load the EABase_1220_Oracle.sql file from the Sparx Systems website.

3.2.3 Run EABase_1220_Oracle.sql  to create the required database schema.

Notes

When transferring a project to Oracle you must have access rights to execute the CREATE SEQUENCE command·
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Create an Oracle Repository

Creating an Oracle database is fully documented in the product information provided with your Oracle installer.

Before creating an Oracle data repository, install the appropriate version of Oracle (9i, 10g, 11g or 12c) and MDAC 2.6
or higher, and obtain access permission to create a new database.

There are many ways to create a new Oracle repository; a common method is to use a SQL-based Management Console
such as SQL Developer, which provides a convenient graphical user interface for creating databases, executing scripts,
and making backups and restores.  However, the exact method used is not important to this discussion, and you can use
the most convenient or familiar method at your disposal.

Having created your Oracle repository, use the SQL script provided by Sparx Systems to create the required table
definitions and indexes for Enterprise Architect. The  EASchema_1220_Oracle.sql is freely available on the DBMS 
Based Repositories page on the Sparx Systems website.

Notes

Enterprise Architect only supports the 32-bit versions of Oracle's OLE/DB and ODBC drivers·

For performance reasons, Sparx Systems recommends the use of the Oracle's OLE/DB driver over the Oracle ODBC·
driver

Enterprise Architect is not compatible with the Microsoft OLE DB Provider for Oracle driver·

Set the collation to the alphabet you use, such as Latin or Cyrillic·
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Set up an Oracle ODBC Driver

After you have created an Oracle repository, you can either set up an ODBC DSN to the new database in order for
Enterprise Architect to connect to it, or configure Enterprise Architect to use the Oracle OLE DB provider in connection
strings to the new database.

Notes:

For performance reasons, Sparx Systems recommends using Oracle Provider for OLE DB·

Enterprise Architect does not support the 'Microsoft OLE DB Provider for Oracle' driver·

Prerequisites

Install the Oracle DBMS and repository·

Set up the Oracle ODBC driver

Your Oracle driver is now available to connect to the repository from Enterprise Architect.

Step Action

1 Under both 32-bit and 64-bit operating systems, Enterprise Architect requires 32-bit ODBC drivers to
connect to a repository through ODBC. You can quickly load the correct 32-bit ODBC Data Source
Administrator by selecting the 'Configure > User Tools > ODBC Data Sources' ribbon option.

The ODBC Data Source Administrator window displays.

2 Click on the Add button.

The 'Create New Data Source' dialog displays, enabling you to add a new DSN.

3 Select 'Oracle in OraDB11g_home1' from the list (or similar, depending on the ODBC installation).

4 Click on the Finish button.

The 'Oracle ODBC Driver Configuration' dialog displays.

5 Enter these configuration details:

A data source name for the connection·

A description (optional)·

The TNS Service Name (click on the drop down arrow and select from the list)·

User ID·

6 Click on the Test Connection button and enter the Oracle user password to confirm that the details are
correct.

7 If the test succeeds, click on the OK button to complete the configuration.

If the test does not succeed, review your settings.
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Connect to an Oracle Repository (ODBC)

To access a your Oracle repository, you must provide the connection details to Enterprise Architect.

Note: For performance reasons, Sparx Systems recommends using Oracle Provider for OLE DB (see Connect to an
Oracle Data Repository (OLE DB)).

Note: Enterprise Architect does not support the 'Microsoft OLE DB Provider for Oracle' driver.

Prerequisites

The Oracle repository and the project already exist·

You have SELECT, UPDATE, INSERT and DELETE access permissions·

The Oracle ODBC driver has been set up·

Access

Ribbon
: Open Project

Keyboard Shortcuts Ctrl+O

Connect to an Oracle Data Repository using an ODBC Driver

Step Action

1 In the 'Open Project' dialog, select the 'Connect to Server' checkbox.

2
Click on the  button.

The 'Data Link Properties' dialog displays.

3 Select 'Microsoft OLE DB Provider for ODBC Drivers' from the list.

4 Click on the Next>> button.

The 'Connection' tab displays.

5 In the 'Data source' field, click on the drop-down arrow and select the data source name.

6 Type in the user name and password.

7 Click on the Test Connection button to confirm that the details are correct.

8 If the test does not succeed, revise your settings.

If the test succeeds, click on the OK button; Oracle prompts you for the password.
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9 Type in the password.

The 'Connection Name and Type' dialog displays.

10 Give the connection a suitable name so that you can recognize it in the 'Recent Projects' panel on the
'Open Project' dialog.

11 If you want to encrypt and hide the connection details of the database from the users that the connection
string is given to, select the 'Encrypt Connection String' checkbox.

12 The Lazy Load facility does not load the full project view when the model is loaded; instead, it loads only
the parts that are necessary to display the visible portion of the tree. With this set, the model loads faster
and users can begin work sooner, but at the expense of later small delays as Enterprise Architect loads
specific portions of the model.

If you want to use the Lazy load facility, select the 'Lazy Load' checkbox.

13 If required, select the 'Use WAN Optimization' checkbox.

Note: this option is only included for historical reasons, the WAN Optimizer product has been replaced by
the vastly improved Pro Cloud Server.

The WAN Optimizer was originally created to improve performance over a Wide Area Network by
compressing all database requests from Enterprise Architect to reducing transfer times.

If you select this checkbox, complete the next two fields (see your administrator for the correct values);
otherwise go to step 16.

14 In the 'Server' field, type the network name or address of the optimizer server.

15 In the 'Port' field, type the number of the Port on which the server is running on the remote machine.

16 Click on the OK button to complete the configuration and open the project.

This also adds the project name to the 'Recent' list on the Start Page; from now on, you can open the
project again just by clicking on this name.

Notes

Connecting to DBMS based Repositories is available in the Corporate, Unified and Ultimate editions of Enterprise·
Architect
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Connect to an Oracle Repository (OLE DB)

To access your Oracle repository, you must provide the connection details to Enterprise Architect.

Prerequisites

Oracle Client already installed on the client machine; please ensure that the OLE/DB drivers are installed (you can·
download the drivers from the Oracle Technology Network web site, as part of the Oracle Data Access Components
(ODAC) package -  see Learn more)

The Oracle repository and the project already exist·

You have SELECT, UPDATE, INSERT and DELETE access permissions·

Access

Ribbon
: Open Project

Keyboard Shortcuts Ctrl+O

Connect to an Oracle Repository using OLE DB

Step Action

1 In the 'Open Project' dialog, select the 'Connect to Server' checkbox.

2
Click on the  button.

The 'Data Link Properties' dialog displays.

3 Select 'Oracle Provider for OLE DB' from the list.

Do not select 'Microsoft OLE DB Provider for Oracle'; Enterprise Architect might not work as expected.

4 Click on the Next>> button.

The 'Connection' tab displays.

5 In the 'Data source' field, click on the drop-down arrow and select the data source name (the service name
of the Oracle database).

6 Type in the user name and password.

7 Click on the Test Connection button to confirm that the details are correct.

8 If the test does not succeed, revise your settings.

If the test succeeds, click on the OK button; the 'Connection Name and Type' dialog displays.
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9 Give the connection a suitable name so that you can recognize it in the 'Recent Projects' panel on the
'Open Project' dialog.

10 If you want to encrypt and hide the connection details of the database from the users that the connection
string is given to, select the 'Encrypt Connection String' checkbox.

11 If required, select the 'Lazy Load' checkbox to not load the full project view when the model is loaded;
instead, only the parts that are necessary to display the visible portion of the tree are loaded.

With this setting, the model loads faster and users can begin work sooner, but at the expense of later small
delays as Enterprise Architect loads specific portions of the model.

12 If required, select the 'Use WAN Optimization' checkbox.

Note: this option is only included for historical reasons, the WAN Optimizer product has been replaced by
the vastly improved Pro Cloud Server.

The WAN Optimizer was originally created to improve performance over a Wide Area Network by
compressing all database requests from Enterprise Architect to reducing transfer times.

If you select this checkbox, complete the next two fields (see your administrator for the correct values);
otherwise go to step 15.

13 In the 'Server' field, type the network name or address of the optimizer server.

14 In the 'Port' field, type the number of the Port on which the server is running on the remote machine.

15 Click on the OK button to complete the configuration and open the project.

This also adds the project name to the 'Recent' list on the Start Page; from now on, you can open the
project again just by clicking on this name.

Notes

This feature is available in the Corporate, Unified and Ultimate editions of Enterprise Architect·
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Create a Project in a PostgreSQL Database

To create a project in a repository on PostgreSQL, you work through these stages:

Stage 1: Create an empty database repository and set up the data tables·

Stage 2: Set up the PostgreSQL ODBC Driver·

Stage 3: Set up initial model data·

Prerequisites

A machine with PostgreSQL 9 or higher installed and running·

psqlODBC, version 8.03 or higher has been installed (do not use version 8.3.4 or 8.4.1)·

1. Create Database Repository

Step Action

1.1 Create the empty database and configure it to your installation's defaults.

1.2 Open your SQL management console of choice (such as pgAdmin) and connect to the new database.

1.3 Load the EASchema_1220_PostgreSQL.sql file from the Sparx Systems website.

1.4 Run the EASchema_1220_PostgreSQL.sql to create the required database schema.

2. Set up the ODBC DSN

Step Action

2.1 Create a suitable ODBC Data Source to the new database, making sure to select these extended options:

Page 1:

  Disable Genetic Optimizer - Uncheck

  Use Declare/Fetch - Check

  Unknowns as LongVarChar - Check

  Bools as Char - Uncheck

  Max Varchar - 1024

  Max LongVarChar - 1000000

Page 2:

  bytea as LO - Check

  Disallow Premature - Check

(c) Sparx Systems 2019 Page  76 of 654 Created with Enterprise Architect

https://sparxsystems.com/resources/repositories/index.html#table_script_postgres


Model Repository - Model Repository 20 January, 2020

  Protocol - 7.4+

3. Set up Initial Data

Enterprise Architect repositories require a basic amount of reference data to function correctly.

You can set up this initial data in one of two different ways:

Transfer the entire contents of an existing model into the new database, or·

Load initial data using a SQL Script·

3.1 Load Initial Data - Transfer existing model

If you choose to set up your new database with the contents of an existing model then Sparx Systems recommend that a
Project Integrity check is performed on the existing model to ensure it is 'clean' and free from data-related errors before
being copied into the new database.

The Enterprise Architect installation provides a model called EABase.eap, which is copied into the installation folder
specifically for the purpose of providing basic data for a new model. However, if you have customized the various
drop-down lists in another model then you might prefer to use that. Regardless of what model you choose to use, the
process is the same and is outlined here.

Step Action

3.1.1 In Enterprise Architect, open the existing repository and select 'Configure > Model > Integrity > Project
Integrity' in the ribbon.

3.1.2 Ensure that the 'Action' panel is set to 'Report Only' and that all items in 'Checks to Run' are enabled, then
click on the Go button.

3.1.3 If Enterprise Architect detects that the existing model contains integrity issues then it will list them in the
main panel at the bottom of the dialog. These issues should be resolved before continuing with the project
transfer.

3.1.4 With Enterprise Architect open, ensure that it there is no project loaded, by selecting 'Close Project' from

the   button.

3.1.5 Select the 'Configure > Model > Transfer > Project Transfer' ribbon option.

The 'Project Transfer' dialog displays.

3.1.6 In the 'Transfer Type' panel, select 'File to DBMS'.

3.1.7
In the 'Source Project' field, click on the  button and browse for the name of the project file to copy to
the repository.

If the .EAP file has Replication enabled, this must be removed before performing the transfer.

3.1.8
At the right of the 'Target Project' field, click on the  button.

The 'Datalink Properties' dialog displays.

3.1.9 Select 'Microsoft OLE DB Provider for ODBC Drivers' from the list.
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Click on the Next button.

3.1.1
0

On the 'Use Data Source Name' field, click on the drop-down arrow and select the ODBC Data Source
you configured to point to your new database.

Click on the OK button. The 'Project Transfer' dialog redisplays.

3.1.1
1

If required, select the 'Logfile' checkbox and type a path and filename for the data transfer log file.

3.1.1
2

Click on the Transfer button to begin the data transfer process.

3.1.1
3

When the process is complete, you have created a project on a PostgreSQL database and can now connect
to it and open it from Enterprise Architect.

3.2 Load Initial Data - SQL Script

3.2.1 Open your SQL management console of choice (such as pgAdmin) and connect to the new database.

3.2.2 Load the EABase_1220_PostgreSQL.sql file from the Sparx Systems website.

3.2.3 Run EABase_1220_PostgreSQL.sql  to create the required database schema.

Notes

During the transfer, if an error message displays reporting '...nonstandard use of \\ in a string literal...', set the server·
variable in the postgresql.conf file to: escape_string_warning = off
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Create a PostgreSQL Repository

Creating a PostgreSQL database is fully documented in the product information provided with your PostgreSQL
installer.

There are many ways to create a new PostgreSQL database. A common method is to use an SQL-based Management
Console such as pgAdmin, which provides a convenient graphical user interface for creating databases, executing scripts,
and performing backups and restores.  However, the exact method used is not important to this discussion, and you can
use the most convenient or familiar method at your disposal.

Having created your PostgreSQL database, use the SQL script provided by Sparx Systems to create the required table
definitions for Enterprise Architect. The EASchema_1220_PostgreSQL.sql script is freely available on the DBMS Based 
Repositories page on the Sparx Systems website.

Notes

Ensure that the collation is set to the alphabet you use, such as Latin or Cyrillic·
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Set up a PostgreSQL ODBC Driver

After you have created a PostgreSQL database, you will need to set up an ODBC DSN to the new database in order for
Enterprise Architect to connect to it.

Prerequisites

Install:

PostgreSQL DBMS and repository·

PostgreSQL ODBC driver software version 7.03.01.00 or above (note that versions 8.3.4, 8.4.1 and 9.03 of the·
PostgreSQL ODBC Driver are not supported)

Set up the ODBC driver

Your PostgreSQL driver is now available to connect to the repository from Enterprise Architect.

Step Action

1 Under both 32-bit and 64-bit operating systems, Enterprise Architect requires 32-bit ODBC drivers to
connect to a repository through ODBC. You can quickly load the correct 32-bit ODBC Data Source
Administrator by selecting the 'Configure > User Tools > ODBC Data Sources' ribbon option.

The ODBC Data Source Administrator window displays.

2 Click on the Add button.

The 'Create New Data Source' dialog displays, enabling you to add a new DSN.

3 Select 'PostgreSQL UNICODE' from the list.

4 Click on the Finish button.

The 'Postgre SQL Connector/ODBC' dialog displays.

5 Enter these configuration details:

A data source name for the connection·

The actual name of the database·

The host address of the DBMS server·

User name·

A description (optional)·

The password·

6 To set the advanced options, click on the Datasource button and set the options on 'Page 1' as shown:
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Note: From version 9.5.4 onwards some options shown in this image are no longer available and can be
ignored.

7 If you are using aversion of PostgreSQL between 8 and 9.5.4, set the options on Page 2 as shown:

The 'Disallow Premature' checkbox should be checked·

In the 'Protocol' panel, the '7.4+' radio button should be selected·

Note: From version 9.5.4 onwards the two options are no longer available and can be ignored.
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8 Click on the OK button to complete the configuration.
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Connect to a PostgreSQL Repository

To access your PostgreSQL repository, you must provide the connection details to Enterprise Architect.

Prerequisites

The PostgreSQL repository and the project already exist·

You know the database user credentials that have SELECT, UPDATE, INSERT and DELETE access permissions·

The PostgreSQL ODBC driver has been set up·

Access

Ribbon
: Open Project

Keyboard Shortcuts Ctrl+O

Connect to the repository

Step Action

1 In the 'Open Project' dialog, select the 'Connect to Server' checkbox.

2
Click on the  button.

The 'Data Link Properties' dialog displays.

3 Select 'Microsoft OLE DB Provider for ODBC Drivers' from the list.

4 Click on the Next>> button.

The 'Connection' tab displays.

5 Click on the 'Use data source name' radio button and on the drop-down arrow in its field.

From the list, select the ODBC driver you have set up to connect to your PostgreSQL repository.

6 Click on the Test Connection button to confirm that the details are correct.

7 If the test does not succeed, revise your settings.

If the test succeeds, click on the OK button; the 'Connection Name & Type' dialog displays.

8 Give the connection a suitable name so that you can recognize it in the 'Recent Projects' panel on the
'Open Project' dialog.

9 If required, select the 'Encrypt Connection String' checkbox.
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This encrypts and hides the connection details of the database from the users that the connection string is
given to.

10 If required, select the 'Lazy Load' checkbox to not load the full project view when the model is loaded;
instead, only the parts that are necessary to display the visible portion of the tree are loaded.

With this setting, the model loads faster and users can begin work sooner, but at the expense of later small
delays as Enterprise Architect loads specific portions of the model.

11 If required, select the 'Use WAN Optimization' checkbox.

Note: this option is only included for historical reasons, the WAN Optimizer product has been replaced by
the vastly improved Pro Cloud Server.

The WAN Optimizer was originally created to improve performance over a Wide Area Network by
compressing all database requests from Enterprise Architect to reducing transfer times.

If you select this checkbox, complete the next three fields (see your administrator for the correct values);
otherwise go to step 15.

12 In the 'Server' field, type the network name or address of the optimizer server.

13 In the 'Port' field, type the number of the Port on which the server is running on the remote machine.

14 In the 'DSN' field, type the data source name of the database as it appears on the remote machine.

15 Click on the OK button to complete the configuration and open the project.

This also adds the project name to the 'Recent' list on the Start Page; from now on, you can open the
project again just by clicking on this name.

Notes

This feature is available in the Corporate, Unified and Ultimate editions of Enterprise Architect·
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Create a Project in a SQL Server Database

To create a project on a repository in SQL Server 2005 and above, or SQL Server Express 2005 and above, work through
these stages:

Stage 1: Create an empty database repository and set up the data tables·

Stage 2: Set up initial model data·

Prerequisites

A machine with SQL Server installed and running·

MDAC 2.6 or higher on the client machine·

Permissions to create databases on SQL Server (see the SQL Server Security Permissions Help topic)·

ALTER permission on the t_image table in Enterprise Architect, to be able to import model images·

1. Create a SQL Server Repository

Step Action

1.1 Create a new empty database and configure it to your installation's defaults.

1.2 Open your SQL management console of choice (such as Microsoft SQL Server Management Studio) and
connect to the new database.

1.3 Load the EASchema_1220_SQLServer.sql file from the Sparx Systems website.

1.4 Run EASchema_1220_SQLServer.sql to create the required database schema.

2. Set up Initial Data

Enterprise Architect repositories require a basic amount of reference data to function correctly.

You can set up this initial data in one of two different ways:

Transfer the entire contents of an existing model into the new database, or·

Load initial data using a SQL Script·

2.1 Load Initial Data - Transfer existing model

If you choose to set up your new database with the contents of an existing model then Sparx Systems recommend that a
Project Integrity check is performed on the existing model to ensure it is 'clean' and free from data-related errors before
being copied into the new database.

The Enterprise Architect installation provides a model called EABase.eap, which is copied into the installation folder
specifically for the purpose of providing basic data for a new model. However, if you have customized the various
drop-down lists in another model then you might prefer to use that. Regardless of what model you choose to use, the
process is the same and is outlined here.
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Step Action

2.1.1 In Enterprise Architect, open the existing repository and select 'Configure > Model > Integrity > Project
Integrity' in the ribbon.

2.1.2 Ensure that the 'Action' panel is set to 'Report Only' and that all items in 'Checks to Run' are enabled, then
click on the Go button.

2.1.3 If Enterprise Architect detects that the existing model contains integrity issues, they will be listed in the
main panel at the bottom of the dialog. These issues should be resolved before continuing with the project
transfer.

2.1.4 With Enterprise Architect open, ensure that it there is no project loaded, by selecting 'Close Project' from

the   button.

2.1.5 Select the 'Configure > Model > Transfer > Project Transfer' ribbon option.

The 'Project Transfer' dialog displays.

2.1.6 In the 'Transfer Type' panel, select '.EAP to DBMS'.

2.1.7 In the 'Source Project' field, type the name of the project file to copy to the repository.

If the .EAP file has Replication enabled, this must be removed before performing the transfer.

2.1.8
At the right of the 'Target Project' field, click on the  button.

The 'Datalink Properties' dialog displays.

2.1.9 Select 'Microsoft OLE DB Provider for SQL Server' or 'Microsoft OLE DB Driver for SQL Server' from
the list.

Click on the Next button.

2.1.1
0

On the 'Data Source Details' page of the 'Datalink Properties' dialog, type in the server name, database
name and any security details required.

Click on the OK button. The 'Project Transfer' dialog redisplays.

2.1.1
1

If required, select the 'Logfile' checkbox and type a path and filename for the data transfer log file.

2.1.1
2

Click on the Transfer button to begin the data transfer process.

2.1.3 When the process is complete, you have created a project on a SQL Server database and can now connect
to it and open it from Enterprise Architect.

2.2 Load Initial Data - SQL Script

The Sparx Systems website provides a SQL Script that contains a series of INSERT statements that will load an empty
database with all the data needed by Enterprise Architect.

Step Action
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2.2.1 Open your SQL management console of choice (such as Microsoft SQL Server Management Studio), and
connect to the new database.

2.2.2 Load the EABase_1220_SQLServer.sql file from the Sparx Systems website.

2.2.3 Run EABase_1220_SQLServer.sql  to create the required database schema.
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Create a SQL Server Repository

Creating a SQL Server database is fully documented in the product information provided with your SQL Server installer.

There are many ways to create a new SQL Server database. A common method is to use an SQL-based Management
Console such as Microsoft SQL Server Management Studio, which provides a convenient graphical user interface to
create databases, execute scripts, and perform backups and restores.  However, the exact method used is not important to
this discussion, and you can use the most convenient or familiar method at your disposal.

Having created your SQL Server database, use the SQL script provided by Sparx Systems to create the required table
definitions for Enterprise Architect. The EASchema_1220_SQLServer.sql script is freely available on the DBMS Based 
Repositories page on the Sparx Systems website.

SQL Server Management Studio example

Step Action

1 In SQL Server Management Studio, locate the server on which to create your new repository (such as
DBSERVER02\SQLEXPRESS) and login with administrator privileges.

2 Right-click and choose the 'New Database' option.

3 Enter a suitable name for the database. Set any file options as required.

Ensure that the database collation is set to the alphabet you use, such as Latin or Cyrillic, and
case-insensitive.

4 Click on the database to select it, then select the 'New Query' menu option.

5 In the Query window, use the 'Open File' dialog to locate the EASchema_1220_SQLServer.sql script file.

6 Click on the Open button. In the drop-down menu, check that you have selected the correct database to
run the script in.

7 Click on the Execute button; SQL Server executes the script, which creates the base tables for an
Enterprise Architect project.

Notes

You should have ALTER permission on the t_image table in Enterprise Architect, to be able to import model images·

When creating a project in a SQL Server database you must have 'db_ddladmin' permission in order to execute the·
SET IDENTITY_INSERT (table) {ON | OFF} command
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SQL Server Security Permissions

The security model implemented by Microsoft's SQL Server is quite powerful and highly configurable, supporting many
different possible solutions for securing the data contained in SQL Server databases and ensuring it is only accessible to
users with the required permissions. For a more detailed description and explanation of SQL Server permissions, see the
SQL Server documentation.

Enterprise Architect users who plan to add, edit and delete contents in a SQL Server repository must have permissions to
execute SELECT, UPDATE, INSERT and DELETE statements on all Tables in the Enterprise Architect database. The
easiest way to achieve this is to grant the database roles of 'db_datareader' and 'db_datawriter' to each user.

Additional Permissions for Diagram Images

When an Enterprise Architect repository has not been defined with the optional schema update
(EASchema_1220_SQLServer_Update1.sql) database users will require additional permissions in order to be able to
perform Project Transfers and XML imports that include diagram images.

Why is this the case?  In order for Enterprise Architect to be able to store unique images in each repository the value
used as the key in T_IMAGE records needs to be set; however, the original schema definition of the T_IMAGE table did
not allow this and as a result Enterprise Architect needed to execute SET IDENTITY_INSERT T_IMAGE {ON | OFF}
commands, which requires higher permissions; i.e. the role of 'db_ddladmin'.

To avoid the need for each user to have an elevated level of permissions, an optional schema update
(EASchema_1220_SQLServer_Update1.sql) was developed which unfortunately is not backward compatible with earlier
versions of Enterprise Architect.  Therefore the optional schema update (EASchema_1220_SQLServer_Update1.sql)
should only be applied if all users are using Enterprise Architect 14 or later.  see
https://sparxsystems.com/resources/repositories/index.html

Does Enterprise Architect support Windows Authentication?

Enterprise Architect does support Windows Authentication. However, the type of authentication is determined by the
configuration of the connection used, and not by Enterprise Architect.

Windows Authentication to SQL Server is commonly used by Enterprise Architect users, but this requires that all
Windows users in Enterprise Architect be defined on the SQL Server server and be granted the security roles
'db_datareader' and 'db_datawriter' for the repository.
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Connect to a SQL Server Repository

After you have created a Microsoft SQL Server database, you can connect to it immediately without any further
configuration directly from Enterprise Architect.

Prerequisites

The Microsoft SQL Server database/repository already exists and you know the details·

You have the details of a database user with the required permissions within the database, see SQL Server Security ·
Permissions

Microsoft SQL Server OLE DB driver·

Access

Ribbon
: Open Project

Keyboard Shortcuts Ctrl+O

Connect to the repository

Step Action

1 In the 'Open Project' dialog, select the 'Connect to Server' checkbox.

2
Click on the  button.

The 'Data Link Properties' dialog displays.

3 Select 'Microsoft OLE DB Provider for SQL Server' or 'Microsoft OLE DB Driver for SQL Server' from
the list.

Note:

'Microsoft OLE DB Provider for SQL Server' is usually part of the Windows Operating System,·
otherwise it can be installed as part of MDAC 2.8

'Microsoft OLE DB Driver for SQL Server' is a newly released driver that adds support for TLS v1.2·
and other more recent features of Microsoft SQL Server (such as multi-subnet failover capabilities);
this driver is available from the Microsoft website

4 Click on the Next>> button.

The 'Connection' tab displays.

5 Type in the server details, including Server Name, User Name and Password.

6 Click on the 'Select the database on the server' option and on the drop-down arrow.
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From the list, select the project to connect to.

7 Click on the Test Connection button to confirm that the details are correct.

8 If the test does not succeed, revise your settings.

If the test succeeds, click on the OK button; the 'Connection Name & Type' dialog displays.

9 Give the connection a suitable name so that you can recognize it in the 'Recent Projects' panel on the
'Open Project' dialog.

10 If required, select the 'Encrypt Connection String' checkbox.

This encrypts and hides the connection details of the database from the users that the connection string is
given to.

11 If required, select the 'Lazy Load' checkbox to not load the full project view when the model is loaded;
instead, only the parts that are necessary to display the visible portion of the tree are loaded.

With this setting, the model loads faster and users can begin work sooner, but at the expense of later small
delays as Enterprise Architect loads specific portions of the model.

12 If required, select the 'Use WAN Optimization' checkbox.

Note: this option is only included for historical reasons, the WAN Optimizer product has been replaced by
the vastly improved Pro Cloud Server.

The WAN Optimizer was originally created to improve performance over a Wide Area Network by
compressing all database requests from Enterprise Architect to reducing transfer times.

If you select this checkbox, complete the next two fields (see your administrator for the correct values);
otherwise go to step 15.

13 In the 'Server' field, type the network name or address of the optimizer server.

14 In the 'Port' field, type the number of the Port on which the server is running on the remote machine.

15 Click on the OK button to complete the configuration and open the project.

This also adds the project name to the 'Recent' list on the Start Page; from now on, you can open the
project again just by clicking on this name.

Notes

Connecting to DBMS based Repositories is available in the Corporate, Unified and Ultimate editions·
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Create a Project in a Sybase ASA/SQL Anywhere Database

To create a project in a repository on Sybase Adaptive Server Anywhere 8 or 9, or SQL Anywhere 10, 11 or 12, you
work through these stages:

Stage 1: Create an empty database repository·

Stage 2: Set up the ASA ODBC Driver·

Stage 3: Set up initial data·

Prerequisites

A machine with Adaptive Server Anywhere installed and running·

Install SQL Anywhere Studio, this also installs the ASA ODBC driver·

1. Create Database Repository

Step Action

1.1 Create a new empty database.

1.2 Open your SQL management console of choice (such as Sybase Central) and connect to the new database.

1.3 Load the EASchema_1220_ SybaseASA.sql file from the Sparx Systems website.

1.4 Run the EASchema_1220_ SybaseASA.sql to create the required database schema.

2. Set up the ODBC DSN

Step Action

2.1 Create a suitable ODBC Data Source using the Sybase Adaptive Server Anywhere ODBC driver to the
new database.

3. Set up Initial Data

Enterprise Architect repositories require a basic amount of reference data to function correctly. For Sybase ASA-based
models you can provide this by transferring the contents of an existing model into the new database.

Step Action

3.1 In Enterprise Architect, open the existing repository and select 'Configure > Model > Integrity > Project
Integrity' in the ribbon.
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3.2 Ensure that the 'Action' panel is set to 'Report Only' and that all items in 'Checks to Run' are enabled, then
click on the Go button.

3.3 If Enterprise Architect detects that the existing model contains integrity issues, they will be listed in the
main panel at the bottom of the dialog. These issues should be resolved before continuing with the project
transfer.

3.4 With Enterprise Architect open, ensure that it there is no project loaded, by selecting 'Close Project' from

the   button.

3.5 Select the 'Configure > Model > Transfer > Project Transfer' ribbon option.

The 'Project Transfer' dialog displays.

3.6 In the 'Transfer Type' panel, select '.EAP to DBMS'.

3.7 In the 'Source Project' field, type the name of the project file to copy to the repository.

If the .EAP file has Replication enabled, this must be removed before performing the transfer.

3.8
At the right of the 'Target Project' field, click on the  button.

The 'Datalink Properties' dialog displays.

3.9 Select 'Microsoft OLE DB Provider for ODBC Drivers' from the list.

Click on the Next button.

3.10 In the 'Use Data source name' field, click on the drop-down arrow and select the ODBC Data Source you
configured to point to your new database.

Click on the OK button. The 'Project Transfer' dialog redisplays.

3.11 If required, select the 'Logfile' checkbox and type a path and filename for the data transfer log file.

3.12 Click on the Transfer button to begin the data transfer process.

3.13 When the process is complete, you have created a project on an ASA database and can now connect to it
and open it from Enterprise Architect.
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Create an Adaptive Server Anywhere Repository

Creating an ASA database is fully documented in the product information provided with your ASA installer.

There are many ways to create a new Adaptive Server Anywhere database. A common method is to use an SQL-based
Management Console such as Sybase Central, which provides a convenient graphical user interface to for creating
databases, executing scripts, and performing backups and restores.  However the exact method used is not important to
this discussion, and you can use the most convenient or familiar method at your disposal.

Having created your ASA database, use the SQL script provided by Sparx Systems to create the required table
definitions for Enterprise Architect. The EASchema_1220_SybaseASA.sql script  is freely available on the DBMS Based 
Repositories page on the Sparx Systems website.

Notes

Ensure that the collation is set to the alphabet you use, such as Latin or Cyrillic·
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Set up an ASA ODBC Driver

After you have created a Sybase ASA database, you will need to set up an ODBC DSN to the new database in order for
Enterprise Architect to connect to it.

Prerequisites

Install:

Adaptive Server Anywhere - SQL Anywhere Studio 8 or higher, and create a repository·

ASA ODBC driver software (installed with the ASA DBMS)·

Set up the ODBC Driver

Step Action

1 Under both 32-bit and 64-bit operating systems, Enterprise Architect requires 32-bit ODBC drivers to
connect to a repository through ODBC. You can quickly load the correct 32-bit ODBC Data Source
Administrator by selecting the 'Configure > User Tools > ODBC Data Sources' ribbon option.

The ODBC Data Source Administrator window displays.

2 Click on the Add button.

The 'Create New Data Source' dialog displays, enabling you to add a new DSN.

3 Select 'Adaptive Server Anywhere' or 'SQL Anywhere' from the list.

4 Click on the Finish button.

The 'ASA Connector/ODBC' dialog displays.

5 Enter these configuration details:

A data source name for the connection, on the 'ODBC' tab·

User name and password on the 'Login' tab ('dba' and 'sql' are the defaults when ASA is installed)·

The server name and the path to the database, on the 'Database' tab·

The network protocol on the 'Network' tab (if the database is on a network location)·

6 Return to the 'ODBC' tab and click on the Test Connection button to confirm that the details are correct.

7 If the test succeeds, click on the OK button to complete the configuration.

If the test does not succeed, review your settings.
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Connect to an ASA Data Repository

To access a project in your Adaptive Server Anywhere (ASA) data repository, you must connect to the data repository
from Enterprise Architect.

Prerequisites

The ASA repository and the project already exist·

You have SELECT, UPDATE, INSERT and DELETE access permissions·

The ASA ODBC driver has been set up·

Access

Ribbon
: Open Project

Keyboard Shortcuts Ctrl+O

Connect to the repository

Step Action

1 In the 'Open Project' dialog, click on the Connect to Server button.

2
Click on the  button.

The 'Data Link Properties' dialog displays.

3 Select 'Microsoft OLE DB Provider for ODBC Drivers' from the list.

4 Click on the Next>> button.

The 'Connection' tab displays.

5 Click on the 'Use data source name' radio button and on the drop-down arrow in its field.

From the list, select the ODBC driver you have set up to connect to your ASA repository.

6 Click on the Test Connection button to confirm that the details are correct.

7 If the test does not succeed, revise your settings.

If the test succeeds, click on the OK button; the 'Connection Name & Type' dialog displays.

8 Give the connection a suitable name so that you can recognize it in the 'Recent Projects' panel on the
'Open Project' dialog.
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9 If required, select the 'Encrypt Connection String' checkbox.

This encrypts and hides the connection details of the database from the users that the connection string is
given to.

10 If required, select the 'Lazy Load' checkbox to not load the full project view when the model is loaded;
instead, only the parts that are necessary to display the visible portion of the tree are loaded.

With this setting, the model loads faster and users can begin work sooner, but at the expense of later small
delays as Enterprise Architect loads specific portions of the model.

11 If required, select the 'Use WAN Optimization' checkbox.

Note: this option is only included for historical reasons, the WAN Optimizer product has been replaced by
the vastly improved Pro Cloud Server.

The WAN Optimizer was originally created to improve performance over a Wide Area Network by
compressing all database requests from Enterprise Architect to reducing transfer times.

If you select this checkbox, complete the next three fields (see your administrator for the correct values);
otherwise go to step 15.

12 In the 'Server' field, type the network name or address of the optimizer server.

13 In the 'Port' field, type the number of the Port on which the server is running on the remote machine.

14 In the 'DSN' field, type the data source name of the database as it appears on the remote machine.

15 Click on the OK button to complete the configuration and open the project.

This also adds the project name to the 'Recent' list on the Start Page; from now on, you can open the
project again just by clicking on this name.

Notes

Connecting to DBMS based Repositories is available in the Corporate, Unified and Ultimate editions of Enterprise·
Architect

(c) Sparx Systems 2019 Page  97 of 654 Created with Enterprise Architect



Model Repository - Model Repository 20 January, 2020

The WAN Optimizer

You can significantly improve Enterprise Architect's performance in a Wide Area Network (WAN) by reducing the
amount of data transmitted and the number of network calls made. To achieve this, you can use the Sparx Systems Wide
Area Network (WAN) Optimizer, a lightweight server installed on a Local Area Network (LAN) connection to a
Database Management System (DBMS) that hosts an Enterprise Architect repository. You can configure the server to
listen for client connections on a particular port; it acts as a local proxy to execute queries and return the results in a
compressed format to the client.

In this diagram, transmission between Enterprise Architect and a DBMS is depicted first without and then with the WAN
Optimizer.

You can download the WAN Optimizer installer from the 'Downloads' page of the Registered Users section of the Sparx
Systems website. The Wan Optimizer Service installer package provides two installable features for the target machine:

WAN Optimizer Service - the installer also helps register and start the service on the target machine, and add it to·
the Windows Startup folder

WAN Optimizer Admin Client - to enable an administrator to administer and configure the service from a remote·
client

The Optimizer has its own Sparx Systems WAN Optimizer User Guide. See that Guide for more information on:

WAN Optimizer Components·

Installing and Starting the WAN Optimizer Service·
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Configuring the Service·

Troubleshooting·

Notes

The WAN optimizer was the first generation product·

The Sparx Systems Cloud Services was the second generation and replaced the WAN optimizer·

The Sparx Systems Pro Cloud Server is the third generation and has replaced the Sparx Systems Cloud Services·

All Cloud products provided similar basic functionality of the WAN Optimizer, but the later generations do so faster·
and more securely; they also have many more additional features

Whilst you can still use the WAN Optimizer as described here, we recommend that the Pro Cloud Server should now be
used instead of both the WAN Optimizer and Cloud Services products.
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Cloud Based Repositories

In terms of Sparx Systems and Enterprise Architect, Cloud-based repositories are repositories that are hosted by the
Sparx Systems Pro Cloud Server. The Pro Cloud Server is a supporting product for Enterprise Architect that allows
Enterprise Architect repositories to be hosted anywhere in the world, encapsulating the retrieval of all repository data and
serving it to Enterprise Architect clients for consumption.

Sparx Systems have designed the Pro Cloud Server to be installed in your company's infrastructure, thereby giving you
full control over its configuration and - even more importantly - the data contained in your repositories.  We use the term
'Cloud' to indicate that Enterprise Architect users can simply connect to a repository with a single URL without any
further configuration or setup.

Notes

Cloud Repositories are supported in Enterprise Architect Corporate Edition and above·

Enterprise Architect Professional Edition also supports Cloud Repositories, although only those hosted on a Firebird·
database

An unlicensed installation of the Pro Cloud Server provides basic Cloud Repository functionality, allowing you to·
host Cloud repositories and access them via Enterprise Architect; with a valid license, the Pro Cloud Server provides
a range of additional features
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Introducing Cloud Repositories

The Sparx Systems Pro Cloud Server solution provides seamless access to Enterprise Architect models in repositories
held anywhere in the world, providing high performance in remote access, secure encrypted links, and optimization for
high-latency WAN connections.

Cloud-based repositories provide easy access to models, not only for people within your local team but also for remote
team members, external customers and consultants with Internet access, anywhere around the world. Collaborative and
distributive modeling and design are dramatically enhanced by using a Cloud-based repository, which can provide the
shared backbone of a wealth of development scenarios.

This section will:

Familiarize you with the concepts of Cloud Repositories·

Discuss considerations of when and where you should use a Pro Cloud Server·

Walk you through the process of setting up a Pro Cloud Server·

Walk you through the process of connecting for the first time·

Highlight some of the additional functionality available through licensing the Pro Cloud Server·

Outline working with Active Directory using IIS·

Benefits of Cloud Repositories

Enterprise Architect models are stored in databases, such as MySQL, SQL Server and Oracle. Traditional installations of
Enterprise Architect require each user to install the appropriate drivers for each DBMS, and in some cases define an
ODBC DSN with the database connection details.

When connecting to a Pro Cloud Server, the procedure for a user to connect to a model is dramatically simplified. Users
connecting to models hosted on a Pro Cloud Server only need a single URL; no special drivers or further configuration
are required.

Connecting to a Pro Cloud Server provides a number of key benefits:

Improved performance for models used for distributed development. The Pro Cloud Server provides benefits to1.
connections that have high latency and reduced data transfer speeds.

The process of setting up drivers and connections is performed once by an administrator during the server2.
configuration. The only set-up required on a user machine is to install Enterprise Architect and to connect to a model
on the Cloud server.

Database servers no longer have to be exposed through a firewall; the Pro Cloud Server can be run from inside the3.
corporate firewall. All model connections are created using HTTP/S, allowing firewalls to completely isolate your
database server.

A Pro Cloud Server can be configured to encrypt all communication. Using standard TLS/SSL protocols, you can be4.
confident that your data is not intercepted during transmission on insecure networks.

A Pro Cloud Server can be configured to provide HTTP-level authorization to any model taken directly from the5.
model user list. Even when the model is exposed on a public network, you can be assured that only authorized users
are able to access your model.

A Pro Cloud Server can be configured to provide read-only access to any model; for example, read-only access for6.
clients required to review a model.

Pro Cloud Server Features

Even without a License, the Pro Cloud Server can be used for hosting Cloud Repositories to be accessed by Enterprise
Architect, providing all the benefits mentioned above; however, using a valid Pro Cloud Server license provides a
number of additional benefits:
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A web based application, WebEA, that allows users to view and discuss elements in Enterprise Architect models1.
through a web browser, while on portable devices or remote desktop systems

OSLC Restful API, providing an interface for external applications2.

Integration Plug-ins, allowing data from external providers to be displayed within Enterprise Architect3.

Prolaborate, a team Sharing and Collaboration Software package4.

The Sparx Systems Floating License Server5.

Visibility Levels for Oracle- and SQL Server 2016-based models, so that it is possible to restrict parts of the model6.
to individual users or groups of users

Sparx Systems Pro Cloud licenses are available in three different editions:

Token Edition is a scalable edition of the Pro Cloud Server; 'Tokens' are allocated to enable specific features of the·
Pro Cloud Server and they also determine the number of concurrent web users - there are no restrictions on the
number of Tokens, you only purchase the number that suits your organization's needs

Team Server Edition supports up to seven repositories and unlimited web users·

Enterprise Server Edition supports any number of repositories, and unlimited web users·

Webinar

Before you go on to set up the Pro Cloud Server, Sparx Systems recommend that you watch the 'Setting Up Pro Cloud 
Server for Enterprise Architect' webinar.

You can also watch a second webinar that demonstrates setting up a MySQL repository on the Amazon Web Services
(AWS) Cloud using Amazon Relational Database Services (RDS), and creating and configuring an Enterprise Architect
project in the repository via the Cloud connection.
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Pro Cloud Server Setup

This is an overview of the typical process of setting up the Pro Cloud Server.

Typical steps for setting up a Cloud Server

Step Description

1 Install the Pro Cloud Server.

2 Review the default settings in the 'SSProCloud.config' file; in most environments these will be sufficient.
However, if necessary change the SERVER_PORT to suit your environment and restart the Pro Cloud
Server service.

3 Open the Configuration Client. By default a shortcut to this client should be created on the Desktop.

4 Configure the Port(s) to be used for accessing your Cloud-based models.  If changes were made, restart
the Pro Cloud Server service.

5 Define the connections to your repositories or models.

6 Configure your Firewall.

7 Test access to your Cloud-based model(s) from Enterprise Architect.

8 If you are planning to use any 'Pro' features such as WebEA or Integration Plug-ins, your Pro Cloud
Server will have to be 'licensed'. Refer to the Pro Cloud Server Licensing topic for details.

9 Optionally, if you are using the Token edition of the Pro Cloud Server then consider adjusting the token
allocations (for example, enabling specific integration plug-ins).
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Pro Cloud Server Installation

The basic installation process is quite straightforward. Typically, you can simply download and run the installer on your
server, then follow the prompts.

Download the Installer

The Pro Cloud Server installer can be downloaded from the 'Registered User' section of the Sparx Systems website.

Installation Steps

If you already have the 'Sparx Systems WAN optimizer' or 'Sparx Systems Cloud Services' installed on your server we
recommend you manually remove them before commencing the Pro Cloud Server Installation.

To remove any potential permission issues, we recommend that the installation is performed by a user with
Administrator-level permissions. To install, follow these steps:

Run the SparxProCloud.msi installer.1.

On the 'Welcome' page, click on the Next button.2.

Read the End User License Agreement, and accept the terms outlined in it, and click on the Next button.3.

The 'Readme' information page contains the minimum system requirements, so make sure that the host server meets4.
those outlined requirements, and then click on the Next button.

The 'Custom Setup' page allows you to choose what components of the Pro Cloud Server are installed; for the5.
simplest installation (that is, using the defaults), go straight to step 7.

If you want to install specific components, for example, to have different components on separate machines, refer to6.
the Pro Cloud Server Components table later in this topic, then return here to step 7.

The 'Ready to Install' page is in the last step before the installation begins; when ready, click on the Install button.7.

The installation progress will be shown and, once finished, the wizard should state that the process has completed;8.
click on the Finish button.

Now refer to the Pro Cloud Server Configuration Help topic9.

To assist you in performing and understanding the installation process, watch the Sparx Systems webinar Setting Up Pro
Cloud Server for Enterprise Architect. Click on this link to access the webinar.

Pro Cloud Server Components

The 'Custom Setup' page lists the various components that are available in the installer. Each component can be
controlled separately by clicking the small disk image in front of the component name and selecting the option you
require.

Component Description

Pro Cloud Server service This component is the Windows service that will accept connections from
Enterprise Architect, the configuration client, and the OSLC RESTful API. For Pro
Cloud Server, this includes the Sparx Systems Floating License Server. The default
option is to install this component.

Generally, the only time you would choose not to install this component is when
you have already installed it on one machine and are now installing other
components on a different machine.
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Management Clients When the Management Client component is selected the Pro Cloud Server
Configuration Client application will be installed, which supports the execution of
management tasks including:

Setting which databases a Pro Cloud Server can connect to·

Configuring those database connections·

Configuring what HTTP/HTTPS ports the Pro Cloud Server will listen on·

Configuring various server options·

The default option is to install this component; Sparx Systems recommends that the
Configuration Client should be installed whenever the Pro Cloud Server service is
installed.

WebConfig This component installs the application files (PHP, CSS and JavaScript) for the
Web Base Configuration Client (WebConfig).

The default option is to install this component; you can unselect this component if
you do not plan to use the Web Based Configuration Client.

WebEA This component installs the WebEA application files (PHP, CSS and JavaScript)
that enable a web user to view an Enterprise Architect model on a mobile, android
or remote desktop machine without having to install Enterprise Architect on that
device.

The default option is to install this component; you can unselect this component if
you do not plan to use WebEA.

Integration Plug-ins Integration Plug-ins, or the Server Based Plug-in Interface (SBPI); this component
installs the SBPI Server and all the SBPI Plug-ins that allow the Pro Cloud Server
to read data from external products such as Dropbox, Jira and Team Foundation
Server. There is a separate SBPI Plug-in for each external product.

The default option is to install this component; you can unselect the component if
you do not plan to link your Enterprise Architect models to external products.

Visibility Levels Visibility Levels; this component installs a set of SQL scripts to be applied to any
Enterprise Architect repositories based on MS SQL Server 2016 + or Oracle.

The default option is to install this component; you can unselect the component if
you do not plan to use the Visibility Level functionality.

IIS Integration An optional component providing integration with IIS.

The default option is to not install this component; however, if your server requires
advanced authentication methods available through IIS then this component should
be installed.
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Installing New Versions

If you are installing a newer version of the Pro Cloud Server product then the new installer will automatically uninstall
the old version. Before installing a new version, typically it is better to manually stop the 'Sparx System Professional
Cloud' Windows service because the installer might have problems performing this task and will require the machine to
be rebooted after the installation is finished.

Note:  The installer has been designed to retain all configuration settings of a previous installation (except Firewall rules,
see section below) !

Installation Steps

Run the installer using the earlier installation steps.1.

The installer will have copied the newest version of  WebEA to the location specified during installation; if this2.
location is not being used by your web server, you need to manually copy (and overwrite) all WebEA files (except
the includes/webea_config.ini file) from the installation folder to the web server folder.  See WebEA Consideration.

As above, if you use the WebConfig client you should copy the contents of the WebConfig folder (specified during3.
installation) to the appropriate location on your Web Server, overwriting the existing WebConfig files (except
settings.php).

PCS4 Considerations

The release of Pro Cloud Server version 4 made changes to the  default installation folder and the main configuration
filename.   These changes require special considerations depending on your situation and if you want to retain any of
your previous configuration.

Pro Cloud Server 4's default installation path has been changed to:

      'C:\Program Files (x86)\Sparx Systems\Pro Cloud Server\'

The configuration filename has been changed to:

     'SSProCloud.config'

Installation folder name change

Firebird Database Mangers

If you have any Firebird based Database Managers defined, their connection strings will contain the path of the old
installation folder, ie   'C:\Program Files (x86)\Sparx Systems\Cloud Services\Service\Models\'  therefore the following
steps should be followed:

Make a note of each Firebird based Database Manager, the database name, Alias, extended settings etc1.

Delete each of the Firebird based Database Managers2.

Shutdown the Pro Cloud Server Windows service3.

Physically move all Firebird database files from the old installation folder to the new installation folder  'C:\Program4.
Files (x86)\Sparx Systems\Pro Cloud Server\Service\Models\'.

Start the Pro Cloud Server Windows service5.

Recreate each of the Firebird Database Managers6.

Integration Plugins

If your environment has any Integration Plugins defined and they were created prior to PCS4.1 then the physical path of
the SBPI executables will be defined in the definitions, each path will need to be updated to the new installation path.
PCS4.1 and later has removed the need to define the complete path to the SBPI executables.
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Configuration File

If you wish to retain your previous configuration from version 2 or 3 of the Pro Cloud Server into version 4 or later, you
will need to follow these steps:

Shutdown the Pro Cloud Server1.

Backup the default PCS4 configuration file by renaming C:\Program Files (x86)\Sparx Systems\Pro Cloud2.
Server\Service\SSProCloud.config'  to  C:\Program Files (x86)\Sparx Systems\Pro Cloud
Server\Service\SSProCloud-default.config'

The old configuration file 'C:\Program Files (x86)\Cloud Services\Service\SSCloudServices.config' will have to be3.
manually copied into the new installation folder  'C:\Program Files (x86)\Sparx Systems\Pro Cloud Server\Service\'
using the new name SSProCloud.config.

Start the Pro Cloud Server Windows Service.4.

WebEA Considerations

WebEA Note: In regard to WebEA, consider the situation in which WebEA was installed to the default location and
your website is being served by Apache in C:\Xampp\htdocs\webea. This command will perform the required copy and
not override your existing configuration file in the live site:

     robocopy "C:\Program Files (x86)\Sparx Systems\Pro Cloud Server\WebEA" "C:\xampp\htdocs\webea" /MIR /e
/DCOPY:T /njh /ndl /nfl /xf webea_config*.ini

Firewall Notes

Firewall Note: The installer creates a Firewall rule for the Pro Cloud Server. This rule is removed and re-created during
an upgrade. If you had previously modified this rule then you will need to apply these changes again after the Pro Cloud
Server installation.

Note: To avoid the need to manually adjust the standard firewall rule after each reinstall, you can create a complete new
firewall rule using a different name.
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Pro Cloud Server Configuration

This topic discusses the configuration of the Pro Cloud Server.  The main settings of the Pro Cloud Server are stored in
the configuration file .\Services\SSProCloud.config which will be created and populated with the default values during
the initial installation process.  By design, subsequent installations/updates of the Pro Cloud Server will not change the
contents of this file, so your settings will not be lost.

The Pro Cloud Server Configuration Clients (both Application and Web) are designed to manage all Pro Cloud Server
settings, except SERVER_PORT which defines the port the Pro Cloud Server service will listen for requests from the
Pro Cloud Server Configuration Client application.  By default the SERVER_PORT is set to 803, we would expect this
value to be acceptable for most environments, however if this does not suit or you simply want to use a different port this
can be manually changed by editing the SSProCloud.config file using a text editor (*) and restarting the Pro Cloud
Server service (**).

(*)   Depending on the current user's permissions the SSProCloud.config may need to be edited using the 'Run as
administrator' option.

(**)  Restarting the Pro Cloud Server after manually changing its configuration file is needed because it only reads the
file as it is starts up.

Opening the Pro Cloud Server Configuration Client

After configuring SERVER_PORT to a port value suitable for your environment, you can open the Configuration Client
installed on the same machine as the Pro Cloud Server and perform the remaining setup ready for Enterprise Architect
users.

When the Configuration Client is opened you will presented with the 'Pro Cloud Server Logon' screen, which will
prompt for the URL of the Pro Cloud Server and the Pro Cloud Server administrator password.  see Pro Cloud Server 
Logon Screen

As a security precaution from PCS version 4.1 the default password for the Configuration Clients is:

    pcsadm1n

For all versions prior to PCS version 4.1 the default password was empty. ie no password

Additional Configuration for Pro Cloud Server Components

- Floating License Server

- WebEA

- SBPI

Configuration Client Connection Settings

Normally the first settings you will see in the configuration file are to control how Pro Cloud Server Configuration
Clients will connect to the server. The default values are:

     SERVER_PORT=803

     ADMIN_WHITE_LIST=127.0.0.1|::1
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Setting Description

SERVER_PORT SERVER_PORT is used when you connect to the Configuration Client or opt to
use the IIS integration instead of the integrated web-server. For more detail see the
Pro Cloud Server using IIS Help topic.

Note: When changing this setting, check firewall settings and other services using
the port. Additionally, when the service is running on Wine you should not use
privileged ports - those below 1024. Under Wine, most applications are only able to
listen on ports above 1024.

ADMIN_WHITE_LIST ADMIN_WHITE_LIST defines a separated list of client IP addresses that are
allowed to administer the Pro Cloud Server.  If a client address attempts to logon to
the Pro Cloud Server Configuration Client that is not specified in the White List
they will be denied access.

Default value:  127.0.0.1|::1

Supported Versions:  PCS v4.1 and later

This setting was added in PCS version 4.1, prior versions did not impose any
restrictions on what client addresses could change the Pro Cloud Server settings.

The default value is 127.0.0.1|::1, which grants access to the current machine
hosting the Pro Cloud Server service, via its IPv4 address (127.0.0.1) and IPv6
address (::1).

SERVER_PASSWORD SERVER_PASSWORD is the password to protect the administration functions of
the server. As a security precaution this setting is encrypted and as such can only be
changed by using the Configuration Client. This value should not be set or modified
by directly editing the configuration file.

Default value:  pcsadm1n (value is stored encrypted)

Supported Versions:  All

Note: The default value of this setting was changed in PCS version 4.1, prior
versions did not define a default password.

General Settings

This list of settings includes the default global settings across the entire service:

     DBMAN_DEFAULTMAXSIMQUERIES=10

     AUDIT_TIME_PERIOD=3600

     TEMP_DIRECTORY=%SERVICE_PATH%\Temp

     LOGGING_LEVEL=SYSTEM

     LOGGING_DIRECTORY=%SERVICE_PATH%\Logs

     LOGGING_FILECOUNT=3

     LOGGING_FILESIZE=1048576

Setting Description

DBMAN_DEFAULTMAX
SIMQUERIES

The default for the maximum number of simultaneous queries that can be run at a
time for any configured database. This can be changed directly within the
Management Client (see Default Max Simultaneous Queries in the Extended
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Server Properties Help topic under Pro Cloud Server Configuration Client -
Application). There is no explicit limit for this default value.

Note: If this setting is changed via one of the Configuration Clients, then a server
restart is not required.

AUDIT_TIME_PERIOD The number of seconds between the recording activities by system logs on each
database.

TEMP_DIRECTORY The location to which to write temporary files before they are sent to clients.
Generally you should not change this, as there are security implications. For
example, the owning user of the Windows service will need full write permissions
to this directory.

LOGGING_LEVEL Determines how verbose the server should be when writing log files. The valid
values are: OFF, FATAL, WARNING, INFO and SYSTEM. The value can be
changed directly within the Management Client. (See Log Level in the Extended
Server Properties Help topic under Pro Cloud Configuration Client - Application).

Note: If this setting is changed via one of the Configuration Clients, then a server
restart is not required.

LOGGING_DIRECTORY Defines where the log files are to be stored. The default is set to:

     %SERVICE_PATH%\Logs

Note: The %SERVICE_PATH% refers to the directory in which the Pro Cloud
Server is installed; this is, by default, 'C:\Program Files (x86)\Sparx Systems\Pro
Cloud Server'.

LOGGING_FILECOUNT Determines the maximum number of rolling log files that should be kept. When the
file count is exceeded, the oldest file is automatically deleted.

LOGGING_FILESIZE Determines the maximum file size of each log file. Whenever the current log file
has reached its maximum size, a new log file is created as
'SSProCloudServerLog-1.log' and all older ones have their number incremented.

For more details on using the logs see the Cloud Server Troubleshooting topic.

Restarting the Sparx Systems Professional Cloud service

If you make any manual changes to the configuration file you must restart the service for the changes to take effect
(unless otherwise stated). A service restart is carried out in the Windows Services application.

Depending on the operating system, there are two methods for restarting the Pro Cloud Server service:

1)  Using Windows Services directly; this is available in all versions of Windows (see 'Control Panel | Administrative
Tools | Services').

2)  Using the Server Manager on Windows Server 2012.
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Pro Cloud Configuration Clients

With the release of version 3 of the Pro Cloud Server, Sparx Systems now offers two different Configuration Clients: the
original Windows-based application and the new web-based application. Each client is capable of managing the main
settings of the Sparx Systems Pro Cloud Server. We expect that most users will prefer to use the web-based application,
although it does require one extra step during setup - to install the web pages into a supported web server (such as
Apache or IIS).

Windows Application benefits

No third party products required, you can connect to the Pro Cloud Server immediately after install using the default·
settings

Web-based Application benefits

Can be configured to use SSL (HTTPS)·

One interface for all component settings·

For details of each of the Configuration Clients, see these Help topics:

Pro Cloud Server Configuration Client - Application·

Pro Cloud Server Configuration Client - Web·
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Pro Cloud Server Configuration Client - Application

At any point after installation you can configure the Pro Cloud Server using the Configuration Client application; the
installer will create a Pro Cloud Config Client shortcut on the desktop.

By default the Configuration Client executable is accessible from the 'C:\Program Files (x86)\Sparx Systems\Pro Cloud
Server\Client' folder.

The Configuration Client can be used from any machine on your local network; however, communications between it
and the Pro Cloud Server are not secure, so it should only be used from within a secure network.

The Configuration Client is used to configure various settings related to the Pro Cloud Server and the repositories it
connects to. When the application first starts, a prompt to enter the address of the Pro Cloud Server to connect to is
displayed (see the Pro Cloud Server Logon Screen Help topic for details). Once you have connected, the main screen
displays.

The Main Screen

This screen shows a list of all defined database managers and the details of the connected Pro Cloud Server.  It is also the
entry point for all management functions, such as configuring your License, setting the ports the Pro Cloud Server listens
on, and maintaining database connections.

Sparx Systems Pro Cloud Server supports connections to these DBMS products:

Firebird·

Microsoft SQL Server·

MySQL·

Oracle·

PostgreSQL·

Item Description

Database Managers This tab lists the defined repositories that the Pro Cloud Server makes available to
clients. Each database manager definition contains the details of one database
connection and a number of other properties that control how it will function.

Ports This tab allows you to view and configure Ports that the Pro Cloud Server will
allow connections on for accessing models.
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Integration This tab allows you to configure Cloud models to use Integration Plug-ins.
Integration Plug-ins require a valid Pro Cloud Server license; see the Integration
Plug-ins section for details.

Server Properties The properties on the right hand side specify the details of the connected Pro Cloud
Server.

Main Properties

Server name - the server name hosting the currently connected Pro Cloud·
Server

Configuration Port - the Port the Cloud Client is using for communication with·
the Pro Cloud Server

Server version - the major, minor and build numbers of the connected Pro·
Cloud Server

Edition - the edition of the Pro Cloud Server·

Expiry - the expiry date for the current license·

Licensed to - The name of the company that the Pro Cloud Server is licensed·
to.

Licensee - The email address associated with this license; that is, the email·
address provided when the License Request was created

Pro Models - the number of models enabled for Pro Features and the number·
allowed under the current license

The Edition, Expiry and Pro Models properties apply to Pro Cloud Server licenses.
If no license has been added, or the license is invalid or has expired, then the
Edition will display 'None' and the Expiry 'Never'.

Extended Properties Click on this button to display the extended properties for the connected Pro Cloud
Server.  A number of these extended properties can also be modified.

Licensing Click on this button to view and manage the connected Pro Cloud Server's licenses.
This button allows you to enter the license for the Pro Cloud Server.

Refresh Click on this button to reload the contents of the 'Database Managers' list.

Add... Click on this button to add a new database manager.

Edit... Click on this button to view and manage the settings for the currently selected
database manager.

Remove Click on this button to permanently delete the selected database manager from the
Cloud Server.
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Pro Cloud Server Logon Screen

The Pro Cloud Server Logon screen is the first to be shown when launching the Configuration Client. At a minimum it
requires the address and Port of the Pro Cloud Server to connect to.

Pro Cloud Server Logon

Option Description

Server Address The Server Address format is:

     <ServerURI>:<Port>

The server URI can be ‘localhost’, an IP address, a DNS name or a machine name;
for example, MyCloudServer. If you are working on the Cloud Server, 'localhost'
will be sufficient.

Password Enter the password you defined in Configuration Client Connection Settings, in the
Pro Cloud Server Configuration Help topic.

As a security precaution from PCS version 4.1 onwards the default password is:

    pcsadm1n

while PCS version 4 and earlier did not define a password.  You can set the
password to a new value, as described in the Help topic Extended Server Properties.

OK Click on this button to log in to the Cloud Configuration Client.
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Database Managers

The list of Database Managers on the Pro Cloud Server Configuration Client's main screen displays all defined
repositories that are accessible by Enterprise Architect clients, and the main properties for each. Database Managers can
be maintained (added, modified and deleted) directly from the main screen.

The Database Managers list includes these details for each defined repository:

Columns

Option Description

Database Manager This column includes both a colored icon representing the enabled state (green for
enabled, red for disabled) of the database manager and its connection string.

Alias A unique name that identifies the repository.  On Enterprise Architect's 'Cloud
Connection' screen this is the value entered into the 'Model Name' field.  An alias
can be assigned when a database manager is defined; if this field is left blank the
Pro Cloud Server will determine its value.

Connections The number of active user connections, and the maximum number of connections
possible.

Note: Typically the number of active user connections is zero, since they are only
considered 'active' while a request is being processed. As soon as the data is
returned to the client the connection is set to inactive. The number of connections is
only refreshed when either the Refresh button is clicked on or a change is made to a
database manager's definition.

R / O A flag to indicate if the database manager has been configured as Read-Only.

SSL A flag to indicate if the database manager has been configured to only allow secure
connections.

Pro A flag to indicates if 'Pro features' has been enabled for the repository, this is
controlled by the 'Enable Pro Features (OSLC, WebEA and Integration)' option on
the Configure Database Manager screen.
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Add Database Manager

The Add Database Manager screen displays when you click on the Add.. button on the 'Sparx Systems Pro Cloud Server
Configuration Client' screen; it allows you to define a new database connection to any supported DBMS.

The process for defining a Database Manager is subtly different for each DBMS, as explained on these pages:

Add Database Manager - Firebird·

Add Database Manager - ODBC·

Add Database Manager - SQL Server·

Add Database Manager - Oracle·

The 'Alias'

It is important to note that the Pro Cloud Server uniquely identifies databases by a single value; this value is referred to
as the database 'Alias'.

When adding a new database manager, the Alias can be specified using the 'Alias' field on the 'Add Database Manager'
dialog.

If no Alias is specified, then a default Alias is determined using these rules:

Firebird definitions, the 'Alias' is the filename minus the extension·

ODBC-based definitions, the 'Alias' is the 'Data Source'·

Oracle OLE DB based definitions, the 'Alias' is the Oracle 'net service name'·

SQLServer OLE DB based definitions, the 'Alias' is the 'Initial Catalog'·

Therefore, take care when defining database connections, to ensure that you do not create duplicate database aliases.
However, if two or more database definitions do share the same alias, then all Enterprise Architect clients will connect to
the first database found with the requested alias.

Relative path Note

This note is shown on the Add Database Manager screen:

'Note: The Data Source Names and network paths provided by the Data Link Properties and ODBC Data Sources
dialogs are relative to this machine and may need to be modified to match those on the server.'

The purpose of this note is to inform the user that ODBC definitions are saved on each machine and that if the Pro Cloud
Server Configuration Client is used to access a Pro Cloud Server on another machine the ODBC DSN definition list is
relative to the client machine and not the machine hosting Pro Cloud Server.
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This means if the Pro Cloud Server Client application is running on a remote machine (that is, not the machine running

the Pro Cloud Server) the definitions that are shown by clicking on the  button and ODBC Data Sources button are
relative to the current machine and not the Pro Cloud Server machine, so care should be taken.

Default State of Added Database Managers

As a safety precaution, whenever a new Database Manager is defined it is automatically configured to be disabled. You
can enable the database after it has been initially defined by selecting the 'Enabled' checkbox on the Configure Database
Manager screen.
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Add Database Manager - Firebird

Firebird-based repositories are the simplest DBMS to add to the Pro Cloud Server and can be either completely new or
an existing repository.

New Firebird Repository

To add a completely new repository, just enter the physical file name of the new model (for example, MyFireBird.feap)
and click on the OK button.

The Pro Cloud Server will automatically create a new empty Enterprise Architect repository database and add it to the
list of defined Database Managers on the main Pro Cloud Server Configuration Client screen.

Existing Firebird Repository

To add an existing Firebird database to your Pro Cloud Server environment, the physical file must first be copied into the
'Models' folder in the Pro Cloud Server's installation folder (the default being 'C:\Program Files (x86)\Sparx Systems\Pro
Cloud Server\Service\Models'). This ensures the Pro Cloud Server has the necessary security permissions to the file.

Once the existing file is placed in the 'Models' folder, simply enter the filename of the database in the 'Add Database
Manager' screen and click on the OK button.  Your existing database will then be added to the list of defined Database
Managers on the main Pro Cloud Server Configuration Client screen.

Background Information

Firebird is a free, open source rational database that runs on a variety of platforms. Firebird is very sophisticated and
offers great concurrency, scalability and performance. It can be used in an enterprise setting and has been used in
production systems, under a variety of names, since 1981.

To discover more about the Firebird database, please visit this website:

     http://www.firebirdsql.org/en/about-firebird/

The Introduction to Cloud Services webinar shows the use of a Firebird database. You can view the webinar by clicking
on this link:

     https://sparxsystems.com/resources/webinar/model-repository/cloud/introduction/introduction-cloud-services.html
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Add Database Manager - ODBC

Pro Cloud Server connections to MySQL, Oracle and PostgreSQL databases require the use of ODBC DSNs, which are
defined in the Windows 'ODBC Data Source Administrator (32-bit)' screen. If you are running the Configuration Client
on the same machine as the server you can:

Click on the  button to open the 'Data Link Properties' dialog to build the connection string.1.

Select the provider 'Microsoft OLE DB Provider for ODBC Drivers' and click on the Next >> button.2.

Select the pre-defined System DSN from the 'Use data source name' field.3.

Fill in the user name and password and select the 'Allow saving password' checkbox.4.

Notes:

All ODBC DSNs should be defined as SYSTEM DSNs, because the Pro Cloud Server runs as a Windows Service·
and User DSNs might not be available to the Pro Cloud Server

The step for filling in the user name and password might not be required if the user name and password have been·
saved with the ODBC DSN

The ODBC Data Sources button displays the Windows 'ODBC Data Source Administrator' dialog, which you can·
use to set up a new ODBC system data source to be listed on the 'Data Link Properties' dialog (if you are running the
administration client on the same machine as the server); it is particularly helpful because it shows the 32-bit ODBC
data sources

For MySQL  - make sure to adjust the MAX_PACKET_SIZE of your MySQL installation to be large enough to·
store the largest record in your database; this is needed in order for Enterprise Architect to retrieve and manipulate
large records
It is difficult for Sparx Systems to state a recommendation for this setting because it is dependant on the size of
records in a user's repository; however, it is not unusual that a value of at least 200M is required
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Typically the largest records are stored in T_DOCUMENT and are the results of embedding a document or storing a
baseline within the repository; the MAX_PACKET_SIZE setting is defined in MySQL's configuration file, 'my.ini'
for Windows or  '~/.my.cnf' for Linux
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Add Database Manager - SQL Server

Pro Cloud Server connections to SQL Server-based databases require the use of an OLE/DB driver; currently Sparx
Systems Pro Cloud Server supports both the historical 'Microsoft OLE DB Provider for SQL Server' (which has been
included with MDAC for many years) and the newly-released 'Microsoft OLE DB Driver for SQL Server', with the latter
supporting TLS v1.2 and other new features released with the later versions of SQL Server.

Authentication

The SQL Server OLE/DB drivers support two forms of database authentication, both of which are supported by Sparx
Systems Pro Cloud Server:

1. Windows Authentication / Windows NT Integrated security (or SSPI) and

2. SQL Server Authentication / "specific user name and password"

Many Sparx Systems customers expect the 'Windows Authentication' option to use the authentication details of the end
user logging into Enterprise Architect; however this is NOT the case.  When this option is selected it is actually the
credentials of the owning user of the Sparx Systems Professional Cloud Windows Service that are used to authenticate
against the database.  This, by default, is 'Local System'.

Credentials are needed to establish a database connection; however, it is a relatively slow process - if the Pro Cloud
Server was required to establish a connection to the database using the end user's details for every query, performance
would be severely impacted. Instead, the Pro Cloud Server creates a 'pool' of database connections when it starts.
Database connections from the pool are allocated to action each request for data as it arrives and, since they have already
been established, execution is almost instantaneous.

Therefore, when defining database connections to SQL Server-based repositories, special consideration should be given
to determine the best/most appropriate database credentials for your environment.  Typically we recommend SQL Server
authentication with the use of a predefined SQL Server user; however, for many customers the SQL Server
authentication method goes against their company's security policy, so they need to either:

Change the owning user of the Sparx Systems Professional Cloud Windows Service to one that has the necessary·
permissions in SQL Server, or

Grant the Local System account permissions to the SQL Server database·

Roles / Permissions

In order for end users of Enterprise Architect/WebEA/Prolaborate to be able to read and update information within the
repository, the database users require the relevant permissions; the easiest way to achieve this is to grant these roles to
each database user:

    db_datareader

    db_datawriter

Add SQL Server database using SQL Server authentication

Prior to defining the Pro Cloud Server connection, define a SQL Server user with roles to the database that will act as the
Enterprise Architect repository.

You can define a connection to a SQL Server Database by specifying the connection string to the database. If you are
running the Configuration Client on the same machine as the server you can:

Click on the  button to open the 'Data Link Properties' dialog to build the connection string.1.

Select 'Microsoft OLE DB Provider for SQL Server' or 'Microsoft OLE DB Driver for SQL Server' and click on the2.
Next >> button.

Select or type in the instance of SQL Server.3.

Select the 'Use a specific user name and password' checkbox and fill in the user name and password, then select the4.
'Allow saving password' checkbox.

Select the database that is the Enterprise Architect repository in 'Select the database on the server'.5.

(c) Sparx Systems 2019 Page 121 of 654 Created with Enterprise Architect



Model Repository - Model Repository 20 January, 2020

Add SQL Server database using Windows Authentication

You can define a connection to a SQL Server Database by specifying the connection string to the database. If you are
running the Configuration Client on the same machine as the server you can:

Click on the  button to open the 'Data Link Properties' dialog to build the connection string.1.

Select the provider 'Microsoft OLE DB Provider for SQL Server' or 'Microsoft OLE DB Driver for SQL Server' and2.
click on the Next >> button.

Select or type in the instance of SQL Server.3.

Select the 'Use Windows NT Integrated security' checkbox.4.

Select the database that is the Enterprise Architect repository in 'Select the database on the server'.5.
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Note:

Because the Sparx Systems Professional Cloud Windows service is run under a single account, all database access·
will be under that account, so it will not be possible to keep track of what records are updated in the database by
individual end users; however, internally Enterprise Architect can store audit history if required
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Add Database Manager - Oracle

Pro Cloud Server connections to Oracle-based databases require the use of either ODBC or OLE/DB drivers, although
Sparx Systems recommend the use of OLE/DB since it provides superior performance compared to ODBC.

You can define a connection to an Oracle Database (via OLE/DB) by specifying the connection string to the database. If
you are running the Management Client on the same machine as the server you can:

Click on the  button to open the 'Data Link Properties' dialog to build the connection string.1.

Select the provider 'Oracle Provider for OLE DB' and click on the Next >> button.2.

Type in the name of the 'Data Source'; this is the Oracle net service name as defined in the TNSNAMES.ORA.3.

Fill in the user name and password and select the 'Allow saving password' checkbox.4.

Note:

The Pro Cloud Server identifies databases by the 'Data Source' value and Oracle OLE DB defines the 'Data Source'·
as the net service name, so it is only possible to access one Oracle repository per net service name; the workaround
to this limitation is to define multiple net service names in TNSNAMES.ORA that differ only by name
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Configure Database Manager

The Configure Database Manager screen is shown when you click on the Edit button on the 'Sparx Systems Pro Cloud
Server Configuration Client' screen. It allows you to modify the various options for the selected database manager.

Options

Option Description

Database Manager Read-only field showing the description of the database as shown in the 'Database
Manager' List. The format of the description quickly identifies the database, as
illustrated here:

{odbc provider}:{user}@{datasource}

Enabled Select this checkbox to allow the Data Manager to respond to requests for the
connection.

Alias The database Alias. This is the value Enterprise Architect clients will need to enter
in the 'Model Name' field of the 'Cloud Connection' screen. Whenever a database
manager is created the system will define a value for 'Alias' automatically, but if
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necessary you can change this value to a more meaningful or appropriate name for
your Enterprise Architect and WebEA users.

Database Type Read-only field showing the DBMS of the defined database, such as Firebird,
MySQL, Postgres, SQLSvr or Oracle.

Connection String Read-only field showing the full connection string used to connect to the database.

Copy Button A convenient button for copying the connection string to the clipboard.

Max Simultaneous Queries Type in the maximum number of queries that the Pro Cloud Server can process
simultaneously for the selected Database Manager. You can use the up/down
arrows to adjust this figure to balance resource usage with concurrent user
performance.

There is no explicit limit for this value, but the higher the value the more resources
are consumed on your server, without a matching increase in benefit in user
performance. Connections are held so briefly that the reduction in user wait time
due to more connections being opened is not usually noticeable. If you are reaching
the number of queries/connections you have defined here, increase it by small
increments.

Minimum EA Build Optional. If you want to ensure that all users of the model are on an appropriate
build of Enterprise Architect, type in the lowest build number required.

OSLC Access Code Optional. Type in the access code that all OSLC clients, including WebEA, are
required to send in an HTTP header.

Leave blank to indicate that the OSLC clients are not required to send an access
code.

Require a secure and
authenticated connection

Select this checkbox to ensure that all clients (such as Enterprise Architect, WebEA
and Prolaborate) connecting to this Database Manager must use SSL authentication.

Note: before setting this option make sure the repository has been enabled for User
Security, (see Enable/Disable Security), otherwise if the repository is enabled for
User Security after setting this value the Pro Cloud Server will not recognize that
the correct User Security state until after it has been restarted.

Read-only connection Select this checkbox to prevent users from modifying the database.

Enable Pro Features
(OSLC, WebEA and
Integration)

This option is only available in Pro Cloud Server editions. A checked state indicates
that the current model has 'Pro Features' enabled, which includes OSLC, WebEA
and Integration to external systems.

If this option is disabled then the reason for disabling it will be shown in the text.
For example:

No License - There is no license defined or the license has expired

Model Limit Reached - Both the 'Token' and 'Team' editions of the Pro Cloud
Server are limited to a certain number of models that can be Pro-enabled; this
reason code implies the maximum number of models has already been Pro-enabled

Run Scheduled Chart
Generation

When this option is checked the Pro Cloud Server will update Time Series charts in
the current model as a schedule task.

To configure the Scheduled Chart Generation , select the checkbox, then click the
Configure button.

Start Time: The time of day that the schedule task should run·

Number of times to retry: In the event of repeated errors, how many times·
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should the process retry

Interval between retries: The number of minutes between retries·

Next Run: The calculated next run date and time. Note: this value only updates·
after the various settings has been saved.

Periodically Generate
Diagram Images for
WebEA & Prolaborate

This option is only available in Pro Cloud Server editions when a Database
Manager has Pro Features enabled.

In order to generate diagram images and linked documents (which are required by
WebEA and Prolaborate) a 'worker' can be configured to run periodically; the Pro
Cloud Server is capable of automatically starting these workers whenever it starts.

To configure a worker, select the checkbox, then click the Configure button.

On the 'Worker Configuration' screen enter the configuration details for these
fields:

Port:  select the desired Port that the Worker should use to connect to this·
repository

Model User: enter a valid repository user.  This value only requires a value if·
the current repository has model security enabled

Model Password: enter the password for the repository user.  This value only·
requires a value if the current repository has model security enabled

Interval (seconds):  This value defines how often the Worker process will·
check for modified diagrams, and generate where required; the default value is
30 seconds

OK Click on this button to save the settings and close the dialog.
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Obtain Database Manager Connection String

Each Cloud Connection/Database Manager definition includes a connection string that the Pro Cloud Server uses to
access the Project/Database.

This connection string can be particularly helpful in diagnosing issues when connecting to the Cloud model. You can
obtain the connection string either via the Cloud Configuration Client Application or the Cloud Configuration Web
interface (WebConfig).

Cloud Configuration Client

To obtain the connection string via the Cloud Configuration Client Application, follow these steps:

Step Description

1 Open the Cloud Configuration Client.

2 In the list of defined Database Managers, click on the relevant Database Manager, then click on the Edit
button.

3 The Configure Database Manager screen is displayed. This includes the 'Connection String' field.

4 Click on the Copy button, which is located next to the 'Connection String' field.

WebConfig

To obtain the connection string via the Cloud Configuration Web Interface (WebConfig), follow these steps:

Step Description

1 Log in to the WebConfig home screen.

2 Click on the relevant model in the 'Model Connections' list. Click on the Edit Connection button in the
'Action' column.

3 The 'Edit Model Connection' page is displayed. Click on the 'Advanced' heading to expand its contents.

4 Click on the Copy button, which is located next to the 'Connection String' field.
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Extended Server Properties

The Extended Server Properties screen displays when you click on the 'Extended Properties' button on the Main screen.
It helps you to configure the global options applied to the Pro Cloud Server. Each of these options can also be set in the
configuration file; however, the service does not require a restart if the options are changed using this screen.

Options

Option Description

Audit Time Period Read-only value showing the number of seconds between audit reports.

Default Max Simultaneous
Queries

Default Value:  10

Provides a default value for the setting of 'Max Simultaneous Queries' when
defining new database managers.

Logging File Count Default Value: 3

Read-only value showing the number of log files that should be retained. All
logging is written to files named 'SSProCloudServerLog-X.log' where X represents
the file number.

File 'SparxCloudServicesLog-1.log' is always the current file. When the maximum
file size is reached, all existing files are renamed by incrementing the file number
and a new 'SSProCloudServerLog-1.log' file is created.

Logging File Size Default Value: 1048576

Read-only value showing the maximum file size (measured in bytes) of each log
file. When the file reaches this maximum, a new file is created.
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Log Level Click on the drop-down arrow and select the level of information to be written to
the log file. The valid options are:

OFF - No logging is performed·

FATAL - Only fatal errors are logged·

WARNING - Warnings are logged·

INFO - Information messages that provide general advice on what actions are·
occurring

SYSTEM - More detailed messages·

DEBUG - (new in PCS v4.1) Normally only used to help debug potential·
issues

TRACE - (new in PCS v4.1) The most detailed level of logging·

Log Levels are cumulative; for example, the INFO level includes all messages of
type FATAL, WARNING and INFO.

Logging Directory Read-only value showing the physical directory into which the log files are saved.

License Store Displayed when using the Pro Cloud Server, to show the path of the license store
file. By default this is:

C:\Program Files (x86)\Sparx Systems\Pro Cloud Server\Service\sskeys.dat.

Temp Directory Read-only value showing the physical path of the temp directory; by default this is:

C:\Program Files (x86)\Sparx Systems\Pro Cloud Server\Service\Temp.

Set New Password Select this checkbox to set or change the administrator password for the currently
connected Pro Cloud Server.  If a password is set then all users attempting to access
the Pro Cloud Server Configuration Client will be required to provide the specified
password.

White List Added in Pro Cloud Server v4.1.

Default Value:  127.0.0.1 and ::1

The White List control shows the list of client machine IP numbers that are allowed
to log onto the Configuration Clients and maintain the Pro Cloud Server's settings.

When a client attempts to connect to a Configuration Client the request will contain
the client's IP number, whether it presents as IPv4 or IPv6 depends on a number of
factors (like the connection method, the type of client application, the client's
operating system etc) however Sparx Systems would recommend that for each
authorized user both their IPv4 and IPv6 numbers should be defined in the white
list.

Use the Add, Edit and Delete buttons to maintain the client IP numbers.

Note:

- An empty White List will allow all clients without any restrictions.

- If you are accessing WebConfig on the machine which hosts the WebConfig
website and using localhost in the URL then the browser will typically provide the
Pro Cloud Server with an IP of 127.0.0.1 or ::1
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Pro Cloud Server Licensing

The Pro Cloud Server License Manager screen displays whenever you click on the Licensing button on the Main screen.
It allows the user to quickly and easily see what Pro Cloud Server licenses have been defined, and the complete details of
each license.

On a new installation, when the 'License' screen is first shown it resembles this:

However, over time as your Pro Cloud Licenses expire you will be able to see a complete history of all licenses:

In the above example, the current Token license is valid from February 3rd, 2019 to February 4th, 2020 and has 5 tokens.

If there is any kind of problem with the license, the 'Valid' column will show the reason; this message is also written to
the current log file.

License Procedure

As of Pro Cloud Server version 4.0.30, the licensing procedure has been enhanced.  Pro Cloud Server licenses are now
linked to the host machine, which is an enforcement of what was stated in the license agreement.  To add a License, the
basic procedure to follow is:

Purchase the required Pro Cloud Server license.1.

Create a 'License Request' from the Pro Cloud Server machine.2.

Send the 'License Request' file to the Sparx Systems Sales team.3.

The Sparx Systems Sales Team will then return the 'License Certificate'.4.
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Add your 'License Certificate' to your Pro Cloud Server installation.5.

Your Pro Cloud Server is now licensed!6.

Along with the change to Licensing procedures, Pro Cloud Server 4.0.30 introduced the 'Token' Edition, which provides
a more flexible upgrade path by making use of tokens that can be purchased separately at any time to enable only the
extra functionality your environment requires.

For the premium editions ('Team' and 'Enterprise') the enabled functionality remains unchanged, except that the 'Team'
edition now allows 7 Pro-enabled models, 2 more than in earlier versions.

Licensing Screen Options

As shown in the above screen shots, the Pro Cloud Server License Manager screen contains a list of Licenses and a
selection of action buttons, which are described here:

Option Description

Pro
Clou
d
Serv
er
Lice
nses

The list of Licenses displays a historical record of all Licenses for the current Pro Cloud Server.  Each
License will display values in these columns:

License Type - One of 'Token', 'Team' or 'Enterprise'·

Tokens - The number of Tokens associated with the License·

Company - The name of the company that the Pro Cloud Server is licensed to·

Email - The email address associated with this license; that is, the email address that was provided·
when the License Request was created

Start Date - The date the License is valid from·

Expiry Date - The date the License expires on·

Valid - A value of 'True' indicates that the current license is loaded, otherwise an error message·
displays explaining why it is not valid

Crea
te
Requ
est...

The Create Request button is permanently visible on the Pro Cloud Server License Manager screen.

Selecting this button will display the New License Request screen, which allows the user the create a new
Pro Cloud Server License request.

Add.
..

The Add button is permanently visible on the Pro Cloud Server License Manager screen.

Selecting it will prompt the user to select a Pro Cloud Server License Certificate file (*.CRT) in the file
system.

Rem
ove

The Remove button is permanently visible on the Pro Cloud Server License Manager screen, however it is
only enabled when a License is selected in the list.

Selecting this button will remove the selected Pro Cloud Server License from list.

If the Remove action was performed by mistake, the License Certificate file (.CRT) will still exist in the
file system under the, {installation path}\Licenses\deleted\ folder.  Therefore to reinstate the deleted
license, manually copy the {GUID}.CRT from the \deleted\ folder to {installation path}\Licenses\ and
restart the Pro Cloud Server.

Rene
w...

The Renew button is permanently visible on the Pro Cloud Server License Manager screen; however, it is
only enabled when a License is selected in the list.

Selecting this button will display the 'New License Request' screen, but some of the fields will be
pre-populated with the details of the selected License.

Man
age

The Manage Allocations... button is only visible when the selected Pro Cloud Server License is a Token
license.
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Allo
catio
ns...

Selecting this button will display the 'Manage License Token Allocations' screen, which allows the user to
control the minimum and/or maximum number of Tokens associated with each Pro Feature.
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Create Request

The New License Request screen is displayed when the user clicks on the Create Request button on the Pro Cloud Server
License Manager screen. The purpose of this screen is to create a license request for the connected Pro Cloud Server
installation.

The New License Request screen will initially be displayed as shown here:

The creation of a License Request is required after purchasing a Pro Cloud Server license. The License Request helps
Sparx Systems identify and register what hardware is going to host the Pro Cloud Server.

Complete a License Request

The New License Request screen prompts for these input details:

Field Description

Company Name Mandatory value. The name of the company that made the Pro Cloud Server
purchase.

Email Mandatory value. The email address associated with the Pro Cloud Server
purchase.

Installation ID Mandatory value. The unique GUID that was supplied in the email to confirm your
Pro Cloud Server purchase.

If you purchased your Pro Cloud Server license prior to June 2019, use your Pro
Cloud Server version 3 License key.

Start Date Optional value. Use this date to request that your Pro Cloud Server License should
start on a future date.  If no value is supplied the Sparx Systems Sales Team will
assume the current date.

Comments Optional value.  Any additional comments that might be helpful to the Sparx
Systems Sales Team.
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Submit the Request

In order to minimize any potential delays please provide the Sales team with as much detail as possible about your Pro
Cloud Server License purchase.  For example:

Once you have entered all Pro Cloud Server purchase information, click on the OK button; a prompt displays to save the
resulting License Request to the file system.  The file should then be emailed to the Sparx Systems Sales team:
sales@sparxsystems.com.
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Add a New License

After you submit a License Request, the Sparx Systems Sales Team will reply with your License Certificate. When this
occurs click on the Add button on the Pro Cloud Server License Manager screen and select the supplied License
Certificate file (*.lic or *.crt). The details of the License Certificate will be loaded and shown on the License screen,
resembling this:

When the License screen is closed, the Main screen will now reflect the new License in the 'Server Properties' section:

(c) Sparx Systems 2019 Page 136 of 654 Created with Enterprise Architect



Model Repository - Model Repository 20 January, 2020

Remove a License

It is possible to remove, at any time, an existing Pro Cloud Server License, simply by selecting the license in the list on
the Pro Cloud Server License Manager screen and clicking on the Remove button. The list of allocated licenses will be
refreshed accordingly. There is no need to restart the Pro Cloud Server, the internal License and all related functionality
enabled (or disabled) by the change or removal of a License will take effect immediately.
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Renew a License

On the Pro Cloud Server License Manager screen, the Renew button will be enabled whenever a License is selected in
the list of licenses. It is a convenient function that displays the same New License Request screen as is shown by the
Create Request button; however, the difference is that the 'Renew' option will pre-populate the valid details of the
selected License, although the remaining fields will still have to be filled in manually. The renewal process is the same as
the initial process and will have to be repeated whenever the License expires.
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Manage Allocations

The Manage License Token Allocations screen is displayed when you click on the Manage Allocations button on the Pro
Cloud Server License Manager screen.  This screen allows you to control how tokens are consumed to enable Pro
Feature functionality.

The Manage Allocations screen is broken up into three sections: a Summary of token usage, Explicit Allocations, and
allocations of tokens that are shared for Web Access.

Token Summary

The token summary shows:

Total - The total number of tokens based on the active license(s)·

Explicit - The number of explicit token allocations, which refers to tokens that have been allocated to enable specific·
features on the server

Shared - The number of shared tokens that are available; these are consumed when users access features such as·
WebEA - when logging out, the token is returned to the shared token pool

Click on the Usage button to display a more detailed breakdown of the token allocations, including how many tokens are
currently in use.

Explicit Allocations

This section allows you to enable Integration Plug-ins for your Pro Cloud Server. Enabling integration with a specific
product (such as Jira) consumes one token.

Shared for Web Access

WebEA, Prolaborate and OSLC users consume a single token with every logon. For most environments these allocations
can be left with their default values (0 reserved and no maximum). In this case all users are accessing a single shared
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pool of tokens, regardless of what type of access (WebEA, Prolaborate or OSLC) they require. Alternatively, each user
type can define a number of tokens that are reserved (that is, they can only be used by that type of access) as well as a
maximum number.

Notes:

A Max Allowed value of 0 implies that users are NOT allowed; that is, if WebEA's Max Allowed value was set to·
0, the Pro Cloud Server would deny all WebEA user requests to logon

An empty value for Max Allowed implies there is no limit on the number of users, although the total number of·
users is still limited to the number of available tokens
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Port Configuration

When setting up the Pro Cloud Server you will need to define at least one Port that will be used for communication
between the Pro Cloud Server and Enterprise Architect when accessing a Cloud model.

Ports can be configured via the 'Ports' tab in the Cloud Configuration client.

The Ports Tab

The 'Ports' tab provides information and a number of options:

Item Description

Port List The main area of the 'Ports' tab provides a list of the existing Port definitions.

These Port settings are also covered in more detail in the Add a Port Definition
topic.

Columns

Port - The Port number·

Protocol - Displays the transfer protocol (http or https) that the Port has been·
configured to communicate on

OSLC Supported - Displays True if OSLC support is enabled for this Port;·
OSLC Support is required for WebEA access

Authentication - Indicates what type of Authentication is required (if any)·

Resource Monitor Located in the lower left of the 'Ports' tab, this button can be used to open the
Windows Resource Monitor. This allows you to check which Ports are already in
use before adding a new Port Definition.

Please note: this will open the Windows Resource Monitor for the current machine,
which is only relevant if the Configuration Client is running on the machine hosting
the Cloud Server.

Add Click on this button to add a new Port Definition.

Edit Click on this button to edit the configuration of the selected Port. Editing a Port
provides the same options as when adding a new one, except that the Port number
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cannot be changed.

Remove Click on this button to permanently delete the selected Port Configuration
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Add a Port Definition

As mentioned in the Port Configuration topic, when setting up the Cloud Server you must define at least one Port for
communication between the Pro Cloud Server and Enterprise Architect.

To add a new Port Definition:

Open the Pro Cloud Server Configuration Client - Application.1.

Select the 'Ports' tab.2.

Click on the Add button.3.

The 'Add TCP Port' dialog will be displayed. Referring to the Add TCP Port table, enter the Port details, then click4.
on the OK button.

Confirm that your Firewall Settings are correct.5.

Restart the Pro Cloud Server Windows Service so that the changes take effect.6.

Add TCP Port

Field Description

Server Port Enter the number of the Port to be used for Cloud Connections.

Each defined Port must be unique and not used by any other service or application
on the current machine. The standard HTTP Port (80) and HTTPS Port (443) are no
different; if they are available, the Pro Cloud Server can be configured to use them.
You can use the Windows Resource Monitor (which is accessibly via an icon on the
Configuration Client 'Ports' tab) to check which Ports are already in use.

Firewall Note: When changing or adding a new Port, check that incoming requests
are allowed by the firewall settings at both the local machine and network levels.

Wine Note:  When the service is running on Wine you should not use privileged
Ports - those below 1024; under Wine, most applications are only able to listen on
Ports above 1024.

Protocol Select the protocol that the Port will be configured as. The options are:
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HTTP - The default value·

HTTPS - When this option is selected, you will be presented with four·
additional checkboxes that control which versions of TLS (and SSL) are
allowed on the given Port

Additionally, for HTTPS to be configured correctly, a file named server.pem must
also exist in the same directory as the configuration file, and it must contain a valid
private key/certificate.  For more details on server.pem see the SSL Certificates
section.

OSLC Supported Enable this option to allow OSLC access to models.

Note: WebEA makes use of OSLC; if you intend to access models via WebEA then
this option should be enabled

Authentication Select the type of authentication that will be required for this Port:

Model - All model connections that use the current Port will be forced to·
request HTTP authorization, using the user security defined in the Enterprise
Architect model being connected to; passwords must be explicitly and
individually assigned in that model using the Maintain Users procedure - the
default administrator password and any passwords imported from Windows
Active Directory do not work
Note: if you are not using SSL to connect, the usernames and passwords will
be sent in plain text
If the model does not have security enabled, the Cloud user is not prompted for
a password

Global - Selecting this option displays an additional 'Global Model' field, in·
which you enter the DB Alias of a Database Manager that will be used to
provide the security profile to all connections opened with the current Port; this
is helpful if you want to provide multiple models but only manage one list of
users
Passwords must be explicitly and individually assigned in the Global model
using the Maintain Users procedure; the default administrator password and
any passwords imported from Windows Active Directory will not work.
Note: If you are not using HTTPS as the protocol, the usernames and
passwords will be sent in plain text, therefore Sparx Systems recommends that
Global authentication should only be used with HTTPS.

SSL Certificates

In order for the Pro Cloud Server's internal Web Server to start a Port using SSL, two individual files, cacert.pem and
server.pem are required to be in the same folder as the Pro Cloud Server configuration file.

cacert.pem - contains a collection of trusted CA certificates (in .X509 format), this file is reserved for future use·

server.pem - contains a certificate and private key (in .X509 format) for your server·

Sparx Systems do not supply a server.pem, because typically SSL certificates have to include the current server's details
as well as individual details about your organization.  Although this is an additional step, it is a particularly good idea to
apply it if you are providing access to external users.  You should create and sign an SSL certificate for your Cloud
Server using an appropriate certificate authority (CA).

However, to help with initial set up and testing purposes, or for setups that are entirely within a closed network, you can
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generate your own self-signed certificate. In general, self-signed certificates are not trusted by major browsers or
operating systems and will generate errors or warnings visible to end users. See the Self-Signed SSL Certificates Help
topic on how to create a self-signed certificate.

To add trust to a self-signed certificate when it is not practical to generate globally trusted certificates, see the Add Trust
with a Certificate Authority (CA) Help topic.

Note: If the Pro Cloud Server is started without a valid server.pem file and a Port is defined with Protocol=HTTPS, then
the internal web server will not be able to open the Port; if this situation occurs, error messages to this effect will be
written to the .LOG file

Manual Port Configuration

Optionally, Ports can also be configured by directly editing the Cloud Server's configuration file (SSProCloud.config).
This allows some additional settings, which are not available in the Pro Cloud Configuration Client, although a manual
restart of the Pro Cloud Server Windows Service will be required before any manually adjusted setting take effect.

The definition of a Port is denoted in the configuration file, with open and close parentheses, each on their own lines
without any leading whitespace.  Inside the parentheses are a number of supporting options that control and limit how the
Port can be used.  All options except SERVER_PORT are optional.

     (

     SERVER_PORT=804

     REQUIRE_SSL=0

     OSLC_SUPPORT=1

     DEFAULT_MODEL=

     MODEL_AUTHENTICATION=

     GLOBAL_AUTHENTICATION=user model

     EA_MINIMUM_BUILD=

     EA_MAXIMUM_BUILD=

     SSL_PROTOCOLS=SSLv3 | TLSv1 | TLSv1_1 | TLSv1_2 | TLSv1_3

     )

Settings Explained

Setting Description

SERVER_PORT This option expects a numeric value (whole number) that defines a Port number;
there is no default value.

For example, SERVER_PORT=804  states that the Pro Cloud Server service will
listen to HTTP connections on Port 804.  Each defined Port must be unique and not
used by any other service or application on the current machine. The standard
HTTP Port (80) and HTTPS Port (443) are no different, if they are available the Pro
Cloud Server can be configured to use them.

Firewall Note: When changing or adding a new Port, check that incoming requests
are allowed by the firewall settings at both the local machine and network levels

Wine Note:  When the service is running on Wine you should not use privileged
Ports - those below 1024; under Wine, most applications are only able to listen on
Ports above 1024

REQUIRE_SSL This option expects a value of either 0 or 1; the default is 0.
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A value of 1 will enforce the use of SSL on the current Port; that is, all connections
must be performed using HTTPS, which is useful when connections need to be
exposed on public networks.

In order for the Pro Cloud Server to be able to successfully configure Ports as
REQUIRE_SSL=1, a file called server.pem must exist in the same directory as the
configuration file, and contain a valid private key/certificate. For more details on
server.pem see the earlier SSL Certificates section.

SSL_PROTOCOLS This option is a pipe-delimited list of TLS/SSL protocol versions accepted by the
Port.  If omitted, the default value of TLSv1_2 | TLSv1_3 is assumed. Valid values
are 'SSLv3', 'TLSv1', 'TLSv1_1', 'TLSv1_2', 'TLSv1_3'.  For example, if a Port was
to accept versions TLS 1.1, 1.2 and 1.3 an entry should be:

SSL_PROTOCOLS=TLSv1_1 | TLSv1_2 | TLSv1_3

OSLC_SUPPORT This option expects a value of either 0 or 1. The default is 1.

A value of 1 defines that connections that use the current Port will be able to
perform queries using the 'Open Services for Lifecycle Collaboration' standard.
This is discussed further in the OSLC Requirements Management Help topic.

DEFAULT_MODEL This option expects the alias of a defined database manager, or blank. The default is
blank.

Defining a value for this option allows a single repository to be exposed on a Port,
making it possible to use a different Port for each repository. Model names are
discussed further in the Connecting Enterprise Architect to a Cloud Server Help
topic.

MODEL_AUTHENTICAT
ION

This option expects  a value of either 0 or 1. The default is 0.

By defining this option as 1, all model connections that use the current Port will be
forced to request HTTP authorization using the user security defined in the
Enterprise Architect repository being connected to. Passwords must be explicitly
and individually assigned in that repository using the Maintain Users procedure;
the default administrator password and any passwords imported from Windows
Active Directory will not work. Note that if you are not using HTTPS/SSL to
connect, the usernames and passwords will be sent in plain text.

If the repository/model does not have security enabled, the user is not prompted for
a password.

This option is mutually exclusive with GLOBAL_AUTHENTICATION.

GLOBAL_AUTHENTICA
TION

This option expects the alias of a defined database manager, or blank, the default is
blank.

By defining this option a single Enterprise Architect repository with security
enabled can be used to provide the security profile to all connections opened with
the current Port.  This is helpful if you want to expose multiple repositories/models
but only manage one list of users. Passwords must be explicitly and individually
assigned in the Global model using the Maintain Users procedure; the default
administrator password and any passwords imported from Windows Active
Directory will not work.

This option is mutually exclusive with MODEL_AUTHENTICATION.

EA_MINIMUM_BUILD This option expects a numeric value that represents the minimum Enterprise
Architect version that can connect to models using this Port.  The default is
undefined, which implies all versions are allowed.

EA_MAXIMUM_BUILD This option expects a numeric value that represents the maximum Enterprise
Architect version that can connect to models using this Port.  The default is
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undefined, which implies all versions are allowed.
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Advanced SSL

In general, self-signed certificates are not trusted by major browsers or operating systems and will generate errors or
warnings visible to end users. See the Self-Signed SSL Certificates Help topic on how to create a self-signed certificate.

To add trust to a self-signed certificate when it is not practical to generate globally trusted certificates, see the Add Trust 
with a Certificate Authority (CA) Help topic.
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Self-Signed SSL Certificates

There are many ways to create SSL certificates; however, we have found the OpenSSL toolkit to be the easiest and most
comprehensive. As the name suggests, OpenSSL is an open source toolkit for SSL/TLS; see the official website for
details.

You will need to download and install the OpenSSL product that suits your environment. For the purposes of this
document, OpenSSL was installed into C:\OpenSSL-Win64. If your OpenSSL is installed into a different directory then
these steps will have to be adjusted to suit.

Create a new command/batch file in C:\OpenSSL-Win64\bin\·

Open this file and paste these details into it·

      set SRVNAME=localhost

      openssl genrsa -out %SRVNAME%.key 2048

      openssl req -new -x509 -key %SRVNAME%.key -out %SRVNAME%.cert -days 3650 -subj /CN=%SRVNAME%

      copy /b %SRVNAME%.cert+%SRVNAME%.key server.pem
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Add Trust with a Certificate Authority (CA)

In general, it is preferable to use a certificate that has been signed by a globally trusted root Certificate Authority (CA).
There are many CAs that are trusted by all major browser and operating systems and that can be used to sign certificates
for use with an https server.

If the system architecture makes using a globally trusted CA impractical, it is still possible to have client browsers and
operating systems set up to trust a self-signed certificate and so avoid security errors or showing warnings to end users.

One way is to simply add the certificate to the trust store of the client browser or operating system; however this would
need to be done for each certificate generated. A better approach is to create your own root Certificate Authority and use
that to sign each server certificate.

To do this, a self-signed SSL certificate needs to be signed with your own Certificate Authority (CA) certificate and key,
and the clients (browsers, operating systems) need to be told to trust the CA certificate. The instructions for adding a CA
to a client vary according to the operating system or browser used.

Create a Certificate Authority

There are many ways to create Certificate Authority certificates; however, the OpenSSL toolkit is one of the easiest and
most comprehensive. As the name suggests, OpenSSL is an open source toolkit for SSL/TLS; see the official website for
details. You will need to download and install the OpenSSL product that suits your environment.

To create a CA follow these two steps:

Generate a new key and certificate request.1.

Self-sign the request to generate a CA certificate.2.

1. Generate new key and certificate request

This can be done in multiple steps, or by generating from an existing key file, but for simplicity a new key and new
request can be generated in one command. This example shows how to create a request for a company named 'My
Company'. Change this to something more appropriate for your organization:

openssl req -new -sha256 -nodes -newkey rsa:4096 -subj '/O=My Company/CN=My Company Internal CA' -keyout·
MyCompanyCA.key -out MyCompanyCA.csr

2. Self-sign the request to generate a CA certificate

This step self-signs the CA certificate request, and makes the CA valid for 1 year (-days 365). Change 'MyCompany' to
match the key and csr request generated in the previous step:

openssl x509 -req -sha256 -in MyCompanyCA.csr -signkey MyCompanyCA.key -days 365 -out MyCompanyCA.crt·

Create a server certificate and use the CA to sign it

Now that the MyCompanyCA.crt is generated, it can be used to sign your own certificates for a Cloud Server or WebEA.

First, as in the Self-Signed SSL Certificates Help topic, create a new certificate request. This example creates a new key
and certificate request for a server named 'cloud.mycompany.com':

openssl req -new -nodes -newkey rsa:4096 -subj '/CN=cloud.mycompany.com' -keyout cloud.mycompany.com.key·
-out cloud.mycompany.com.csr

Sign the new certificate request with the CA:
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openssl x509 -req -CA MyCompanyCA.crt -CAkey MyCompanyCA.key -CAcreateserial -sha256 -days 365 -in·
cloud.mycompany.com.csr -out cloud.mycompany.com.crt

The final step for use with a Pro Cloud Server is to concatenate the key and certificate into a 'server.pem' file:

Windows: copy /b cloud.mycompany.com.crt+cloud.mycompany.com.key server.pem·

Linux: cat cloud.mycompany.com.crt cloud.mycompany.com.key > server.pem·

Allow clients to trust the root CA

The client operating system or browser now needs to have the CA certificate added to its list of trusted CAs. The
instructions vary according to operating system and browser, but instructions for a few major clients are listed here. For
all these steps the 'certificate' referred to is the 'MyCompanyCA.crt' generated in Step 2.

Client (Operating System,
Browser)

Instructions

Microsoft Windows Right-click the CA certificate file and select 'Install Certificate'. Follow the prompts
to add the certificate to the trust store either for the current user only or for all users
of the computer.

Linux - Ubuntu Copy the CA certificate to /usr/local/share/ca-certificates

For example:

sudo cp ~/MyCompanyCA.crt /usr/local/share/ca-certificates/·

Update certificates with this command:

sudo update-ca-certificates·

The output should show something similar to 'Adding
debian:~/MyCompanyCA.pem'.

If using Wine, then close all Wine programs and restart Wine:

wineserver -k·

See Ubuntu Help for more information.

Firefox Firefox does not use the operating systems trust store, so the CA has to be added
manually.

If the certificate has a '.pem' extension, then the simplest way is to drag-and-drop
the CA certificate file onto Firefox; a prompt will ask you to trust the certificate.

Otherwise, manually add certificates and manage added certificates through
Firefox's Privacy & Security preferences.

More information can be found on the Firefox wiki.

Chrome/Chromium Chrome and Chromium do not use the operating system trust store, so the CA needs
to be added manually.

Open Settings > Advanced > Manage Certificates > Authorities    select 'Import'

Internet Explorer Internet Explorer uses the Windows trust store, so adding the certificate to
Windows (see above) is sufficient to add trust to the browser as well.

WebEA WebEA uses PHP/curl to communicate with a Pro Cloud model. If the connection
between PHP and the Pro Cloud uses HTTPS, then the CA can be added to PHP's
configuration to allow it to trust the certificate.
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Pro Cloud Server Configuration Client - Web

As an alternative to the Pro Cloud Server Configuration Application, the Pro Cloud Server also includes a Web-based
Configuration Client 'WebConfig'.

Configuration Steps

Step Description

1 If you have not done so already, install the Pro Cloud Server by working through the steps outlined in the
Pro Cloud Server Installation Help topic, making sure that the WebConfig component is installed.

After installation you should find the WebConfig website files in the Installation directory (e.g.
C:\Program Files (x86)\Sparx Systems\Pro Cloud Server\WebConfig). These files make up the
'WebConfig' website/client, and must be hosted on a web server. In the simplest configuration the web
server would be installed on the same machine as the Pro Cloud Server.

2 Download, install and configure your web server for PHP, according to your requirements.

Tip: XAMPP is the most common Apache/PHP web server that includes all the required components; it is
available for Windows/Linux and OS X at:

     https://www.apachefriends.org/download.html.

Note: The WebConfig only requires the minimum XAMPP installation, Apache and PHP; it does not
require MySQL, FileZilla Mercury, Tomcat or any of the other optional components, so if you have no
need for these components Sparx Systems would recommend to not install them.

3 Define and configure a website for the WebConfig in your web server.

As there are many different web servers and configurations, configuring the web site, deciding what Port
the web server will listen to, and making sure the website is secure from external attacks, are all outside
the scope of this documentation.

Tip: Using the default XAMPP configuration, the Port for the default website is 80 and the base folder is
at 'C:\xampp\htdocs'. XAMPP will already have added files to this folder; the WebConfig does not require
these files, so if you have no need for them, move them to a backup location.

4 Copy the WebConfig folder from the Pro Cloud Installation (e.g. C:\Program Files (x86)\Sparx
Systems\Pro Cloud Server\WebConfig) to an appropriate location on the web server (e.g.
C:\xampp\htdocs).

5 Within the WebConfig folder that was copied to your web server, locate the file settings.php and open it
with a text editor. This file defines these settings:

$sProtocol = 'http';·
The Protocol used to access the Pro Cloud Server

$sServerName = 'localhost';·
The Name/IP of the machine running the Pro Cloud Server

$sPort = '804';·
The Port that should be used to access the Pro Cloud Server

$sEnforceCerts = 'true';·
Applies to https connections only
When 'true', self-signed SSL certificates will be denied
When 'false', self-signed SSL certificates can be used

These settings determine how the WebConfig will access the Pro Cloud Server. By default, the Pro Cloud
Server is configured to allow HTTP communication on Port 804; therefore, if the Pro Cloud Server and
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web server are on the same machine these settings can typically be left as is.

Alternatively, update these values to reflect the name/IP of the Cloud Server and the appropriate Protocol
and Port based on the definitions in the SSProCloud.config file.

6 On a remote machine, open an internet browser and enter the URL
http://{yourwebserver}/WebConfig/index.php, where the value '{yourwebserver}' is either the name or IP
number of the machine hosting the WebConfig website.

This should display the 'PCS Configuration - Login' prompt. Enter the password and click on the Login
button to login.

As a security precaution from PCS version 4.1 the default password for the Configuration Clients is:

    pcsadm1n

For all versions prior to PCS version 4.1 the default password was empty (ie no password), in which case
you are logged in automatically.

Note, the Pro Cloud Server will only be accessible if the current machine's IP address is on the Pro Cloud
Server's WebConfig - Server Settings.

WebConfig Server Requirements

To set up the WebConfig Client you require:

A web server (Apache or IIS) capable of hosting PHP v7.0 (or later)·

A web server with these standard PHP extensions installed and enabled: core, curl, date, gettext, hash, json, libxml,·
mbstring, pcre, session, standard and tokenizer

A web server with PHP sessions enabled·

Communication between the web server and the server hosting the Pro Cloud Server·

A base folder (on the web server) to store the WebConfig website pages·

Note: These requirements are the same as for hosting WebEA; the WebConfig could be deployed on the same web server
as WebEA

Managing Multiple Pro Cloud Servers

As mentioned above, by default the WebConfig page will connect to the Pro Cloud Server as defined in the settings.php
file. Alternatively, an additional 'server' URL parameter can be used to access a different Pro Cloud Server (effectively
overriding the settings.php). This allows a single WebConfig to be used for accessing multiple different Pro Cloud
Servers.

For example, if your URL for accessing the WebConfig is:

http://sparx-pcs1/webconfig/index.php

You could use the following URL to connect to access the Pro Cloud Server on 'sparx-pcsdemo':

http://sparx-pcs1/webconfig/index.php?server=http://sparx-pcsdemo:804

This will then connect to the Pro Cloud Server using:
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Protocol: http

Server name/IP: sparx-pcsdemo

Port: 804

Note, for HTTPS connections the $sEnforceCerts setting from the settings.php file will be used.

As usual, the Pro Cloud Server will only be accessible if the current machine's IP address is on the Pro Cloud Server's
WebConfig - Server Settings.
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WebConfig - Login

Having setup the WebConfig client/website you can login by entering the relevant URL. For example:

      http://{yourwebserver}/WebConfig/

     or

     http://{yourwebserver}/WebConfig/index.php

If a Password has been assigned then the PCS Configuration - Login prompt will be displayed. Enter the password and
click on the Login button to login. As a security precaution from PCS version 4.1 the default password for the
Configuration Clients is:

    pcsadm1n

For all versions prior to PCS version 4.1 the default password was empty (ie no password), in which case you are logged
in automatically.

If necessary, after logging in you can set/reset the password for the Cloud Server via the 'WebConfig - Server Settings |
Change Password' option.
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WebConfig - Home Screen

The Pro Cloud Server Configuration 'Home' page has three sections - 'Server Summary', 'Tasks' and 'Model Connections'.

Server Summary

The 'Server Summary' section provides information regarding the current server, including server name, version, license
and port configurations.

Field Description

Server Name The Server Name which is being used to access the Pro Cloud Server. Note, in this
case 'localhost' would refer to the machine which hosts WebConfig.

Version The version number of the Pro Cloud Server that the WebConfig is accessing.

Pro Models The number of models that currently have Pro Features enabled.

License The edition of the Pro Cloud Server (based on the license). If no license has been
added then an 'Add' link will be displayed here (which will take you to the 'Pro
Cloud Server Licenses' screen').

Expiry The expiry date of the Pro Cloud Server License.

Licensed to The name of the company to which the Pro Cloud Server is licensed.

Licensee The email address associated with this license, this being the email address that was
provided when the License Request was created.

Model Ports Lists Ports that are currently defined for use by Model Connections.
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Tasks

The tasks section provides links to perform various tasks. The options available can vary depending on the type of
license.

Button Description

Server Settings Provides options to configure the Pro Cloud Server (log level, password, and Cloud
Server License), and displays additional server information (log settings, and paths
to relevant configuration files and directories).

Configure Ports View and configure Ports that the Pro Cloud Server will use for accessing models.

Configure Integration Configure the Integration Server and Integration Providers, and bind Integration
Providers with Pro Models Connections.

Note: This is only available when using the Team Server or Enterprise edition of
the Pro Cloud Server. When using the Token edition, this option can be enabled by
adjusting the Token Allocations.

Manage EA Licenses Manage floating licenses for Enterprise Architect (and Enterprise Architect
Add-Ins).

Note: This option is only available when using the Team Server or Enterprise
edition of the Pro Cloud Server; it is not available when using the Token edition.

View Logs Navigates to the 'View Logs' page, which lists the Cloud Server log files. On the
'View Logs' page, click on the 'View Log' icon in the 'Actions' column to view the
contents of the log file.

Model Connections

Lists the model connections defined for the Cloud Server. The list includes this information.

Item Description

Model Status To the left of the 'Name / Alias' field is a status icon. Red indicates that the
connection has not been enabled (via the 'Enable Access' option), meaning this
connection cannot currently be used. Green indicates that the model connection is
enabled.

Name / Alias This field displays the name or alias of the model connection. When connecting to a
Cloud model via Enterprise Architect, this name or alias should be entered in the
'Model Name' field.

Pro This field indicates whether Pro features are enabled for this model connection. Pro
features include the ability to access the model connection via WebEA, and the
ability to use Integration Plug-ins (for Confluence or Jira, for example). A green
tick indicates that Pro features are enabled, while a blank field indicates they are
not.

An alert icon indicates that the 'Pro Features' option was enabled, but Pro Features
are not currently enabled/accessible for the model connection. For example, this
could occur if Pro Features were enabled but the Pro Cloud License has expired.
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When the alert icon is displayed, check the icon's tooltip for more information.

Database Type Displays the database type of the model (such as Firebird or SQL Server).

Read Only Indicates whether this connection provides read-only access to the model.

Require HTTPS Indicates that the model connection can only be accessed via the HTTPS protocol
(via a Port that is also configured to use the HTTPS protocol).

Actions Provides icons to perform these actions:

Edit - Edit the model connection settings·

Delete - Delete the model connection·

Add a Connection The list always contains, at the bottom, an option to add a new connection.

(c) Sparx Systems 2019 Page 159 of 654 Created with Enterprise Architect



Model Repository - Model Repository 20 January, 2020

WebConfig - Server Settings

The 'Server Settings' page provides various options and information regarding the Pro Cloud Server Configuration.

Server Settings

Item Description

Default Max Queries Model connections can specify the maximum number of requests that can be
serviced concurrently. This setting determines the default 'Max Simultaneous
Queries' when defining a new model connection.

Default: 10

Logging Level Click on the drop-down arrow and select the level of information to be written to
the log file. The valid options are:

OFF - No logging is performed·

FATAL - Only fatal errors are logged·

WARNING - Warnings are logged·

INFO - Information messages that provide general advice on what actions are·
occurring

SYSTEM  - More detailed messages·

DEBUG - (new in PCS v4.1) Normally only used to help debug potential·
issues

TRACE - (new in PCS v4.1) The most detailed level of logging·

(c) Sparx Systems 2019 Page 160 of 654 Created with Enterprise Architect



Model Repository - Model Repository 20 January, 2020

Log Levels are cumulative; for example, the INFO level includes all messages of
type FATAL, WARNING and INFO.

Manage PCS Licenses Navigates to the 'Pro Cloud Server Licenses' screen, which allows you to add or
remove Pro Cloud Licenses.

Change Password Allows you to change the password for accessing the Cloud Configuration (or set a
password if one has not already been set).

Changing or setting a password will also log you out of the Cloud Configuration,
returning you to the login screen.

Client White List Added in Pro Cloud Server v4.1.

Default Values:  127.0.0.1 and ::1

The White List table shows the list of client machine IP numbers that are allowed to
log onto the Configuration Clients and maintain the Pro Cloud Server's settings.

When a client attempts to connect to a Configuration Client the request will contain
the client's IP number, whether it presents as IPv4 or IPv6 depends on a number of
factors (like the connection method, the type of client application, the client's
operating system etc) however Sparx Systems would recommend that for each
authorized user both their IPv4 and IPv6 numbers should be defined in the white
list.

Use the 'Add an IP Address' button, and the Delete button in the Action column to
maintain the client IP numbers.

Note:

- An empty White List will allow all clients without any restrictions.

- If you are accessing WebConfig on the machine which hosts the WebConfig
website and using 'localhost' in the URL then the browser will typically provide the
Pro Cloud Server with an IP of 127.0.0.1 or ::1

More Info The 'More Info' section contains a number of read-only fields providing information
regarding the Cloud Server Configuration.

Log File Count

The number of log files that should be retained. All logging is written to files
named 'SparxCloudServicesLog-X.log' where X represents the file number.

File 'SSProCloudServerLog-1.log' is always the current file. When the maximum
file size is reached, all existing files are renamed by incrementing the file number
and a new 'SSProCloudServerLog-1.log' created.

Log File Size (bytes)

The maximum file size of each log file. When the file reaches this maximum, a new
file is created.

Log Audit Time Period (sec)

The number of seconds between audit reports.

Log Directory

The directory into which the log files are saved.

Floating License Keystore

The full path of the Floating License Keystore file.

Floating License Group Config
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The full path of the Floating License Keystore group configuration file.

Cloud Installation Directory

The directory into which the Cloud Server is installed.

Temp Directory

The Cloud Server Temp directory.
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WebConfig - Pro Cloud Server Licenses

The Pro Cloud Server Licenses screen can be accessed from the WebConfig - Home Screen, either by using the 'Add
Link' icon found in the 'Server Summary' section, or by clicking on the Server Settings button and then on the Manage
PCS Licenses button.

This screen allows you to quickly and easily see what Pro Cloud Server licenses have been defined, and the complete
details of each license.

In this example the current Token license is valid from February 3rd, 2019 to February 4th, 2020 and has 5 tokens.

If there is any kind of problem with the license the 'Valid' column will show an alert icon. Mouse-over the icon and
check the tooltip for more information on the problem. Details of the issue will also be written to the current log file.

License Procedure

As of Pro Cloud Server version 4.0.30 Pro Cloud Server licenses are linked to the host machine, which is an enforcement
of what is stated in the license agreement.

Along with the change to Licensing procedures, Pro Cloud Server 4.0.30 introduced the 'Token' Edition, which provides
a more flexible upgrade path by making use of tokens that can be purchased separately at any time to enable only the
extra functionality your environment requires.

For the premium editions (Team and Enterprise) the enabled functionality remains unchanged, except that the Team
edition now allows seven Pro-enabled models, which is an increase of two compared to earlier versions.

To add a License, the basic procedure is:

Step Description

1 Purchase the required Pro Cloud Server license (e.g. via the Sparx Systems Website).

2 Create a 'New License Request'.

3 Send the 'License Request' file to the Sparx Systems Sales team with the details of your purchase.

4 The Sparx Systems Sales Team will then return the 'License Certificate'.

5 Add your 'License Certificate' to your Pro Cloud Server installation.
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6 Your Pro Cloud Server is now licensed!

Pro Cloud Server Licenses

The Pro Cloud Server Licenses screen displays a table with information and actions for each Pro Cloud Server license
that has been added.

Field Description

License Type The License Type (either Token, Team or Enterprise). In the case of a Token
edition license, this field displays the number of Tokens.

Valid Displays a tick to indicate that the license is valid and enabled. If the license is not
valid an alert icon is displayed. Mouse-over the icon and read the tooltip for details
of why the license is considered invalid.

Start Date The date the License is valid from.

Expiry Date The date the License expires on.

Company The name of the purchasing company provided on the License Request.

Email The contact email address of the person or department that purchased the License.

Actions Provides buttons to either renew or delete the License.

Tasks

Below the 'Pro Cloud Server Licenses' table is a 'Tasks' section, which provides these options.

Option Description

New License Request Create a new license request.

Add License Add a license to the Pro Cloud Server.

Allocate Tokens Allocate Tokens to enable specific Pro Cloud Server features.

Note: This option appears only when using the Token edition of the Pro Cloud
Server.
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WebConfig - New License Request

Pro Cloud Server licenses are linked to a specific machine. After purchasing the Pro Cloud Server you will be provided
with an Installation ID. You will then need to create a License Request file and send this to the Sparx Systems sales
team. The Sales team will respond with your License Certificate file.

Note: When creating the License Request it is important that the Pro Cloud Server you are accessing is running on the
machine you intend to use. The License Certificate that you are provided with will be valid for this machine only.

To create a new license request, open the WebConfig - Pro Cloud Server Licenses screen, then click on the New License
Request button. The New License Request screen is displayed.

Fill in the details of your company and the Pro Cloud Server purchase (refer to the New License Request Form table for
more information), for example:

Click on the Create License Request button, then email the saved file to the Sparx Systems Sales team on
sales@sparxsystems.com.

New License Request Form

The 'New License Request' form contains these fields:

Company Name Mandatory value. The name of the company that made the Pro Cloud Server
purchase.

Email Mandatory value. The email address associated with the Pro Cloud Server
purchase.

Installation ID Mandatory value. The unique 'Installation ID' that was supplied in the confirmation
email for your Pro Cloud Server purchase.

If you purchased your Pro Cloud Server license prior to June 2019, use your Pro
Cloud Server version 3 License key.

Start Date Optional value.  Use this date to request that your Pro Cloud Server License should
start on a future date.  If no value is supplied the Sparx System Sales Team will
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assume the current date.

Comments Optional value.  Any additional comments that might be helpful to the Sparx
Systems Sales Team.
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WebConfig - Add a License

After you send a License Request to the Sparx System's Sales Team, they will reply with your License Certificate file.
You can then add your license to the Pro Cloud Server.

On the WebConfig - Pro Cloud Server Licenses screen, click on the Add License button. The 'Add Pro Cloud Server
License' screen is then displayed.

Click on the Browse button, select the supplied License Certificate file (*.lic or *.crt), then click on the OK button.

The details of the License Certificate will be loaded and the license should appear in the list on the Pro Cloud Server
Licenses screen, similar to this:

When returning to the Pro Cloud Server Configuration 'Home' page, the 'Server Summary' details should now display the
appropriate information for your license.
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WebConfig - Remove a License

On the WebConfig - Pro Cloud Server Licenses screen, the 'Actions' column for each existing license contains a 'Renew
License' icon and a 'Delete License' icon.

Click on the 'Delete License' icon to delete and remove that license. The list of allocated licenses will be refreshed
accordingly; there is no need to restart the Pro Cloud Server, the internal License and all related functionality enabled (or
disabled) by the change or removal of a License will take effect immediately.
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WebConfig - Renew a License

On the WebConfig - Pro Cloud Server Licenses screen, the 'Actions' column for each existing license contains a 'Renew
License' icon and a 'Delete License' icon.

The 'Renew License' icon is a convenient function that displays the same License Request form that the Create Request
button shows; however, the difference is that the 'Renew' option will pre-populate the valid details of the selected
License. The remaining fields will still need to be completed manually.  The renewal process is the same as the initial
process and will need to be followed whenever the License expires.
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WebConfig - Token Allocations

The Manage Allocation button will only be visible when the current license is the Token edition. It allows the user to
control how tokens are consumed to enable Pro Feature functionality.

Click on the Allocate Tokens button to access the 'Manage Allocations' screen.

The 'Manage Allocations' screen is broken up into four sections - a Summary of tokens, Explicit Allocations, Web
Access Allocations, and Token Usage.

Summary

The token summary lists:

Total - The total number of tokens based on the active license/s·

Explicit - The number of explicit token allocations; these refer to tokens that have been allocated to enable specific·
features on the server

Shared - The number of shared tokens available; shared tokens are consumed when users access features such as·
WebEA - when logging out the token is returned to the shared token pool

Explicit Allocations

This section allows you to enable Integration Plug-ins for your Pro Cloud Server. Enabling integration with a specific
product (such as Jira) consumes one token.

Shared for Web Access

WebEA, Prolaborate and OSLC users consume a single token with every logon. For most environments, these
allocations can be left with their default values (0 reserved and no maximum). In this case all users are accessing a single
shared pool of tokens, regardless of what type of access (WebEA, Prolaborate or OSLC) they require. Alternatively, each
user type can define a number of tokens that are reserved (that is, can only be used by that type of access) as well as a
maximum number.
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Notes:

A Max Allowed value of 0 implies that users are NOT allowed; that is, if WebEA's Max Allowed value was set to·
0, the Pro Cloud Server would deny all WebEA user requests to logon

An empty value for Max Allowed implies there is no limit on the number of users, although the total number of·
users is still limited to the number of available tokens

Token Usage

Click the heading to expand this section. The 'Token Usage' section displays a more detailed break down of the token
allocations, including how many tokens are currently in use.
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WebConfig - Configure Ports

The 'Ports' page allows you to configure Ports that can be used for communication with the Pro Cloud Server. A Port
must be configured to allow access to Cloud Models (via Enterprise Architect or WebEA).

By default, Port 804 is defined for http access and Port 805 for https.

The WebConfig client itself also communicates on one of these defined Ports (as specified in the WebConfig
'settings.php' file). The WebConfig's default configuration uses Port 804 (via http).

Configure Ports

The 'Configure Ports' list displays these details and links to corresponding information.

Item Description

Port The Port number.

Protocol The Protocol that can be used on this Port.

OSLC Support Indicates whether OSLC / WebEA support is enabled.

Authentication Indicates what type of Authentication is required (if any).

Actions Provides options to either Edit or Remove the Port definition.

Editing a Port provides the same options as adding a new Port, except that the Port
number cannot be modified.

Note, the WebConfig itself uses one of the defined Ports for communication with
the Cloud Server (as defined in the WebConfig 'settings.php' file). It is not possible
to delete this Port while it is in use. If necessary you can modify the 'settings.php'
file so that the WebConfig uses a different Port. You can then delete the Port that
the WebConfig was previously using.

Add a Port The final item in the Port list is a link to add a Port.
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WebConfig - Add or Edit a Port

The 'Add Port' page allows you to define a Port to be used by the Pro Cloud Server.

The 'Edit Port' page provides the same options, except that the Port number cannot be modified.

Add Port / Edit Port

The 'Add Port' and 'Edit Port' pages provide these options.

Item Description

Server Port Defines the Port number that the Pro Cloud Server will listen on for HTTP/HTTPS
connections.

Each defined Port must be unique and not used by any other service or application
on the current machine. The standard HTTP Port (80) and HTTPS Port (443) are no
different; if they are available, the Pro Cloud Server can be configured to use them.
You can use the Windows Resource Monitor (which is accessibly via an icon on the
Configuration Client 'Ports' tab) to check which Ports are already in use.

Firewall Note: When changing or adding a new Port, check that incoming requests
are allowed by the firewall settings at both the local machine and network levels.

Wine Note: When the service is running on Wine you should not use privileged
Ports - those below 1024; under Wine, most applications are only able to listen on
ports above 1024.

Protocol Select the transfer protocol that the Port communicates on.

When selecting HTTPS you can also specify which versions of SSL/TLS are
allowed, by selecting the relevant checkboxes.

Additionally, for HTTPS to be configured correctly, a file named server.pem must
also exist in the same directory as the configuration file, and it must contain a valid
private key / certificate. For more information, see the SSL Certificates section of
the Add a Port Definition Help topic.

WebEA / OSLC Supported If checked, this flag enables OSLC requests on the current Port.  Note: this option
must be selected for WebEA access.
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Authentication Select the type of authentication that will be required for this Port:

Model - All model connections that use the current Port will be forced to request
HTTP authorization using the user security defined in the Enterprise Architect
model being connected to. Passwords must be explicitly and individually assigned
in that model using the Maintain Users procedure; the default administrator
password and any passwords imported from Windows Active Directory do not
work.

Note: If you are not using HTTPS/SSL to connect, the usernames and passwords
will be sent in plain text.

If the model does not have security enabled, the Cloud user is not prompted for a
password.

Global - Selecting this option enables the 'Global Authentication Model' field. In
this field enter the DB Alias of Data Manager that will be used to provide the
security profile to all connections opened with the current Port.  This is helpful if
you want to provide multiple repositories but only manage one list of users.
Passwords must be explicitly and individually assigned in the Global model using
the Maintain Users procedure; the default administrator password and any
passwords imported from Windows Active Directory will not work.

Note: If you are not using HTTPS/SSL to connect, the usernames and passwords
will be sent in plain text. Sparx Systems recommends that Global authentication
should only be used with the HTTPS protocol.

Global Authentication
Model

Required when the 'Authentication' option is set to 'Global'.
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WebConfig - Integration Plug-ins

The 'Integration Settings' page allows you to configure integration plug-ins to be used with Pro Cloud Models. These
plug-ins enable data from external providers to be displayed within Enterprise Architect. This component is only
available in the licensed editions of Sparx System Pro Cloud Server; that is, Token, Team and Enterprise editions.

The Integration Plug-ins component is also known as the Server Based Plug-in Interface (SBPI).

Integration Settings

The 'Integration Settings' section refers to the configuration of the Pro Cloud's Integration Server. The Integration Server
communicates with one or more Integration Plug-ins, each of which provides the integration with a specific product such
as Jira or Confluence.

Typically, if the Integration Server is run on the same machine as the Pro Cloud Server, and Port 8080 is not in use, then
the default settings can be used.

To make the Integration Server configuration as easy as possible for the majority of users, version 4.1 of the Pro Cloud
Server has introduce a simplified set of options, however if the default configuration does not suit your environment,
check the 'Use Legacy Settings' option to show all the available options.

Item Description

Enable Integration This checkbox enables (or disables) Integration Plug-ins for the current Pro Cloud
Server installation.

Port Default value:  8080

This option is only shown when the 'Use Legacy Settings' option is unchecked. It
defines the Port the Integration Server is listening to for requests from the Pro
Cloud Server.

SBPI Server URL This option is only shown when the 'Use Legacy Settings' option is checked.

The SBPI Server URL consists of three components. When combined these settings
form the Integration Server's URL that the Pro Cloud Server will send SBPI related
requests to.

Note: The complete URL ({protocol}://{server-name}:{port} needs to be
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resolvable by the Pro Cloud Server machine.

Protocol·
This field defines the SBPI Server's Protocol.

Name/IP·
This field defines the SBPI Server's machine name or IP.

Port·
This field defines the SBPI Server's Port.

Use Legacy Settings Default value:  Unchecked

This checkbox determines if the simplified or complex set of options should be
shown.   The name refers to the fact that the earlier versions of the Pro Cloud
Server required users to fill-in the complex set of options. In later versions of the
Pro Cloud Server the set of options needed was greatly reduced by making some
assumptions that will be true for the majority of environments.

Ignore SSL Errors Default value:  unchecked

This option is only shown when the 'Use Legacy Settings' option is checked.

This value defines if SSL related errors that occur while communicating with the
Integration Server component should be ignored.  The most common SSL errors are
related to self-signed certificates; by default a client does not treat self-signed
certificates as being secure, therefore in order to connect to servers that use
self-signed certificates this option should be checked.

Use Proxy This value defines if the Integration Server is operating behind a proxy, and if
Enterprise Architect clients are required to connect to one URL but the Integration
Server is physically listening for requests on a completely different URL.  In most
environments this option should be set to the default value of unchecked.

Attempt URL Auto
Discovery

Default value:  checked

This option is only shown when the 'Use Legacy Settings' option is checked.

This option defines if the Pro Cloud Server should automatically attempt to
determine the Enterprise Architect client's network address and supply that to the
Integration Server.

This option was introduced in Pro Cloud Server 4.1.40; earlier versions were not
capable of discovering the client's network address.

When Auto Discovery is checked, the following setting is the 'Fallback URL',
which will be used only if the Auto Discovery fails. When Auto Discovery is
unchecked, the following setting is the 'Absolute URL' which will be used in all
cases.

Absolute URL The Absolute URL consists of three components. When combined these form the
resolvable URL that Enterprise Architect clients can communicate to the SBPI
server.

Note: The complete URL ({protocol}://{server-name}:{port} needs to be
resolvable by the Pro Cloud Server machine.

In some environments server URLs are redirected to completely different locations,
therefore to handle this situation the absolute URL is returned to Enterprise
Architect clients so that they can communicate to the SBPI Server.

Protocol·
This field defines the URL's Protocol.

Name/IP·
This field defines the URL's machine name or IP.

Port·
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This field defines the URL's Port.

Integration Providers

A single Pro Cloud Server can support any number of external Data Providers and, in turn, each of the external Data
Providers can be available to as many models as are supported by the installation's license. Please note only Pro-enabled
Model Connections can access external data providers. A Pro-enabled Model Connection is one that has the 'Enable Pro
Features (OSLC, WebEA and Integration)' option checked.

The 'Integration Providers' section provides this information:

Item Description

Name A friendly name that describes the provider; this value will be displayed within
Enterprise Architect.

Provider The type of external provider.

Prefix A short, unique value for the provider. This value is added to each external link
within Enterprise Architect.

Port The Port the Integration Plug-in is configured to listen to.

Bindings Bindings refer to the model connections that will have access to this Integration
Plug-in. These can be configured via the 'Actions' column.

Actions Provides options to either:

Edit the Integration Provider's settings·

Configure Model Bindings, or·

Delete the Integration Provider·

Add a Provider The final item is a link to add a new provider.
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WebConfig - Add or Edit an Integration Data Provider

The 'Add Data Provider' and 'Edit Data Provider' screens allow you to configure an Integration Data Provider. The
options provided are the same in both cases, except that when editing you cannot modify the Provider and Prefix.

Wherever possible the 'Add/Edit Data Provider' screen will fill each field with a default value in order to make it easier
for you; if the default values are not correct, simply overwrite them.

The Integration settings are broken up into a number of groupings.

Data Provider

This group of settings contains the basic information to identify the Data Provider and determine how the Plugin
communicates with the Provider Server.

Item Description

Enabled This value controls if the Integration Server (SBPI.exe) should allow
communications to be forwarded to this Data Provider.

Name This value represents the friendly name for the current Data Provider, it will be
shown to users of Enterprise Architect.

Provider This value specifies the Provider type of the current Data Provider.  When this
value is changed a number of other fields may be automatically updated.

Group This field is available only when the 'Custom Integration' provider type is selected.
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Typically in Enterprise Architect, integrations are grouped by the Provider type
('Jira', 'Dropbox', etc). For Custom Integrations, the Grouping is applied based on
the value entered in this field.

Prefix This value represents a short unique name to identify the current Data Provider.
This value will be saved against every Enterprise Architect element that is linked to
an external element.

Auto Start This value controls if the Integration Server (SBPI.exe) should maintain a running
process (*sbpi.exe) for this Data Provider.

For standard Integration Plug-ins we would expect this value to be checked,
however for custom ones it may be useful to not auto start the Plug-in and instead
manually control when it is running, particularly while developing it.

Port This value represents the Port that the Integration Server should use to
communicate with the Integration Plug-in.  The Integration Server assumes the Port
is relative to the current machine (or http://localhost:{port}).

Each Integration Plug-in requires a unique Port number which will be checked
when an attempt is made to save the Plug-in's settings.  However the Pro Cloud
Server can only check the what ports are in use by the Pro Cloud Server itself and
its components, there is still a possibility of a port clash with other applications.

DLL Path This field is only available for 'Custom Service' and 'Custom Integration' provider
types.

This value represents the physical path to the custom DLL, that will be called by
the CustomService.exe or CustomIntegration.exe Data Provider processes.

Custom Properties

The Custom Properties section is only shown for Data Providers of type 'Custom Service'. This table allows you to define
Item/Value pairs which can be used by the Custom Service.

Item The 'name' of the custom property.

Value The value of the custom property.

Actions This column provides Action buttons which apply to the property in this row.

Accept New Custom Property - This appears when adding or editing a property.
Click this button to save the Item/Value.

Edit Custom Property - Click this button to allow editing of the property's
item/value.

Delete Custom Property - Click this button to delete the property.

Provider Server

This group of settings relates to the details of the external data provider, such as Dropbox or Jira.  The Integration
Plug-in will use the defined details to connect to the remote system and retrieve data from it so that it can be sent back to
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Enterprise Architect.  The combination of Protocol, Server Name and Port must be resolvable by the server hosting the
Integration Plug-in, which in the simplest case is the Pro Cloud Server.

Item Description

Provider URL The Provider URL consists of the following 4 fields, which make up the URL
which the Plugin will use to access the external data.

Protocol - The Protocol to be used.

Server Name/IP - The Server Name or IP address.

Port - The Port to be used. It the data is typically accessed using a URL without a
Port then enter the default Port value (80 for HTTP or 443 for HTTPS).

URL Folder - Some external Data Providers allow for the concept of multiple
repositories at a single location; for such Data Providers this field acts as a filter.

For example, it is possible to use another Enterprise Architect model as an external
data source; in this case the 'Protocol', 'Server' and 'Port' determine the Pro Cloud
Server (for example, http://myEAServer:804) while the 'URL Folder' is the DB
Alias of the repository (myModel). Thus:

http://myEAServer:804/myModel

Below these fields is a label showing the full URL which will be used by the plugin
(based on the values which have been entered.

Ignore SSL Errors This option is only displayed if the protocol 'HTTPS' has been selected.

This checkbox controls if the Integration Plug-in should ignore SSL related errors
that occur as a result of communicating with the external system.

Username This value represents the user name that should be used (in combination with the
password) to access the data within the external system.  If a value is defined in this
field all Enterprise Architect users of the current Data Provider will use the same
set of credentials to read the external system. Otherwise if the user name field is left
empty, Enterprise Architect will prompt each user independently for their
credentials.

Password This value represents the matching password for the specified user name.

Create Items This checkbox controls if Enterprise Architect users are able to create new items
within the external system.

Modify Items This checkbox controls if Enterprise Architect users are able to modify the details
of external items within the external system.

Post Discussions This checkbox controls if Enterprise Architect users are able to create discussions
against elements within the external system.

Logging

This group of settings relates to how the Integration Plugin will create entries in its log file(s). Since the Integration
Plugins run without user intervention, it is important for them to be able to write any messages or potential problems to a
log file.  However, special consideration must be given to ensuring that performance isn't impacted by writing to such
files, which is possible if the log file continually grows without limits.  It is also unreasonable to expect that manual
intervention should be required to ensure that the size and number of log files don't impact performance. For these
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reasons each Integration Plugin has its own set of log files and configuration options to manage its log files.

The current log file will always include a '1' on the end of its filename.  A new log file will be created whenever the
Integration Plugin is started or the physical size of the current log file reaches the Max File Size.  When this occurs all
existing files will be 'rolled over', meaning their file numbers will be incremented and a new '{filename}1.log' created.  If
the roll over process causes more files to exist than the 'File Count' setting allows, these additional files will be deleted.

Item Description

File Count Default value:  3

This value represents the 'rolling' number of log files that should be retained for the
current Integration Plug-in.

Max File Size Default value:  1048576

This value represents the maximum number of bytes a log file can be before a new
one is created.

Level Default value:   WARNING

This value represents the maximum level of messages that should be written to the
log file. The levels are: OFF, FATAL, WARNING, INFO and SYSTEM.  A
defined log level is inclusive of all lower levels, therefore if a Plug-in is set to a log
level of INFO then all FATAL, WARNING and INFO messages will be written to
its log file.

Directory (READ-ONLY) This field displays the physically location of where the log files for
the current Data Provider will be saved.

Proxy

This group of settings relate to how the Integration Plug-in should communicate with the External Data Provider when
they are separated by a Proxy Server.

Item Description

Server Name/IP The server name (or IP) and Port number of the Proxy Server. For example,
proxyserver.com:3131

Bypass This field provides a mechanism for certain addresses to bypass the proxy; it
accepts multiple values separated by semi-colons (;).  For example,
192.168.*;*.localdomain.com;www.mydomain.com

User Name If the Proxy Server requires credentials, then enter the user name into this field.

Password If the Proxy Server requires credentials, then enter the password into this field.
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WebConfig - Edit Model Bindings

After defining an integration provider you must apply some model bindings. The integration will only be available to
these 'bound' models. Also note, integrations can only be bound to models that have the 'Enable Pro Features (OSLC,
WebEA and Integration)' option enabled.

The 'Edit Bindings' page provides this information and these options.

Provider

Item Description

Provider Name (Read Only) The Name of the Provider which you are editing the bindings of.

Provider Type (Read Only) The Provider type (Enterprise Architect, Jira, etc).

Model Bindings

The Model Bindings section lists all model connections which currently have pro features enabled. Next to each model
connection name is a checkbox. Check this box to bind the integration provider with that model connection (i.e. making
the integration available when using that model).

Note, one Provider can be bound to many model connections.
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WebConfig - Manage EA Floating Licenses

The 'Manage EA Floating Licenses' page allows you to manage Enterprise Architect (and Add-in) floating licenses.

Important: All communications with the Pro Cloud's Floating License Server are performed via HTTPS. Therefore, to
use the Pro Cloud Server's Floating License Server functionality at least one Port has to be configured to use the HTTPS
protocol, and a valid certificate/private key file must be defined in the Pro Cloud Server's Services folder. See the
Advanced SSL - Adding Trust to a Self-Signed Certificate Help topic for more details.

The 'Manage EA Floating Licenses' page has three sections, as described in this topic.

License Server Settings

The 'License Server Settings' section allows you to adjust the settings for handling Floating Licenses.

After adjusting these settings, save and apply them by clicking on the Apply button.

Item Description

Total Key Count (Read Only) Displays the total number of keys in the keystore.

Key leases expire after These two fields determine when a checked out key is automatically returned to the
keystore.

Enter a numerical value, then select either 'Days' or 'Weeks' from the drop-down
list.

When enabled, if a user closes Enterprise Architect then their key will be
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Auto Checkin immediately returned to the keystore.

When disabled, closing Enterprise Architect will not automatically return the key.
Instead, the key remains checked out to the user for the amount of time defined by
the 'Key leases expire after' field.

Typically the 'Auto Checkin' option would be disabled if users need to work offline
for periods of time. Otherwise, the option should be enabled to make the most
efficient use of shared keys.

Key Summary

The 'Key Summary' table on the 'License Server Settings' page provides a quick overview of the keys in the keystore for
each product type.

Item Description

Product The name of the product.

Available The number of checked in keys for the product.

Expired Lease (Available) The number of keys that are checked out but are available because their lease has
expired.

Checked Out The number of keys that are currently checked out.

Total Available The total number of keys that are currently available for the product (that is, the
sum of the 'Available' and 'Expired Lease' values).

Keys

The 'Keys' table lists information on each key held in the keystore. Each item line on the table provides options to force
the check-in of the key, delete the key, and add new keys.

Checked out keys are displayed at the top of the list, and keys are grouped by product type.

Item Description

Key The product Floating License key.

Product The name of the product that the key provides access to.

Assigned to The name of the user who currently has the key checked out. When the field is
empty it indicates that the key is checked in.

Lease Expires The date when the key will be automatically returned to the keystore (based on the
'Key leases expire after' field settings).

Actions Provides the options to manually check in or delete a key:

Check In Key·
Only available if the key is currently checked out; select this option to
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manually release or check-in the key

Delete·
Deletes the key from the keystore

Add Keys The final item in the 'Keys' list is the 'Add Keys' option. Click on this option to
display the 'Add Floating Licenses' page, which contains a single field for adding
keys to the keystore.

To add a key, type it into the 'Enter Floating License/s' field, then click on the OK
button.

You can type multiple keys in the field; each key should be typed on a separate
line.

Group Configuration

The Cloud Server allows you to define groups that only have access to a set number of keys for a specific product. You
define the groups by directly editing the ssflsgroup.config file on the Cloud Server.

See the Floating License Server Install and Configure Help topic for details.

Notes

The WebConfig Floating License Management feature is available when using either the Team Server or Enterprise·
edition of the Pro Cloud Server
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WebConfig - Adding a Model Connection

New model connections can be added using the 'Add a Connection' option at the foot of the WebConfig 'Home' page.

The process of adding a new model connection has two steps - selecting the connection type, then entering the details
that are required for the model connection.

Select Connection Type

When you click on the 'Add a Connection' option the 'Select Connection Type' page displays.

The WebConfig supports the creation of Firebird, Oracle (OLE DB) or SQL Server (OLE DB) Model Connections.
Select the relevant radio button for the connection type, depending on the type of database you are accessing.

In the case of Firebird you will then have the option of either creating a new Firebird model directly from the
WebConfig, or accessing an existing Firebird model.

For other model types (DBMS repositories), the model should have been created and tested (by accessing the model via
Enterprise Architect's 'Connect to Server' option) prior to adding the Cloud Connection.

Note:

The DBMS types (such as Oracle and SQL Server) are only listed on this page if the relevant drivers are found on·
the server

The Pro Cloud Server also supports connections to MySQL and PostreSQL databases; however, these connections·
cannot be created using the WebConfig (they require definition of an ODBC system data source, which is not
possible via the web client)
To create a connection to MySQL or PostreSQL, use the Pro Cloud Server Configuration Client - Application

Add Model Connection

After you select the model type, the 'Add Model Connection' page is displayed. The options provided vary depending on
the model connection type you selected.

Item Description

Firebird Firebird models are stored on the server within the Pro Cloud Server's Models
sub-folder (e.g. C:\Program Files (x86)\Sparx Systems\Pro Cloud
Server\Service\Models).

When selecting Firebird you are provided with two options.
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New Firebird Model - Select this option to create a new Firebird model; enter·
a name for the Firebird model in the 'File Name' field. No path or file extension
are required
The new, empty Firebird model will be created on the server (in the 'Models'
sub-folder) and the model connection will be associated with this file

Existing Firebird Model - Select this option to create a model connection that·
links to an existing Firebird model (which already exists in the 'Models'
sub-folder)

Oracle (OLE DB)

Connection Name / Alias

Specify a short, unique name for the connection. This is required when accessing
the model via Enterprise Architect or WebEA.

Net Service Name

Enter the Oracle Net Service Name as defined in the TNSNAMES.ORA.

User

Enter the user name.

Password

Enter the password for the specified user.

SQL Server (OLE DB)

Connection Name / Alias

Specify a short, unique name for the connection. This is required when accessing
the model via Enterprise Architect or WebEA.
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Server / Instance

Enter the Server Name or Server Instance; for example: 'SQL-SERVER' or
'SQL-SERVER\SQL2012'.

User

Enter the user name.

Password

Enter the password for the specified user.

Database

Enter the name of the database that is the Enterprise Architect repository.
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WebConfig - Edit Model Connection

The 'Edit Model Connection' screen displays when you click on the Edit button for an existing model connection on the
WebConfig 'Home' page. This page allows you to modify various options for the selected model connection, as described
in the tables below.

Edit Model Connection

Item Description

Alias The database Alias. This is the value all Enterprise Architect clients will need to
select in the 'Model Name' field of the 'Cloud Connection' screen. If necessary, you
can edit this Alias to enable users to reference it from Enterprise Architect and
WebEA.

Note, this value must be unique. You are not able to use the same alias for multiple
model connections.

Database Type (Read only) Displays the DBMS type of the database, such as Firebird, MySQL,
Postgres, SQLServer or Oracle.

Enable Access By default, new model connections are disabled. Select this checkbox to allow
access to the model connection.

Enable Pro Features
(OSLC, WebEA and
Integration)

This option is only available in Pro Cloud Server editions. Select this checkbox to
enable 'Pro Features', such as OSLC, WebEA and Integration with external systems.
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Advanced

Connection String (Read only) Displays the connection string used to connect to the database. The
Copy button can be used to copy this connection string to the clipboard.

Max Simultaneous Queries Type in the maximum number of connections that can be open. You can use the
up/down arrows to adjust this figure to balance resource usage with concurrent user
performance.

There is no explicit limit for this value, but the higher the value the more resources
are consumed on your server, without a matching increase in benefit in user
performance. Connections are held so briefly that the reduction in user wait time
due to more connections being opened is not usually noticeable. If you are reaching
the number of connections you have defined here, increase it by small increments
(units) rather than large ones (tens).

Minimum EA Build Optional. If you want to ensure that all users of the model are on an appropriate
build of Enterprise Architect, type in the lowest build number required.

OSLC Access Code Optional. Type in the access code that all OSLC clients, including WebEA, are
required to send in an HTTP header.

Leave blank to indicate that the OSLC clients are not required to send an access
code.

Require HTTPS and
Authentication

If this checkbox is selected, this model connection can only be accessed via https,
using a Port that is configured to use https with 'Authentication' enabled (that is, set
to either 'Model' or 'Global').

Read-only connection Select this checkbox to prevent users from modifying the database referenced by
this connection.

Scheduled Tasks

Start Time (HH:MM) The time of day that the schedule task should run. This should be entered in 24hr
time format (HH:MM).

Number of times to retry In the event of repeated errors, how many times should the process retry.

Run Scheduled Tasks When this option is checked the Pro Cloud Server will update Time Series charts in
the current model as a scheduled task.

Interval between retries
(mins)

Default: 30

Specify how often the 'Worker' process will check for modified diagrams and
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update their stored images.

Worker Settings

Enable Worker Select this checkbox to enable the Pro Cloud 'Worker' application. The 'Worker'
process runs on the server and periodically generates images for diagrams in the
model. These images are required for WebEA and Prolaborate.

Port Select the desired Port that the Worker should use to connect to this repository.
Typically this would match the Port you enter when accessing this Model via Cloud
Connection in Enterprise Architect.

Model User Enter a valid repository user.  This value only requires a value if the current
repository has model security enabled.

Model Password Enter the password for the repository user.  This value only requires a value if the
current repository has model security enabled.

Update Period (seconds) This value defines how often the Worker process will check for modified diagrams,
and generate where required; the default value is 30 seconds.
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Firewall Settings

When setting up a Pro Cloud Server, you must check that the Firewall on the server is set to allow the incoming Ports for
the database connections that you have created.

For example, in the default SSProCloud.config configuration file the Pro Cloud Server listens on Ports 804 and 805;
however, if you have a firewall you must set these Ports as enabled for inbound traffic.

The Pro Cloud Server installation will automatically create an inbound Windows firewall rule, similar to the one shown
in the image; however, the default rule should be reviewed and updated to suit your environment.

For information on creating the Inbound Rule to identify the Ports you have specified in the config file (the 'Sparx
Systems Professional Cloud' rule in the illustration), see the Microsoft Windows online topic Create an Inbound Port 
Rule.

Note: A common cause of failure is that other services or programs are already using the allocated Ports. This is
especially likely when using the default http (80) and https (443) Ports. Check that no other services are using the
allocated Ports.
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Using Multiple Configurations

The Sparx Systems Pro Cloud Server can be run multiple times with different configurations by passing command line
arguments.

The Pro Cloud Server executable can be run as either a standalone executable or a Windows service.  By default the Pro
Cloud Server installer will create a Windows service that does not specify any arguments (which forces the Pro Cloud
Server to uses the default settings).

Command line arguments

Argument Description

--config / -c The argument following this will be interpreted as the path to the configuration file
to read on start up. This allows a secondary instance of the Cloud server to run on a
different set of Ports, using an altered logging level or different directories.

When multiple configurations are being used, you must ensure that each instance
reads a configuration file that specifies different paths. Otherwise only the first
instance will start successfully.

By default this references SSProCloud.config in the directory containing the service
executable.

--path / -p The argument following this will be interpreted as the absolute path to search for
other resources. Changing this parameter changes where the configuration file is
read from, along with all paths in the configuration file that specify
%SERVICE_PATH%. Setting this to a directory other than the default is an easy
way to separate multiple running instances of the Cloud service.

--registry / -r The argument following this will be interpreted as a registry path within
HKEY_LOCAL_MACHINE, where the models provided by the Cloud server are
specified. Changing this parameter allows the use of different Cloud servers to
provide access to different models.

By default this is Software\Sparx Systems\SQLBridge.

standalone This argument allows starting the SSProCloud.exe as a standalone executable
instead of requiring it to be launched as a Windows service.

This can be important if the Windows firewall is blocking the service, as it will
prompt to create a firewall exception.

Additionally, Wine by default closes services automatically when the last user
process closes, but using the 'standalone' argument to run the server as an
application will ensure that the service isn't terminated when there are any clients
connected. Use the command line:

     wine SSProCloud.exe standalone

Or, if you are launching from a terminal and want to close it:

     wine SSProCloud.exe standalone & disown     or

     nohup wine SSProCloud.exe standalone

(The 'disown' parameter and 'nohup' command both close the terminal but ignore
the 'hangup' message that would otherwise disconnect Pro Cloud Server again.)
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Additional Windows Services

It is possible to create additional Pro Cloud Server Windows services that run independently of one another and use
different configurations.  Special care needs to be taken to ensure the correct syntax is specified when creating a
additional Pro Cloud Server instance.

For example to create a 2nd Windows service that has a '2' appended to the default names/folders, perform the following
steps.

1. Copy the entire contents of  'C:\Program Files (x86)\Sparx Systems\Pro Cloud
Server\'  to a new folder of  'C:\Program Files (x86)\Sparx Systems\Pro Cloud
Server2\'

2. Edit the 'C:\Program Files (x86)\Sparx Systems\Pro Cloud
Server2\SSProCloud.config' file and adjust the list of ports that this instance of the
PCS should listen to.

3. Open REGEDIT, and navigate to   HKEY_USERS\.DEFAULT\Software\Sparx
Systems\SQLBridge

4. Clone the 'SQLBridge' node (and all children) to SQLBridge2'

6. To apply a description to the newly created Windows service, execute the following
command:

    C:\>  sc description "Sparx Systems Professional Cloud 2" "Sparx Systems
Professional Cloud 2"

5. Open a terminal windows and enter the following command:

    C:\>  sc create "Sparx Systems Professional Cloud 2" binpath= "\"C:\Program
Files (x86)\Sparx Systems\Pro Cloud Server2\Service\SSProCloud.exe\" -p
\"C:\Program Files (x86)\Sparx Systems\Pro Cloud Server2\Service\" --registry
\"Software\Sparx Systems\SQLBridge2\"" start= auto DisplayName= "Sparx
Systems Professional Cloud 2"

This will define a new Windows service called  Sparx Systems Professional
Cloud 2 and instruct it to use the 'C:\Program Files (x86)\Sparx Systems\Pro Cloud
Server2\Service\' folder as the base location and
'HKEY_USERS\.DEFAULT\Software\Sparx Systems\SQLBridge' as the registry
hive.
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Pro Cloud Server using IIS (Optional)

For most users, the built-in web server provided with the Pro Cloud Server provides all the functionality they require. It
is also the easiest method to set up and use.

However, the Pro Cloud Server also provides the option of integrating with Internet Information Services (IIS). This is
recommended only for users for whom the built-in authentication methods are insufficient, and who want to use
Windows Active Directory or certificate-based authentication (see the Import User IDs from Active Directory Help
topic). Note that the use of IIS does not eliminate the login process, and users must still enter their user IDs and
passwords.

To configure IIS to host the Pro Cloud Server, you must first set the SparxCloudLink.sseap file to refer to the Pro Cloud
Server, and then in Windows open the Internet Information Services (IIS) Manager and configure it to send requests to
the appropriate module. Depending on your preferences you can choose either an HTTP Module or an ISAPI module.

Prior to setting up HTTP or ISAPI, these settings must be made in IIS:

Application Pool settings·

Feature settings·

For a secure HTTPS setup (optional):

Set up a Certificate·

Set up HTTPS·

Configuration Settings

Before setting up your HTTP module or ISAPI module, you must first check that the SSProCloud.config file for the
service is configured as required, and note the Port used so that you can specify it when you go on to set the
SparxCloudLink.sseap file to refer to the Pro Cloud Server.

The directory path containing the ISAPI .dll also contains the SparxCloudLink.sseap configuration file.

The path should resemble this example:

     C:\Program Files (x86)\Sparx Systems\Pro Cloud Server\ISAPI

Edit this file in a text editor, running as an Administrator.

The default contents are:

    [cloud]

    server=localhost

    port=803

server:

The address to look up the machine running the Pro Cloud Server. In most circumstances it is best to run the HTTP
module and the Pro Cloud Server on the same machine. In this case, the default value of localhost can be used. If the Pro
Cloud Server is running on a different machine, use the IP address or server name where the service is running.

port:

The Port the Pro Cloud Server is listening on for admin requests. By default this takes the value of 803, but this should
be cross-referenced against your service configuration in the SSProCloud.config file.

Optional settings

These points are optional. For testing purposes you might prefer to leave these changes until any issues with IIS are
resolved.

In the SSProCloud.config file, remove all the references to Ports other than the administration Port (default 803). In1.
other words, remove the bracketed entries (…) from the config file.

Save the SSProCloud.config file.2.

Restart the Service.3.
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Application Pool Settings

HTTP or ISAPI will require an Application pool that is 32-bit and not managed code. This illustration shows the settings
for 32-bit applications in the IIS Application Pools Advanced Settings view.

Feature Permissions

This illustration shows the access path and the 'Default Web Site | Handler' mappings to permit Script Execution.

Setting up a Certificate

In order to run the HTTPS service you must set up a security certificate in IIS. In the IIS Manager:

Under 'Connections', select the root connection (machine name).1.

Double-click on the 'Server Certificates' icon.2.

Click on 'Create Self Signed Certificate'.3.

Specify a simple, user-friendly name for the certificate.4.
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Setting up HTTPS

To set the bindings through which HTTPS will operate, you must include a Port and a certificate in the site bindings.

In the IIS Manager:

Under 'Connections', select the 'Default Web Site' option·

Under 'Actions' click on the 'Bindings' option·

In the Site Bindings window click on 'Add'·

This will open the Add Site Binding window.

Set these parameters:

Type: HTTPS·

Port: 443·

SSL Certificate: select the certificate created in Setting up a Certificate·
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HTTP Module

To set up the HTTP module in the Internet Information Services (IIS) Manager:

In the 'Connections' panel, select the machine properties (top of the tree).1.

Double-click on the 'Modules' icon in the middle panel.2.

This returns the 'Modules' list and the 'Actions' view.

In the 'Actions' list, click on the 'Configure Native Modules…' option.3.

This opens the 'Configure Native Modules' view.

Click on the Register button to open the 'Register Native Module' dialog.4.
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Type in the name and the path of the SSCSIISHttpLink.dll file.

Click on the OK button. The 'SSCloudServices' checkbox will now be selected.5.

Click on the OK button to close the 'Configure Native Modules' dialog.6.

In the 'Connections' panel (see Step 1), click on your web site.7.

Double-click on the 'Handler Mappings' in the middle pane.8.

This opens the Handler Mappings view:

In the 'Actions' list, click on the 'Add Module Mapping' option to open the 'Add Module Mapping' dialog.9.

As illustrated, set the 'Request path' and 'Name'.10.

In the 'Module' field, click on the drop-down arrow and select the module added in step 4.11.
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Click on the Request Restrictions button. On the 'Request Restrictions' dialog, select the 'Access' tab. Select the12.
'Execute' radio button to enable Execute permission.

Select the 'Mappings' tab and deselect the 'Invoke Handler only if request is mapped to' checkbox.13.

Click on the OK button.14.

Close the 'Add Module Mapping' dialog by clicking on the OK button again.15.

To complete this HTTP module set up, see the Configuration Settings section at the start of this topic. You should then
be able to connect to a model using Enterprise Architect via your IIS server using the HTTP module.

ISAPI Module

To configure an ISAPI module instead of the HTTP module:

In the 'Connections' panel, select the machine properties:1.
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Double-click on the 'Handler Mappings' icon:2.

In the 'Actions' list, click on the 'Add Module Mapping' option.3.

In the 'Add Module Mapping' dialog, set 'Request path' to 'sparxCloudLink.sseap', 'Module' to 'IsapiModule', and4.
'Executable' to 'SSCSIISIsapiLink.dll', as shown.

Click on the OK button to close the dialog. You should now be able to connect to a model using Enterprise Architect5.
via your IIS server using ISAPI.
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Connecting Enterprise Architect to a Cloud Model

Once your Pro Cloud Server has been set up with at least one Port listening for communications and at least one model
that is enabled, you can connect to that model from Enterprise Architect. When you first open Enterprise Architect, the
'Manage Projects' dialog displays. The Connect to Cloud button on the top right provides access to Cloud connections.

In later work sessions you can access this dialog and button by selecting the 'New | Manage projects' option on the Start
Page. However, there is also a Cloud Connection link on the 'Start Page' itself.

Cloud Connection Dialog

The 'Cloud Connection' dialog prompts you for the details of the model.

Option Action

Name Type a name for the project/repository that is meaningful to you (or your
environment), it does not have to match any values on the server.  The name
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entered will be shown in the list of recent projects.

Protocol Click on the drop-down arrow and select the protocol to use to connect to the
server. When you select the protocol, the Port will be automatically set to match the
default for that protocol.

https should be preferred for most users as it allows for both authenticating the·
server and protects all communications with the server.

http is not protected. It can be used for model connections, best used to test·
connections before setting up the server certificate.

tcp allows connecting directly to the server over its admin port. Using this·
method eliminates many of the benefits provided by the other two protocols.

Server Type in the machine name (sparxcloud.com) or IP address (192.168.0.20) of the
server hosting the Pro Cloud Server.

Port Define the Port number the Pro Cloud Server service is listening on. This should
match the settings in the configuration file on the server.

Note: For a server, the default settings will use Port 804 for http and Port 805 for
https.

Model Name Type in the name of the model available on the server.

Note: Generally a system administrator will provide you with a list of available
models. However, for those with the ability to use the Sparx Systems Pro Cloud
Server Configuration Client, the model name to access the given database is the
Database Manager's 'Alias' field on the Configure Database Manager screen.
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Pro Cloud Server Features

As mentioned in the Introducing Cloud Repositories Help topic, even without a License the Pro Cloud Server can be
used for hosting Cloud Repositories to be accessed by Enterprise Architect. When using a licensed Pro Cloud Server a
number of additional features are available, as outlined here.

WebEA

One of the most requested features from the Enterprise Architect user base recently has been the ability to access
Enterprise Architect models on mobile devices or from desktops without the need to install the Enterprise Architect
application.

Sparx Systems has developed WebEA using PHP, JavaScript and CSS to provide a solution that can be deployed easily,
that runs on the widest variety of systems, and that doesn't require any special hardware or additional licensing.

WebEA has a large array of configuration options that give the Enterprise Architect customer the power to control
exactly how each model can be accessed and what types of action can be performed.

WebConfig

The Pro Cloud Server 'WebConfig' is a web-based configuration client, which can be used as an alternative to the
Windows-based 'Configuration Client'.

The WebConfig allows you to add and configure Cloud connections, set up integration plug-ins, manage floating
licenses, and view Pro Cloud Server logs, all from a Web Browser.

OSLC RESTful API

The OSLC RESTful API (OSLC Architecture Management v2.0) provides direct access to a wide range information
from your Enterprise Architect Cloud Repositories.

Integration Plug-ins

Also called Server Based Plug-in Interface (SBPI), this is a framework developed to extend the Pro Cloud Server via
Plug-ins.  The Integration Plug-ins allow you to link Enterprise Architect elements to elements or objects in external
products.

Prolaborate

Prolaborate represents the next step in effectively delivering rich models and designs to the broader community and in
enabling high level executives, business process managers, process implementers, consultants, customers and other
stakeholders to see their personal and curated view of the model in a way that they are personally comfortable with!

Prolaborate is a tailored set of views that reduce complexity, focus attention and increase the accessibility of model
information for non-modelers and others who are more concerned with consuming the model than directly editing it.
Prolaborate provides a social platform 'outside the model' that supports talking about the model from a different
viewpoint to those actively engaged 'within the model'. Prolaborate also provides dashboards, impact analysis and other
'outside the model' features that derive information from the model or provide unique windows into the model for a
custom audience, such as Chief Executive Officers, Chief Information Officers and customers.
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Floating License Server

The Sparx Systems Floating License Server functionality has been available for many years as the Key Store, providing
users of Enterprise Architect with the ability to manage their floating licenses. Up until the creation of Pro Cloud Server,
the Key Store was only offered as an independent Windows service. Now that it has been integrated into the Pro Cloud
Server, users only need to install, configure and maintain one service for all their Enterprise Architect needs.

Visibility Levels

The 'Visibility Levels' feature within Enterprise Architect gives model managers the ability to restrict access to certain
sections of a model. Only models hosted by a Pro Cloud Server are able to make use of this feature. Visibility Levels are
implemented by taking advantage of the Row Level Security feature included in Oracle and Microsoft SQL Server.
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WebEA

Sparx System's WebEA is an application designed to display data from Enterprise Architect models in a web browser,
which means users can review and comment on a model in real time, on a range of mobile devices or a remote work
station, without needing to install Enterprise Architect.

WebEA is a component of the Sparx Systems Pro Cloud Server, which is a separately-installed and licensed product, to
complement Enterprise Architect. WebEA makes use of the PHP, HTML, CSS3 and javascript technologies and requires
a web server (such as Apache or IIS) to host it. The topics of this chapter explain how to install and configure WebEA in
detail, but if you are interested in getting started quickly see one of the WebEA Quick Start Guides for the necessary
steps.

Requirements

Users of WebEA require an HTML5 / CSS3 compatible web browser·

The WebEA interface requires JavaScript to be enabled in the web browser·

A client's device will require network connectivity to the web server hosting WebEA·

Users of WebEA will require this information in order to connect to and log into a WebEA model:·
     -  The complete URL; that is, machine name/IP number and optionally the Port number and/or
         the path to the WebEA files, depending on how the web server has been configured
     -  The name of the model to access
     -  (Optional) an access code necessary to open a model, if one has been configured
     -  (Optional) the user ID and password required to open a model, if user security has been applied
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WebEA Quick Start Guide

The purpose of the WebEA Quick Start Guide is to provide the complete process for quickly installing and configuring
WebEA in a new environment using the most common options.

The process is based on these assumptions:

A clean Windows 7 (or later) based machine has been selected to host both the Pro Cloud Server and Web Server;·
that is, no other Web Servers or applications are configured to listen on Port 80

The latest version of XAMPP will be used to install Apache as the Web Server·

WebEA will access one brand new Firebird model (because it is the simplest, as it does not require any third party·
ODBC drivers)

The Enterprise Architect user base is using Enterprise Architect 13.5 or later·

1. Download the Pro Cloud Server

Step Description

1.1 The Pro Cloud Server installer can be downloaded from the 'Registered User' section of the Sparx Systems
website.

https://sparxsystems.com/registered/reg_ea_down.html

Note:  You will need valid credentials to access this area of the website.

2. Install the Web Server

Step Description

2.1 XAMPP is available at https://www.apachefriends.org/download.html. Download the latest version for
Windows, to your machine's desktop.

2.2 The XAMPP installer should be run with Administration privileges; on the desktop, right-click on the
XAMPP installer icon and select 'Run as Administrator'.

2.3 Proceed through the installation process, accepting the defaults until the Select Components screen
displays.

Deselect these checkboxes: MySQL, FileZilla, Mercury, Tomcat, Perl, phpMyAdmin, Webalizer and Fake
Sendmail. WebEA only requires the minimum XAMPP installation of Apache and PHP.

Click on the Next button.

2.4 The installation folder should be set to C:\xampp. Click on the Next button until the installation starts.

When the installation finishes, select the option to open the 'Control' panel, then complete the installation.

3. Configure the Web Server

With the default XAMPP configuration, the default website will use Port 80. Its base folder is C:\xampp\htdocs.
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Step Description

3.1 Using the XAMPP control panel, start Apache. No errors should be reported at this stage.

4. Install Pro Cloud Server

Step Description

4.1 The Pro Cloud Server installer is a standard MSI; double-click on it to start the installation.

Note: Depending on a number of factors, you might be prompted for the credentials of a user with
elevated permissions; these must be entered before the installation will continue.

4.2 The 'Sparx Systems Pro Cloud Server Setup' dialog displays. Click on the Next button.

4.3 Read the license agreement and select the checkbox for indicating that you accept the terms. Click on the
Next button.

4.4 Read the information about the Pro Cloud Server. Click on the Next button.

4.5 The 'Custom Setup' page displays. Click on the Next button to accept the defaults.

4.6 Click on the Install button to run the installation.

5. Configure the Pro Cloud Server

The Pro Cloud Server will have installed all of its files to the 'C:\Program Files (x86)\Sparx Systems\Pro Cloud Server\'
folder and added a shortcut to the desktop.

Step Description

5.1 Run the 'Pro Cloud Config Client' shortcut that was added to your desktop.

5.2 Enter the Server address:

localhost:803

Enter the default password:

pcsadm1n

Click on the OK button.

Note, if you are using PCS version 4 or earlier, the default password is blank (leave the password field
empty).

5.3 Click on the Licensing button, then on the Create Request button, fill in your company and purchase
details, save the License Request and email it to the Sparx Systems Sales team
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(sales@sparxsystems.com).

When the Sparx Systems Sales team return your License Certificate, click on the Add button and select
the supplied certificate file, the Pro Cloud Server should now have a valid License loaded.

5.4 Select the 'Ports' tab.

Select Port '804' from the list and click on the Edit button.

Tick the 'OSLC Supported' checkbox, then click on the OK button.

5.5 Select the 'Database Managers' tab, then click on the Add button.

Type the name 'fb-procloud.feap' in the connection string field, then click on the OK button.

Select the new entry in the list and click on the Edit button.

On the Configure Database Manager screen, select the 'Enabled' and 'Enable Pro Features (OSLC, WebEA
and Integration)' checkboxes.

Click on the OK button.

For a more in depth explanation of how to add database managers, see the Help topic Add Database 
Manager.

5.6 Open the standard Windows Services console (command 'services.msc'), locate and select the service
'Sparx Systems Professional Cloud', then restart it.

6. Copy WebEA files to Website

Step Description

6.1 Copy the folder  C:\Program Files (x86)\Sparx Systems\Pro Cloud Server\WebEA\   to   C:\xampp\htdocs.

7. Configure WebEA to access the model

To give a better demonstration of the WebEA options, we will define three different WebEA model connections. All will
connect to the same physical Firebird database.

Each model connection will have its own set of options that control how users will be able to interact with the data.

Step Description

7.1 Open the file 'C:\xampp\htdocs\WebEA\includes\webea_config.ini' with a text editor.

7.2 In the "[model_list]" section, remove the 'model4' and 'model5' lines. Edit the remaining model names to:

model1 = "Pro Cloud Model (no updates)"

model2 = "Pro Cloud Model with discussions"

model3 = "Pro Cloud Model with access code"

7.3 In the "[model1 : settings]" section change the SSCS_DB_ALIAS option to "fb-procloud". The remaining
default options should remain unchanged.

7.4 In the "[model2 : settings]" section change the SSCS_DB_ALIAS option to "fb-procloud". The remaining
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default options should remain unchanged.

7.5 Delete the "[model3 : settings]" and "[model5 : settings]" sections, rename the "[model4 : settings] section
header to [model3 : settings]", then set these options as shown:

sscs_db_alias = "fb-procloud"·

sscs_port = "804"·

sscs_model_user = ""·

sscs_model_pwd = ""·

auth_code = "password01"·

7.6 Save the changes to the file webea_config.ini in C:\xampp\htdocs\WebEA\includes.

8. Configure your firewall(s) to allow client access

Step Description

8.1 Firewall rules will have to be adjusted to allow traffic between the [Client] and [Web Server], on ports 80
and 443.

8.2 Firewall rules will have to be adjusted to allow traffic between the [Web Server] and [Pro Cloud Server],
on ports 804 and 805.

9. Use Enterprise Architect to add content

The initial Firebird model we created earlier will be empty. The easiest way to add content to the model is with
Enterprise Architect.

Step Description

9.1 On a client machine with access to the web server, open Enterprise Architect v13.5 or later.

9.2
From the main menu select 'Open Project...' or, from the ribbon, select the '  > Open Project'
option.

9.3 Click on the Connect to Cloud button.

9.4 On the 'Cloud Connection' screen set these parameters:

Name:     fb-procloud·

Protocol:     http://·

Server:    {your servername}·

Port:    804·

Model Name:     fb-procloud·

Click on the OK button.

9.5 Open the 'Configure > Model > Options > Cloud' options and tick these checkboxes:
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Auto create Diagram Image and Image Map (each time a Diagram is saved)·

Auto create HTML Page (each time a Linked Document is saved)·

These options ensure diagrams and Linked Documents are saved in a format that allows them to be
viewed in WebEA.

9.6 Create a sample set of Model Views, Packages, diagrams and elements, so that they can be viewed in
WebEA later.

10. Test WebEA access

Step Description

10.1 On a client machine, open a web browser and enter the URL:

     http://{yourwebserver}/WebEA/login.php

where the value '{yourwebserver}' is either the name or IP number of the machine hosting the WebEA
website.

The WebEA login screen displays, listing the three model connections we defined earlier:

Pro Cloud Model (no updates)·

Pro Cloud Model with discussions·

Pro Cloud Model with access code·

10.2 Select the first model connection - Pro Cloud Model (no updates) - and click on the Next button. This
connects you to the model and displays the model views that are defined.

From here you should be able to navigate through the model by selecting Packages, diagrams and
elements. When you select an element, its complete details are displayed. Because of the way this model
connection is defined, the bottom of the properties section will NOT contain the 'Discussions' section.

10.3 Click on the 'hamburger' icon in the top right corner of the display, and select the 'Logout' option. Then
select the second model connection - Pro Cloud Model with discussions - and click on the Next button.
You should see the same model views as before; now navigate to an element and confirm that the
'Discussions' section is visible.

10.4 Once again, click on the 'hamburger' icon in the top right corner, and select the 'Logout' option.

Select the third model connection, 'Pro Cloud Model with access code' and click on the Next button.

This time you should be presented with a prompt for the Access Code: enter 'password01' (as we defined
in step 7.5) and click on the Login button. You should see the same model views as before.

Navigate to an element; this time there should be a blue 'hamburger' menu in the element details area that
allows the creation of element features such as tests and resource allocations. There should also be a
pencil icon next to the element notes area that, when clicked on, will allow the modification of element
notes.

Complete

This quick start procedure is now complete. It has shown you how to install and configure a basic installation of WebEA.
The Sparx System's online Help documentation has more detailed instructions and explains all possible options that can
be configured. See the section Model Repository | Cloud Based Repositories | Pro Cloud Server in the Enterprise
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Architect online Help.
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WebEA Quick Start Guide - IIS

The purpose of the WebEA Quick Start Guide - IIS is to provide the complete process for quickly installing and
configuring WebEA in a new IIS environment using the most common options.

The process is based on these assumptions:

A clean Windows Server 2012 (or later) based machine has been selected to host both the Pro Cloud Server and·
Web Server; that is, no other Web Servers or applications are configured to listen on Port 80

IIS will be used as the Web Server·

WebEA will access one brand-new Firebird model (because it is the simplest, as it does not require any third party·
ODBC drivers)

The Enterprise Architect user base is using Enterprise Architect 13.5 or later·

1. Download the Pro Cloud Server

Step Description

1.1 The Pro Cloud Server installer can be downloaded from the registered user section of the Sparx Systems
website.

     https://sparxsystems.com/registered/reg_ea_down.html

Note:  You will need valid credentials to access this area of the website.

2. Install the Web Server

Step Description

2.1 Enable IIS on Windows Server by running the Server Manager and selecting 'Add roles and features'

2.2 Proceed through the installation process, accepting the defaults until the 'Server Roles' screen displays.

Select the 'Web Server (IIS)' checkbox.

Continue through the installation, accepting defaults.

2.3 Install PHP for IIS with 'Microsoft Web Platform Installer', available from:

https://www.microsoft.com/web/downloads/platform.aspx

Run Microsoft Web Platform Install and select 'Products > Frameworks'.

Select the version of PHP required (for example, 'PHP 7.2.2 (x64)').

Click on the Add button and Install button.

(This will download the required files and install them for use with IIS.)

3. Configure the Web Server

With the default IIS configuration, the default website will use Port 80. Its base folder is
%SystemDrive%\inetpub\wwwroot, which is normally C:\inetpub\wwwroot.
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Step Description

3.1 No additional configuration is required. Test the connection by browsing to the server address from
another computer. The 'Internet Information Services' landing page should display.

4. Install Pro Cloud Server

Step Description

4.1 The Pro Cloud Server installer is a standard MSI; double-click on it to start the installation.

Note: Depending on a number of factors, you might be prompted for the credentials of a user with
elevated permissions; these must be entered before the installation will continue.

4.2 The 'Sparx Systems Pro Cloud Server Setup' dialog displays. Click on the Next button.

4.3 Read the license agreement and select the checkbox to indicate that you accept the terms. Click on the
Next button.

4.4 Read the information about the Pro Cloud Server. Click on the Next button.

4.5 The 'Custom Setup' page displays. Click on the Next button to accept the defaults.

4.6 Click on the Install button to run the installation.

5. Configure the Pro Cloud Server

The Pro Cloud Server will have installed all of its files to the 'C:\Program Files (x86)\Sparx Systems\Pro Cloud Server\'
folder and added a shortcut to the desktop.

Step Description

5.1 Double-click on the 'Pro Cloud Config Client' shortcut that was added to your desktop.

5.2 Enter the Server address:

localhost:803

Enter the default password:

pcsadm1n

Click on the OK button.

Note, if you are using PCS version 4 or earlier, the default password is blank (leave the password field
empty).

5.3 Click on the Licensing button and then on the Create Request button; fill in your company and purchase
details, save the License Request and email it to the Sparx Systems Sales team
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(sales@sparxsystems.com).

When the Sparx Systems Sales team return your License Certificate, click on the Add button and select
the supplied certificate file; the Pro Cloud Server should now have a valid License loaded.

5.4 Select the 'Ports' tab

Select Port '804' from the list and click on the Edit button.

Tick the  'OSLC Supported' checkbox then click on the OK button.

5.5 Select the 'Database Managers' tab, then click on the Add button.

Type the name 'fb-procloud.feap' in the connection string field, then click on the OK button.

Select the new entry in the list and click on the Edit button.

On the Configure Database Manager screen, select the 'Enabled' and 'Enable Pro Features (OSLC, WebEA
and Integration)' checkboxes.

Click on the OK button.

For a more in-depth explanation of how to add database managers, see the Help topic Add Database 
Manager.

5.6 Open the standard Windows Services console (command 'services.msc'), locate and select the service
'Sparx Systems Professional Cloud', then restart it.

6. Copy WebEA files to Website

Step Description

6.1 Delete the default IIS files from C:\inetpub\wwwroot

6.2 Copy the folder   C:\Program Files (x86)\Sparx Systems\Pro Cloud Server\WebEA\     to
C:\inetpub\wwwroot.

7. Configure WebEA to access the model

To give a better demonstration of the WebEA options, we will define three different WebEA model connections. All will
connect to the same physical Firebird database.

Each model connection will have its own set of options that control how users will be able to interact with the data.

Step Description

7.1 Open the file 'C:\inetpub\wwwroot\WebEA\includes\webea_config.ini' with a text editor.

7.2 In the "[model_list]" section, remove the 'model4' and 'model5' lines. Edit the remaining model names to:

model1 = "Pro Cloud Model (no updates)"

model2 = "Pro Cloud Model with discussions"

model3 = "Pro Cloud Model with access code"

7.3 In the "[model1 : settings]" section change the SSCS_DB_ALIAS option to "fb-procloud". The remaining
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default options should remain unchanged.

7.4 In the "[model2 : settings]" section change the SSCS_DB_ALIAS option to "fb-procloud". The remaining
default options should remain unchanged.

7.5 Delete the "[model3 : settings]" and "[model5 : settings]" sections, rename the "[model4 : settings] section
header to [model3 : settings]", then set these options as shown:

   sscs_db_alias = "fb-procloud"

   sscs_port = "804"

   sscs_model_user = ""

   sscs_model_pwd = ""

   auth_code = "password01"

7.6 Save the changes to the file webea_config.ini   in   C:\inetpub\wwwroot\WebEA\includes.

8. Configure your firewall(s) to allow client access

Step Description

8.1 Firewall rules will have to be adjusted to allow traffic between the [Client] and [Web Server], on ports 80
and 443.

8.2 Firewall rules will have to be adjusted to allow traffic between the [Web Server] and [Pro Cloud Server],
on ports 804 and 805.

9. Use Enterprise Architect to add content

The initial Firebird model we created earlier will be empty. The easiest way to add content to the model is with
Enterprise Architect.

Step Description

9.1 On a client machine with access to the web server, open Enterprise Architect v13.5 or later.

9.2
From the Start Page select 'Manage Projects' or, from the ribbon, select the '  > Open Project'
option.

9.3 Click on the Connect to Cloud button.

9.4 On the 'Cloud Connection' screen set these parameters:

Name:         fb-procloud

Protocol:     http://

Server:        {your servername}

Port:        804

Model Name:    fb-procloud
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Click on the OK button.

9.5 Open the 'Configure > Model > Options > Cloud' page and tick these checkboxes:

Auto create Diagram Image and Image Map (each time a Diagram is saved)·

Auto create HTML Page (each time a Linked Document is saved)·

These options ensure diagrams and Linked Documents are saved in a format that allows them to be
viewed in WebEA.

9.6 Create a sample set of Model Views, Packages, diagrams and elements, so that they can be viewed in
WebEA later.

10. Test WebEA access

Step Description

10.1 On a client machine, open an internet browser and enter the URL:

http://{yourwebserver}/WebEA/login.php

where the value '{yourwebserver}' is either the name or IP number of the machine hosting the WebEA
website. The WebEA login screen displays, listing the three model connections we defined earlier:

Pro Cloud Model (no updates)·

Pro Cloud Model with discussions·

Pro Cloud Model with access code·

10.2 Select the first model connection - Pro Cloud Model (no updates) - and click on the Next button. This
connects you to the model and displays the model views that are defined.

From here you should be able to navigate through the model by selecting Packages, diagrams and
elements. When you select an element, its complete details are displayed. Because of the way this model
connection is defined, the bottom of the properties section will NOT contain the 'Discussions' section.

10.3 Click on the 'hamburger' icon in the top right corner of the display, and select the 'Logout' option. Then
select the second model connection - Pro Cloud Model with discussions - and click on the Next button.
You should see the same model views as before; now navigate to an element and confirm that the
'Discussions' section is visible.

10.4 Once again, click on the 'hamburger' icon in the top right corner, and select the 'Logout' option.

Select the third model connection, 'Pro Cloud Model with access code' and click on the Next button. This
time you should be presented with a prompt for the Access Code; enter 'password01' (as we defined in
step 7.5) and click on the Login button. You should see the same model views as before. Navigate to an
element; this time there should be a blue 'hamburger' menu in the element details area that allows the
creation of element features such as tests and resource allocations. There should also be a pencil icon next
to the element notes area that, when clicked on, will allow the modification of element notes.

Complete

This quick start procedure is now complete. It has shown you how to install and configure a basic installation of WebEA
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on IIS. The Sparx System's online Help documentation has more detailed instructions and explains all possible options
that can be configured. See the section 'Model Repository | Cloud Based Repositories | Pro Cloud Server' in the
Enterprise Architect online Help.
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WebEA Installation and Configuration

The Sparx Systems Pro Cloud Server product is installed using a standard Microsoft Windows Installer package that
includes a number of optional components. WebEA is one of these components and is installed by default. It is possible
to change the install location of WebEA; however, if the default settings are used WebEA will be installed into the
C:\Program Files (x86)\Sparx Systems\Pro Cloud Server\WebEA\  folder (assuming a 64 bit machine is being used).

See the Pro Cloud Server Installation and Pro Cloud Server Configuration Help topics for a full description of how to
install and configure the Sparx Systems Cloud Service.

Important: If you are installing the Pro Cloud Server on a machine that already has the Sparx Systems Cloud Services
or Sparx Systems WAN Optimizer installed then these should be uninstalled first.

WebEA Server Requirements

In order to run WebEA in your environment you must have:

A Web Server (Apache or IIS) capable of hosting PHP v7.0 (or later)·

A Web Server with these standard PHP extensions installed and enabled: core, curl, date, gettext, hash, json, libxml,·
mbstring, pcre, session, standard and tokenizer

A Web Server with PHP sessions enabled·

Communication between the web server and the server hosting the Pro Cloud Server·

A base folder (on the web server) to store the WebEA website pages·

Configuration Steps

The installation of the WebEA application should have already been completed by following the steps outlined in the Pro
Cloud Server Installation Help topic, making sure that the WebEA component was installed.

In additional to installing the Pro Cloud server, WebEA also needs a web server to host it. In the simplest configuration
the web server would be installed on the same machine as the Pro Cloud Server.

Configuring WebEA applies these steps:

Step Action

1 Decide what models are going to be available to WebEA users.

At the same time it is worth considering these points, which will determine the configuration options of
each model:

Is user security currently configured on the model?·

Should WebEA users be prompted for their model user ID and password?·

Should WebEA users be able to view element discussions?·

Should WebEA users be able to add element discussions?·

Should WebEA users be able to join and participate in reviews?·

Should WebEA users be able to insert new objects, and if so, what types?·

Should WebEA users be able to add new element features, and if so, what types?·

Should WebEA users be able to edit element notes?·

Should WebEA users be able to edit element tests?·

Should WebEA users be able to edit element resource allocations?·

What is the default list of watchlist items for the model?·
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2 Use the Cloud Configuration Client and define a Port to be used for access to your Cloud Models. Ensure
that the 'OSLC Supported' option has been set to true.

After adding or modifying Port configurations, ensure the Windows service 'Sparx Systems Professional
Cloud' is restarted.

3 Ensure a database manager is defined for each model decided on in step 1, in the Pro Cloud Server's
database manager list. The process to do this is as outlined in Sparx Systems Pro Cloud Server
Configuration Client, in Add Database Manager.

4 For each of the models decided on in step 1, select the model on the 'Sparx Systems Pro Cloud Server
Configuration Client', click on the Configure button and select the 'Enable Pro Features (OSLC, WebEA
and Integration)' checkbox.

5 Ensure that your Pro Cloud Server has a valid License, loaded by completing these steps:

Click on the Licensing button.1.

Click on the Create Request button.2.

Fill in your company and purchase details.3.

Save the License Request and email it to the Sparx Systems Sales team (sales@sparxsystems.com).4.

When the Sparx Systems Sales team return your License Certificate:

Click on the Add button.1.

Select the supplied certificate file.2.

The Pro Cloud Server should now have a valid License loaded.

6 Check that you can access the model(s) in Enterprise Architect using the 'Connect to Cloud' option.

After opening each model in Enterprise Architect, enable the 'Data Cache' options and click on the Create
button to generate the initial set of viewable diagrams and Linked Documents. See the Model
Configuration topic for details.

7 Download, install and configure your web server for PHP, according to your requirements.

Tip: XAMPP is the most common Apache/PHP web server that includes all the required components; it is
available for Windows/Linux and OS X at:

https://www.apachefriends.org/download.html

WebEA has been tested on all of the currently available versions of PHP, but if your environment has no
special requirements then Sparx Systems would recommend v7.1.1 for Windows. All further Quick Start
points will assume this configuration.

Note: WebEA only requires the minimum XAMPP installation, Apache and PHP; it does not require
MySQL, FileZilla Mercury, Tomcat or any of the other optional components, so if you have no need for
these components Sparx Systems would recommend to not install them.

8 Define and configure a website for WebEA in your web server.

As there are many different web servers and configurations, configuring the web site for WebEA,
deciding what Port the web server will listen to, and making sure the website is secure from external
attacks, are all outside the scope of this documentation.

Tip: Using the default XAMPP configuration, the Port for the default website is 80 and the base folder is
at 'C:\xampp\htdocs'.  XAMPP will already have added files to this folder; WebEA does not require these
files, so if you have no need for them, move them to a backup location.

9 Copy the contents of the entire WebEA installation folder ('C:\Program Files (x86)\Sparx Systems\Pro
Cloud Server\WebEA\') to the base folder of the website.

Tip: Copy the WebEA folder from 'C:\Program Files (x86)\Sparx Systems\Pro Cloud Server\WebEA\'  to
'C:\xampp\htdocs'.
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Special Note regarding reinstalls: Before updating the WebEA files, take a backup of the files you have
modified; that is, \includes\webea_config.ini  and \includes\webea_strings.ini.

10 Due to the sensitive nature of some of the information contained in the WebEA configuration file, we
recommend that the '\includes\' folder within the WebEA folder is severely restricted so that only PHP can
access the files within. For example, in Apache this is achieved with this entry in the Apache configure
file:

     <Directory "{website_path}/includes">

          AllowOverride none

          options none

          Require all denied

     </Directory>

Once your web server is configured and the WebEA application files copied into the base folder, start or
restart the web server.

Tip:  Using the XAMPP control panel, Stop/Start Apache.

11 Edit the '\includes\webea_config.ini'  file and define each model decided on in step 1.

See the How to configure WebEA models Help topic for more details on what each option means in
WebEA's config file.

Tip:  Edit the 'C:\xampp\htdocs\includes\webea_config.ini' file, and update all parameters with the prefix
'SSCS_' to that of a defined repository in your Cloud Service.

Special Note regarding reinstalls: If you a have a previous backup of the \includes\webea_config.ini
file and wish to use the same configuration, you can simply restore the backup file.

12 On a remote machine, open an internet browser and enter the URL of http://{yourwebserver}/login.php,
where the value '{yourwebserver}' is either the name or IP number of the machine hosting the WebEA
website. This should display the WebEA login screen that lists the models defined in the webea_config.ini
file.

13 Other considerations:

If you require different lists of models (or different options) for different user bases, then it is possible·
to define multiple websites, each with their own dedicated Port and base folder, using Apache's
virtual hosts; this could mean user group A could access its set of models with the URL
http://{yourwebserver}:180/ while user group B would use the URL http://{yourwebserver}:200/

Firewall rules will have to be adjusted to allow traffic between the [Client] and [Web Server]·

Firewall rules will have to be adjusted to allow traffic between the [Web Server] and [Pro Cloud·
Server]

HTTPS and SSL

If the models have SSL enabled and are using self-signed certificates, then see the Advanced SSL - Adding Trust to a 
Self-Signed Certificate Help topic for advanced configuration of WebEA.

Model Configuration

Action Description
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Configure Enterprise
Architect model options

By default, diagrams and Linked Documents are not saved in a format that is
viewable by web browsers. In order for users of WebEA to view these components,
Enterprise Architect must be configured to generate (and store) viewable versions
of them whenever changes are made. The options to generate viewable diagrams
and Linked Documents are defined at the model level.

With the model open in Enterprise Architect, select the 'Configure > Model >
Options' ribbon option. On the 'Manage Project Options' dialog, refer to the 'Data
Cache' options on the 'Cloud' page.

The first option (if enabled), in addition to saving a diagram normally will also
generate and save a static image of the diagram.

The second option (if enabled), in addition to saving a Linked Document normally
will also generate and save the document in HTML format.

If these options are not enabled, diagrams and Linked Documents will not be
viewable from within WebEA.

When initially configuring a model to auto-create viewable diagrams and Linked
Documents, it is advisable to click on the Create button to generate the initial set of
viewable diagrams and Linked Documents. While this is not mandatory, viewable
versions of all existing diagrams and Linked Documents will not exist until they are
saved.

Note: This approach is relevant when all Enterprise Architect users are using a
build later than 1350. If, however, some of your user base are using older versions
of Enterprise Architect then updates to diagrams and Linked Documents will not be
reflected immediately when saved.

See the How to configure automatic viewable components Help topic for the
recommended approach to overcome this situation.

Configure model users It is possible for WebEA users to connect to user security enabled models in one of
two ways:

Using their model User Login and Password; that is, the same credentials they·
use when connecting to the model with Enterprise Architect, or

If the model has been configured in WebEA to not require login credentials·
then all users will be logged in under the one user account (using the
sscs_model_user and sscs_model_pwd defined in the 'webea_config.ini' file)

Single Sign-On (SSO) WebEA supports these Single Sign-On Systems:

Windows authentication with Active Directory·

OpenID·

Provided the Enterprise Architect model has been configured for Single Sign-On,
users will have the option to use Single Sign-On when accessing the model via
WebEA.

Acknowledgements
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to the WebEA product by these components.
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jQuery v1.12.3  - jQuery Foundation·

NicEdit ©2007-2008, Brian Kirchoff, under license from MIT·

Date Picker for jQuery v5.1.1, Keith Wood, under license from MIT·
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How to configure automatic viewable components

While Sparx Systems recommend that users should always use the latest release of Enterprise Architect, we do
acknowledge that in some situations this is hard to achieve. Therefore, in order for WebEA (and the Pro Cloud Server) to
function correctly when users are using builds of Enterprise Architect earlier than 1350, the Pro Cloud Server includes a
custom version of Enterprise Architect (referred to as the EA Worker) that will automate the generation of WebEA
viewable diagrams and Linked Documents.

Each instance of the EA Worker is capable of connecting to a single model, and typically runs on the same server as the
Pro Cloud Server.

How to run EA Worker

The EA Worker application does not have a GUI of any kind, therefore it is started with two command line options:

cloudupdate: - the frequency (measured in seconds) of how often the application should check for new or modified1.
diagrams and Linked Documents.

A connection string to the model, defined as a .EAP file.2.

An example command line is:

    C:\> EA.exe /cloudupdate:30 "C:\EA\shortcuts\model1.eap"

Typically the easiest and most efficient method to run the EA Worker is with a Windows batch/command file.

Model shortcuts for EA Worker

Within Enterprise Architect it is possible to save model connections (no matter what type of DBMS is in use) as a .EAP
file. These model shortcuts are not .EAP file databases, but plain text files that contain a connection string to a model.

This is an example .EAP shortcut to a model without security:

    EAConnectString:model1 --- ;Connect=Cloud=protocol:http,address:localhost,port:804;Data Source=model1;

However, when the model has security enabled the connection string requires USER and PASSWORD parameters:

    EAConnectString:model1 --- ;Connect=Cloud=protocol:http,address:localhost,port:804,user:fred,pwd:pwdxxx;Data
Source=model1;

EA Worker Configuration Steps

Step Description

1 Create a .EAP shortcut to the model.

The creation of a .EAP shortcut file can be achieved by either:

Manually creating a plain text file, renaming its extension to .EAP and entering the complete1.
connection string as shown (making sure to replace all values enclosed in {}):

     EAConnectString:{modelname} ---
;Connect=Cloud=protocol:http,address:{servername},port:{port},user:{username},pwd:{password};
Data Source={modelname};
or

In Enterprise Architect, open a Cloud connection to the model in question and then choose 'Save As2.

Shortcut...' from the  drop-down menu.
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2 Create a batch/command file.

Create a plain text file, give it a meaningful name, and change its extension to .CMD. Then edit the file
and enter this text, making sure to replace {seconds} with the number of seconds and {filepath} with the
location of the fully qualified .EAP created in Step 1:

     "C:\Program Files (x86)\Sparx Systems\Pro Cloud Server\Worker\EA.exe" /cloudupdate:{seconds}
"{filepath}"

3 Run the batch/command file.

Double-click on the file created in Step 2.

Sparx System recommends that this batch/command file is added to Startup so that it is automatically run
when the server starts.

Lifecycle of EA Worker

The EA Worker application is designed to connect to the specified model automatically when it starts; if there is a
problem with the connection the application ends. If the connection string is valid and the EA Worker connects to the
model it will run continually until the server is restarted or until the process is manually terminated.
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How to configure WebEA models

All WebEA configuration is controlled by a single file 'webea_config.ini', which must reside in the WebEA '\includes\'
folder.

This configuration file defines the model connections that are available on WebEA's login page. For each WebEA model
connection you define how WebEA will access the model (which server, which Port and so on), and optionally apply
settings to adjust WebEA's functionality  (such as showing or hiding specific features).

Configuration Options

There are two different options available for WebEA model configuration. Apply one of these:

Step Description

1 (Recommended) Use the web based configuration page (config.php).

2 Directly modify the 'webea_config.ini' file using a text editor.
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Security Considerations

Due to the sensitive nature of some of the information contained in the WebEA configuration file, we recommend that
the '\includes\' folder within the WebEA folder is severely restricted.

For example, in Apache this could be achieved using .htaccess and .htpasswd files in the '\includes\' folder.
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Configure WebEA models - via Web Browser

After copying the WebEA files from the Pro Cloud Installation to your website, you can configure WebEA via a web
browser.

Using the web browser, enter the URL for  WebEA's login page and, at the end of the URL, append '?config' after
'login.php'.

For example:

http://{yourwebserver}/login.php?config   or·

http://{yourwebserver}/webea/login.php?config·

The value '{yourwebserver}' is either the name or the IP number of the machine hosting the WebEA website.

This should display the 'WebEA Configuration' page, which includes a list of the WebEA connections that are currently
defined in the webea_config.ini file.

WebEA Configuration

The 'WebEA Configuration' model list provides these fields.

Field Description

Name The display name for the WebEA Model connection. This appears in the WebEA
login page, and in the WebEA header after opening the model.

Actions The 'Actions' column contains a number of buttons for modifying the model
connection.

Edit - Allows you to edit/configure the options for this WebEA model·
connection

Rename - Allows you to change the WebEA display name·

Copy - Creates a duplicate of this WebEA model connection; the duplicate will·
be added to the list of models with the name: {original name} - Copy

Delete - Delete this WebEA model connection·
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Move The 'Move' column contains options for moving the model connection.

Move Up - Move the model connection up one position in the list·

Move Down - Move the model connection down one position in the list·

Move to... - Move the model connection to a specific location in the list·

Add a Model The final list item is the option to add a new model connection. When selecting this
option you will be prompted to enter the connection name or WebEA display name.

After you enter the name, the page to edit the Model Connection settings is
displayed.

Saving the WebEA configuration

Changes made via the 'WebEA Configuration' page (including changes when editing a specific model connection) are not
saved automatically.

To save changes, click on the Save button at the bottom of the 'WebEA Configuration' page.

Note, the Save button is only enabled when there are unsaved changes.

Creating a backup of the webea_config.ini file

The Create Backup button at the bottom of the 'WebEA Configuration' page will create a backup of the current
webea_config.ini file.

Backups are created with the name:

     webea_config_bak_{date}_{time}.ini

Note: A backup cannot be created while there are unsaved changes (if necessary click on the Save button, then on the
Create Backup button).
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Edit WebEA Model Connection settings

After you select the option to edit a Model Connection, the configuration options for that connection are displayed.

In the simplest case, the connection can be defined by only updating the 'Protocol', 'Server', 'Port' and 'Model
Name/Alias' fields. A number of additional options are provided for configuring settings such as authentication, available
functions and display options.

Connection Options

Item Description

Protocol Identifies the protocol to be used to connect to the Sparx Systems Pro Cloud Server.

Server Identifies the fully qualified machine name or IP address of the server hosting the
Pro Cloud Server.

Port Defines the TCP Port used to connect to the Sparx Systems Cloud Service. This
Port number must match one of the Ports that the Pro Cloud Server Windows
Service is listening to or, in the case of an IIS setup, the IIS Port servicing this
repository.

Model Name/Alias Defines the name or alias of the model connection. This corresponds to the
Database Manager's 'Alias' in the Pro Cloud Server Configuration Client or the
'Model Name' on the Enterprise Architect's 'Cloud Connection' screen. The value is
case sensitive.

Deny Self Signed
Certificate

Defines whether self signed SSL certificates can be used.

If you are using HTTPS and a self signed certificate, then this should be set to 'No'.

Note: This option is only applicable when the Protocol is set to HTTPS.

Authentication Options

Item Description

Authentication Code Defines the authorization code all WebEA users must enter before they can access
the model. If this value is blank, WebEA users are not prompted to enter a code.

This option is only used for basic username/password authentication and is not used
for Windows Authentication or OpenID.

It is possible to set this option and also set a Model User. In this case the user will
be required to enter the access code only and will not be prompted for a username
or password.

Model User Defines the model user login (as defined in Enterprise Architect User Security) that
will be used in combination with the 'User Password' option to log in to a
security-enabled model.

When set, all other authentication schemes are bypassed, including Windows·
Authentication, OpenID and the basic username/password login prompt
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Sparx Systems would recommend the use of this option only on a model that·
has been configured as read only, since all updates made by WebEA users in
this configuration will be identified as the same user

User Password Defines the password (as defined in Enterprise Architect User Security) that will be
used in combination with the 'Model User' option to login to a security enabled
model.

When set, all other authentication schemes are bypassed, including Windows·
Authentication, OpenID and the basic username/password login prompt

Sparx Systems recommend the use of this option only on a model that has been·
configured as read only, since all updates made by WebEA users in this
configuration will be identified as the same user

Allow blank passwords Defines whether or not WebEA will attempt to send blank passwords to the Cloud
Services for validation.

General Options

Item Description

Default Package Layout Defines the default layout when viewing the contents of a Package (or an element
with children) in WebEA's main view. WebEA can display child items in one of
three layouts, either Icon view (the default), List view, or Notes view (resembling
the Enterprise Architect Specification Manager view).

Object Order Defines the order of objects in the Browser and Object List views. There are three
different ordering behaviors:

Alphabetical - Objects are sorted alphabetically (by name)·

Free Sort - Objects are sorted based on their 'Set Position' (manual sorting,·
which is applied in Enterprise Architect), then alphabetically; this reflects
Enterprise Architect's sorting when the 'Allow Free Sorting' option is enabled

Object Type - Objects are sorted by type, then set position, then·
alphabetically; this reflects Enterprise Architect's sorting when the 'Allow Free
Sorting' option is disabled

Note: Regardless of the 'Object Order' setting, WebEA displays diagrams, then
Packages, then elements. The 'Object Order' applies to the items within each of
these groupings.

Default Diagram Defines the GUID of the diagram that should be automatically loaded when users
log onto the model. If this option is not defined or an empty value is specified,
WebEA assumes that no diagram should be loaded and displays the model root
instead. The GUID of any diagram can be obtained from WebEA using the 'Obtain
direct link to the current page' icon in the navigation bar.

Note: The entire GUID (including {}) must be used.

Mini Properties Navigates When set to 'Yes', selecting certain 'navigable' elements will cause WebEA to
navigate to the target of these elements. Examples of such 'navigable' elements are
Hyperlinks and Navigation Cells.  For all other elements, selecting them will
display the properties of the element in the Properties View.  This option has no
effect when the Properties View is not shown.
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Diagram Elements
Navigate

As of WebEA version 3.01.23.1690 (included in Pro Cloud Server 3.0.23) the
default selection of some objects on diagrams matches Enterprise Architect's
behavior. This applies to i) Composite Elements and ii) Package elements that
contain a diagram.

Composite Elements - A Composite element on a diagram will navigate·
directly to its Composite diagram

Package Elements - A Package element on a diagram will navigate to the first·
child diagram contained within the selected Package; if the selected Package
does not contain any diagrams, then the Package's properties are displayed

When 'Diagram Elements Navigate' is set to 'No', selecting either a Composite
element or Package element on a diagram will display the selected element's
properties.

Recent Search Days Defines the number of days the predefined 'Recent ...' searches should consider. For
example if this value was set to '7' then whenever a user invokes the search for
'Recent elements', all elements modified in the previous 7 days will be returned.

Show Browser Defines the default visibility of the Browser.

Notes:

If a user selects the 'Mobile' option when logging in to WebEA, this overrides·
the 'Show Browser' option and the Browser will be hidden

This behavior could be overridden depending on the screen resolution; for·
example, on a low resolution screen such as a mobile phone, the Browser will
be hidden regardless of the 'Show Browser' option

Show Properties View Defines the default visibility of the Properties View.

Notes:

If a user selects the 'Mobile' or 'Tablet' option when logging in to WebEA, this·
overrides the 'Show Properties View' option and the 'Properties View' will be
hidden

This behavior could be overridden depending on the screen resolution; for·
example, on a low resolution screen such as a mobile phone, the 'Properties
View' will be hidden regardless of the 'Show Properties View' option

Show Discussions Defines whether or not discussions on Packages and elements should be displayed
within the WebEA interface.

Add Discussions Defines whether or not new discussions on Packages and elements can be added to
the model.

Note: This option is disabled when Show Discussions is set to 'No'

Participate in Reviews When set to 'Yes', users are able to Join discussion reviews. In order to make full
use of this option the 'Show Discussions' and 'Add Discussions' options would also
have to be set to 'Yes'.

Use Avatars When set to 'Yes', all discussion messages are displayed with the creating user's
avatar. When set to 'No', a set of generic images representing discussions and
replies is used instead.

Object Update Options
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Item Description

Can add Objects Defines whether or not new objects (elements, diagrams, or Packages) can be added
to the model.

Note: This option will be internally set and restricted to 'No' for Pro Cloud Server
Express installations.

Edit Object Notes Defines whether an object's notes can be edited.

Can add <type> The remaining options in this section define whether or not elements of the given
object type can be added to the model.

Note: If the 'Can add Objects' option is set to 'No', then this overrides the individual
'Can add <type>' options.

Object Feature Update Options

Item Description

Can add Object Features Defines whether or not element features (such as Changes and Tests) can be added
to the model.

Can edit Tests Defines whether or not the details of element tests can be edited in the model.

Can edit Resources Defines whether or not the details of element resource allocations can be edited in
the model.

Can add <feature type> The remaining options in this section define whether or not specific feature types
(such as Changes or Tests) can be added to elements in the model.

Note: If the 'Can add Object Features' option is set to 'No', then this overrides the
individual 'Can add <feature type>' options.

Property Section Options

The Property Section Options define whether specific properties are available and/or visible when viewing the properties
of an element in WebEA. By default, all property sections are set to be visible ('Yes').

Note: When viewing the Properties of an element in WebEA's Main View, the feature buttons to display specific
properties are only displayed if the element has features or properties of that type.

For example, if an element has no Tagged Values, then the 'Tagged Values' feature button will not be displayed
(regardless of Property Section Options).

Default Watchlist Options

Item Description
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Days to Watch Defines the default activity period of the model watchlist. The value is a number of
days; for example, look for activity in the last 10 days.

Cookie Retention Defines the period over which a WebEA user's set of Watchlist options is stored.
The value is the number of days that the cookies will be retained for.

Recent Discussions Define whether or not the watchlist should display a count of elements that have
had discussions during the activity period.

Recent Reviews Define whether or not the watchlist should display a count of review elements that
have been added or modified during the activity period.

Recent Diagrams Define whether or not the watchlist should display a count of added/modified
diagrams during the activity period.

Recent Elements Define whether or not the watchlist should display a count of added/modified
elements during the activity period.

Active resource tasks Define whether or not the watchlist should display a count of elements with active
resource allocations during the activity period.

Ending resource tasks Define whether or not the watchlist should display a count of elements with
resource allocations ending during the activity period.

Overdue resource tasks Define whether or not the watchlist should display a count of elements with
resource allocations that fall overdue during the activity period.

Recently passed tests Define whether or not the watchlist should display a count of elements with tests
that passed during the activity period.

Recently failed tests Define whether or not the watchlist should display a count of elements with tests
that failed during the activity period.

Recently deferred tests Define whether or not the watchlist should display a count of elements with tests
that were deferred during the activity period.

Recent tests not checked Define whether or not the watchlist should display a count of elements with tests
that were not checked during the activity period.

Tests not run Define whether or not the watchlist should display a count of elements with tests
that were not run during the activity period.

Verified changes Define whether or not the watchlist should display a count of elements with verified
changes during the activity period.

Recently requested changes Define whether or not the watchlist should display a count of elements with
requested changes during the activity period.

Recently completed
changes

Define whether or not the watchlist should display a count of elements with
changes completed during the activity period.

New changes Define whether or not the watchlist should display a count of elements with new
changes added during the activity period.
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Incomplete changes Define whether or not the watchlist should display a count of elements with
incomplete changes during the activity period.

High Priority events Define whether or not the watchlist should display a count of elements with events
set to high during the activity period.

Verified defects Define whether or not the watchlist should display a count of elements with verified
defects during the activity period.

Recently reported defects Define whether or not the watchlist should display a count of elements with defects
reported or 'requested' during the activity period.

Recently resolved defects Define whether or not the watchlist should display a count of elements with defects
completed during the activity period.

New defects Define whether or not the watchlist should display a count of elements with defects
added during the activity period.

Incomplete defects Define whether or not the watchlist should display a count of elements with
incomplete defects during the activity period.

Verified issues Define whether or not the watchlist should display a count of elements with verified
issues during the activity period.

Recently reported issues Define whether or not the watchlist should display a count of elements with issues
reported or 'requested' during the activity period.

Recently resolved issues Define whether or not the watchlist should display a count of elements with issues
completed during the activity period.

New issues Define whether or not the watchlist should display a count of elements with issues
added during the activity period.

Incomplete issues Define whether or not the watchlist should display a count of elements with
incomplete issues during the activity period.

Verified tasks Define whether or not the watchlist should display a count of elements with verified
tasks during the activity period.

Recently reported tasks Define whether or not the watchlist should display a count of elements with
requested tasks during the activity period.

Recently resolved tasks Define whether or not the watchlist should display a count of elements with tasks
completed during the activity period.

New tasks Define whether or not the watchlist should display a count of elements with tasks
added during the activity period.

Incomplete tasks Define whether or not the watchlist should display a count of elements with
incomplete tasks during the activity period.

Recently reported events Define whether or not the watchlist should display a count of elements with
requested events during the activity period.
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Incomplete events Define whether or not the watchlist should display a count of elements with
incomplete events.

Verified decisions Define whether or not the watchlist should display a count of elements with verified
decisions during the activity period.

Recently reported decisions Define whether or not the watchlist should display a count of elements with
requested decisions during the activity period.

Recently resolved
decisions

Define whether or not the watchlist should display a count of elements with
decisions resolved during the activity period.

New decisions Define whether or not the watchlist should display a count of elements with
decisions added during the activity period.

Incomplete decisions Define whether or not the watchlist should display a count of elements with
incomplete decisions during the activity period.
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Configure WebEA models - via Text Editor

WebEA models can be configured by directly editing WebEA's  \includes\webea_config.ini file. For example:

     C:\xampp\htdocs\webea\includes\webea_config.ini

Options are grouped under section headers, which are enclosed by square brackets. Each option must be defined on a
separate line and follow the syntax:

   {option name} = "{option value}"

Note that:

Option values are enclosed by double quotes·

The configuration file supports comments; the semi-colon character starts a comment·

The default 'webea_config.ini' file included in the installation package contains samples of how models can be·
configured

Why are there so many options?

In order to offer the greatest level of flexibility in how WebEA models can be accessed and used, Sparx Systems
provides a large number of configuration options, which can be daunting when the complete list is viewed for the first
time. However, to minimize your effort in understanding and managing the options, most are also grouped by prefix
(sscs, login, add, edit and wl), which helps you to quickly understand what a particular option is used for.

The Model List

The first section in the configuration file is '[model_list]'; this section defines the model names that will be displayed to
WebEA users on the 'Login' page. There is no limit to the number of models that can be defined; however, when there
are more than ten models the login screen will automatically show a vertical scroll bar.

The model names have no direct link to the physical server or database name of the models they are describing, so you
are free to use any meaningful name.

For example:

     [model_list]

     model1 = "Model One (no updates)"

     model2 = "Model One with discussions"

     model3 = "Model Two with user login"

     model4 = "Model Three with all options"

     model5 = "Sparx Systems Sample Model"

Note: It is important that the 'modelx' definitions are consecutive; any out-of-sequence model numbers will be ignored
and no further models will be added to the WebEA Login page.

Model options

For each numbered model found in the '[model_list]' section a matching '[modelx : settings]' section is expected, further
down the configuration file. All options within this section relate to that model only; that is, options cannot be shared
between models.

For example:

     [model1 : settings]
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     sscs_protocol = "http"

     sscs_server = "localhost"

     sscs_port = "80"

     sscs_db_alias = "model1"

     auth_code = ""

     login_prompt = "false"

     default_diagram = ""

     show_discuss = "false"

Model connection settings

Probably the most important settings for any model are the connection-related ones, prefixed with sscs_ (which stands
for 'Sparx Systems Cloud Server'). This group of settings defines how WebEA will connect and communicate with the
Pro Cloud Server for data retrieval.

All communication between WebEA and the Pro Cloud Server is performed via the PHP cURL library, therefore some of
the connection settings relate directly to the cURL options.

Option Description

sscs_protocol Defines the protocol to be used to connect to the Sparx Systems Pro Cloud Server.

Options:     http or https

Default:     http

Example:    sscs_protocol = "http"

Note: When using the https protocol the configuration should also include
'sscs_use_ssl = "true"'. If you are using a self-signed certificate then
'sscs_enforce_certs = "false"' should also be included.

sscs_port Defines the TCP Port used to connect to the Sparx Systems Pro Cloud Server. This
Port number must match one of the Ports the Sparx Systems Pro Cloud Server is
listening to or, in the case of an IIS setup, the IIS Port servicing this repository.

Default:            80

Example:    sscs_port = "804"

sscs_server Defines the fully qualified machine name or IP address of the server hosting the Pro
Cloud Server.

Default:    localhost

Example:     sscs_server = "sparxpublic.com" or sscs_server = "197.168.0.10"

sscs_use_ssl As of WebEA version 3.01.23.1690 (included in Pro Cloud Server 3.0.23) this
option is no longer used. Instead WebEA determines this value dynamically based
on the protocol in use:

HTTP - sscs_use_ssl="false"   and

HTTPS - sscs_use_ssl="true"

WebEA versions prior to 3.0.23.1690 use this value to define if all communications
between WebEA and Pro Cloud Server should use SSL (Secure Socket Layer).
When this value is "true", the protocol should be set to "https".

Options:     true or false

Default:    false
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Example:     sscs_use_ssl = "false"

sscs_db_alias Defines the database alias name of the model repository hosted on the Pro Cloud
Server. This corresponds to the 'Database Alias' identified in the Pro Cloud Server
Configuration Client or the 'Model Name' on the Enterprise Architect 'Cloud
Connection' screen. The value is case sensitive.

Default:    ea

Example:    sscs_db_alias = "RepositoryName"

sscs_enforce_certs When HTTPS is the protocol in use, this option defines whether or not cURL will
enforce that the certificate installed in Pro Cloud Server is correctly signed by a
Certificate Authority.

Note: If you are using a self-signed certificate for Pro Cloud Server, this option
must be set to "false".

Options:     true or false

Default:    true

Example:     sscs_enforce_certs = "false"

sscs_model_user Defines the model user login (as defined in Enterprise Architect User Security) that
will be used in combination with the 'sscs_model_pwd' option to log in to a security
enabled model.

Note:

Starting in Pro Cloud Server version 3.0.23 - When set, all other authentication·
schemes are bypassed, including Windows Authentication, OpenID and basic
username/password login

Sparx Systems recommend the use of this option only on a model that has been·
configured as read-only, since all updates made by WebEA users in this
configuration will be identified as the same user.

Default:

Example:    sscs_model_user = "webuser"

sscs_model_pwd Defines the password (as defined in Enterprise Architect User Security) that will be
used in combination with the 'sscs_model_user' option to login to a security enabled
model.

Note:

Starting in Pro Cloud Server version 3.0.23 - When set, all other authentication·
schemes are bypassed, including Windows Authentication, OpenID and basic
username/password login

Sparx Systems recommend the use of this option only on a model that has been·
configured as read-only, since all updates made by WebEA users in this
configuration will be identified as the same user

Default:

Example:    sscs_model_pwd = "pwdxxx"

Model general settings

These options define how WebEA users can access and display objects within the model.

Option Description
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auth_code Defines the authorization code all WebEA users must enter before they can access
the model. If this value is blank, WebEA users are not prompted to enter a code.

This option is only used for basic username/password authentication and is not used
for Windows Authentication or OpenID.

It is possible to set this option and also set 'sscs_model_user'. In this case the user
will be required to enter the access code only and will not be prompted for a
username or password.

Options:    text

Default:    blank

Example:     auth_code = "JWG478"

login_prompt This option is no longer used as of WebEA version 3.0.23.1690 (included in Pro
Cloud Server 3.0.23). Basic authentication username and password fields will show
for models that allow basic authentication (that is, are not restricted to SSO
logins).

The basic authentication (username/password) will show for security enabled
models that have not set sscs_model_user.

Windows Authentication, if enabled for the model, will be attempted automatically
when selecting the model.

OpenID authentication, if enabled in the model, will show above any basic
authentication prompt.

For older versions of WebEA, the option is used to define whether or not all
WebEA users must enter a model user/password before they can access the model.

Note: When this option is set to "false" and the model has security enabled, the
'sscs_model_user' and 'sscs_model_pwd' options must also be used to specify the
logon credentials.

Options:     true or false

Default:    false

Example:     login_prompt = "false"

login_allow_blank_pwd When the 'login_prompt' option is set to "true", this option defines whether or not
WebEA will attempt to send blank passwords to the Pro Cloud Server for
validation.

Options:     true or false

Default:    false

Example:     login_allow_blank_pwd = "false"

miniprops_navigates When the 'miniprops_navigates' option is set to "true", selecting certain 'navigable'
elements will cause WebEA to navigate to the target of these elements. Examples
of such 'navigable' elements are Hyperlinks and Navigation Cells.  For all other
elements, selecting them will display the properties of the element in the Properties
View.  This option has no effect when the Properties View is not shown.

Options:     true or false

Default:    true

Example:     miniprops_navigates = "false"

navigate_to_diagram As of WebEA version 3.01.23.1690 (included in Pro Cloud Server 3.0.23) the
default selection of some objects on diagrams matches Enterprise Architect
behavior. This applies to i) Composite elements and ii) Package elements that
contain a diagram.
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Composite Elements - A composite element on a diagram will navigate directly·
to its composite diagram.

Package Elements - A Package element on a diagram will navigate to the first·
child diagram contained within the selected Package; if the selected Package
does not contain any diagrams then the Package's properties are displayed

When 'navigate_to_diagram' is set to "false", selecting either a composite element
or Package element on a diagram will display the selected element's properties.

Options:    true or false

Default:    true

Example:    navigate_to_diagram = "false"

show_discuss Defines whether or not discussions on Packages and elements should be displayed
within the WebEA interface.

Options:     true or false

Default:    false

Example:     show_discuss = "true"

participate_in_reviews When set to "true", 'participate_in_reviews' allows users of WebEA to Join reviews
that will automatically assign all discussions to the joined review. In order to make
full use of this option 'show_discuss' and 'add_discuss' would also have to be set to
"true".

Options:    true or false

Default:    false

Example:     participate_in_reviews = "false"

use_avatars When the 'use_avatars' option is set to "true", all discussion messages are displayed
with the creating user's avatar. When set to "false" a set of generic images
representing discussions and replies is used instead.

Options:  true or false

Default:  true

Example:  use_avatars = "false"

show_search Defines whether the 'Search' menu is visible and available.

Options:     true or false

Default:    true

Example:     show_search = "false"

show_watchlist Defines whether the 'Watchlist' menu item is visible and available.

Options:     true or false

Default:    true

Example:     show_watchlist = "false"

recent_search_days Defines the number of days the predefined 'Recent ...' searches should consider. For
example if this value was set to "7" then whenever a user invokes the search for
'Recent elements', all elements modified in the previous 7 days will be returned.

Options:    any positive integer value

Default:    3

Example:    recent_search_days = "10"

prop_sec_<section>_visibl
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e Defines whether or not a property section (or feature) is accessible.

If a feature is not visible then the button to display that feature will not be available
in the 'Main View', and the Feature will not be listed in the 'Select Feature' menu in
the Properties View.

<section> can be one of:

location·

instances·

relationships·

taggedvalues·

testing·

resourcealloc·

attributes·

operations·

files·

runstates·

features·

changes·

documents·

defects·

issues·

tasks·

events·

decisions·

efforts·

risks·

metrics·

Options:     true or false

Default:    true

Example:     prop_sec_testing_visible = "true"

prop_sec_<section>_expan
ded

This option is no longer used as of WebEA version 3.0.23.1690 (included in Pro
Cloud Server 3.0.23). Property sections are no longer displayed as
expandable/collapsible panels.

Defines whether or not a property section is expanded by default when the model is
opened.

The property view includes numerous sections that can be optionally expanded or
collapsed; these options set the default values for the model.

<section> can be one of:

info·

location·

instances·

relationships·

taggedvalues·

testing·

resourcealloc·

attributes·
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operations·

runstates·

changes·

defects·

issues·

tasks·

events·

decisions·

efforts·

risks·

metrics·

Options:     true or false

Default:    false for all sections except 'info' and 'location', which are true

Example:     prop_sec_testing_expanded = "true"

default_diagram Defines the GUID of the diagram that should be automatically loaded when users
log onto the model. If this option is not defined or an empty value is specified,
WebEA assumes that no diagram should be loaded and displays the model root
instead. The GUID of any diagram can be obtained from WebEA by loading the
diagram properties.

Note: The entire GUID (including {}) must be used.

Example:     default_diagram = "{C89E174A-19B0-47c7-B4A8-8A98071CD838}"

default_main_layout Defines the default layout of container items for the current model. WebEA can
display child items of a container in one of three layouts. Either "icon" view (the
default), "notes" view (resembling the Enterprise Architect Specification Manager
view) or "list" view.

Options:     icon, notes or list

Default:        icon

Example:     default_main_layout = "icon"

object_order Defines the order of objects in the 'Browser' and 'Object List' views. There are three
different ordering behaviors, represented by values 1,2, and 3.

"1" = Alphabetical - Objects are sorted alphabetically (by name)·

"2" = Free Sort - Objects are sorted based on their 'Set Position' (manual·
sorting which is applied in Enterprise Architect), then alphabetically; this
reflects Enterprise Architect's sorting when the 'Allow Free Sorting' option is
enabled

"3" = Object Type - Objects are sorted by type, then set position, then·
alphabetically; this reflects Enterprise Architect's sorting when the 'Allow Free
Sorting' option is disabled

Options:     1, 2 or 3

Default:        3

Example:     object_order = "2"

Note: Regardless of the 'object_order' setting, WebEA displays diagrams, then
Packages, then elements; the 'object_order' applies to the items within each of these
groupings

favorites_as_home When set to "true", the WebEA 'Home' page will display the user's 'Favorites'
Packages in the 'Browser' or 'Package' view. This is loaded when first accessing the

(c) Sparx Systems 2019 Page 244 of 654 Created with Enterprise Architect



Model Repository - Model Repository 20 January, 2020

model, and also when using WebEA's Home button.

The Browser's Up button is also hidden, helping to keep navigation within the
Favorites Package(s).

Options:     true or false

Default:    true

Example:     favorites_as_home = "false"

Notes:

When set to true, this overrides the 'default_diagram' setting·

Favorites are defined using Enterprise Architect; refer to the link in the See·
Also column for details

If a user has no Favorites defined then the Model Root or Default diagram (if·
one is defined) will be loaded instead

show_browser Defines the default visibility of the 'Browser'.

Options:     true or false

Default:        true

Example:     show_browser = "false"

Notes:

If a user selects the 'Mobile' option when logging in to WebEA then this·
overrides the 'show_browser' option and the 'Browser' will be hidden

This behavior can be overridden, depending on the screen resolution; for·
example, on a low resolution screen such as a mobile phone, the 'Browser' will
be hidden regardless of the 'show_browser' option setting

show_propertiesview Defines the default visibility of the 'Properties View'.

Options:     true or false

Default:        true

Example:     show_propertiesview = "false"

Notes:

If a user selects the 'Mobile' or 'Tablet' option when logging in to WebEA, this·
overrides the 'show_propertiesview' option and the Properties View will be
hidden

This behavior could be overridden depending on the screen resolution; for·
example, on a low resolution screen such as a mobile phone, the Properties
View will be hidden regardless of the 'show_propertiesview' option setting

show_path_button Defines the visibility of the Object Path button. When set to true, the button is
available in WebEA's Navigation Bar. The Object Path button is used to display a
list of Packages and Objects from the current Object up to the Model Root.

Options:     true or false

Default:    true

Example:     show_path_button = "false"

Setting this option to "false" can help in keeping WebEA focused on a specific area
of your model, especially when used in conjunction with 'favorites_as_home =
"true"'.

Model update settings
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This group of settings determine what insert/edit options are available to WebEA users.

Note: Within the Pro Cloud Server it is possible to configure a model as 'Read-only'; this setting in the Pro Cloud Server
will override any WebEA update setting, forcing them to have the value "false".

Option Description

add_discuss Defines whether or not new discussions on Packages and elements can be added to
the model. Note: This option is forced to "false" if 'show_discuss' has been set to
"false".

Options:    true or false

Default:    false

Example:     add_discuss = "true"

add_objects Defines whether or not new objects can be added to the model.

Note: This option will be internally set and restricted to "false" for Pro Cloud
Server Express installations.

Options:     true or false

Default:    false

Example:     add_objects = "true"

add_diagrams Defines whether or not new diagrams can be added to the model.

Note: this option will be internally set and restricted to "false" for Pro Cloud Server
Express installations.

Options:     true or false

Default:    false

Example:     add_diagrams = "true"

add_objecttype_<type> Defines whether or not elements of the given object type can be added to the model.

These options are forced to "false" if 'add_objects' has been set to "false".

The value of <type> can be one of:

package·

review·

actor·

change·

component·

feature·

issue·

node·

requirement·

task·

usecase·

Options:     true or false

Default:    false

Example:     add_objecttype_actor = "true"

add_object_features Defines whether or not element features can be added to the model.

Note: this option will be internally set and restricted to "false" for Pro Cloud Server
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Express installations.

Options:     true or false

Default:    false

Example:     add_object_features = "true"

add_objectfeature_<type> Defines whether or not element features of the given type can be added to the
model.

These options are forced to "false"  if 'add_object_features' has been set to "false".

The value of <type> can be one of:

tests·

resources·

features·

changes·

documents·

defects·

issues·

tasks·

risks·

Options:     true or false

Default:    false

Examples:     add_objectfeature_changes = "true"

edit_objectfeature_resource
s

Defines whether or not the details of element resource allocations can be edited in
the model.

Note: this option will be internally set and restricted to "false" for Pro Cloud Server
Express installations.

Options:     true or false

Default:    false

Example:     edit_objectfeature_resources = "true"

edit_objectfeature_tests Defines whether or not the details of element tests can be edited in the model.

Note: this option will be internally set and restricted to "false" for Pro Cloud Server
Express installations.

Options:     true or false

Default:    false

Example:     edit_objectfeature_tests = "true"

Model watchlist settings

The watchlist functionality allows users to quickly see a wide variety of objects that have changed recently in the model.
WebEA users can configure their personal preferences to control what sort of objects they are interested in 'watching'.

All watchlist settings are prefixed by 'wl_' and represent the default value for the model. However, once a user saves
their own watchlist settings the model defaults will no longer be used.

In order to persist the watchlist preferences across sessions, WebEA saves them in a browser cookie. If the user's browser
does not allow the saving of cookies, personal watchlist settings can not be persisted across sessions.
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Option Description

cookie_retention Defines the period over which a WebEA user's set of watchlist options are stored.
The value is the number of days that the cookies will be retained for.

Options:    any positive integer value

Default:    365

Example:      cookie_retention = "180"

wl_period Defines the default activity period of the model watchlist. The value is a number of
days; for example, look for activity in the last 10 days.

Options:    any positive integer value

Default:    0

Example :    wl_period = "10"

wl_recent_discuss Define whether or not the watchlist should display a count of elements that have
had discussions during the activity period.

Options:     true or false

Default:    false

wl_recent_reviews Define whether or not the watchlist should display a count of review elements that
have been added or modified during the activity period.

Options:     true or false

Default:    false

wl_recent_diagram Define whether or not the watchlist should display a count of the diagrams that
have been added/modified during the activity period.

Options:     true or false

Default:    false

wl_recent_element Define whether or not the watchlist should display a count of the elements that have
been added/modified during the activity period.

Options:     true or false

Default:    false

wl_resalloc_active Define whether or not the watchlist should display a count of elements with active
resource allocations during the activity period.

Options:     true or false

Default:    false

wl_resalloc_today Define whether or not the watchlist should display a count of elements with
resource allocations ending during the activity period.

Options:     true or false

Default:    false

wl_resalloc_overdue Define whether or not the watchlist should display a count of elements with
resource allocations that fall overdue during the activity period.

Options:     true or false

Default:    false

Define whether or not the watchlist should display a count of elements with tests
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wl_test_recentpass that passed during the activity period.

Options:     true or false

Default:    false

wl_test_recentfail Define whether or not the watchlist should display a count of elements with tests
that failed during the activity period.

Options:     true or false

Default:    false

wl_test_recentdefer Define whether or not the watchlist should display a count of elements with tests
that were deferred during the activity period.

Options:     true or false

Default:    false

wl_test_recentnotchk Define whether or not the watchlist should display a count of elements with tests
that were not checked during the activity period.

Options:     true or false

Default:    false

wl_test_notrun Define whether or not the watchlist should display a count of elements with tests
that were not run during the activity period.

Options:     true or false

Default:    false

wl_feature_verified Define whether or not the watchlist should display a count of elements with verified
features during the activity period.

Options:     true or false

Default:    false

wl_feature_requested Define whether or not the watchlist should display a count of elements with
requested features during the activity period.

Options:     true or false

Default:    false

wl_feature_completed Define whether or not the watchlist should display a count of elements with
features completed during the activity period.

Options:     true or false

Default:    false

wl_feature_new Define whether or not the watchlist should display a count of elements with new
features added during the activity period.

Options:     true or false

Default:    false

wl_feature_incomplete Define whether or not the watchlist should display a count of elements with
incomplete features during the activity period.

Options:     true or false

Default:    false

Define whether or not the watchlist should display a count of elements with verified
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wl_change_verified changes during the activity period.

Options:     true or false

Default:    false

wl_change_requested Define whether or not the watchlist should display a count of elements with
requested changes during the activity period.

Options:     true or false

Default:    false

wl_change_completed Define whether or not the watchlist should display a count of elements with
changes completed during the activity period.

Options:     true or false

Default:    false

wl_change_new Define whether or not the watchlist should display a count of elements with new
changes added during the activity period.

Options:     true or false

Default:    false

wl_change_incomplete Define whether or not the watchlist should display a count of elements with
incomplete changes during the activity period.

Options:     true or false

Default:    false

wl_document_verified Define whether or not the watchlist should display a count of elements with verified
documents during the activity period.

Options:     true or false

Default:    false

wl_document_requested Define whether or not the watchlist should display a count of elements with
requested documents during the activity period.

Options:     true or false

Default:    false

wl_document_completed Define whether or not the watchlist should display a count of elements with
documents completed during the activity period.

Options:     true or false

Default:    false

wl_document_new Define whether or not the watchlist should display a count of elements with new
documents added during the activity period.

Options:     true or false

Default:    false

wl_document_incomplete Define whether or not the watchlist should display a count of elements with
incomplete documents during the activity period.

Options:     true or false

Default:    false

Define whether or not the watchlist should display a count of elements with verified
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wl_defect_verified defects during the activity period.

Options:     true or false

Default:    false

wl_defect_requested Define whether or not the watchlist should display a count of elements with defects
reported or 'requested' during the activity period.

Options:     true or false

Default:    false

wl_defect_completed Define whether or not the watchlist should display a count of elements with defects
completed during the activity period.

Options:     true or false

Default:    false

wl_defect_new Define whether or not the watchlist should display a count of elements with defects
added during the activity period.

Options:     true or false

Default:    false

wl_defect_incomplete Define whether or not the watchlist should display a count of elements with
incomplete defects during the activity period.

Options:     true or false

Default:    false

wl_issue_verified Define whether or not the watchlist should display a count of elements with verified
issues during the activity period.

Options:     true or false

Default:    false

wl_issue_requested Define whether or not the watchlist should display a count of elements with issues
reported or 'requested' during the activity period.

Options:     true or false

Default:    false

wl_issue_completed Define whether or not the watchlist should display a count of elements with issues
completed during the activity period.

Options:     true or false

Default:    false

wl_issue_new Define whether or not the watchlist should display a count of elements with issues
added during the activity period.

Options:     true or false

Default:    false

wl_issue_incomplete Define whether or not the watchlist should display a count of elements with
incomplete issues during the activity period.

Options:     true or false

Default:    false

Define whether or not the Watchlist should display a count of elements with
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wl_task_verified verified tasks during the activity period.

Options:     true or false

Default:    false

wl_task_requested Define whether or not the watchlist should display a count of elements with
requested tasks during the activity period.

Options:     true or false

Default:    false

wl_task_completed Define whether or not the watchlist should display a count of elements with tasks
completed during the activity period.

Options:     true or false

Default:    false

wl_task_new Define whether or not the watchlist should display a count of elements with tasks
added during the activity period.

Options:     true or false

Default:    false

wl_task_incomplete Define whether or not the watchlist should display a count of elements with
incomplete tasks during the activity period.

Options:     true or false

Default:    false

wl_event_requested Define whether or not the watchlist should display a count of elements with
requested events during the activity period.

Options:     true or false

Default:    false

wl_event_high Define whether or not the watchlist should display a count of elements with events
set to high during the activity period.

Options:     true or false

Default:    false

wl_event_incomplete Define whether or not the watchlist should display a count of elements with
incomplete events.

Options:     true or false

Default:    false

wl_decision_verified Define whether or not the watchlist should display a count of elements with verified
decisions during the activity period.

Options:     true or false

Default:    false

wl_decision_requested Define whether or not the watchlist should display a count of elements with
requested decisions during the activity period.

Options:     true or false

Default:    false

Define whether or not the watchlist should display a count of elements with

(c) Sparx Systems 2019 Page 252 of 654 Created with Enterprise Architect



Model Repository - Model Repository 20 January, 2020

wl_decison_completed decisions completed during the activity period.

Options:     true or false

Default:    false

wl_decision_new Define whether or not the watchlist should display a count of elements with
decisions added during the activity period.

Options:     true or false

Default:    false

wl_decision_incomplete Define whether or not the watchlist should display a count of elements with
incomplete decisions during the activity period.

Options:     true or false

Default:    false
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How to configure WebEA Localization

The physical text values of all labels and messages within WebEA are defined in a single file that is read when the web
pages are being built. This allows WebEA customers to tailor the content of web pages displayed to their users.

WebEA's default language is English. As pages are built on the server, the WebEA application will check whether there
is a defined localization for a string and use that. If a localized version of the string is not defined then WebEA will use
the default English value.

The WebEA localization definitions are saved in the file 'webea_strings.ini' in the '\includes\' folder. The localization file
is saved in plain text format with each localized string being defined on a separate line with the syntax:

   {default_english_string} = "{localized_string}"

Note that:

Localized string values are enclosed by double quotes·

The configuration file supports comments; the semi-colon character starts a comment·

The supplied 'webea_strings.ini' file includes a definition of all strings used within the WebEA application, therefore·
there is no need to add any new lines to the file

For example, on the login page the first label is "Select Model" in the English version; however, a French user would
want to change this text to:

    Select Model = "Sélectionnez le modèle"

Replacements

The wording of some labels/messages within WebEA requires the names of items to be added to the string displayed.
Such replacements are denoted by the %s placeholder. The localized versions of these strings should also include the %s
placeholder in the appropriate position.

The other standard replacement that WebEA supports is the replacement of  %NN% with a number. For example, in the
Watchlist when WebEA detects that elements have been modified recently, this message is used:

    %NN% recently modified element%S% = "%NN% recently modified element%S%"

%NN% will be replaced with a count of recently modified elements.

Plurals

Given the nature of the English language, some of the localized strings support the ability to display words in their plural
form. WebEA supports the special substitution of %S% which will replace, %S% with 's' when the supplied number is
greater than 1.  Using our example, when a single element has been modified recently the message displayed on the
watchlist page is:

    1 recently modified element

However, when there are five recently modified elements, WebEA would generate the message:

    5 recently modified elements
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Advanced SSL - Adding Trust to a Self-Signed Certificate

A self-signed SSL certificate can be signed with your own Certificate Authority (CA). This allows trust to be added to
clients to avoid security warnings. The instructions for adding a CA to a client vary by operating system or browser used.

See Add Trust with a Certificate Authority (CA) for instructions on generating a CA and using it to sign server
certificates.

WebEA uses PHP and cURL to communicate with a Pro Cloud Server. To enable PHP/curl to trust a new CA:

Add/edit 'curl.cainfo' in php.ini to point to either a single root CA certificate or a CA bundle file (this is multiple·
concatenated crt files)

[curl]
; A default value for the CURLOPT_CAINFO option. This is required to be an
; absolute path.
curl.cainfo="C:\xampp\php\MyCompanyCA.crt"

Restart Apache/PHP·
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Single Sign-On (SSO) with WebEA

As with Enterprise Architect, WebEA can make use of these Single Sign-On systems:

Windows authentication with Active Directory·

OpenID·

The ability to use Single Sign-On for WebEA is based on the configuration of the Enterprise Architect model itself.

Steps

Step Description

1 Using Enterprise Architect, configure the model to use Single Sign-On.

2 Using Enterprise Architect, confirm that the model can be accessed via Single Sign-On.

3 If you intend to use OpenID, ensure that your OpenID server configuration includes the WebEA
login_sso.php page as a valid redirect/callback URI.

For example:

     http://myserver/webea/login_sso.php

Or (if the OpenID provider supports wildcards):

     http://myserver/webea/*

4 If you have not already done so, configure WebEA to access the model.

No WebEA configuration options are required specifically for Single Sign-On (WebEA will detect that
Single Sign-On is enabled in the model).

5 Login to the model via WebEA.

The WebEA login screen will provide Login with OpenID and/or Login with Windows ID buttons,
allowing you to log in via Single Sign-On.
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Web Browser Considerations

Single Sign-On support can vary depending on the Web Browser being used to access WebEA.

WebEA's Windows Authentication makes use of the NTML authentication protocol. Web Browsers typically require
some configuration to make use of NTLM authentication. For example, see:

     https://www.websense.com/content/support/library/web/hosted/iseries_deploy/ntlm_firefox.aspx

As with Enterprise Architect, for OpenID support an OpenID server must be configured and accessible by your Web
Browser.

The OpenID server must support the 'OpenID Connect' standard and should be able to return a unique user identifier in
the 'user_info' request. This user identifier will be matched to a local model user.
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WebEA User Guide

Sparx System's WebEA is an external interface to Enterprise Architect models through which users can review and
comment on a model, in real time via the web, on a range of mobile devices or a remote work station, without needing to
install Enterprise Architect. The reviewer can be anywhere in the world and does not need to be in an office, just
somewhere where internet access is available. WebEA is ideal for stakeholders and clients to see the work in which they
are invested, and to comment on and discuss aspects of the model.

WebEA models can be configured to allow users to update element notes, add element features (such as tests and
resource allocations) and even create Project Management elements (to record issues, changes and similar), or Use
Cases, Requirements and system components.

WebEA is the interface to the model, so although you are using your web browser, the data shown is the same as that
shown when you use Enterprise Architect. This means that all model updates occur in real time, so WebEA users can be
confident that they are seeing the latest version of the model structure.

How to Open WebEA

Open the web browser on your device and, in the address bar, type in the complete WebEA URL. Press the Enter key or
tap the Go key.

These are some examples of the complete URL that might be needed to open WebEA.

      https://demo.sparxpublic.com

In the case where the web server has the IP of 11.22.33.44 and has been configured to use the non-standard Port of 800,
the complete URL would be:

      https://11.22.33.44:800

If the WebEA application files were placed in a sub-folder called 'WebEA' under the web server's root folder, then the
complete URL would be:

      http://11.22.33.44:800/WebEA/

If the entered URL is a valid, the WebEA Login page displays, which will show all the models that are available.
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Login

WebEA websites are configured to allow access to one or more Enterprise Architect models, each of which can be
configured independently to only grant access to users with valid logon credentials. WebEA user validation supports two
forms of security: 1) an access code and 2) standard Enterprise Architect model security. These two validation methods
can be used independently or in combination in each model.

Prerequisites

Users of WebEA will need to be advised of their login credentials for each model, which will include:

An access code, or·

A user ID and password, or·

Possibly all three·

This data will be provided to you by your Web Administrator or by the Project Manager responsible for the model.

Logging In

The first page that is displayed in WebEA is the 'Login' page, which lists the models available to you.

Select the model you want to open, then click or tap on either the Mobile button, Tablet button or Desktop button. The
button selected determines whether the Browser View and Properties View will be enabled by default.

If access to your model requires only an access code, then the 'Login' page prompts you for this.

Note:

The red asterisk (*) denotes a mandatory field·

Access Codes are not required for Windows Authentication or OpenID authentication·
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If User Security has been applied to the model, the 'Login' page prompts you for your user ID and password.

If the model requires both an access code and a user id/password, the 'Login' page prompts for both together:
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Single Sign On

This feature is available from Enterprise Architect Release 14.1 and Pro Cloud Server Release 3.0 build 23.

If the Enterprise Architect model has been configured for Windows and/or OpenID authentication then the 'Login' page
will show the relevant single sign-on Login with OpenID button or Login with Windows ID button.  Clicking the Login
with OpenID button will redirect the user to the 'OpenID Server Authentication' page. After authenticating with OpenID
the browser will automatically return to WebEA and log the user in.

If the user is already authenticated with OpenID, the OpenID website might not be displayed, and the user will simply be
logged in.

If the model is configured to also allow manual login then both the single sign on buttons and manual login fields will be
visible on the 'Login' page. If the option 'Restrict access to Windows & OpenID users only' is checked then the manual
login fields will not be available.

See:

Single Sign-On (SSO) Options·
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If you do not have the authorization data, click or tap on the Back button to go back and select another model.

Otherwise, type in your access code and/or user ID and password, and click on the Login button.
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WebEA's layout

Having logged on to a model in WebEA, depending on how the model has been configured and the resolution of the
Browser/Device, WebEA will typically display the model root node/s in either the Browser (on the left), or in the main
content area.

Alternatively, if the WebEA model connection has been configured with a default diagram, then the diagram will be
displayed.

From this point you can start navigating the model by selecting objects or links, review the organization and contents of
the model elements, and read and add to discussions or reviews of particular structures.

Note: WebEA only supports single click when using a PC, or single touch when using a touch-enabled device.

This image shows the WebEA screen after loading the example model, when no default diagram has been configured.

The next image shows the WebEA screen after loading the example model, when a default diagram has been configured.

The WebEA view can be broken into four sections - heading, Navigation bar, content area and Status bar.
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Note: In order to support small screen devices, some layout sections move or merge with others to minimize the amount
of screen real estate needed. For example, the heading section merges with the Navigation bar when the screen height
goes below 400 pixels.

Heading

WebEA's heading area displays the application logo in the top left corner, the name of the currently opened model, a
search icon and a 'Hamburger' icon. The search and 'Hamburger' icons contain further options that are accessible when
selected.

Search

The search icon provides access to the search functionality offered by WebEA. The functionality includes a number of
standard searches, and the custom search.

Optionally, this button can be hidden using the 'Show Search' configuration option. See the How to configure WebEA 
models Help topic for details.

Icon Description

Goto item
Select to display the 'Goto WebEA item' dialog, into which you paste (Ctrl+V) a
WebEA item's unique ID that you have copied earlier, using the 'Object Link'
option in the 'Hamburger' menu (see the Hamburger table in this topic). Click on
the Go button to load the details of the specified object.

Reviews
Select to display a list of all recently modified Review elements.

Note: The number of days that are considered 'recent' is defined as a configuration
option for the model.

Discussions
Select to display a list of all elements to which a Discussion item has been recently
added.

Diagrams
Select to display a list of all recently modified diagrams.

Elements
Select to display a list of all recently modified elements (new Discussion items are
not regarded as modifications to the element).

Custom search
Select to display the 'Custom Search' dialog. WebEA provides a facility that
enables you to search through the model for a specific item or group of items that
have certain characteristics.

Hamburger
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The 'Hamburger' icon provides access to these options:

Icon Description

Object Link
Select to display the 'Link to WebEA item' dialog, which shows the current object's
unique ID and full URL. You can highlight the ID and press Ctrl+C to copy it, then
at a later point use it in the 'Goto WebEA item' dialog to return directly to that page,
as described in the Search table.

Alternatively, you can copy the full URL and send it to another user if you want
them look at a particular item.

Note: This option is only supported when displaying a specific object (diagram,
element or Package). It is not supported for the Watchlist, Matrix, or similar
facilities.

Watchlist
Select to display the 'Watchlist summary'. The Watchlist facility in WebEA helps
you to quickly identify recent activity in the model.

Optionally, this menu item can be hidden using the 'Show Watchlist' configuration
option. See the How to configure WebEA models Help topic for details.

Matrix
Select to display the 'Matrix Profiles' page, which helps you to select any matrix
profile defined in the model and display the associated Relationship Matrix.

Logout
Choose this option if you want to disconnect from the current model. After the
logout process has run, the 'Login' dialog automatically displays.

Navigation Bar

The Navigation bar provides information and buttons that assist in navigating an Enterprise Architect model.

Icon Description

Home
Click on this button to return focus to the 'home' object for the current model. The
home object is either the model's default diagram (if defined in the configuration
file) or the model root Package.

Object Path
Click on this button to display the complete path of parent nodes, Views, Packages
and elements for the current object, all the way to the model's root node.

You can click on any item in the list (except for the last one, which is the current
object) and navigate directly to that object.

Note:

When viewing the root node there will be only one entry, which is not·
selectable

Optionally, this button can be hidden using the 'Show Path Button'·
configuration option

Refresh
Click on this button to refresh the current view. For example, if you are currently
viewing a diagram and a user in Enterprise Architect has made changes to it since
you opened it, simply click the Refresh button; WebEA will display the newly
updated diagram.

Current object

(c) Sparx Systems 2019 Page 266 of 654 Created with Enterprise Architect

http://www.sparxsystems.com/enterprise_architect_user_guide/15.1/model_repository/webea_howtoconfig.html


Model Repository - Model Repository 20 January, 2020

This is a read-only text field that displays the name and object type (displayed as an
image) of the current object.

Properties
This option is only accessible when the screen is less than 800 pixels in width.

When viewing a diagram or the contents of a Package, this button can be used to
view the properties of the diagram/Package itself.

When using a screen that is more than 800 pixels wide, you can access the
properties of a diagram/Package by displaying the Properties View, using the
Properties button in the Status bar (see the Status bar section for details).

Content Area

WebEA's content area adjusts and adapts to display a custom layout for the currently selected item, depending on its
type. For example, when a diagram is selected the content area consists entirely of the diagram image, but when a
Package is selected the content area displays a view of child objects in that Package.

See the Content Area section later in this guide for more details.

Status bar

The WebEA Status bar is displayed at the very bottom of the page; it provides these options and information.

Icon Description

Browser
Click this button to hide/show the 'Browser' view on the left side of the main
content area.  This area will contain the currently selected object and a list of all of
its child objects. Between the object name and the name of the first child object is a

 icon; clicking on this icon refreshes the display to show the next-highest
level of the hierarchy.

Note: This option is disabled when the screen is less than 800 pixels in width.

Properties
Click this button to hide/show the 'Properties View' on the right side of the main
content area.

When viewing a diagram the Properties View allows you to access properties of an
element without navigating away from the diagram.

When viewing an element, the Properties View allows you to have a split view of
the element's properties, displaying one feature in the Main View while also
showing another in the Properties View (for example, you could add Discussions in
the Main View while referring to the element's notes in the Properties View).

Note: By enabling this option, links in the Diagram View are changed to populate
the Properties View instead of navigating to the selected object. It is important to
realize that selecting objects in the Diagram View while the Properties View is
displayed will not affect the navigation history, so you can select as many objects
as you need in the current view and see their properties without navigating away
from the current diagram.

Note: This option is only accessible when the screen is more than 800 pixels in
width.

About
Click on this button to display the 'About WebEA' screen. The 'About...' screen
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provides information regarding the version of WebEA, Pro Cloud Server, and
OSLC, as well as license and model information.

Review element
If you have joined a review, the name of the Review element will display in the
Status bar on the left side of the Properties button. Click on the name to display the
Review element in WebEA's Main View.

iOS Scrolling
When accessing WebEA via iPad or iPhone, the status bar will display 'iPad
Diagram Scrolling: Off' or 'iPhone Diagram Scrolling: Off' respectively. Touch this
text to toggle the option on and off.

Typically, images can be scrolled on mobile devices by touching/dragging on the
image; however, iOS browsers will not scroll if you are touching a clickable area
(such as an element on a diagram). This could make scrolling difficult on diagrams
that are densely populated with clickable elements.

iPad/iPhone Diagram Scrolling: On - Diagram elements will not be selectable,·
allowing you to scroll by touching/dragging anywhere on the diagram

iPad/iPhone Diagram Scrolling: Off - Diagram elements will be selectable;·
however, to drag the diagram image you will need to ensure you are not
touching a selectable element
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Content Area

The main content area of WebEA consists of:

The Main View in the center, used for displaying such things as diagrams and element properties·

Optionally, the Browser on the left, used to assist in navigating the model·

Optionally, the Properties View on the right, which allows you to view properties of an element while·
simultaneously viewing something else (such as a diagram) in the Main View

Details

View Description

Main View The Main View typically displays these types of content:

A diagram image·

The properties of an element·

A list of objects that are contained in a specific Package (or objects that are·
children of a specific element); this object list is only accessible when the
'Browser' is not displayed (as the 'Browser' functions as an alternative)

Browser The Browser assists with navigation, and provides context for the object that is
currently displayed in the Main View

Properties View The Properties View displays properties of a selected object. When viewing a
diagram, it allows you to view some properties of an element without navigating
away from the diagram.
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Main View - Object List

In the Main View, in the Object List, the child objects of a container are represented in one of three viewing styles: Icon,
List or Notes view.

It is possible to define a default viewing style for a model in the configuration file. However, you can also change the
style via the icons in the upper right of the Object List.

Icon View

In Icon view, each object is represented by an image and an object name. As an example, a root node with the name
'ASA Finance' would be represented by:

A View object with the name 'Class Model' would be represented by:

List View

In List view, each object is represented as a row in a table, which includes columns for name, type, author and modified
date. The two examples would be represented in List view as shown:

Notes View

In Notes view each object is represented by the object name and any text from the object's 'Notes' field.

Display Order
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In the Object List, objects are displayed in the predefined order: Packages, diagrams and elements; if there are multiples
of any object type then they will be sorted in alphabetical order. This is different to Enterprise Architect's behavior,
which can allow elements to be manually ordered.

As an example:

Additional Symbols

While navigating the model structure with WebEA you might see a number of symbols applied to the object images.

Each symbol has a meaning; for example, the  symbol indicates that the object contains children, whilst the 
symbol indicates the object is locked to the current user.

The action taken when an item is selected is dependent on the object type of the item.

For Packages, the default action is to navigate down one level of the Browser window and display the child objects·
contained within that Package

For diagrams the default action is to open the diagram image·

For elements the default action is to display the properties for the selected element·

To view the properties of a Package while viewing it in the Object List, click on the   button in the status bar to
display the Properties View. Alternatively, on lower resolution screens (less than 800 pixels wide), where the Properties

View is not available, you can click on the  button to view the Package's properties.

If you navigate to a Package that does not have children, the message 'No child element(s)' will be displayed.

Adding New Elements

If the model has been configured to allow the addition of elements and the current user has the required permissions, the

 icon will be shown as the last element of a Package's Object List. For more details see the Object Creation in
WebEA Help topic.

Notes

WebEA's WebEA - Browser acts as an alternative to the Object List; if the WebEA Browser is displayed then the·
Object List is not accessible
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Main View - Diagram

When a diagram is selected, the Main View content area displays the entire diagram as a single image.  As an example,
this is the Pro Cloud Server diagram in the EAExample model:

Objects on the diagram are selectable and, based on the object type and if the 'Properties View' is visible, will behave
slightly differently.

The behavior when the 'Properties View' is not visible:

Packages: opens the selected Package in the Object List mode·

Diagrams: opens the selected diagram image·

Elements: opens the selected element in the Main View·

Hyperlinks to external URLs: navigates away from WebEA and loads the external URL·

The behavior when the 'Properties View' is visible:

Packages: main properties are displayed in the 'Properties View'·

Diagrams: main properties are displayed in the 'Properties View'·

Elements: main properties are displayed in the 'Properties View'·

Hyperlinks: navigate to link target·

Notes

To view the properties of a diagram either display the Properties View, or (when using a screen width less than 800·

pixels) click on the  button in the Navigation bar
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Main View - Object Properties

When you select an element in WebEA, its properties are displayed either in the Main View, or in the Properties View (if
it is currently open). If the properties are displayed in the Properties View (to the right side of WebEA's Main View) then
you can click on the Full Properties button to start to explore more of the element's properties in the WebEA Main View.

The property display in the Main View consists of a section at the top with common element properties, followed by a
row of feature buttons (such as Notes and Relationships) which can be used to access specific features. By default the
Notes are already displayed.

Common Properties

The common properties section displays an image representing the object's type, and its name, type and stereotype. This
is followed by general information about the object, such as the status, version and phase, the time and date created and
last modified, and the author.

Note: The Properties View can also be enabled and displayed alongside the property display in the Main View. In this
case the author, version, and other general characteristics will only be displayed in the Properties View.
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If the model has been configured to allow it, there will be an element 'Hamburger' icon that allows the creation of·
object features; see the Object Creation in WebEA Help topic for further details

If the element has a regular Linked Document applied, a line with 'Linked Document' and an Open button will be·
displayed immediately under the object's name and type fields; clicking on the Open button will display the contents
of the Linked Document

If the element has an encrypted Linked Document applied, in addition to the 'Linked Document' label and Open·
button a password text box displays; if you enter the correct password and click or tap on the Open button the
contents of the encrypted document will be displayed

If the element has a stored document applied, a Download button (along with the label 'Stored Document') will be·
displayed; clicking on the Download button will save the document to your machine where you can use the
appropriate application to view it

If the element has an image asset applied, a Download button (along with the label 'Image Asset') will be displayed;·
clicking on the Download button will save the image to your machine where you can use the appropriate application
to view it

If you are viewing the properties of a diagram then a 'Generated' field will be displayed. This shows the date/time·
when the diagram image was saved, followed by a button which can be used to flag the diagram to be 're-generated'
by the EA Worker application. See the How to configure automatic viewable components topic for details.

Selectable Features

Below the common properties a number of buttons are displayed that allow you to view other existing features of the
object, including location, Tagged Values, attributes and operations. By default, the element Notes will be selected and
displayed.

To the right of the feature buttons is a filter button.

Click this button to toggle between the display modes:

Single - In this mode, clicking on a feature button will display only that feature type, such as Notes or Tagged·
Values

All - In this mode, all the element's features are displayed on the page, one after the other; clicking a feature button·
will scroll down (if necessary) so that the section for that feature is visible

These buttons are available to display the corresponding features:

Notes: the notes of the current object·

Location: information relating to the current object's parent, any diagrams that the element appears on, and a list of·
instances that the element is a classifier of

Tagged Values: a list of defined Tagged Values for the current object·

Relationships: a list of incoming and outgoing connections for the current object; clicking on the connector type will·
display the connector's properties

Attributes: a list of all defined attributes for the current object·

Operations: a list of all defined operations for the current object·

Files: a list of Associated Files that have been defined for the current object·

Requirements: a list of all defined internal requirements (responsibilities) for the current object·

Constraints: a list of all defined constraints for the current object·

Scenarios: a list of all defined scenarios for the current object·

Tests: a list of all defined tests for the current object; selecting a test from the list will display more information - if·
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you have the required permissions and the model has been configured correctly, clicking or tapping the pencil icon
will allow you to edit the details of the selected test

Resources: a list of all defined Resource Allocations for the current object; selecting a resource from the list will·
display more information - if you have the required permissions and the model has been configured correctly,
clicking or tapping the 'Pencil' icon will allow you to edit the details of the selected resource allocation

Features: a list of all defined 'feature' maintenance items for the current object; selecting a change from the list will·
display more information

Changes: a list of all defined 'change' maintenance items for the current object; selecting a change from the list will·
display more information

Documents: a list of all defined 'document' maintenance items for the current object; selecting a document from the·
list will display more information

Defects: a list of all defined  'defect' maintenance items for the current object; selecting a defect from the list will·
display more information

Issues: a list of all defined 'issue' maintenance items for the current object; selecting an issue from the list will·
display more information

Tasks: a list of all defined 'task' maintenance items for the current object; selecting a task from the list will display·
more information

Events: a list of all defined events for the current object; selecting an event from the list will display more·
information

Decisions: a list of all defined decisions for the current object; selecting a decision from the list will display more·
information

Effort: a list of all defined effort items for the current object·

Risks: a list of all defined risks for the current object·

Metrics: a list of all defined metrics for the current object·

Discussions: a list of all formal review discussions and informal discussions on the element; if the current model has·
been configured to allow it, you can contribute to discussions on the current object - for further information on these
facilities, see the Reviews in WebEA and Discussions in WebEA Help topics

Opening Associated Files from WebEA

If an element has Associated Files defined, the file paths will be listed as hyperlinks in the 'Files' section.

For security reasons, web browsers typically will not allow local files to be opened directly via a hyperlink on a web
page. In some cases the browser can be configured to allow this.

For example, for FireFox, see:

     http://kb.mozillazine.org/Firefox_:_Issues_:_Links_to_Local_Pages_Don%27t_Work

At the end of each file path is a 'Copy to Clipboard' icon. This can be used to easily copy and paste the path (for example,
into Windows Explorer) and open the file.
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WebEA - Browser

The WebEA Browser displays a context sensitive view of a Package or element and its children. It can be enabled via the
'Browser' option in the main 'Hamburger' menu, which is located in the upper right corner of WebEA. When enabled, the
Browser displays on the left side of WebEA's Main View.

If the currently-selected object is a Package, or an element with children, then the Browser displays the object at the
parent level, and the children below it.

If the currently-selected object is a diagram or an element without children, then the Browser displays the object's parent,
then its children (which include the current object and its siblings).

If the currently selected object is not the root, then the second item in the Browser is an up arrow, allowing navigation to
the next level up. Selecting an object in the Browser will cause WebEA to navigate to that object.

Favorites in the WebEA Browser

WebEA Model connections can be configured to treat the user's 'Favorites' as the Home page (via the 'favorites_as_home'
configuration option); see the Refine Browser Content and How to configure WebEA models Help topics for details.

In this case the Browser behavior is changed to help focus on Favorites Packages.

When initially opening the model, the Browser will display your Favorites·

Selecting a Package from the Favorites list will update the Browser to display the contents of that Package; to help·
keep the focus on the contents of the Favorites, the Browser will not include the Up arrow to go to the Package's
parent - when navigating down through nested Packages you can simply use the Web Browser's Back function to
return to the previous page (i.e. the parent)

You can return to the list of Favorites using WebEA's Home button·
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Notes

The Browser panel is only visible if the screen is greater than 800 pixels wide·

The Browser acts as an alternative to viewing the object list in WebEA's Main View; when the Browser is enabled·
the Main View Object List is not accessible
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WebEA - Properties View

The WebEA Properties View displays a context sensitive view of a diagram, Package or element's properties. It can be
enabled via the 'Properties' option in the main 'Hamburger' menu, which is located in the upper right corner of WebEA.
When enabled, the Properties View displays on the right side of WebEA's Main View.

The Properties View displays the principle property details of the object currently selected in the main content area, these
being the name, type, notes, creation and modification dates, version and location details.

By default, the Properties View will also display the element Notes; however, you can select a different feature to display
in this location by using the 'Select Feature' Hamburger menu (to the right of the 'Notes' heading).

The main purpose of the Properties View is to allow users to quickly and easily see details of elements without
navigating away from a diagram.

The Properties View  is also displayed while viewing the Full Properties of an object in WebEA's Main View. This
allows you to access one feature of the element (such as Notes) in the Properties View while also accessing another (such
as Discussions) in the Main View.

Navigation Buttons

When appropriate, the Properties View will also include navigation buttons that allow you to either display the object's
full properties in WebEA's Main View, or view the element/Package's children.

Button Description

(c) Sparx Systems 2019 Page 278 of 654 Created with Enterprise Architect



Model Repository - Model Repository 20 January, 2020

This can be used to navigate to the object, showing its full properties in the Main
View.

If you have selected a Package or an element with children, and the 'Browser' is not
currently enabled, then an additional icon is displayed. This allows you to view the
object's children in the Object List/Icon view.

Navigation Element Behavior

Within Enterprise Architect it is possible to define a number of different element types that make it easier to navigate
your model (such as Hyperlinks or Navigation Cells). By default, selecting one of these objects in WebEA will navigate
directly to the target (instead of displaying its properties in the Properties View).

If necessary, you can change this behavior by setting the 'miniprops_navigates' option in the 'Configure WebEA models - 
via Text Editor' file to "false".

Notes

The Properties View is only visible if the screen is greater than 800 pixels wide·

Selecting elements on a diagram while the Properties View is shown will not affect the browsing history·
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Object Creation in WebEA

Depending on how the current model has been configured in the WebEA configuration file, and on your security access
to the model, you might have the ability to create a range of objects in the model through WebEA. These objects include
Packages and diagrams; elements such as Use Cases, Requirements, Components, Changes and Issues; and features of
elements such as Tests, Decisions, Defects and Events. You can therefore define additional scope or problems that have
arisen, directly in the model, with precision and in detail, adding to the accuracy and quality of the solution that the
model represents.

The Project Manager responsible for the model should guide you in how to create objects and in the purpose of you
doing so.

In addition to adding new elements you might also be able to edit the Notes of any object regardless of type, and the
details of element Tests and Resource Allocations for any element in the model, whether you have created it or not. See
the Edit Objects Help topic.

Adding Objects

You can quickly establish if you have the ability to create objects in WebEA by checking the WebEA - Browser or the
Main View - Object List.

If you are able to create objects then the final item in the list will be a '<new>' button.

For example:

Click on this button to display the 'Add Object' page.

Field Description
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Element type Click on the drop-down arrow and select the type of object to create. Depending on
your security permissions and the model's options, you can create some or all of
these objects:

Package·

Diagram·

Review·

Actor·

Change·

Component·

Feature·

Issue·

Node·

Requirement·

Task·

Use Case·

Technology This is an optional field that is only visible when 'Diagram' is selected as the
element type.  It allows the selection of a Technology that provides an additional
set of diagram types.

Diagram Type This is an optional field that is only visible when 'Diagram' is selected as the
element type. Click on the drop-down arrow and select the type of diagram to
create.

Name Type in an appropriate name for the object, preferably giving some indication of its
purpose or function.

Notes Type in a more detailed description of the element, such as why you are creating it
and what other elements it might be associated with.

You can format this text using the facilities provided in the Notes toolbar. These
are:

Bold·

Italic·

Underline·

Numbered list·

Bulleted list·

Superscript text·

Subscript text·

Color of selected text·

Add Click on this button to add the new object to the Package in which you are creating
it. This message displays:

     Object added

Either:

Work through the fields again, defining another new object in this Package, or·

Click on the  icon and select the Package line to return to the 'Hierarchy'·
view of the Package, now containing the new element
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Adding Element Features

You can, again, quickly establish if you have the ability to create element features in WebEA, by displaying the

Properties of an element in WebEA's Main View - Object Properties; if the  icon displays in the right corner of the
element name/notes panel, you can add element features.

Display the Properties of the element to which you want to add a feature, and click on the  icon. A menu displays
offering options to add to the element each feature that you have the access permissions to create. These features might
include:

Other Objects·

Tests·

Resources·

Features·

Changes·

Documents·

Defects·

Issues·

Tasks, or·

Risks·

Select the appropriate option; a dialog displays in which you complete the fields to define the feature for the element.
Each type of feature has a different dialog; refer to these topics for the details appropriate to each dialog.

Add Test Records·

Add Resource Records·

Add a Feature·

Add Change Requests·

Add a Document·

Add a Defect·

Add an Issue Notification·

Add a Task·

Add a Risk·

Notes

As suggested in the Adding Element Features section, you can also add an object to a Package or to another object·
within the Main View's 'Object Properties' page; click on the 'Hamburger' icon and select the 'Add Object' option,
and complete the 'Add Object' page as described at the start of this topic

When using the security 'Lock to Edit' mode, features and child elements can only be created if the element has been·
locked by the current user (via Enterprise Architect); users require 'Lock Elements' permission to release or set locks
on a diagram element

(c) Sparx Systems 2019 Page 282 of 654 Created with Enterprise Architect

http://www.sparxsystems.com/enterprise_architect_user_guide/15.1/content_property.html


Model Repository - Model Repository 20 January, 2020

Add Test Records

Within an element, you can create a record for each Test that you want to add to the element.

Add a Test

Display the properties of the element to which you want to add the Test record, and click on the  icon. A menu
displays offering options to add various features to the element. Select the 'Add Test' option. The 'Add Test to <element
name>' dialog displays.

Mandatory fields on the dialog are indicated by a red asterisk (*).

Complete the fields as directed here.

Field Action

Test name Type an appropriate and meaningful name for the Test.
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Class Type Click on the drop-down arrow and select the appropriate test group; that is:

Unit·

Integration·

System·

Acceptance·

Scenario, or·

Inspection·

Type Click on the drop-down arrow and select the appropriate test type; that is:

Load·

Regression or·

Standard·

Status Click on the drop-down arrow and select the appropriate test status; that is:

Not Run (the most likely value for a new record from you)·

Pass·

Fail·

Deferred or·

Cancelled·

Run by If the test has been run, click on the drop-down arrow and select the name of the
person who ran it.

Last Run If the test has been run, click on the calendar icon and select the date on which the
test was most recently run.

Checked by If the test has been run, click on the drop-down arrow and select the name of the
person who checked the test execution and results.

Description Type in a description of the test, what it is intended to show and why it is
necessary.

You can format this text using the facilities provided in the Notes toolbar. These
are:

Bold·

Italic·

Underline·

Numbered list·

Bulleted list·

Superscript text·

Subscript text·

Set color of selected text·

Input Type a description of what actions or parameters are required as input to this test.

You can format this text using the facilities provided in the Notes toolbar.

Acceptance Criteria Type a description of what criteria must be satisfied to indicate that the test has
passed.
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You can format this text using the facilities provided in the Notes toolbar.

Results Type a description of the expected and/or actual results of this test.

You can format this text using the facilities provided in the Notes toolbar.

Add Click on this button to submit the details and create the Test record on the selected
element.

This message is displayed:

     Test <name> was successfully added to <element name>.

Either:

Work through the fields again, defining another new Test on this element, or·

Click on the browser's Back button to return to the 'Properties' view of the·
element, which will be refreshed to show the new record in the 'Testing' panel
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Add Resource Records

Within an element, you can create a record for each Resource that you want to add to the element.

Add a Resource

Display the properties of the element to which you want to add the Resource record, and click on the  icon. A menu
displays offering options to add various features to the element. Select the 'Add resource' option. The 'Add resource
allocation to <element name>' dialog displays.

Mandatory fields on the dialog are indicated by a red asterisk (*).

Complete the fields as directed here.

Field Action

Resource Click on the drop-down arrow and select the name of the person to be allocated as
the resource.

Role Click on the drop-down arrow and select the role of the resource in this work; for
example:

Application Analyst·

Business Analyst·

C++ Programmer  or·

Project Manager·

Start date Click on the calendar icon and select the date on which the resource is expected to
start the assigned work.

End date Click on the calendar icon and select the date on which the resource is expected to
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complete the assigned work.

% Complete Click on the up and down arrows to change the field value to the percentage
completion of work that the resource has achieved.

Description Type in a description of the resource allocation - what the work is, why this (kind
of) resource is required to do it, and any criteria that must be satisfied.

You can format this text using the facilities provided in the Notes toolbar. These
are:

Bold·

Italic·

Underline·

Numbered list·

Bulleted list·

Superscript text·

Subscript text·

Set color of selected text·

Add Click on this button to submit the details and create the Resource Allocation record
on the selected element.

This message is displayed:

     Resource allocation for <name> was successfully added to <element name>

Either:

Work through the fields again, defining another new Resource Allocation on·
this element, or

Click on the Browser's Back button to return to the 'Properties' view of the·
element, which will be refreshed to show the new record in the 'Resource
Allocation' panel
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Add a Feature

Within an element, you can create a record for each 'feature' maintenance item that you want to add to the element.

Add a Feature

Display the properties of the element to which you want to add the feature, and click on the  icon. Select the 'Add
feature' option. The 'Add feature to <element name>' dialog displays.

Mandatory fields on the dialog are indicated by a red asterisk (*).

Complete the fields as directed here.

Field Action

Name Type an appropriate and meaningful name for the feature.

Status Click on the drop-down arrow and select the appropriate record status; that is:

New·

Verified, or·

Complete·
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Priority Click on the drop-down arrow and select the appropriate priority value; that is:

High·

Medium, or·

Low·

Requested by Click on the drop-down arrow and select the name of the person requesting the
feature.

Requested on Click on the calendar icon and select the date on which the record was made.

Completed by If the feature has been completed/added, click on the drop-down arrow and select
the name of the person who complete it.

Completed on Click on the calendar icon and select the date on which the feature was
completed/added.

Version Type in a version number or letter to indicate any evolution of the same feature.
Generally, '1.0' indicates the first instance of a feature.

Description Type in a description of the feature. You can format this text using the facilities
provided in the Notes toolbar. These are:

Bold·

Italic·

Underline·

Numbered list·

Bulleted list·

Superscript text·

Subscript text·

Set color of selected text·

History Over time, enter any notes on the actions concerning this feature; you can format
this text using the facilities provided in the Notes toolbar.

Add Click on this button to submit the details and create the feature record on the
selected element.

This message is displayed:

     Feature <name> was successfully added to <element name>.

Either:

Work through the fields again, defining another feature on this element, or·

Click on the browser's Back button to return to the 'Properties' view of the·
element, which will be refreshed to show the new record in the 'Features' panel
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Add Change Requests

Within an element, you can create a record for each Change Request that you want to add to the element.

Add a Change Request

Display the properties of the element to which you want to add the Change Request, and click on the  icon. A menu
displays offering options to add various features to the element.  Select the 'Add change' option. The 'Add change to
<element name>' dialog displays.

Mandatory fields on the dialog are indicated by a red asterisk (*).

Complete the fields as directed here.

Field Action

Name Type an appropriate and meaningful name for the requested change.

Status Click on the drop-down arrow and select the appropriate request status; that is:

New·

Verified, or·

Complete·
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Priority Click on the drop-down arrow and select the appropriate priority value; that is:

High·

Medium, or·

Low·

Requested by Click on the drop-down arrow and select the name of the person requesting the
change.

Requested on Click on the calendar icon and select the date on which the request was made.

Completed by If the change has been completed, click on the drop-down arrow and select the
name of the person who completed it.

Completed on Click on the calendar icon and select the date on which the requested change was
completed.

Version Type in a version number or letter to indicate any evolution of the same change.
Generally, '1.0' indicates the first instance of a change.

Description Type in a description of the change, what it is intended to be and why it is
necessary.

You can format this text using the facilities provided in the Notes toolbar. These
are:

Bold·

Italic·

Underline·

Numbered list·

Bulleted list·

Superscript text·

Subscript text·

Set color of selected text·

History If there is any background to this change, such as previous versions, document them
here (you might copy the 'Description' from the last version or iteration of this
change, for example). It is recommended that you include a date stamp and user
initials in the entry.

You can format this text using the facilities provided in the Notes toolbar.

Add Click on this button to submit the details and create the change request on the
selected element.

This message is displayed:

     Change <name> was successfully added to <element name>.

Either:

Work through the fields again, defining another new change request on this·
element, or

Click on the browser's Back button to return to the 'Properties' view of the·
element, which will be refreshed to show the new record in the 'Changes' panel
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Add a Document

Within an element, you can create a record for each document maintenance item that you want to add to the element. A
document could be used to record supporting documentation such as Help, release notes or user comments.

Add a Document

Display the properties of the element to which you want to add the document, and click on the  icon. Select the 'Add
document' option. The 'Add document to <element name>' dialog displays.

Mandatory fields on the dialog are indicated by a red asterisk (*).

Complete the fields as directed here.

Field Action

Name Type an appropriate and meaningful name for the document.

Status Click on the drop-down arrow and select the appropriate record status; that is:

New·

Verified, or·

Complete·
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Priority Click on the drop-down arrow and select the appropriate priority value; that is:

High·

Medium, or·

Low·

Requested by Click on the drop-down arrow and select the name of the person who requested the
document.

Requested on Click on the calendar icon and select the date on which the record was made.

Completed by If the document is complete, click on the drop-down arrow and select the name of
the person who completed it.

Completed on Click on the calendar icon and select the date on which the document was
completed.

Version Type in a version number or letter to indicate any evolution of the same document.
Generally, '1.0' indicates the first instance of a document.

Description Type in the details/contents of the document. You can format this text using the
facilities provided in the Notes toolbar. These are:

Bold·

Italic·

Underline·

Numbered list·

Bulleted list·

Superscript text·

Subscript text·

Set color of selected text·

History Over time, enter any notes on the actions concerning this document; you can format
this text using the facilities provided in the Notes toolbar.

Add Click on this button to submit the details and create the document record on the
selected element.

This message is displayed:

     Document <name> was successfully added to <element name>.

Either:

Work through the fields again, defining another document on this element, or·

Click on the browser's Back button to return to the 'Properties' view of the·
element, which will be refreshed to show the new record in the 'Documents'
panel
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Add a Defect

Within an element, you can create a record for each defect that you want to report on the element.

Add a Defect Record

Display the properties of the element to which you want to add the defect record, and click on the  icon. A menu
displays offering options to add various features to the element.  Select the 'Add defect' option. The 'Add defect to
<element name>' dialog displays.

Mandatory fields on the dialog are indicated by a red asterisk (*).

Complete the fields as directed here.

Field Action

Name Type an appropriate and meaningful name for the defect.

Status Click on the drop-down arrow and select the appropriate record status; that is:

New·

Verified, or·

Complete·
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Priority Click on the drop-down arrow and select the appropriate priority value; that is:

High·

Medium, or·

Low·

Reported by Click on the drop-down arrow and select the name of the person reporting the
defect.

Reported on Click on the calendar icon and select the date on which the record was made.

Resolved by If the defect has been resolved, click on the drop-down arrow and select the name
of the person who resolved it.

Resolved on Click on the calendar icon and select the date on which the recorded defect was
fixed.

Version Type in a version number or letter to indicate any evolution of the same defect.
Generally, '1.0' indicates the first instance of a defect.

Description Type in a description of the defect, what it is, what the solution might be, and why
it is a problem.

You can format this text using the facilities provided in the Notes toolbar. These
are:

Bold·

Italic·

Underline·

Numbered list·

Bulleted list·

Superscript text·

Subscript text·

Set color of selected text·

History If there is any background to this defect, such as previous occurrences, document
them here (you might copy the 'Description' from the last version or iteration of this
defect record, for example). It is recommended that you include a date stamp and
user initials in the entry.

You can format this text using the facilities provided in the Notes toolbar.

Add Click on this button to submit the details and create the defect record on the
selected element.

This message is displayed:

     Defect <name> was successfully added to <element name>.

Either:

Work through the fields again, defining another new defect record on this·
element, or

Click on the browser's Back button to return to the 'Properties' view of the·
element, which will be refreshed to show the new record in the 'Defects' panel
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Add an Issue Notification

Within an element, you can create a record for each issue notification that you want to add to the element.

Add an Issue

Display the properties of the element to which you want to add the issue notification, and click on the  icon. A menu
displays offering options to add various features to the element.  Select the 'Add issue' option. The 'Add issue to
<element name>' dialog displays.

Mandatory fields on the dialog are indicated by a red asterisk (*).

Complete the fields as directed here.

Field Action

Name Type an appropriate and meaningful name for the reported issue.

Status Click on the drop-down arrow and select the appropriate issue status; that is:

New·

Verified, or·

Complete·

(c) Sparx Systems 2019 Page 296 of 654 Created with Enterprise Architect



Model Repository - Model Repository 20 January, 2020

Priority Defaults to 'High'. If necessary, click on the drop-down arrow and select the
appropriate priority value; that is:

Medium, or·

Low·

Raised by Defaults to the first name in the list of project users. If necessary, click on the
drop-down arrow and select the name of the person raising the issue.

Raised on Defaults to today's date. If necessary, click on the calendar icon and select the
actual date on which the issue was raised.

Completed by If the issue has been resolved, click on the drop-down arrow and select the name of
the person who resolved it.

Completed on Click on the calendar icon and select the date on which the issue was resolved.

Version Type in a version number or letter to indicate any evolution of the same issue.
Defaults to '1.0', indicating the first instance of an issue.

Description Type in a description of the issue, what it is, what the solution might be, and why it
is a problem.

You can format this text using the facilities provided in the Notes toolbar. These
are:

Bold·

Italic·

Underline·

Numbered list·

Bulleted list·

Superscript text·

Subscript text·

Set color of selected text·

History If there is any background to this issue, such as previous occurrences, document
them here (you might copy the 'Description' from the last version or iteration of this
issue, for example). It is recommended that you include a date stamp and user
initials in the entry.

You can format this text using the facilities provided in the Notes toolbar.

Add Click on this button to submit the details and create the issue report on the selected
element.

This message is displayed:

     Issue <name> was successfully added to <element name>.

Either:

Work through the fields again, defining another new issue on this element, or·

Click on the browser's Back button to return to the 'Properties' view of the·
element, which will be refreshed to show the new record in the 'Issues' panel
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Add a Task

Within an element, you can create a record for each task that you want to add to the element.

Add a Task Record

Display the properties of the element to which you want to add the task record, and click on the  icon. A menu
displays offering options to add various features to the element.  Select the 'Add task' option. The 'Add task to <element
name>' dialog displays.

Mandatory fields on the dialog are indicated by a red asterisk (*).

Complete the fields as directed here.

Field Action

Name Type an appropriate and meaningful name for the new task.

Status Click on the drop-down arrow and select the appropriate task status; that is:

New·

Verified, or·

Complete·
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Priority Defaults to 'High'. If necessary, click on the drop-down arrow and select the
appropriate priority value; that is:

Medium, or·

Low·

Requested by Click on the drop-down arrow and select the name of the person requesting the
task. This defaults to the name selected for the previous record.

Requested on Defaults to today's date. If necessary, click on the calendar icon and select the
correct date on which the request was made.

Completed by If the task has been completed, click on the drop-down arrow and select the name
of the person who completed it.

Completed on Click on the calendar icon and select the date on which the task was completed.

Version Type in a version number or letter to indicate any evolution of the same task.
Defaults to '1.0', indicating the first instance of a task.

Description Type in a description of the task, what it is, what the objective might be, and why it
is required.

You can format this text using the facilities provided in the Notes toolbar. These
are:

Bold·

Italic·

Underline·

Numbered list·

Bulleted list·

Superscript text·

Subscript text·

Set color of selected text·

History If there is any background to this task, such as previous occurrences, document
them here (you might copy the 'Description' from the last version or iteration of this
task, for example). It is recommended that you include a date stamp and user
initials in the entry.

You can format this text using the facilities provided in the Notes toolbar.

Add Click on this button to submit the details and create the task record on the selected
element.

This message is displayed:

     Task <name> was successfully added to <element name>.

Either:

Work through the fields again, defining another new task request on this·
element, or

Click on the browser's Back button to return to the 'Properties' view of the·
element, which will be refreshed to show the new record in the 'Tasks' panel
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Add a Risk

A Risk is a condition that could cause the disruption, loss or compromise of a system. It can refer to either technical or
business risks.

Within an element, you can create a record for each risk that you want to record against the element.

Add a Risk Record

Display the properties of the element to which you want to add the risk record, and click on the  icon. A menu
displays offering options to add various features to the element.  Select the 'Add risk' option. The 'Add risk to <element
name>' dialog displays.

Mandatory fields on the dialog are indicated by a red asterisk (*).

Complete the fields as directed here.

Field Action

Name Type an appropriate and meaningful name for the new risk.

Type Type in the risk type.

Weight Defaults to 1. Click on the up and down arrows to set a different weighting on the
risk. There is no limit to the value that you can set, but within Enterprise Architect
the usual value is a small number between, say, 1.0 (normal) and 5.0 (heavily
weighted).

Description Type in a description of the risk, what it is and what the mitigation might be.

You can format this text using the facilities provided in the Notes toolbar. These
are:

Bold·

Italic·
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Underline·

Numbered list·

Bulleted list·

Superscript text·

Subscript text·

Set color of selected text·

Add Click on this button to submit the details and create the risk record on the selected
element.

This message is displayed:

    Risk <name> was successfully added to <element name>.

Either:

Work through the fields again, defining another new risk on this element, or·

Click on the browser's Back button to return to the 'Properties' view of the·
element, which will be refreshed to show the new record in the 'Risks' panel
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Edit Objects

Within any model in which you have the security permissions to create elements, you can also edit the Notes, Resource
Allocation and Testing details of any object in which they occur.

Firstly, display the property (either the Notes, or a specific Test/Resource item) that you want to edit in WebEA's Main 
View - Object Properties.

On the right of the item field for these three properties you will see a  icon, which indicates that you have the ability
to edit that property.

Edit Notes

To edit the notes of an object, click on the  icon for the field. The 'Edit note for <object type>' page displays.

You can add, delete and change text, and use the formatting tools in the Notes toolbar; that is, for a selected text string,
add:

Bold·

Italic·

Underline·

Numbered List·

Bulleted List·

Superscript·

Subscript·

Text color·

The final two toolbar buttons allow you to add or remove a hyperlink from some selected text.

To add a hyperlink:

Select the text in the editor.1.
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Click on the Add Hyperlink button.2.

Enter the URL for the hyperlink.3.

Click on the Apply button.4.

To remove a hyperlink:

Select the text.1.

Click on the Remove Hyperlink button.2.

Note: This function supports hyperlinks to Web URLs only.

You can also right-click on the selected text and select options from the browser context menu to:

Undo the last change·

Move (cut) the text string into the buffer for pasting·

Copy the text string into the buffer for pasting·

Paste text from the buffer into the 'Notes' field·

Delete the selected text·

Select all the text in the 'Notes' field·

Search for the selected text string on the internet·

Turn spell-checking on and off (if on, possibly misspelt text is underlined in red)·

Add a different language dictionary to check spelling against (this would probably have been done already for your·
web browser)

When you have finished editing the text, click on the Save button. A confirmation message briefly displays and you are
returned to the object 'Properties' view.

Edit Tests

The tests assigned to an element support a range of situations including user acceptance and scenario. You could be
asked to define or perform tests on parts of a model of relevance to you as a customer or user, or you might want to add
information obtained from other people you have asked to perform an evaluation. Therefore, you might need to edit test
records to update them with your information.

To edit a test record, display the appropriate element in WebEA's Main View, click on the Tests button and select the
appropriate test from the list.

Once the test is displayed click on the  icon. The 'Edit Test for <element name>' page displays.
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Edit Test for <<element name>> page

Mandatory fields on the dialog are indicated by a red asterisk (*).

Complete the fields as directed here.

Field Action

Test name If necessary, type a new name for the Test.

Class type In necessary, click on the drop-down arrow and select a different test group for the
test; that is:

Unit·

Integration·

System·

Acceptance·

Scenario, or·

Inspection·

Type If necessary, click on the drop-down arrow and select a new test type; that is:

Load·
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Regression, or·

Standard·

Status If necessary, click on the drop-down arrow and select a new test status; that is:

Not Run·

Pass·

Fail·

Deferred, or·

Cancelled·

Run by If the test has been run, click on the drop-down arrow and select the name of the
person who ran it.

Last Run If the test has been run, click on the calendar icon and select the date on which the
test was most recently run.

Checked by If the test has been run, click on the drop-down arrow and select the name of the
person who checked the test execution and results.

Description Type in a description of the test, what it was intended to show and - if the test has
been run - what the test situation and results were.

You can format this text using the facilities provided in the Notes toolbar, as
described in the Edit Notes section.

Input Type a description of what actions or parameters are or were required as input to
this test.

You can format this text using the facilities provided in the Notes toolbar, as
described in the Edit Notes section.

Acceptance Criteria Type a description of what criteria must be or were satisfied to indicate that the test
has passed.

You can format this text using the facilities provided in the Notes toolbar.

Results Type a description of the expected and/or actual results of this test.

You can format this text using the facilities provided in the Notes toolbar.

Save Click on this button to submit the details and update the Test record on the selected
element.

A confirmation message briefly displays and you are returned to the object
'Properties' view

Edit Resource Allocation

The resources allocated to an element can include reviewers in various roles, and you might be allocated as a resource
yourself. Alternatively, you could have allocated another person as a reviewer. Therefore, you might need to edit a
resource allocation to record either your own progress in a review, or the progress of the resource you have allocated.

To edit the resource allocation, display the appropriate element in WebEA's Main View, click on the Resources button
and select the appropriate resource from the list.
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Once the resource is displayed, click on the  icon. The 'Edit resource allocation for <element name>' page displays.

Edit Resource Allocation for <element name> page

Notice that this page has a few more fields than the initial 'Add resource allocation ...' page.

Mandatory fields on the dialog are indicated by a red asterisk (*).

Complete the fields as directed here.

Field Action

Resource If necessary, click on the drop-down arrow and select the name of a different person
to be allocated as the resource.

Role If necessary, click on the drop-down arrow and select a different role for the
resource in this work.

Start Date If necessary, click on the calendar icon and select a different date on which the
resource started or is expected to start the assigned work.

End Date If necessary, click on the calendar icon and select a different date on which the
resource completed or is expected to complete the assigned work.

% Complete Click on the up and down arrows to change the field value to the percentage
completion of work that the resource has achieved.

Expected Type in the number of whole time units the task is expected to take. The value must
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be an integer; you cannot record part units.

The unit of time you use will be identified by the Project Manager, and depends on
the granularity of the work being recorded. Most tasks are completed in a number
of hours or a number of days; use the smallest practical unit that you can record as a
whole number, and use the same units for the expected, allocated and actual times.

Allocated Type in the number of whole time units the task can be spread over. For example,
you might expect the task to take 2 days of work performed at any point over a
period of 5 days.

Actual If the task is 100% complete, type in the number of whole time units it actually
took.

Description If necessary, edit the description of the resource allocation, perhaps to explain the
changes you have made to earlier fields.

You can format this text using the facilities provided in the Notes toolbar, as
explained in the Edit Notes section.

Before changing the text, you might want to copy it to paste into the 'History' field
for editing there.

History Optionally, paste or type in an explanation of what has previously taken place with
this Resource Allocation. You can also format this text, using the facilities in the
Notes toolbar.

Save Click on this button to submit the details and update the Resource Allocation record
on the selected element.

A confirmation message briefly displays and you are returned to the object
'Properties' view.
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Reviews in WebEA

Review elements are a convenient way for groups of users to collaboratively discuss one or more model objects and
capture those discussions as a formal review. A Review element is a custom element that captures all discussions that
you participate in over a period of time. That period begins when you select to 'join' the review, and ends either when
you select to leave the review, or when you log out of the current model. You can also return to the review in a
subsequent work session and your continuing discussions are also captured. The Review element would typically have a
start and end date set to define the duration of the review.

When a Review element is created, a child diagram is also created, automatically. Both Enterprise Architect and WebEA
consider any element added to this diagram as requiring comment during the Review. When the properties of the Review
element are loaded in WebEA the 'Objects in Review' section will contain a list of all elements that have already been
commented on or have been added to the Review diagram. This list provides a convenient way to quickly navigate to
each element in the Review.

When the properties of a Review element are loaded in WebEA's Main View, the default feature that is displayed is a
'Review Summary'. This includes the status, start and end dates, number of elements discussed and yet to be discussed,
and a breakdown of review topics based on priority and status, as illustrated here:

The 'Review Summary' is followed by the 'Review Diagrams' and 'Objects in Review' sections.
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The 'Review Diagrams' section provides links to the diagrams that are associated with the review (i.e. those that are
children of the Review element).

The 'Objects in Review' section displays a list of elements to be discussed during the review. Elements that have not yet
been discussed are presented first in the list, followed by elements that have been commented on, showing each review
topic. The name of the object acts as a hyperlink to that object.

Locating Reviews

There are a number of ways in which to locate existing Review elements to join, or to switch to your active review (the
review that you have already joined).

To check on recent Review elements available in the model, click on the 'Search' icon in the WebEA header and select
the 'Reviews' option. This conducts a search for recent Review elements and lists them in the 'Search Results' view, with
the most recently changed element at the top of the list.

You can click on the name of a Review in the list to load the details of the selected Review element, and then join or
leave the Review as appropriate.

The name of your active Review is displayed in the WebEA's Status bar, and you can click on the name (in the Status
bar) to load the details of the active Review element.

Join a Review
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While the property details of a Review element are loaded, the Join Review button will be enabled.

Clicking on this button will join you to the review and link your discussions to the Review element. The display will
automatically be adjusted to the change of state. These changes include:

The addition of the joined Review element's name to the status bar·

The 'Review' section filtering elements to the current Review element only·

The 'Discussion' section's update/add actions being disabled·

The Join Review button being disabled, and the Leave Review button being enabled·

The Join Review button might be disabled, for these reasons:

You are already joined to a review on a different Review element·

The loaded Review is closed·

The Join Review button and Leave Review button are only visible on Review elements when the 'participate_in_review'
configuration option is set to "true" for the current model. See the How to configure WebEA models Help topic for more
information.

Add topics to a Review

When you have opened and read through the contents of a Review element, you can add your own review topics or
respond to existing points. To do this you click on the name of the object you want to comment on, then select the
'Discussions' feature button.

Note: Whilst you are joined to a review, the contents of the panel are filtered to show only the review comments for that
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review.

Add a review topic

To create a review topic on a new point, simply type into the 'Create Review Topic' field. When you have finished typing
your message, submit it by clicking on this button:

Note: WebEA does not support editing (or deleting) review comments, therefore you should take care to type messages
clearly the first time, and double-check before submitting.

Depending on how the WebEA model is configured, you might connect to it using your personal user ID, or via a single
generic User that is shared by multiple people.  In the second case, Sparx Systems recommends that each user identifies
themselves in each message, either at the beginning or at the end.

Whilst you are adding comments to a review, at any point you can return to a posted topic and add or change its status
and priority. To the right of the review topic text are two icons. The first is the 'Status' icon, and the second is the
'Priority' icon. The appearance of the icons depends on the current setting for status and priority. To set a status or
priority, simply click on the appropriate icon and select from the listed options. These are:

Status·

Priority·

Add a reply to a comment

If you want to respond to either a review topic or a reply to that topic, click or tap on the appropriate message. A blank
field and button underneath the conversation thread will appear; type in your message and click or tap on this button:

Your reply is added to the end of the thread.

Note: Currently the review threads are only read from the model when the page is loaded, which means if other users
make additional comments they will not be displayed until the page is reloaded or refreshed.

Review another element

Click on the name of the Review element in the 'Reviews' panel or in the page footer, to display the Properties view for
that review element. Select another element in the review from the list.

Leave the current Review

When you have finished contributing to the review, you can either return to the Review element Properties view and
click on the Leave Review button, or log out of the current model.
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The Leave Review button will only be enabled when the details of the currently joined Review element are loaded.

Creating a Review

Typically, only a Project Manager will create Review elements in Enterprise Architect, notifying the relevant users of
their location so that each user can join and leave the review(s) as necessary.

However, a WebEA user might create a Review element as a direction to the Project Manager to set up. In this case you
create the Review element by clicking on the 'New' icon in the Package hierarchy view, selecting 'Review' as the element
type. The procedure is as described in the Object Creation in WebEA Help topic.

You require specific access permissions to create a Review element; those permissions are totally separate from the
permission to join a review.
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Discussions in WebEA

Enterprise Architect has a Discussion facility through which users can post short messages in informal discussions with
other users, on a specific element or Package. As a WebEA user, if the model has been configured to allow Discussions
to be viewed and added, you can also read and participate in these Discussions. The facility is very useful in informal
reviews, as you can comment or respond immediately on a specific point as you come across it, without having to collate
a list of comments and compose a relatively long document or email, or schedule a telephone call.

To access Discussions, when viewing the properties of an object in WebEA's Main View, select the Discussions feature
button.

Note that if you are joined to a formal review, you can read existing Discussion points but you cannot respond to them or
add new topics.

The input area shows as a blank field and a 'Discussion' button to save the entered text; if there has already been some
discussion on the element, the comments of each Discussion display above the input field.

There are two types of discussion message - an initial message (usually called a Discussion) and replies. Replies are
responses to an initial message, and are displayed as child items.

Avatars

In Enterprise Architect there is an application option for the current users that controls if avatars of security users are
displayed with each Discussion item. In WebEA this option is defined for a model in the configuration file; see the
option use_avatars.

When a model has been configured to 'use avatars' and the model has security enabled, then instead of displaying generic
blue speech bubbles the author's avatar is displayed, as shown here:

Starting a Discussion

To start a Discussion on a new point, simply start typing in the blank field. If you want to have separate paragraphs, press
the Enter key to start each new line.
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When you have finished typing your message, submit it by clicking on this button:

Note: WebEA does not support editing (or deleting) Discussions, therefore you should take care to type messages clearly
the first time, and double-check before submitting.

Depending on how the WebEA model is configured, you might connect to it using your personal user ID, or as a single
generic User that is shared by multiple people ('Web User' in the first illustration). In the second case, Sparx Systems
recommends that each user identifies themselves in each message, either at the beginning or at the end.

Replying to a discussion

If you are reading an existing Discussion and want to respond to either the opening point or a reply to that point, click or
tap on the appropriate message. A blank field and button underneath the conversation thread will display; type in your
message and click or tap on this button:

Your reply is added to the end of the thread.

Note: Currently the Discussion threads are only read from the model when the page is loaded, which means if other users
make additional comments they will not be displayed until the page is reloaded or refreshed.

Status and Priority

If you are adding comments to a Discussion, at any point you can return to a posted topic or reply and add or change its
status and priority.

To the right of the Discussion text are two icons. The first is the 'Status' icon, and the second is the 'Priority' icon. The
appearance of the icons depends on the current setting for status and priority. To set a 'Status' or 'Priority', simply click
on the appropriate icon and select from the listed options. These are:

Status·

Priority·

Notes

As a WebEA user you cannot delete Discussions or replies; however they can be deleted using Enterprise Architect·
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Create and Check Watchlists

The Watchlist facility in WebEA helps you to quickly identify recent activity in the model. Each user can tailor their
Watchlist to monitor activity in any of a wide range of objects and features with various characteristics. Whenever the
Watchlist Summary is generated, all object types of interest are checked for recent activity and a count of matched
objects displayed. All matched object counts can be clicked on to display the list of objects that match the particular
activity type.

Note: Each model has a default set of activity types that have been enabled in the WebEA configuration file; each user
can override the model defaults and save their customized settings.

Watchlist Summary

You can select the Watchlist facility by selecting the 'Watchlist' option found under the main Hamburger  icon.
This immediately displays the 'Watchlist summary' view that shows:

Any activity that has recently been detected, for·

All objects and features that are to be monitored·

If there is no activity for a configured activity type, that activity type is omitted from the 'Watchlist Summary'. The
display might look like this:

Every type of object on the report is represented by a line providing the number of objects that match the given criteria.
The number of objects is a link that, if you click or tap it, displays a results page listing the specific objects that match
the given criteria.
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The 'Watchlist results' page is the same as the custom search results page, in that if you then click or tap on an individual
item in the list, the 'Properties' view will be displayed for the selected object. See the WebEA's Layout Help topic.

If you have finished checking the 'Watchlist summary', you can click on the OK button to return to the WebEA view you
were displaying previously.

Alternatively, you can tailor the Watchlist to provide information relevant to you; see Configure the Watchlist.

Configure the Watchlist

If you want to customize the activity types monitored in your Watchlist summary, click or tap the configure button 
located in the Watchlist summary header. The 'Watchlist configuration' page displays.
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In the 'Number of days' field, type the number of days that should be considered. This might be the number of days since
you last used WebEA, or the number of days in a reporting period that you want to compare with.

For the remaining fields, select the checkbox against all items that you want to monitor and include in your Watchlist.
The complete list is:

Recent:·
     -  Discussions
     -  Active reviews
     -  Modified diagrams
     -  Modified elements

Resource Allocations:·
     -  Active
     -  Ending today
     -  Overdue

Tests:·
     -  Recently passed
     -  Recently failed
     -  Recently deferred
     -  Recently not checked
     -  Not run

Changes, Defects, Issues, Tasks and Decisions:·
     -  Verified
     -  Recently requested
     -  Recently completed
     -  New
     -  Incomplete

Events:·
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     -  Recently requested
     -  High Priority
     -  Incomplete

The 'Select All' and 'Deselect All' options can be used to select or deselect  every checkbox.

Once you have finished choosing which items to monitor, click or tap on the Save button to save the configuration and
redisplay the Watchlist summary.

Note:

All Watchlist options are saved based on current model and User ID for the current browser, and stored as cookies·
(where possible) so that the options are remembered between sessions

If your browser does not allow the saving of cookies, then your customized Watchlist setting will only last as long as·
the current session
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Relationship Matrix

The Matrix facility in WebEA enables you to view the Relationship Matrix generated from any Relationship Matrix
Profile that has been defined in the model.

The Relationship Matrix is a spreadsheet display of relationships between model elements within a Package, or between
elements in two different Packages. It is a convenient and simple tool for reporting and working on all the relationships
in a selected structure. The relationships shown can be filtered according to:

The element type of the source and target elements in each relationship·

The relationship type and direction·

The Package(s) in which the source elements and target elements are held·

Those parameters can be defined in a Relationship Matrix profile; to display a matrix in WebEA you select one of the
available profiles.

The matrix shows all the relationships of the specified type between source and target elements by:

Listing the source Package elements down the side of the matrix, as row titles·

Listing the target Package elements across the top of the matrix, as column titles, and·

If a relationship exists between a source and target element, displaying an arrow indicating the direction of the·
relationship, at the intersection of the appropriate row and column

Clicking on a square containing an arrow displays the 'Relationship Properties' screen for the relationship represented by
that arrow. On that screen you can click on the source or target element names and display the 'Element Properties'
screen for those elements.

Access

On the WebEA header, click on the main Hamburger icon   and select the 'Matrix' option. The 'Matrix Profiles'
page displays.

Matrix Profiles

The 'Matrix Profiles' page provides the 'Select Profile' drop-down field that you use to list and select from the matrix
profiles defined within Enterprise Architect.  You cannot add to or edit these profiles.
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When you select a matrix profile, the rest of the fields on the page will be populated with the values defined in the
profile. Click on the View Matrix button to load the relationships selected under the profile, in a Relationship Matrix
grid.

WebEA is only able to load complete matrix profiles; if an incomplete matrix profile is requested, this error message will
be displayed:

If this message is displayed, ask the Project Manager to update the Matrix Profile.

Matrix

This is a sample Relationship Matrix as displayed by WebEA. It is almost identical to what would be displayed in
Enterprise Architect.
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When you click on a relationship arrow - such as, in the example, the 'Manage Titles' to 'REQ019 - Manage Inventory'
arrow - the 'Relationship Properties' screen displays.
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Notes

A Matrix Profile can also be accessed via a Hyperlink or a Matrix Specification Artifact on a diagram·

Matrix Profiles that use a Model Search to populate the source or target elements are not supported in WebEA·
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Search the Model

WebEA provides a facility that enables you to search through the model for a specific item or group of items that have
certain characteristics. This can help you to quickly locate objects of importance, such as elements you have created
yourself (if you have the access privileges to do so).

You access the Search facility by clicking on the 'spyglass' icon in the WebEA header and selecting the 'Custom search'
option.

Search Specification

Define your search using these options.

Option Description

Term Type or paste in the string of characters or digits you want to locate - name, Notes
text or the complete object ID. Be aware that for some DBMSs - such as Firebird or
Oracle - searches are case-sensitive.

Search for Select one of these object types to search:

Diagrams·

Elements·

Packages·

Discussions, or·

Reviews·

If you select 'Discussions', the 'Search in' and 'Term' options are not relevant and so
are grayed out and unavailable. The search is for elements having active
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discussions within the specified time period.

Note: the 'Discussions' option is only available in models that have the
show_discuss parameter set to "true" in the WebEA configuration file. Similarly,
the 'Reviews' option is only available when the participate_in_reviews parameter is
set to "true" in the configuration file.

Search in Select from the list of fields to search:

Name·

Name, Alias and Notes (the proper name, an assigned alternative name, and·
any text written in the object's 'Notes' field)

Author (the person who created the object)·

ID (the GUID of the object, displayed as the last item in the 'Properties' panel·
when you expand it)

When Select the period of time that should be searched. You can select to search for
objects modified:

Today·

Within the last 3 days·

Within the last 7 days·

Within the last 14 days·

Within the last 30 days·

Within the last 12 months·

At any time·

Run Search Click or tap this button to execute the search and locate the objects that meet the
search criteria.

Search Results

When you execute the search the results are displayed in the main content area.
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The results provide the object name, type, author and last-modified date of each object that matches the search criteria. If
you click on an item, the 'Properties' view will be loaded for that object.
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Troubleshooting WebEA

If WebEA users experience a problem, an error message will be displayed on the screen. This topic provides a list of
common WebEA error messages that could occur. Each entry describes the situation that has occurred and provides
guidance on how to correct the error.

WebEA Configuration Test

On initial set up, these steps can be performed to help identify configuration issues:

Step Action

1 On the Web Server machine, open a web browser and test access to the WebEA login page.

E.g. http://localhost/webea/login.php

If this fails, check that the Web Server has been set up as described in the WebEA Installation and
Configuration Help topic.

2 On a client machine test access to the WebEA login page.

E.g. http://<server name>/webea/login.php

If this fails, there is a network/communication issue between the client and the web server.

3 Before attempting to access a model via WebEA, confirm you can successfully open the model using
Enterprise Architect's 'Connect to Cloud' option.

If this fails, refer to the Pro Cloud Server Troubleshooting Help topic.

4 In the webea_config.ini file, add a model connection with the minimum required options, as outlined here.
Ensure these match the settings used when connecting via Enterprise Architect. Note, the 'sscs_db_alias'
should match the value entered in the 'Model Name' field.

sscs_protocol = "<Protocol>"

sscs_server = "<Server Name or IP address>"

sscs_port = "<Port>"

sscs_db_alias = "<Model Name>"

auth_code = ""     ;leave this empty

If the Project has Enterprise Architect User Security enabled then also include:

login_prompt = "true"

If the Protocol being used is HTTPS then also include:

sscs_use_ssl = "true"

If you are using HTTPS with a Self-signed certificate then also include:

sscs_enforce_certs = "false"

5 Try accessing the model in WebEA. If this fails, the error returned by the WebEA login screen might help
identify the cause of the issue.
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WebEA Error Messages

Issue Comments

Server could not be found Server could not be found on the network!

This error usually occurs when WebEA does not receive any kind of response from
the specified server name (or IP number).

Possible reasons:

The server is turned off·

The server is behind a firewall and WebEA is unable to make a connection to it·

Connection refused There was no response from the server, check that Pro Cloud Server is running!

Possible reasons:

Pro Cloud Server is not installed·

Pro Cloud Server is not running·

Pro Cloud Server is not listening on the expected Port·

OSLC not supported The server port is not configured to support OSLC.

Possible reasons:

WebEA communicates with Sparx Systems Pro Cloud Server via OSLC, but·
the defined Sparx Systems Pro Cloud Server has been configured to not allow
OSLC requests for this Port

Using the Pro Cloud Server Configuration Client, check the configuration for the
Port that you are using to access this model. Ensure the 'OSLC Supported' option is
enabled.

Protocol Mismatch Protocol and Port mismatch. Check that the correct protocol and port have been
configured.

Possible reasons:

There is a mismatch between the connection settings; for example,·
'sscs_use_ssl' has been set to "true" but a protocol of HTTP was specified

Incorrect login details The specified login details were not valid for the current model!

Possible reasons:

The supplied user ID and password combination did not match any user·
credentials defined in the model

Connection timed out Request Error: Connection timed out after 5001 milliseconds.

Possible reasons:

Invalid Pro Cloud Server settings (sscs_*), WebEA cannot connect to the·
defined server/Port

Apache/PHP web server requires a proxy server to reach the Pro Cloud Server·
machine and the proxy settings defined in the .config file are incorrect or
invalid

Failed to Connect Request Error: Failed to connect to xxx.xxx.xxx.xxx port yy: Connection refused

Possible reasons:

The 'sscs_port' option in the webea_config.ini file does not match the Port·
setting in your Pro Cloud Server configuration file (SSProCloud.config); make
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them the same

Note that, if the Pro Cloud Server is being re-directed via IIS, you must ensure this
matches the IIS Port used for the Pro Cloud Server.

The configured database is
not defined

The configured database is not defined in the Pro Cloud Server.

Possible reasons:

The 'sscs_db_alias' option in the webea_config.ini file does not correspond to·
the 'Database Alias' defined in Add Database Manager; correct the values so
that they do correspond

Secure connection is
required

A secure connection is required for the selected model.

This message indicates that the 'Require a secure and authenticated connection'
option is enabled for this Model Connection/Database Manager.

To access this model via WebEA you must use the HTTPS protocol. You must also
use a Port that has 'Require SSL' enabled, and has the 'Authentication' option set to
either 'Model' or 'Global'.

Problem reading the model
root

Problem reading the model root.

Possible reasons:

The WebEA options for the current model do not match a Pro Cloud Server·
configuration

You are attempting to access a DBMS repository that has not had a Project·
transferred into it; see Step 4 in the Server Based Repositories Help topic

No response when
selecting an Object

After WebEA loads the initial page (the model root or default diagram), there is no
response to selecting objects.

Possible reasons:

Your browser does not have javascript enabled; re-enable it·

The cURL PHP module/extension is not installed and enabled on the server;·
install/enable cURL on your web server

The PHP version is wrong; it must be greater than PHP 5.0 with all extensions·
supported

An unexpected response
was received

An unexpected response was received, check the Pro Cloud Server configuration!

This error normally occurs while attempting to log in or connect to a model from
the initial page. The error message will display whenever the response from the
configured Pro Cloud Server does not return the expected XML message.

Check that the defined Sparx Systems Pro Cloud Server details, such as server
name and Port, are correct and not those of a web server.

The selected database does
not have Pro Features
enabled

The selected database does not have Pro Features enabled.

This error normally occurs if the selected model does not have 'Pro Features'
enabled.

Possible reasons:

In the Pro Cloud Server Configuration Client, the Database Manager for this·
model does not have the 'Enable Pro Features (OSLC, WebEA and Integration)'
option enabled

The Pro Cloud Server's license has expired and the server is now operating as·
the free, core edition of the Pro Cloud Server

The License key entered is invalid and the Pro Cloud Server is operating as the·
core edition
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Using the Sparx Systems Pro Cloud Server Configuration Client, check the
Database Manager configuration. Ensure that the 'Enable Pro Features (OSLC,
WebEA and Integration)' option is enabled.

Diagram image not found Diagram image not found.

This error indicates that the diagram exists in the model, but the image of the
diagram has not been generated.

Possible reasons:

The model does not have the 'Auto create Diagram Image and Image Map'·
option enabled in model-specific options

The diagram was created in Enterprise Architect, but has not yet been saved·

The user is on an old version (prior to build 1350) of Enterprise Architect and·
the Worker application is not running for this model (it has not been
configured, it is not currently running, or has not run since the diagram was
saved)

Open the model in  Enterprise Architect (build 1350 or later), enabled the 'Data
Cache' options, and click on the 'Create' button as described in the 'Model
Configuration' section of the 'WebEA Installation and Configuration' topic.

Alternatively, ensure that the Worker application is running for this model. See the
'How to configure automatic viewable components' topic for details.

Resource not found 404 - Resource with identifier
'{XXXXXXXX-XXXX-XXXX-XXXX-XXXXXXXXXXXX}' could not be found

The item (element, Package or diagram) with this GUID could not be found in the
current model.

Possible Reasons:

The item has been deleted from the model·

To confirm that the item has been deleted, check the parent Package (or parent
element) in WebEA.

If the error occurred when selecting an item on a diagram, the diagram image might
have to be regenerated.

SSL Error Error: SSL certificate problem: unable to get local issuer certificate

This error suggests you are attempting an HTTPS connection without having SSL
enabled.

Possible Reasons:

The webea_config.ini file does not include 'sscs_use_ssl = "true"' for this·
model; try adding this, then attempt to access the model again

Self signed certificate error Request Error: SSL certificate problem: self signed certificate

This error suggests you are attempting an HTTPS connection with SSL using a
self-signed certificate; however, WebEA has not been configured to allow
self-signed certificates.

Possible Reasons:

The webea_config.ini file does not include 'sscs_enforce_certs = "false"' for·
this model; try adding this, then attempt to access the model again

No credentials provided 400 - User Security is enabled, however no credentials were provided.

Possible Reasons:
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The Project has Enterprise Architect user security enabled; however, WebEA is·
not configured to either show a login prompt or automatically login with
specific credentials

Check that the webea_config.ini contains:

     login_prompt = "true"

Or, all of these:

     login_prompt = "false"

     sscs_model_user = "<user id>"

     sscs_model_pwd = "<password>"

Incorrect Access Code The entered access code is incorrect!

Possible reasons:

This model has been configured (in the webea_config.ini file) to require an·
access code for WebEA access; the access code that was entered is incorrect

Check the webea_config.ini file for the correct access code / "auth_code".

Model is Shutdown The selected model is shutdown.

Possible reasons:

The Cloud Server Model connection that you are attempting to access is not·
enabled

Using the Pro Cloud Server Configuration Client, check that the Database Manager
is set to "Enabled".

Version Mismatch Warning - WebEA / OSLC Version mismatch

Each release of the Pro Cloud Server includes an OSLC component and the WebEA
component (php files). If you are using the OSLC component from one release and
the WebEA component from another, then WebEA might not function as intended.

Possible Reasons:

A new version of the Pro Cloud Server was installed; however, the new version·
of WebEA was not copied to the Web Server

When updating the Pro Cloud Server to a newer version, ensure that WebEA is also
updated. That is, after performing the installation of the Pro Cloud Server, copy the
new WebEA files from the Pro Cloud Server installation to the relevant location on
your web server.

Basic login fields not
shown

The basic login fields will not be visible when attempting to log in to a model under
these circumstances:

The webea_config.ini has 'sscs_model_user' defined·

The model has the user option 'Restrict access to Windows & OpenID users·
only' enabled

Problems loading pages

Issue Comments

No response when clicking
on diagram elements

When clicking on an element on a diagram nothing happens.

Possible reason:
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The element properties are being loaded in the Properties View; however, the·
Properties View is automatically hidden due to a narrow screen/browser width
(less than 800px)

From the hamburger menu at the top right of WebEA, select 'Properties' to turn off
the Properties View.

Pages don't load correctly After the server has been updated to a new version of WebEA, clients experience
problems with pages loading incorrectly.

Possible reason:

The user's browser is using a cached version of WebEA's client side files,·
which is causing unpredictable results
The solution is to clear the browser cache, to force the browser to download the
latest version of the application files from the server; the process for clearing
the cache is different for each browser/device - consult the user manual for
your browser

Login page in Internet
Explorer

The 'Login' page is not drawn correctly and appears different to other browsers; that
is, the selection boxes next to each model name are not square.

All login attempts to models with authentication fail, saying 'No model selected!'

Possible reasons:

IE is running in 'Compatibility View' mode, which does not support HTML5·
and CSS3; turn off 'Compatibility View' at least for the server hosting WebEA
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Prolaborate

The Enterprise Architect set of tools to deliver world-class modeling and design solutions to business, industry and
companies around the world has been significantly expanded with the inclusion of Prolaborate in the Pro Cloud Server
offering.

Whilst Enterprise Architect has become the pre-eminent modeling and design solution globally for modelers and
designers wanting to visualize and understand complex systems, software and architecture, Prolaborate is the next step in
delivering the richness of those models and designs to the broader and greatly expanded consumer community, enabling
high-level executives, business process managers, process implementers, consultants, customers and other stakeholders
to see their personal and curated view of the model in a way that they are personally comfortable with!

Prolaborate is a tailored set of views that reduce complexity, focus attention and increase the accessibility of model
information for non-modelers and others who are more concerned with consuming the model than directly editing it
(although this can occur). Prolaborate provides a social platform 'outside the model' that supports talking about the model
from a different viewpoint to those actively engaged 'within the model'. Prolaborate also provides dashboards, impact
analysis and other 'outside the model' features that derive information from the model or provide unique windows into
the model for a custom audience, such as Chief Executive Officers, Chief Information Officers and customers.

Benefits:

Takes the next step beyond modeling·

A social and collaborative tool for everyone·

Highly focused and customized model views·

New ways of seeing and interacting with Enterprise Architect models·

New tools for decision and impact analysis based on model content·

A platform for 'out of model' reviews and discussions·

For C-level executives looking for critical and strategic information·

For model consumers reviewing or implementing process flows·

For customers and other stakeholders who want to review and discuss the model·

For developers and software teams·

For those unfamiliar with modeling who want to understand and share their viewpoint·

A rich and evocative environment tailored for individual domains·

Reveals the hidden value in your Enterprise Architect models·

Engages with a broader audience - presentation and discussion at the 'right level'·

For further information

Full documentation on Prolaborate is provided on the website. You can access this documentation by clicking on this
link (Javascript must be enabled on your web browser).

     https://prolaborate.sparxsystems.com/resources/documentation
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Integration Plug-ins

The Integration Plug-in components represent a set of Plug-ins (or extensions) for the Pro Cloud Server that enable data
from external providers to be displayed within Enterprise Architect.  These components are also known as the Server
Based Plug-in Interface (SBPI).

The Integration Plug-in components of the Pro Cloud Server run as a series of executables (.EXE files) that do not have a
graphical user interface (GUI) themselves; however, the topics of this section describe the configuration editor screen(s)
that are included in the Pro Cloud Server's Configuration Client that can be used to configure the Integration Plug-ins.

The main screen of the Configuration Client (installed as part of the Pro Cloud Server) includes an 'Integration' tab that is
divided into two main sections. The top half defines the details of the Integration Server (or SBPI Server) with the lower
half displaying the details of the various 'Data Providers'; each of these sections is described in greater detail in this topic.

Note 1: The Integration feature is only available in licensed editions of the Pro Cloud Server, Team, Enterprise or Token.

Note 2: If you are using the Token edition of the Pro Cloud Server, before configuring Integrations ensure you have
enabled the required Integration Provider/s via the Token Allocation options; see: Manage Allocations

Note 3: Any changes to the Integration Server or Plug-ins (made either through the Configuration Client or manually)
will require a restart of the Pro Cloud Server

Alternatively, the Integration Server and Plugins can be configured via the WebConfig interface. See the WebConfig - 
Integration Plug-ins topic for details.

Integration Server

All requests for external data from Enterprise Architect are sent to the Integration Server (via the Pro Cloud Server),
which decides which Data Provider (or SBPI Plug-in) will action the request.

To make the Integration Server configuration as easy as possible for the majority of users, version 4.1 of the Pro Cloud
Server has introduce a simplified set of options, however if the default configuration does not suit your environment,
check the 'Use Legacy Settings' option to show all the available options.

Note: The Integration Server settings are only mandatory when the 'Enabled' flag is checked. The combination of
Protocol, Name and Port must match the machine hosting the Integration Server (in this case the Pro Cloud Server) in
order for Enterprise Architect clients to be able to communicate with it.

(c) Sparx Systems 2019 Page 334 of 654 Created with Enterprise Architect

http://www.sparxsystems.com/enterprise_architect_user_guide/15.1/pcs-license-manage-allocs.html
http://www.sparxsystems.com/enterprise_architect_user_guide/15.1/webconfig_integration_plugins.html
http://www.sparxsystems.com/enterprise_architect_user_guide/15.1/webconfig_integration_plugins.html


Model Repository - Model Repository 20 January, 2020

Item Description

Enable Integrations Default value:  Unchecked

This checkbox enables (or disables) Integrations for the current Pro Cloud Server
installation.

When this value is checked it implies that the other fields ('Protocol', 'Name', 'Port'
and 'Path') are now mandatory and the Integration Server definition can not be
saved without a value in each field.

Load Defaults This button loads the default values for the Integration Server settings into any
empty field.

Note: If a field already has a value, then the Load Default button will not change or
update this existing value

Use Legacy Settings Default value:  Unchecked

This checkbox determines if the simplified or complex set of options should be
shown.   The name refers to the fact that the earlier versions of the Pro Cloud
Server required users to fill-in the complex set of options. In later versions of the
Pro Cloud Server the set of options needed was greatly reduced by making some
assumptions that will be true for the majority of environments.

When this value is checked it implies that the other fields ('SBPI Server Protocol',
'Name' and 'Port') are now mandatory and the Integration Server definition can not
be saved without a value in each field.

Port Default value:  8080

This option is only shown when the 'Use Legacy Settings' option is unchecked. It
defines the Port the Integration Server is listening to for requests from the Pro
Cloud Server.

SBPI Server Protocol Default value:  HTTP

This option is only shown when the 'Use Legacy Settings' option is checked.

This field defines the SBPI Server's Protocol, combined with the 'SBPI Server
Name/IP' and 'SBPI Server Port' these settings form the Integration Server's URL
that the Pro Cloud Server will send SBPI related requests to.

Note: The complete URL ({protocol}://{server-name}:{port} needs to be
resolvable by the Pro Cloud Server machine.

SBPI Server Name/IP Default value:   localhost

This option is only shown when the 'Use Legacy Settings' option is checked.

This field defines the SBPI Server's machine name or IP, combined with the 'SBPI
Server Protocol' and 'SBPI Server Port' these settings form the Integration Server's
URL that the Pro Cloud Server will send SBPI related requests to.

Note: The complete URL ({protocol}://{server-name}:{port} needs to be
resolvable by the Pro Cloud Server machine.

SBPI Server Port Default value:  8080

This option is only shown when the 'Use Legacy Settings' option is checked.

This field defines the SBPI Server's Port, combined with the 'SBPI Server Protocol'
and 'SBPI Server Port' these settings form the Integration Server's URL that the Pro
Cloud Server will send SBPI related requests to.

Note: The complete URL ({protocol}://{server-name}:{port} needs to be
resolvable by the Pro Cloud Server machine.
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Ignore SSL Errors Default value:  unchecked

This option is only shown when the 'Use Legacy Settings' option is checked.

This value defines if SSL related errors that occur while communicating with the
Integration Server component should be ignored.  The most common SSL errors are
related to self-signed certificates; by default a client does not treat self-signed
certificates as being secure, therefore in order to connect to servers that use
self-signed certificates this option should be checked.

Attempt Auto Discovery Default value:  checked

This option is only shown when the 'Use Legacy Settings' option is checked.

This option defines if the Pro Cloud Server should automatically attempt to
determine the Enterprise Architect client's network address and supply that to the
Integration Server.

This option was introduced in Pro Cloud Server 4.1.40; earlier versions were not
capable of discovering the client's network address.

When Auto Discovery is checked, the following setting is the 'Fallback URL',
which will be used only if the Auto Discovery fails. When Auto Discovery is
unchecked, the following setting is the 'Absolute URL' which will be used in all
cases.

Absolute Protocol Default value:   HTTP

This option is only shown when the 'Use Legacy Settings' option is checked.

This field defines the Protocol that when used in combination with the Absolute
Server Name and Port form the resolvable URL that Enterprise Architect clients
can communicate to the Integration server.

Note: The complete URL {protocol}://{server-name}:{port} needs to be resolvable
by Enterprise Architect client machines.

In some environments server URLs are redirected to completely different locations,
therefore to handle this situation the absolute URL is returned to Enterprise
Architect clients so that they can communicate to the Integration Server.

Absolute Name/IP Default value:   {empty}

This option is only shown when the 'Use Legacy Settings' option is checked.

This field defines the Server name/IP that when used in combination with the
Absolute Protocol and Port form the resolvable URL that Enterprise Architect
clients can communicate to the SBPI server.

Note: The complete URL {protocol}://{server-name}:{port} needs to be resolvable
by Enterprise Architect client machines.

In some environments server URLs are redirected to completely different locations,
therefore to handle this situation the absolute URL is returned to Enterprise
Architect clients so that they can communicate to the SBPI Server

Absolute Port Default value:   8080

This option is only shown when the 'Use Legacy Settings' option is checked.

This field defines the Port that when used in combination with the Absolute
Protocol and Server Name form the resolvable URL that Enterprise Architect
clients can communicate to the SBPI server.

Note: The complete URL {protocol}://{server-name}:{port} needs to be resolvable
by Enterprise Architect client machines.

In some environments server URLs are redirected to completely different locations,
therefore to handle this situation the absolute URL is returned to Enterprise
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Architect clients so that they can communicate to the SBPI Server

Save This button saves any pending changes to the Integration Server settings; it is only
enabled when there are unsaved changes.

Data Providers

A single Pro Cloud Server can support any number of external Data Providers, and in turn each of the external Data
Providers can be available to as many models as are supported by the installation's license.  Note that only Pro-enabled
repositories (or database managers) can access external data providers.  A Pro-enabled database manager is one that has
the 'Enable Pro Features (OSLC, WebEA and Integration)' option checked.

Option Description

Defined Providers This controls lists a summary of all defined external Data Providers.

Double-clicking an existing item will display the Edit Data Provider screen.

Add... This button displays the Add Data Provider screen to allow the entry of a new
external Data Provider.

Edit... This button displays the Edit Data Provider screen to allow the modification an
existing external Data Provider definition.

Note: This button is only enabled when there is a Data Provider selected.

Remove This button permanently deletes the selected Data Provider and all of its Bindings.

Note: This button is only enabled when there is a Data Provider selected.

Bindings This control displays a check list of all Database Managers that are Pro-enabled
(that is, the 'Enable Pro Features (OSLC, WebEA and Integration)' option is
selected). A checked Database Manager allocates the current Data Provider to the
given repository.

Check All This button is a quick and easy way to allocate all defined Pro-enabled Database
Managers to the currently selected Data Provider.

Uncheck All This button is a quick and easy way to de-allocate all defined Pro-enabled Database
Managers from the currently selected Data Provider.
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Install and Configure

The Sparx Systems Pro Cloud Server product is installed using a standard Microsoft Windows Installer package that
includes a number of optional components. One of these components is Integration Plug-ins, which is installed by default
into the C:\Program Files (x86)\Sparx Systems\Pro Cloud Server\SBPI\  folder (assuming a 64 bit machine is being
used).

Requirements

In order to install a particular Integration Plug-in you must have:

A licensed Pro Cloud Server·

Physical network access to a server hosting the external data·

User credentials to access the external data·

Enterprise Architect Corporate, Unified or Ultimate edition v14 or later·

What is in the Package?

The Integration Plug-ins folder initially consists of an Integration Server executable (SBPI.exe), a separate executable
(*SBPI.exe) for each supported external product, a sample configuration file and a text file describing the manual
installation and configuration steps.

Plug-In Description

Integration (SBPI) Server The SBPI.exe application acts as the interface between the Pro Cloud Server and
each of the plug-ins, by translating Enterprise Architect requests, forwarding them
to the appropriate plug-in and then returning the generated response to Enterprise
Architect.

Application Lifecycle
Manager Plug-in

The ALMSbpi.exe plug-in interacts with the MicroFocus Application Lifecycle
Manager product (previously known as HP Quality Center).

Autodesk Plug-in The AutodeskSbpi.exe plug-in interacts with AutoCAD's file and management
component AutoDesk.

Bugzilla Plug-in The BugzillaSbpi.exe plug-in interacts with the web based defect/bug tracking
system that was originally developed and used by the Mozilla project and is now
licensed under the Mozilla Public License agreement.

Confluence Plug-in The ConfluenceSbpi.exe plug-in interacts with Atlassian's Team Collaboration
Software.

Dropbox Plug-in The DropboxSbpi.exe plug-in interacts with Dropbox's web based file hosting
service.

EA plug-in The EASbpi.exe plug-in interacts with external Sparx Systems's Enterprise
Architect Cloud-based repositories.

Jazz Plug-in The JazzSbpi.exe plug-in interacts with:

IBM Rational DOORS Next Generation's requirements management tool·
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Rational Rhapsody Design Management (DM)·

Rational Team Concert Change and Configuration Management (CCM)·

Rational Quality Manager (QM)·

Jira Plug-in The JiraSbpi.exe plug-in interacts with Atlassian's issue tracking system.

Salesforce The SalesforceSbpi.exe plug-in interacts with Salesforce's Customer Relationship
Management system.

ServiceNow Plug-in The ServiceNowSbpi.exe plug-in interacts with ServiceNow's asset management
component of its Cloud-based enterprise management system.

SharePoint Plug-in The SharePointSbpi.exe plug-in interacts with Microsoft's  web-based collaborative
platform, SharePoint.

Team Foundation Server
(TFS) Plug-in

The TFSSbpi.exe plug-in interacts with Microsoft's source code management.

Wrike Plug-in The WrikeSbpi.exe plug-in interacts with Wrike's project management system.

How to Set Up

The Integration framework consists of an Integration server (SBPI.EXE) application that starts one or more plug-ins
(such as DropboxSbpi.exe and JiraSbpi.exe).  The Integration Server and each Integration plug-in can be configured to
run either on the same machine as the Pro Cloud Server or on completely different machines.  In the simplest
configuration the Integration server and all Integration plug-ins are installed on a single server. There are two main
advantages with this configuration:

The Pro Cloud Server will automatically start (and stop) all configured plug-ins whenever its Windows service is1.
started (or stopped).

The Integration configuration GUI inbuilt into the Cloud Configuration client can be used to completely manage all2.
aspects of the Integration configuration; see the Steps - Simple table.

However, if you elect to run the Integration Server or Integration plug-ins on different machine(s) to the Pro Cloud
Server, each of the individual plug-ins must be manually configured as well as configured to start as Windows services
with the correct parameters. See the Steps - Manual table.

Steps - Simple

The Integration configuration GUI included in the Cloud Configuration client removes most of the complexity involved
in configuring the Integration Server and Data Provider(s), therefore this is the recommended method for most users.
However, this configuration method is restricted to running all Integration components (*SBPI.exe) on the same server
as the Pro Cloud Server.

Step Description

Configuring Pro Cloud
Server for Integration

Each installation of Sparx Systems Pro Cloud Server can be configured to
communicate with a single Integration Server; the configuration options of this
definition are defined as a series of registry settings, however the 'Integration' tab in
the Pro Cloud Server Configuration Client allows the definition and maintenance of
the Integration Server options without the need for you to manually manipulate the
registry or configuration files.
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This image shows the definition of an Integration Server with the default settings:

Alternatively, the Integration Server and Plugins can be configured via the
WebConfig interface. See the WebConfig - Integration Plug-ins topic for details.

Configuring Integration
Data Providers

Each Data Provider (or plug-in) is defined both as a series of registry entries in
[HKEY_USERS\.DEFAULT\Software\Sparx
Systems\SQLBridge\SBPI\Plugins\{unique} and as settings within a configuration
file.  Again, the 'Integration' tab in the Cloud Configuration Client allows the
definition and maintenance of Integration Data Provider details without the need for
you to manually manipulate the registry and configuration files.

Configuring the Firewall In an effort to minimize Firewall rules needed to configure the Pro Cloud Server
and its features, PCS version 4.1 now routes all requests for the Integration server
(SBPI.exe) via the normal PCS ports, therefore if you are using PCS 4.1 or later
there are no additional Firewall rules needed other than the ones for Enterprise
Architect client to communicate to the Pro Cloud Server.

For versions 3 and 4 of the PCS, the Integration server (SBPI.exe) typically must be
granted access through any local firewall so that Enterprise Architect clients can
connect to it. The Pro Cloud Server installer will automatically create a Firewall
exception that allows any incoming requests to be passed through to SBPI.exe;
however, the default settings should be reviewed and adjusted to suit your
environment.

Steps - Manual

Important: these steps are only needed if the Integration components will run on different machine(s) to the Pro Cloud
Server, otherwise the Steps - Simple table should be used.

Step Description

Configuring Pro Cloud
Server for Integration

Each installation of Sparx Systems Pro Cloud Server can be configured to
communicate with a single Integration (or SBPI) server. These configuration
options are defined as a series of registry settings.

This is an example of all valid options for the Integration server:

    [HKEY_USERS\.DEFAULT\Software\Sparx Systems\SQLBridge\SBPI\Server]

    "Enabled"="true"

    "LocalPort"=dword:00001f90

    "UseLegacy"="false"

    "Arguments"="-port 8080 -protocol http"

    "Protocol"="https"

    "Server"="localhost"

    "Port"=dword:00001f90
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    "IgnoreSSLErrors"="true"

    "AttemptAutoDiscovery"="true"

    "ClientProtocol"="http"

    "ClientServer"="alternativeservername"

    "ClientPort"=dword:00001f90

Enabled - true or false, representing the Port number that the SBPI server·
should be listening on, which value should match the value specified in the
arguments; for example, dword:00001f90   (decimal 8080)

LocalPort - a hexadecimal value, representing the Port number that the·
Integration Server is listening on when the Use Legacy option is FALSE.   for
example, dword:00001f90   (decimal 8080)

UseLegacy - true or false, controls if the simple (false) or complex (true) set of·
configuration options should be used by the Integration Server

Arguments - no longer used since Pro Cloud Server 4.1, but in earlier versions·
represented the arguments that are used to start the Integration server, which
include the Port and Protocol the server should listen on; for example, "-port
8080 -protocol http"

Protocol - http or https, the protocol that should be used to communicate with·
the machine hosting the Integration server when the Use Legacy option is
TRUE.  This field is combined with the 'Server' and 'Port' form the Integration
Server's URL that the Pro Cloud Server will send SBPI related requests to.
Note: The complete URL ({protocol}://{server-name}:{port} needs to be
resolvable by the Pro Cloud Server machine.

Server - the name (or IP number) of the machine hosting the Integration server·
when the Use Legacy option is TRUE (for example, yourdomain.com);   This
field is combined with the 'Protocol' and 'Port' form the Integration Server's
URL that the Pro Cloud Server will send SBPI related requests to.    Note: The
complete URL ({protocol}://{server-name}:{port} needs to be resolvable by
the Pro Cloud Server machine.

Port - a hexadecimal value, representing the Port number that the Integration·
Server is listening on when the Use Legacy option is TRUE.   for example,
dword:00001f90   (decimal 8080).  This field is combined with the 'Protocol'
and 'Server' form the Integration Server's URL that the Pro Cloud Server will
send SBPI related requests to.    Note: The complete URL
({protocol}://{server-name}:{port} needs to be resolvable by the Pro Cloud
Server machine.

IgnoreSSLErrors - true or false, defines if SSL related errors that occur while·
communicating with the Integration Server component should be ignored when
the Use Legacy option is TRUE.

AttemptAutoDiscovery - true or false, defines if the Pro Cloud Server should·
automatically attempt to determine the EA client's network address and supply
that to the Integration Server when the Use Legacy option is TRUE.

ClientProtocol - http or https, defines the protocol that when combined with·
the 'ClientServer' and 'ClientPort' form the resolvable URL that Enterprise
Architect clients can communicate to the Integration Server when the Use
Legacy option is TRUE.    Note: The complete URL
({protocol}://{server-name}:{port} needs to be resolvable by Enterprise
Architect client machine.

ClientServer - defines server name (or IP number) that when combined with·
the 'ClientProtocol' and 'ClientPort' form the resolvable URL that Enterprise
Architect clients can communicate to the Integration Server when the Use
Legacy option is TRUE.    Note: The complete URL
({protocol}://{server-name}:{port} needs to be resolvable by Enterprise
Architect client machine.

ClientPort - a hexadecimal value, defines the Port number that when·
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combined with the 'ClientProtocol' and 'ClientServer' form the resolvable URL
that Enterprise Architect clients can communicate to the Integration Server
when the Use Legacy option is TRUE.  for example, dword:00001f90
(decimal 8080).     Note: The complete URL
({protocol}://{server-name}:{port} needs to be resolvable by Enterprise
Architect client machine.

Note:   Version 4.1 of the Pro Cloud Server removed the need for the Integration
Server requiring a Firewall rules of its own so that Enterprise Architect clients can
communicate to it.  However for PCS version 3 and 4 the Integration Server
(SBPI.exe) typically needs to be granted access through any local firewall so that
clients can connect to it.  The ProCloudServer installer will automatically create a
Firewall exception that allows any incoming request to be passed through; however,
the default settings should be reviewed and adjusted to suit your environment.

Configuring Data Providers Each Data Provider is defined as a series of registry entries in
[HKEY_USERS\.DEFAULT\Software\Sparx
Systems\SQLBridge\SBPI\Plugins\{unique}, where {unique} is a unique UUID for
the Data Provider.  This is an example of a complete External Data Provider
definition:

    [HKEY_USERS\.DEFAULT\Software\Sparx
Systems\SQLBridge\SBPI\Plugins\{853489C1-4C22-4bad-9A8E-3098D07A3FC1
}]

    "AutoStart"="true"

    "Enabled"="true"

    "Group"=""

    "Name"="Sparx Systems Sample account"

    "Port"=dword:00001f91

    "Prefix"="jr1"

    "TypeKey"="jira"

    "Arguments"="-port 8081 -config jr.config"

    "Config"="jr1.config"

AutoStart - true or false, defines if the Integration Server (SBPI.exe) should·
maintain a running process (*sbpi.exe) for this Data Provider.

Enabled - true or false, defines if the Integration Server (SBPI.exe) should·
allow communications to be forwarded to this Data Provider

Group - an optional value that can be used to 'sort' Providers into groups when·
displayed in Enterprise Architect.

Name - a 'friendly' project name to describe the external Data Provider, which·
is displayed to all Enterprise Architect users; for example 'Sparx Systems
Sample account'

Port - a hexadecimal value representing the Port number that the external data·
source expects to receive requests on, which value should match the value
specified in the arguments; for example, dword:00001f91 (decimal 8081)

Prefix - a short unique name that is meaningful to the users and that prefixes·
each link stored within the Enterprise Architect model; for example, jr1::10001
(where 10001 is the Jira object ID)

TypeKey - defines the Provider type of the current Data Provider; only the·
following supported values can be used:  cint, csvc, alm, ad, bug, cflu, drop, ea,
jazz, jira, sf, now, sp, tfs, wrike

Arguments - Deprecated in PCS4.1, a dynamic arguments list is build from the·
individual settings. Earlier version uses this field to defines the arguments that
should be used to start the Integration Plug-in, including the Port, Protocol and
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Config filename.

Config - Deprecated in PCS4.1, the config filename is now the prefix with a·
'.config'.  In version PCS 3 and PCS4 this field was given a independent value
which had to be unique.

Each External Data Provider requires its own set of options to define the details of
how the configured plug-in connects to the External Data Source. These settings are
stored in a .CONFIG file that resides in the same location as the plug-in's .EXE file.
For example, using the above definition a 'jr1.config' would need to be created, and
would contain information similar to this:

    PROTOCOL=https

    SERVER=example.com

    PORT=443

    BASEURL=myproject

    USERNAME=

    PASSWORD=

    CREATEITEMS=false

    MODIFYITEMS=false

    POSTDISCUSSIONS=true

    PROXY=10.0.0.0:3128

    PROXYBYPASS=<local>;10.*

    IGNORESSLERRORS=true

PROTOCOL - the communication protocol, http or https·

SERVER - the name (or IP number) of the external data source's server, such·
as  example.com

PORT - the Port the external data source is configured to listen on, such as 443·

BASEURL - when the external data source supports multiple 'projects', the·
BaseURL property identifies which should be used; for example, for Enterprise
Architect SBPI the BaseURL is the DB Alias as defined in the PCS

USERNAME - optional - see Note1·

PASSWORD - optional - see Note1·

CREATEITEMS - defines if Enterprise Architect users can create items in the·
External Data Source - see Note2; default value: false

MODIFYITEMS - defines if Enterprise Architect users can modify existing·
items in the External Data Source - see Note2; default value: false

POSTDISCUSSIONS - defines if Enterprise Architect users can add·
Discussions to items within the External Data Source - see Note2; default
value: true

PROXY - optional - the server name or IP number and Port of the proxy·
server, such as  10.0.0.0:3128

PROXYBYPASS - optional - a semi colon separated list of IP numbers that·
should not be sent through the proxy; for example, <local>;10.*

IGNORESSLERRORS - optional - a boolean value to ignore any SSL·
certificate errors

Note1

If the external server supports OAuth 2 authentication (Autodesk, Dropbox and·
Wrike), when accessing from within Enterprise Architect, a browser window
will open and prompt you to log in to the external account and allow Enterprise
Architect to access your account

Enterprise Architect never sees your credentials in this process; instead it is·
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provided with a unique token to access the external account

If the external server allows basic authentication, then the username and·
password can be optionally set in the configuration file

If the username and password are not specified in the configuration file,·
Enterprise Architect will prompt you for credentials to access the external data

Note2

Not all external products support the creation and modification of their objects, for
example Dropbox

Configuring Models for
External Data Providers

In order for users of an Enterprise Architect model to connect to a given External
Data Provider, a 'binding' between the Enterprise Architect model and the External
Data Provider must be configured. This is performed by a series of registry settings
in [HKEY_USERS\.DEFAULT\Software\Sparx
Systems\SQLBridge\SBPI\Bindings\{unique}] for each model/external data
provider combination. In this string, {unique} is an 8-digit hexadecimal number
uniquely identifying the binding. For example:

    [HKEY_USERS\.DEFAULT\Software\Sparx
Systems\SQLBridge\SBPI\Bindings\B6EE6851]

    "LocalModel"="eaexample"

    "Plugin"="{853489C1-4C22-4bad-9A8E-3098D07A3FC1}"

LocalModel - the DB Alias of the model, such as 'eaexample'·

Plugin - the UUID of the external data source; for example,·
{853489C1-4C22-4bad-9A8E-3098D07A3FC1}

Special Notes

Using SSL at the Integration Server or Provider Level

If you choose to implement the HTTPS protocol at either the Integration Server level or Integration Provider level, the
Integration Executables (*SBPI.EXE) will require a 'server.pem' file in the same folder as themselves, therefore if using
the default installation path this would mean 'server.pem' should be placed into the C:\Program Files (x86)\Sparx
Systems\Pro Cloud Server\SBPI\  folder.

See the section SSL Certificates in the Add a Port Definition Help topic and the Self-Signed SSL Certificates Help topic
for more information on how to create a valid 'server.pem' file.

The Integration Plug-in for Enterprise Architect Requirements:

The BaseURL as the model's DB Alias·

The defined model configured as 'Enabled' and 'Enable Pro Features (OSLC, WebEA and Integration)' in the Pro·
Cloud Server

What data is returned by Integration Plug-ins

Each of the Integration plug-ins developed by Sparx Systems returns information based on a 'Filter' or position within the
product's external data.  Some products, such as Enterprise Architect, Jira and TFS, provide a mechanism to customize
the data returned, whilst others simply return all information at a particular position within the data.

Note: For Enterprise Architect, Jira or TFS the filters must be configured prior to Enterprise Architect requesting that an
Integration Plug-in should connect to them

Provider Information returned
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Application Lifecycle
Manager

Information returned based on the internal list for Defects, Requirements and Tests.

AutoDesk Information returned based on the contents of:  Hubs | Projects | Folders.

Bugzilla Information returned based on the contents of:  Product | Component | <all items in
component>.

Dropbox Information returned based on the contents of:  Folders .

EA Presents a list of 'External Model' searches as defined in the local model.  See
screen 'Find in Project' | External Models

Jazz Information returned based on the contents of:  (DoorsNG) - Folders.

Jira Presents a list of 'Favorite Filters'. See the menu option 'Issues | Manage Filters'

Salesforce Presents all item types that have a 'List View'.

ServiceNow Presents a list of user-defined filters, grouped by the table they are based on.

Team Foundation Server Presents a list of TFS global and 'My ...' queries.

Wrike Information returned based on the contents of:  Accounts | Folders.
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Add/Edit Data Provider

The Add/Edit Data Provider screen will be shown whenever you request to create a new Data Provider or edit an existing
one.  The screen's behavior will be identical in either mode, the one difference being that the details of the selected Data
Provider will be displayed when the screen loads in Edit mode.

When you choose to add a new Data Provider, the screen will initially display as shown:

Wherever possible the Add/Edit Data Provider screen will fill each field with a default value in order to make it easier
for you; if the default values are not correct, simply overwrite them. To this end, whenever the 'Provider' value is
changed, a number of other fields will be set to the default values for the new Provider, such as the Data Provider's
Prefix, as shown here when Enterprise Architect is selected:
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Note: When defining a Data Provider there are a number of mandatory fields (denoted with a '*') that require a value
before a Data Provider can be saved.

Data Provider settings

Item Description

Enabled Default Value:  unchecked

This value controls if the Integration Server (SBPI.exe) should allow
communications to be forwarded to this Data Provider.

Name This value represents the friendly name for the current Data Provider. It will be
shown to users of Enterprise Architect.

Provider This value specifies the Provider type of the current Data Provider; only supported
values can be used.  As mentioned, whenever this value is changed a number of
other fields will be automatically updated to make data entry easier for the user.

Prefix This value represents a short unique name to identify the current Data Provider.
This value will be saved against every Enterprise Architect element that is linked to
an external element.

Group This field is available only when the 'Custom Integration' provider type is selected.

Typically in Enterprise Architect, integrations are grouped by the Provider type
('Jira', 'Dropbox', etc). For Custom Integrations, the Grouping is applied based on
the value entered in this field.
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Integration Plug-in settings

This group of settings defines the relationship between the Integration Plug-in and the Integration Server and how the
two interact.

Item Description

Auto Start Default Value:  Checked

This value controls if the Integration Server (SBPI.exe) should maintain a running
process (*sbpi.exe) for this Data Provider.

For standard Integration Plug-ins we would expect this value to be checked,
however for custom ones it may be useful to not auto start the Plug-in and instead
manually control when it is running, particularly while developing it.

Port Default Value: 8081

This value represents the Port that the Integration Server should use to
communicate with the Integration Plug-in.  The Integration Server assumes the Port
is relative to the current machine (or http://localhost:{port}).

Each Integration Plug-in requires a unique Port number which will be checked
when an attempt is made to save the Plug-in's settings.  However the Pro Cloud
Server can only check the what ports are in use by the Pro Cloud Server itself and
its components, there is still a possibility of a port clash with other applications.

Protocol This value represents the protocol that the Integration Server should use to
communicate with the Integration Plug-in; in the simplest configuration this will be
'HTTP'.

DLL Path This field is only available for 'Custom Service', 'Custom Integration' and
'Translator' provider types.

This value represents the physical path to the custom DLL, that will be called by
the CustomService.exe or CustomIntegration.exe Data Provider processes.

As a convenience, the application populates the drop list with all .DLL files that are
present in the .\SBPI\Custom\ folder (C:\Program Files (x86)\Sparx Systems\Pro
Cloud Server\SBPI\Custom\).

Custom Properties

The Custom Properties section is only shown for Data Providers of type 'Custom Service'.

List of Custom Properties

Add This button shows the 'Add SBPI Provider Custom Property' screen and allow entry
of a new custom property, defined as a Item/Value pair.

Edit This button shows the 'Edit SBPI Provider Custom Property' screen and allow
modification of an existing custom property definition.

Delete This button permanently removes the selected Custom Property from the current
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Data Provider.

Provider Server settings

This group of settings defines the details of the external data provider, such as Dropbox, Jira or TFS. The Integration
Plug-in will use the defined details to connect to the remote system and retrieve data from it so that it can be sent back to
Enterprise Architect. The combination of 'Protocol', 'Server Name 'and 'Port' must be resolvable by the server hosting the
Integration Plug-in, which in the simplest case is the Pro Cloud Server.

Item Description

Protocol This value represents the protocol that the Integration Plug-in should use to
communicate with the external Data Provider.

Server Name/IP This value represents the Server Name or IP address that the Integration Plug-in
should use to communicate with the external Data Provider.

Port This value represents the Port that the Integration Plug-in should use to
communicate with the external Data Provider.

Base URL Some external Data Providers allow for the concept of multiple repositories at a
single location; for such Data Providers this field acts as a filter.

For example, it is possible to use another Enterprise Architect model as an external
data source; in this case the 'Protocol', 'Server' and 'Port' determine the Pro Cloud
Server (for example, http://myEAServer:804) while the 'Base URL' is the DB Alias
of the repository (myModel). Thus:

http://myEAServer:804/myModel

User Name This value represents the user name that should be used (in combination with the
password) to access the data within the external system.  If a value is defined in this
field all Enterprise Architect users of the current Data Provider will use the same
set of credentials to read the external system.  Otherwise, if the user name field is
left empty, Enterprise Architect will prompt each user independently for their
credentials.

Password This value represents the matching password for the user name specified in the
'User Name' field.

Create Items Default value:  unchecked

This checkbox controls if Enterprise Architect users are able to create new items
within the external system.

Modify Items Default value:  unchecked

This checkbox controls if Enterprise Architect users are able to modify the details
of external items within the external system.

Post Discussions Default value:  checked

This checkbox controls if Enterprise Architect users are able to create discussions
against elements within the external system.

Ignore SSL Errors Default value:  unchecked
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This checkbox controls if the Integration Plug-in should ignore SSL related errors
that occur as a result of communicating with the external system.

Logging settings

This group of settings define how the Integration Plug-in will create entries in its log file(s). Since the Integration
Plug-ins run without user intervention, it is important for them to be able to write any messages or reports of potential
problems to a log file.  However, special consideration must be given to ensuring that performance isn't impacted by
writing to such files, which is possible if the log file continually grows without limits.  It is also unreasonable to expect
that manual intervention should be required to ensure that the size and number of log files don't impact performance. For
these reasons each Integration Plug-in has its own set of log files and configuration options to manage those log files.

The current log file will always include a '1' on the end of its filename.  A new log file will be created whenever the
Integration Plug-in is started or the physical size of the current log file reaches the Max File Size.  When this occurs all
existing files will be 'rolled over', meaning their file numbers will be incremented and a new '{filename}1.log' created.  If
the roll over process causes more files to exist than the 'File Count' setting allows, these additional files will be deleted.

Item Description

File Count Default value:  3

This value represents the 'rolling' number of log files that should be retained for the
current Integration Plug-in.

Max File Size Default value:  1048576

This value represents the maximum size, in number of bytes, that a log file can
reach before a new log file is created.

Level Default value:   WARNING

This value represents the maximum level of messages that should be written to the
log file. The levels are:  OFF, FATAL, WARNING, INFO and SYSTEM.  A
defined log level is inclusive of all lower levels; therefore if a Plug-in is set to a log
level of INFO then all FATAL, WARNING and INFO messages will be written to
its log file.

Directory (READ-ONLY) This field displays the physically location of the directory into
which the log files for the current Data Provider will be saved.

Proxy settings

This group of settings defines how the Integration Plug-in should communicate with the External Data Provider when
they are separated by a Proxy Server.

Item Description

Server Name/IP The server name (or IP) and Port number of the Proxy Server; for example,
proxyserver.com:3131

Bypass This field provides a mechanism for certain addresses to bypass the proxy; it
accepts multiple values separated by semi-colons (;).  For example,
192.168.*;*.localdomain.com;www.mydomain.com
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User Name If the Proxy Server requires credentials, this field provides the user name.

Password If the Proxy Server requires credentials, this field provides the user password.
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Integrate Data from External Providers

The Pro Cloud Server helps you to integrate the data from external providers into an Enterprise Architect model.
Enterprise Architect is a team player and through its powerful server-based integration capability allows models to be
created relating elements from a wide range of disparate tools that contain items from strategy and requirements down to
implementation, work packages and configuration items. Enterprise Architect does not manage the master-record for
these items but rather acts as an accumulator, bringing content into a single repository and allowing the items to be
related.  A variety of third-party providers can be connected to, including:

 Application Lifecycle Management (formerly HP Quality Center)·

 Jazz (interacts with:·
     -  IBM Rational DOORS Next Generation's requirements management tool
     -  Rational Rhapsody Design Management (DM)
     -  Rational Team Concert Change and Configuration Management (CCM)
     -  Rational Quality Manager (QM)

 Jira and  Confluence·

 Team Foundation Server·

 Wrike·

 ServiceNow·

 Autodesk·

 Bugzilla·

 Salesforce·

 SharePoint·

 Dropbox and·

 Other Enterprise Architect models·

See the Install and Configure Help topic for information on how to configure each provider.

When an item from an external provider is selected in the list the meta-data for the item will be displayed in the
appropriate Enterprise Architect window. So any property-and-value type of information will be displayed in the
Properties window, descriptions and comments will be displayed in the Notes window and discussions or posts will be
displayed in the Collaborate window. For example, if Jira was the External Data source and the integration was listing
User Stories, a Jira User Story property such as Priority: Medium would appear in the Properties window, the Story
description would appear in the Notes window and the Comments would appear in the Collaborate window.

Some meta-data such as collaboration information might not be available for all items and integrations, but where it is
available the facility provides a uniform, cross-integration view of the meta-data, making it easy for Enterprise Architect
users to understand the data from multiple providers and integrations without the need to leave the tool or grapple with
vendor specific terminology. Enterprise Architect is performing the role of an accumulator, allowing information from a
wide range of disparate sources to be related to the already rich set of architectural models in the tool, creating a view of
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how the information in these otherwise unrelated tools can be visualized. This removes the need for the bundle of static
spreadsheets that organizations have traditionally used to relate pairs of items such as Test-Cases to Business Drivers, or
Stakeholder Concerns to application services, and much more.

All integrations offer support for linking objects and elements from the external system into an Enterprise Architect
client. The Integration window supports browsing the external provider's items and retrieving lists of elements and
objects based on the provider's queries. Capabilities include:

Link an Enterprise Architect element to an external object·

View external element properties·

View and in some cases add to, external object discussions·

Export links to WebEA URL's that correspond to the current model·

Open external items in a web browser·

Import elements·

Export elements·

From Enterprise Architect Release 14.1 it is possible to link a non-Cloud model to Integration Plug-ins configured on a
Pro Cloud Server.

See the Cloud Page Help topic for configuration options.

Access

Ribbon      Specialize > Tools > System Integration > Open External Data

To view a list of all elements that are linked to external items:

     Specialize > Tools > System Integration > Show All Linked Items

Context Menu In a diagram or the Browser window, for elements that are already linked to an
external item:

Right-click on element > Specialize > External Properties·

Features

Feature Description

Pro Cloud Server
Configuration

Each external provider must be configured on the Pro Cloud Server to enable
connection. Multiple configurations can be made for each provider (such as
connecting to two separate Jira servers).

Authorization If the Integration Provider requires authorization you are prompted to enter your
credentials. If the provider supports it, a new internet browser window will open
and prompt you to log in to the Integration Provider and allow Enterprise Architect
access to its resources. Alternatively, a simple dialog will pop up asking for your
credentials, with the option to securely store them in the current model. If stored in
the model the credentials will only be used for the current user.

Navigate External Provider Find external items to link to by navigating the external provider.

External Item Details Select an external item from the External Data view to see its properties, notes and
discussions in the Properties window, Notes window and Discussions tab of the
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Collaboration window.

Link External Items External items can be linked to Enterprise Architect as a generic
«ExternalReference» stereotype or as another element type.

Add WebEA Link Hyperlinks to WebEA can be added to the external item so that you can quickly
open the WebEA element from the external source.

Right-click on a local linked element in the list and select 'Add WebEA Hyperlink
to External Object'. This will update the external item with a link to the WebEA
element that is linked to it in Enterprise Architect. Note that not all provider types
have a 'link' mechanism. Where none exists, some providers might allow adding the
link as a comment on the item.

Ensure that the model has a valid WebEA address set in the model options.

Configuration Each Integration Provider comes with a set of default mapping values which
determines what type of local element is created in Enterprise Architect, as well as
which fields are copied to the new element. These mappings are configurable via
the 'Configure' option on the Integration window toolbar menu.

Users must have the 'Configure External Data Sources' permission to access this
functionality.

Troubleshooting The System Output window will show any errors while attempting to retrieve·
data from the external providers

The Pro Cloud Server outputs log files for each external provider·

Notes

'Integration' requires a Pro Cloud Server and is only available to Cloud models·

'Integration' is currently provided with the Corporate, Unified and Ultimate editions of Enterprise Architect·

If you select two or more elements at the same time, you can perform an operation on all of the selected elements at·
once

For WebEA links to work a valid URL must be set for the WebEA address (see the Cloud Page Help topic)·
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Navigate External Data

Each Integration Provider can be navigated through to show lists of external items that can be linked to Enterprise
Architect. Each provider might provide a slightly different mechanism for navigation, based on how it stores its data.
Some provide a simple folder hierarchy, whilst others provide for user-defined filters. See the What data is returned by
Integration Plug-ins table in the Install and Configure Help Topic for details of each provider.

Access

Ribbon Specialize > Tools > System Integration > Open External Data

Navigate the Hierarchy

Begin navigation by selecting the provider type from the right-hand drop-down menu.

Next, each provider type offers a slightly different navigation system; for example, Dropbox allows for browsing the
folder structure, whilst Jira give a list of projects followed by a list of user queries.

Item List

At each navigation level, if available, a list of items corresponding to the navigation level will populate the left-hand
panel.
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Any local Enterprise Architect elements that are linked to the external item will be shown as a child of the external item.

All Items Linked to Model

At each navigation level there is an option to show all local Enterprise Architect elements that are linked to the selected
external data source. Select 'All Items Linked to Model' and choose the number of days prior to today (7, 30 or 90 days,
or 'All') from which to collect the information.

Choose 'All Items Linked to Model' on the root navigation level to see the linked items for all external providers.

This view differs from the regular list as it shows the local Enterprise Architect element on top, and the external linked
item as a child of the local element. All the same context menu items are available in the view.

Show Items Linked to Current Context

In the integrations menu, select 'Items Linked to Current Context' to show only the external items that are linked to the
currently selected local element. That is, select an item in the Browser window and see the external items that are linked
to it.

This view is the same as for 'All Items Linked to Model'.
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External Item Details

When an external item is selected in the External Data View, the item's details are retrieved and displayed in an 'External'
tab of the  Browser window, and in External versions of the appropriate Properties, Notes and Collaboration windows.

Browser Window

The 'External' tab of the Browser window displays only when you are reviewing external items. It behaves in much the
same way as the 'Element' tab of the Browser window, revealing the external element's relationships, features,
requirements, Tagged Values, project maintenance items and related files. However, the 'External' tab shows only
categories for which items exist, and does not list all possible but empty categories.

Properties

Click on an external item in the list to view its properties in the 'External' version of the Properties window. This window
shows all available properties of the external item, as defined by the external provider.
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Properties that will be used when creating a linked local element are shown in the top group 'Mapped Properties', while
all other properties are grouped in 'Other Properties'. The property mapping can be configured, as described in the
Configuration Help topic.

Notes

The external item's 'Notes' or 'Description' text is shown in the 'External' version of the Notes window.
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Note that not all external providers have 'Notes' or 'Description' fields.

This version of the Notes window has a different toolbar, containing icons to:

Toggle the editing lock on the notes·

Synchronize the notes in the Enterprise Architect view and the external source·

Push the edited note text to the external source·

Display the online Enterprise Architect User Guide·

Discussion

Select an external item from the list to view and participate in its Discussions in an independent version of the
Collaboration window - this version has no tabs to switch between Discussions, Chats or The Journal. It resembles the
'Chat' tab but does not require you to specify a recipient user group.

New discussions can be posted by typing into the top box and pressing 'Send'. The username used will be the one that is
authorized on the Integration Provider. If generic credentials have been added to the server configuration then the local
model's user name will be added to the start of the comment as well.

Show or hide the discussions by clicking the X icon in the top-right corner.

Note:

To post an external discussion the Integration Provider must be configured to allow this on the Pro Cloud Server·
(allowed by default)

Not all external providers have discussions or comments·
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Linking Items

Create Linked Element in Enterprise Architect

To create a new element in the Enterprise Architect model linked to the external item:

Right-click on an external item in the list·

Select 'Create Local Element'·

Select either the default type or «ExternalReference» (which ignores any Type Mapping; see the Configuration Help·
topic)

Select which Package the element will be created in·

Optionally add the new element to an open diagram·

The local element will be filled in with the values defined in Field Mapping, described in the Configuration Help topic.

Once linked, the local element will show under the external item:

Note: Select multiple items to create multiple elements at the same time. All elements will be created with either the
default type or «ExternalReference»

Link an Existing Enterprise Architect Element

An existing element in Enterprise Architect can be linked to an existing item in the External Provider by dragging the
local element from the Browser window and dropping it onto the external item.

Create a Linked Item in the External Provider

Existing local elements in Enterprise Architect can be added to the External Provider in this way:

Select the local Enterprise Architect element (in the Browser window).1.

Browse the External Provider and select the required destination location.2.

In the 'External Data' menu, select 'Create Linked Item'.3.
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Note:

To create a new external item, the Integration Provider must be configured to allow this on the Pro Cloud Server (it·
is disallowed by default)

Not all providers allow for creation of new items·

Update Local Element ('Pull' changes)

If either the local element or external item have been modified since the items were created or linked, an indicator will be
shown on top of the item's icon. Right-click on the linked Enterprise Architect element and select the 'Pull - Update
Local Element with External Data' option.

Note: If the local element has been modified since the link was created then its changes will be overwritten with the
external data

Update External Item ('Push' changes)

If either the local element or external item have been modified since the items were created or linked, an indicator will be
shown on top of the item's icon. Right-click on the Enterprise Architect element and select 'Push - Update External Item
with Local Data'.

Note:

If the external element has been modified since the link was created then its changes will be overwritten with the·
local data

To update an external item the Integration Provider must be configured to allow this on the Pro Cloud Server·
(disallowed by default)
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Synchronize All Local Elements

All local linked elements from a provider can be quickly updated with new data from the External Provider's items.

Browse to the external provider to be synchronized.1.

In the 'External Data' menu, select 'Synchronize Local Linked Elements'.2.

Tick the fields that should be updated with any new data from the external item. Note that any local changes in the3.
Enterprise Architect element in these fields will be overwritten with the external data.

The bottom of the window indicates how many local elements will be updated (note that it is unknown at this point4.
if there have been any changes to the external item).

Click on the Synchronize button.5.
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Configuration

Each Integration Provider comes with a set of default mapping values that determines firstly what type of local element
is created in Enterprise Architect, and secondly which fields are copied to the new element. These mappings are
configurable for each client model.

Permission

Users must have the 'Configure External Data Sources' permission to access this functionality.

Access

Integration window toolbar 'Hamburger' Menu > Configure

Type Mapping

The 'Type Mapping' dialog defines the element type that will be created when users select the 'Create Local Element'
option for an external element.

To create a new mapping:

Click on the New button, then click on the 'External Type' drop-down arrow and select the type of the element to1.
map from the external source.
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Click on the 'Toolset' drop-down arrow and select the appropriate Enterprise Architect Toolset, then click on the2.
'Type' drop-down arrow and select the Enterprise Architect element type that the external element type maps to.

If appropriate, also click on the 'Stereotype' drop-down arrow and select the stereotype for the extended Enterprise3.
Architect element type that the external element type maps to.

Click on the Save button.4.

Note that if the external element type has been linked as an <<ExternalReference>> element, any Type Mapping settings
are ignored; see the Linking Items Help topic.

Field Mapping

The 'Field Mapping' dialog defines the element fields that will be updated for a mapped element when users select the
'Create Local Element' option. You display this dialog by clicking on the Configure Field Mapping button on the 'Type
Mapping' dialog, having mapped an external element type to an Enterprise Architect element (or selected an existing
mapped element type).

The process generally maps the fields for a specific type of element; however, if you want to map certain fields for all
types of element, click on the 'External Type' drop-down arrow on the 'Field Mapping' dialog, and select the value
'Default'.

To map the fields:

Click on the New button, then click on the 'External Field' drop-down arrow and select the name of the field to map1.
from the external source.

Click on the 'Internal Field' drop-down arrow and select the appropriate Enterprise Architect field name that the2.
external element field maps to.

If the internal field is a Tagged Value field, also click on the 'Tagged Value' drop-down arrow and select the Tagged3.
Value that the external element field maps to.

Click on the Save button.4.
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Notes

Each mapping can be reset to default values by clicking on the Reset to Defaults button·

If no type mapping is defined for a given element type, then the mapping for type 'Default' will be used·
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Writing a Custom Integration Plugin

We live in a highly connected world, and while there is a formidable list of out-of-the-box integrations provided with the
Pro Cloud Server, custom (proprietary) integrations can be created with any product that has a standard web service
interface.  This facility will both open up the contents of the Enterprise Architect repository to an external tool and also
make the information in the external tool available within Enterprise Architect. For example a Project Management tool
may define work pages that would be useful to visualize in Enterprise Architect, or an automated testing tool could
define test cases and test procedures that could be related to implementation and specification elements in Enterprise
Architect. This will require some technical expertise to create an integration using one of a number of programming
languages such as C++ or C# , but this only needs to be done once and can be used across any number of repositories.

The Pro Cloud Server and Enterprise Architect will do the heavy lifting, and there is no need for an administrator to
change any of the base security settings for the Pro Cloud Server as the new integration will operate through the existing
Ports and firewalls. There is also no need for the developer to write http listening code, allowing them to focus on
determining and configuring the RESTful API calls to pass the external items' information into and out of the server.

To write your own Custom Integration Plug-in you can either start from scratch or make a copy of one of the examples
that is installed with Pro Cloud Server, and modify it. The Plug-ins can be written in either C++ or C#.

The examples are written using Visual Studio 2017 but this is not a pre-requisite.

The Custom Integration Plug-in must implement the interface defined in the ISBPIIntegrationPlugin, which is included
in ISBPIIntegrationPlugin.h (for C++) or ISBPIIntegrationPlugin.cs (for C#).

The general flow of the program is as follows:

The user will perform an action within Enterprise Architect that needs information from the Integration Plugin·

The plugin will receive a call (or multiple calls) to the appropriate interface method·

The plugin should parse the request and, if required, make its own request to the actual data provider·

The plugin receives the result from the actual provider, and parses the data·

The plugin set the response to Enterprise Architect via the provided callback functions. This can either be the actual·
data requested or an error value

Enterprise Architect receives the callback data and displays it to the user·

Class

Fucntion/Class Details

Create Plugin The plugin must implement the following export function:

extern "C" SBPI_API SBPI_INTEGRATION_PLUGIN CreatePlugin();

It must return a pointer to a class that implements the ISBPIIntegrationPlugin
interface. The recommedned implementation is:

SBPI_INTEGRATION_PLUGIN CreatePlugin()

{

    return new ExampleIntegrationPlugin;

}

The newly created ISBPIIntegrationPlugin can be deleted when it receives
ISBPIIntegrationPlugin ::Release method.

ISBPIIntegrationPlugin
interface

The dll plugin must implement all methods in theISBPIIntegrationPlugin interface.
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ISBPIIntegrationPlugin interface

The ISBPIIntegrationPlugin interface provides these methods:

ISBPIIntegrationPlugin interface methods

Most methods have a single string parameter (char* in C++, string in C#) that is encoded as JSON to provide a variety of
parameters.

The ISBPIIntegrationPlugin interface provides these methods:

Method Name Notes

Release C++ only. This is called by the controlling application when the interface class is
no longer required. The method should delete class created during the
CreatePlugin() function.

SetCallbacks(const void **
callbackFunctions)

C++ only.

SetConfiguration Receives the settings defined when the user sets up the Custom Integration Plugin
in Pro Cloud Server.

SetAuthorisation

GetAuthorisationDetails

PostOAuthCode

RefreshOAuthToken

GetMenuList

GetItemList

GetItem

GetItems

GetItemNotes

GetItemDiscussion

PostNewItem

PostUpdateItem

PostNewDiscussion

CreateWebEAHyperlink
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GetDefaultTypeMapping

GetDefaultFieldMapping

GetTypes

GetFields

GetIcon

GenericRequest Reserved for future use.
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SetCallbacks

C++ only. This only needs to be implemented in C++. The code in the example is sufficient and doesn't need to be
modified. Extra error or bounds checking may be added.

Inputs

Parameter Details

const void **
callbackFunctions

An array of callback function pointers to be used to pass data back to Enterprise
Architect.

Outputs via Callbacks

None

Details

C++ plugins will receive this method soon after creation. It passes in an array of callback function pointers which are
used by the plugin later on to pass data back to Enterprise Architect

Example Implementation

void ExampleIntegrationPlugin::SetCallbacks(const void ** callbackFunctions)

{

    if (callbackFunctions)

    {

        AddProperty = (AddPropertyPtr)callbackFunctions[0];

        AddBinaryProperty = (AddBinaryPropertyPtr)callbackFunctions[1];

        SetErrorCode = (SetErrorCodePtr)callbackFunctions[2];

        SetError = (SetErrorPtr)callbackFunctions[3];

        LogMessage = (LogMessagePtr)callbackFunctions[4];

    }
}
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SetConfiguration

Inputs

Parameter Details

parameters C++: const char*·

C#: string·

A JSON string of parameters. See Details for more information about available
parameters.

Outputs via Callbacks

[Optional] LogMessage - set log messages about the configuration settings received. Be careful not to log sensitive
information.

Note: SetError callbacks will be ignored for this method.

Details

This method receives the details that the user inputs into the Pro Cloud Server configuration when enabling this Custom
Integration Plugin.

It includes the following details:

External Server to connect to:

serverName·

serverPort·

serverProtocol·

baseURL - the url folder to be appended to the url·

The server settings combine to form a URL as such: <protocol>://<serverName>:<serverPort>/<baseURL>

Hardcoded Credentials - These are optional and can be used to connect to a provider with a generic account:

username·

password·

Permissions - sets wether users can perform the specified actions on the external provider

allowCreateItems·

allowModifyItems·

allowPostDiscussions·

Proxy settings:

proxyServer·

proxyBypass·

proxyUsername·

proxyPassword·
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Example Implementation

void ExampleIntegrationPlugin::SetConfiguration(const char* parameters)

{

    LogMessage(LOG_TRACE, __FUNCTION__);

    Json::Value jsonParameters;

    if (strlen(parameters))

    {

        std::stringstream(parameters) >> jsonParameters;

    }

    // Store the settings as member variables for later use.

    m_serverName = jsonParameters["serverName"].asString();

    m_serverPort = jsonParameters["serverPort"].asString();

    m_serverProtocol = jsonParameters["serverProtocol"].asString();

    m_baseURL = jsonParameters["baseURL"].asString();

    m_settingsUsername = jsonParameters["username"].asString();

    m_settingsPassword = jsonParameters["password"].asString();

    m_allowCreateItems = jsonParameters["allowCreateItems"].asString();

    m_allowModifyItems = jsonParameters["allowModifyItems"].asString();

    m_allowPostDiscussions = jsonParameters["allowPostDiscussions"].asString();

    m_proxyServer = jsonParameters["proxyServer"].asString();

    m_proxyBypass = jsonParameters["proxyBypass"].asString();

    m_proxyUsername = jsonParameters["proxyUsername"].asString();

    m_proxyPassword = jsonParameters["proxyPassword"].asString();

}

(c) Sparx Systems 2019 Page 372 of 654 Created with Enterprise Architect



Model Repository - Model Repository 20 January, 2020

SetAuthorisation

Inputs

Parameter Details

parameters C++: const char*·

C#: string·

A JSON string of parameters. Available fields are:

username·

password·

accessToken - OAuth access token·

Outputs via Callbacks

[Optional] LogMessage or SetError - to provide user feedback.

Details

This method receives authorisation information that the user enters within Enterprise Architect.

It consists of either username:password credentials or OAuth access token.

Enterprise Architect will call SetAuthorisation at the start of each session (eg: open System Integration, open a model,
change user). Use the values provided for any calls to the external provider.

Do not store these as 'static' in any way. Storing as simple members is ok as a new instance of this class will be created
for each new session.

Example Implementation

void ExampleIntegrationPlugin::SetAuthorisation(const char* parameters)

{

    LogMessage(LOG_TRACE, __FUNCTION__);

    Json::Value jsonParameters;

    if (strlen(parameters))

    {

        std::stringstream(parameters) >> jsonParameters;

    }

    m_username = jsonParameters["username"].asString();            // If basic authorisation is used.

    m_password = jsonParameters["password"].asString();
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    m_accessToken = jsonParameters["accessToken"].asString();    // If OAuth is used.

}
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GetAuthorisationDetails

Return the Authorisation methods that your provider requires.

Supported types are:

none·

basic·

OAuth·

Inputs

Parameter Details

parameters C++: const char*·

C#: string·

A JSON string of parameters. This is an empty string reserved for future use..

Outputs via Callbacks

[Optional] AddProperty - to specify which authorisation methods are available and properties of these methods·

[Optional] LogMessage or SetError - to provide user feedback.·

Details

For no authorisation, do nothing in this method.

Enterprise Architect only supports the OAuth 2.0 Authorization Code Grant type.

OAuth Authorisation will set Enterprise Architect to prompt to open a browser page  for the user to log in to the OAuth
provider (the 'authorization endpoint URI').

The OAuth provider will send back a 'code' to Enterprise Architect.  Enterprise Architect will then call PostOAuthCode
with the new code.

Note: If OAuth is specified then it will take priority and not allow basic authorisation.

OAuth requires the authorizationEndpointURIand redirectURI of the OAuth provider.

For Enterprise Architect, the redirectURI must be "http://localhost:8888/oauth/callback".

This usually needs to be added to your OAuth provider as an allowed redirect URI.

Basic Authorisation will set Enterprise Architect to prompt for a  usename and password which will be passed back with
each subsequent request.

Example Implementation

Basic Authorisation:

AddProperty(index, "basic", "true");
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OAuth:

AddProperty(index, "OAuthConfiguration", "true");

AddProperty(index, "authorizationEndpointURI", "https://example.com/oauth/authorize");

AddProperty(index, "redirectURI", "http://localhost:8888/oauth/callback");
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PostOAuthCode

Inputs

Parameter Details

code C++: const char*·

C#: string·

The OAuth code value returned to the user after successful authorisation.

Outputs via Callbacks

AddProperty - "accessToken" to be used for OAuth·

[Optional] AddProperty - "refreshToken" for OAuth·

[Optional] LogMessage or SetError - to provide user feedback.·

Details

After a successful login to the OAuth provider by the user, Enterprise Architect will call this method with the OAuth
'code'. Make an Access Token Request to exchange the code for an OAuth Access Token (using the OAuth token
endpoint).

Return the accessToken and refreshToken with AddProperty.
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RefreshOAuthToken

Inputs

Parameter Details

parameters C++: const char*·

C#: string·

The OAuth refresh token to be used to get a fresh access token.

Outputs via Callbacks

AddProperty - "accessToken" to be used for OAuth·

[Optional] AddProperty - "refreshToken" for OAuth·

[Optional] LogMessage or SetError - to provide user feedback.·

Details

If any method here returns a 401 (Unauthorized) via SetErrorCode then Enterprise Architect will attempt to use the
refresh token (if it was supplied) and call this method.

Perform a refresh request against the OAuth refresh endpoint and return the new accessToken and refreshToken.
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GetMenuList

Inputs

Parameter Details

parameters C++: const char*·

C#: string·

A JSON string of parameters. Includes:

level - the level hierarchy of the requested menu (starting with 1 for first level)·

currentID, currentName - the id and name of the current menu level·

levelXID - the id of the menu level X for all previous levels in the hierarchy, ie·
level1ID, level2ID

levelXName - the name of the menu level X for all previous levels in the·
hierarchy, ie level1Name, level2Name

Outputs via Callbacks

AddProperty - 2 calls per menu item: "id", "name".·

[Optional] LogMessage or SetError - to provide user feedback.·

Details

This method receives a request to populate the menu in External Data window. Each level in the menu hierarchy will
trigger a new request, and the parameters will include the level being requested.

This method should fill in the menu items by calling the AddProperty callback method.

Each item in the menu requires two calls to AddProperty. And each item must use a unique 'index' value as the first
parameters

id - the id passed in specifies a unique id representing this menu item. The plugin may receive this id back in·
subsequent calls (eg when requesting the next sub-menu level)

name - the user displayable name of the menu item·

Don't return an error for a blank response. Simply do nothing.
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GetItemList

Inputs

Parameter Details

parameters C++: const char*·

C#: string·

A JSON string of parameters. Includes:

level - the level hierarchy of the requested menu (starting with 1 for first level)·

currentID, currentName - the id and name of the current menu level·

levelXID - the id of the menu level X for all previous levels in the hierarchy, ie·
level1ID, level2ID

levelXName - the name of the menu level X for all previous levels in the·
hierarchy, ie level1Name, level2Name

Outputs via Callbacks

[Optional] AddProperty - multiple calls per item:

AddProperty(index, "id", "myitemid");·

AddProperty(index, "name", "Example Item 3");·

AddProperty(index, "modifiedDate", "2020-04-06T11:33:44");·

AddProperty(index, "type", "Requirement");·

AddProperty(index, "url", "http://example.com/item/3");·

[Optional] LogMessage or SetError - to provide user feedback.

Details

This method receives a request to populate the list of item in External Data window for the selected menu level. This
method should fill in the items by calling the AddProperty callback method.

Each item in the requires five calls to AddProperty to fill in the details of the item in the list. And each item must use a
unique 'index' value as the first parameters

id - the id passed in specifies a unique id representing this item. The plugin may receive this id back in subsequent·
calls (eg when requesting item details, notes, etc)

name - the user displayable name of the item·

modifiedDate - the date/time that the item was last modified. in the format: YYYY-MM-DDTHH:MM:SS·

type - the type of the item as understood by the external provider, eg Defect, Task, Requirement, Document·

url - a url that will take a user directly to this item. This is used by Enterprise architect when selecting 'Open·
External Item in Browser Window'

Don't return an error for a blank response. Simply do nothing.
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GetItem

Return the full properties for the selected item.

Inputs

Parameter Details

parameters C++: const char*·

C#: string·

A JSON string of parameters. Includes:

itemID - the unique id of the item (as passed back in GetItemList)·

level - the level hierarchy of the requested menu (starting with 1 for first level)·

currentID, currentName - the id and name of the current menu level·

levelXID - the id of the menu level X for all previous levels in the hierarchy, ie·
level1ID, level2ID

levelXName - the name of the menu level X for all previous levels in the·
hierarchy, ie level1Name, level2Name

Outputs via Callbacks

AddProperty - multiple calls per menu item:

AddProperty(index, "id", "item1");·

AddProperty(index, "name", "Item 1");·

Optional extra properties. These can be custom propertyID:propertyValue pairs, eg:

AddProperty(index, "notes", "Example notes for item 1");·

AddProperty(index, "modifiedDate", "2020-04-06T11:33:44");·

AddProperty(index, "type", "Requirement");·

AddProperty(index, "url", "http://example.com/item/1");·

AddProperty(index, "propertyX", "Item 1 Property X");·

AddProperty(index, "propertyY", "Item 1 Property Y");·

AddProperty(index, "propertyZ", "Item 1 Property Z");·

[Optional] LogMessage or SetError - to provide user feedback.

Details

This method receives a request to populate the 'External' tab in the main properties list with details about this external
item.

This method should fill in the item's properties by calling the AddProperty callback method.

Each item requires two calls to AddProperty, and can accept extra optional calls to specify custom properties. the 'index'
value is not required for this call. Set it to 0.
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Mandatory properties:

id - the id passed in specifies a unique id representing this menu item. The plugin may receive this id back in·
subsequent calls (eg when requesting the next sub-menu level)

name - the user displayable name of the menu item·

Optional Properties:

The optional properties can be any propertyID:propertyValue pair. For the property to be listed in the properties window,
the property name must match a Field value as returned by the GetFields method.
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GetItems

Return the full properties for the requested items.

Inputs

Parameter Details

parameters C++: const char*·

C#: string·

A JSON string of parameters. Includes:

itemIDs - a comma separated list of item IDs·

level - the level hierarchy of the requested menu (starting with 1 for first level)·

currentID, currentName - the id and name of the current menu level·

levelXID - the id of the menu level X for all previous levels in the hierarchy, ie·
level1ID, level2ID

levelXName - the name of the menu level X for all previous levels in the·
hierarchy, ie level1Name, level2Name

Outputs via Callbacks

AddProperty - multiple calls per menu item:

AddProperty(index, "id", "item1");·

AddProperty(index, "name", "Item 1");·

Optional extra properties. These can be custom propertyID:propertyValue pairs, eg:

AddProperty(index, "notes", "Example notes for item 1");·

AddProperty(index, "modifiedDate", "2020-04-06T11:33:44");·

AddProperty(index, "type", "Requirement");·

AddProperty(index, "url", "http://example.com/item/1");·

AddProperty(index, "propertyX", "Item 1 Property X");·

AddProperty(index, "propertyY", "Item 1 Property Y");·

AddProperty(index, "propertyZ", "Item 1 Property Z");·

[Optional] LogMessage or SetError - to provide user feedback.

Details

Return the properties for a list of items. Recommended: If the provider has a way of querying a list of items, then it is
recommended to run a single query and return the results. If the provider can't query multiple items, then run multiple
individual 'GetItem' calls and concatenate the results.

The returned values should be the same as for GetItem, but specify a unique 'index' value for each different item.
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GetItemNotes

Return the notes/description/etc for the selected item.

Inputs

Parameter Details

parameters C++: const char*·

C#: string·

A JSON string of parameters. Includes:

itemID - the unique id of the item (as passed back in GetItemList)·

Outputs via Callbacks

AddProperty - notes - the text value of the notes for the item. Some basic html markup is allowed·

[Optional] LogMessage or SetError - to provide user feedback.·

Details

This method receives a request to populate the 'External' tab in the main Notes Window with details about this external
item.
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GetItemDiscussion

Return the discussions/comments/etc for the selected item.

Inputs

Parameter Details

parameters C++: const char*·

C#: string·

A JSON string of parameters. Includes:

itemID - the unique id of the item (as passed back in GetItemList)·

Outputs via Callbacks

AddProperty - 3 calls are required per comment. Use a unique index value per comment:

AddProperty(index, "authorName", "Example Person 1");·

AddProperty(index, "createdDate", "2020-04-06T12:34:56");·

AddProperty(index, "comment", "Example comment on Item 1 by Person 1");·

[Optional] LogMessage or SetError - to provide user feedback.

Details

This method receives a request to populate the 'External' tab in the main Discussion Window with comments/discussion
about this external item.
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PostNewItem

Create a new item in the Eternal Provider

Inputs

Parameter Details

parameters C++: const char*·

C#: string·

A JSON string of parameters. Includes details of the new item to be created.

Outputs via Callbacks

AddProperty - return the id of the newly created item. Enterprise Architect will not consider the creation successful
unless a valid ID is returned.

AddProperty(0, "id", "itemX");·

[Optional] LogMessage or SetError - to provide user feedback.

Details

This method receives a request to create a new item in the External Provider. The input parameters string contains
information about the item to create, including:

"title"·

"type"·

"stereotype"·

"description"·
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PostUpdateItem

Update an item in the Eternal Provider

Inputs

Parameter Details

parameters C++: const char*·

C#: string·

A JSON string of parameters. Includes details of the item to be updated.

Outputs via Callbacks

[Optional] LogMessage or SetError - to provide user feedback.

Details

This method receives a request to create a new item in the External Provider. The input parameters string contains
information about the item to create, including:

"itemID" - the ID of the item to be updated·

"title"·

"type"·

"stereotype"·

"description"·

Note: the new values may not actually be different to the current values.
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PostNewDiscussion

Add a new comment/discussion to the External Item

Inputs

Parameter Details

parameters C++: const char*·

C#: string·

A JSON string of parameters. Includes details of the new comment to be added.

Outputs via Callbacks

[Optional] LogMessage or SetError - to provide user feedback.

Details

This method receives a request to create a new discussion/comment in the External Item. The input parameters string
contains information about the comment to create, including:

"itemID" - the ID of the item to be updated·

"author"·

"comment"·
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CreateWebEAHyperlink

Add a link to WebEA in the External Item

Inputs

Parameter Details

parameters C++: const char*·

C#: string·

A JSON string of parameters. Includes details of the WebEA link to be added.

Outputs via Callbacks

[Optional] LogMessage or SetError - to provide user feedback.

Details

This method receives a request to a WebEA link to the External Item.

Some providers allow for external links to be added to an item, while others may only allow it to be added as a comment
or to the notes section.

The input parameters string contains information about the link to create, including:

"itemID" - the ID of the item to be updated·

"webEALink" - the full URL of the WebEA link·

Note that for the WebEA link to be valid, the Ribbon > Configure > Model > Options > Cloud tab must have a valid
WebEA base link specified.
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GetDefaultTypeMapping

Return a list of how the External Item types map to the Enterprise Architect element types

Inputs

Parameter Details

parameters C++: const char*·

C#: string·

A JSON string of parameters. Reserved for future use.

Outputs via Callbacks

AddProperty - 2-4 values per type to map. Use a unique index value for each mapping:

AddProperty(index, "externalType", "Requirement");·

AddProperty(index, "internalType", "Requirement");·

[Optional] AddProperty(index, "stereotype", "document");·

[Optional] AddProperty(index, "toolbox", "Extended::Requirements");·

[Optional] LogMessage or SetError - to provide user feedback.

Details

The values returned by this method are used to populate the Type Mapping in External Data Configuration.

It defines the default values for how an External Item's type maps to an Enterprise Architect element type.

Always specify a default mapping type. This will be used if no matching mapping is found:

AddProperty(index, "externalType", "Default");·

AddProperty(index, "internalType", "Requirement");·

Optional stereotype

AddProperty(index, "stereotype", "document");·

Specify the toolbox to allow users to change the mapping configuration to a type from the same toolbox.

AddProperty(index, "toolbox", "Extended::Requirements");·

Other mappings may be specified if desired. Eg:

AddProperty(index, "externalType", "Feature");·

AddProperty(index, "internalType", "Feature");·

AddProperty(index, "toolbox", "Extended::Requirements");·
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GetDefaultFieldMapping

Return a list of how the External Item fields/properties map to the Enterprise Architect element fields/properties/tagged
values

Inputs

Parameter Details

parameters C++: const char*·

C#: string·

A JSON string of parameters. Reserved for future use.

Outputs via Callbacks

AddProperty - 2-3 values per field to map. Use a unique index value for each mapping:

AddProperty(index, "externalField", "name");·

AddProperty(index, "internalField", "name");·

[Optional] AddProperty(index, "taggedValue", "My External Name");·

[Optional] LogMessage or SetError - to provide user feedback.

Details

The values returned by this method are used to populate the Field Mapping in External Data Configuration.

It defines the default values for how an External Item's fields/properties map to an Enterprise Architect element
fields/properties/tagged values when linking an External Item.

AddProperty(index, "externalField", "modifiedDate");·

AddProperty(index, "internalField", "Tagged Value");·

AddProperty(index, "taggedValue", "Modified Date");·
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GetTypes

Return a list of known types in the External Provider

Inputs

Parameter Details

parameters C++: const char*·

C#: string·

A JSON string of parameters. Reserved for future use.

Outputs via Callbacks

AddProperty - 2 values per type to map. Use a unique index value for each mapping:

AddProperty(index, "id", "artifact");·

AddProperty(index, "name", "Artifact");·

[Optional] LogMessage or SetError - to provide user feedback.

Details

If possible, this list of types should be dynamically created by querying the External Provider for a list of its known
types. The list of types can be hardcoded for providers that do not provide a list of types.
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GetFields

Return a list of known fields/properties in the External Provider

Inputs

Parameter Details

parameters C++: const char*·

C#: string·

A JSON string of parameters. Reserved for future use.

Outputs via Callbacks

AddProperty - 2 values per type to map. Use a unique index value for each mapping:

AddProperty(index, "id", "type");·

AddProperty(index, "name", "Type");·

[Optional] LogMessage or SetError - to provide user feedback.

Details

If possible, this list of fields should be dynamically created by querying the External Provider for a list of its known
fields. The list of fields can be hardcoded for providers that do not provide a list of fields.
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GetIcon

Return an icon for the External Provider

Inputs

Parameter Details

parameters C++: const char*·

C#: string·

A JSON string of parameters. Reserved for future use.

Outputs via Callbacks

AddBinaryProperty - the binary data of the icon.·

[Optional] LogMessage or SetError - to provide user feedback.·

Details

Specify an icon to be shown in Enterprise Architect External Data. The returned icon should be a png format, 20x16
pixels, with the left 4 columns of pixels blank and transparent.

Bit depth of 32 to include an alpha channel.

AddBinaryProperty(index, <pointer to binary data array>, iconBytesSize);·
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Custom SBPI Services

customsbpiservices.html

Benefits

Allows arbitrary requests and responses·

Once configured for a model can be called from scripting or Add-Ins·

Lifetime and request forwarding automatically handled by Pro Cloud Server·

Further content under development
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Troubleshooting

Integration Server messages

There are certain error messages that could display during the definition of the Integration Server settings; most are self
explanatory. This table describes the most common error messages.

Error Message Description

Please enter a value for
[field_names]. The
Integration Server can only
be saved (while enabled)
when all mandantory fields
have a value

Reason:  When the 'Enabled' flag is checked, all remaining Integration Server fields
are mandatory.  This message occurs when one or more Integration Server fields
are empty and the 'Enabled' flag has been checked.  [field_names] represents a
placeholder for a comma separated list of field names that are empty.

The executable name of
SBPI.EXE  was expected

Reason:  The 'Executable Path' field has a value but it does not include the filename
"...\SBPI.exe", which is the only valid filename that can be used.

The specified Integration
Server path of  [full_path]
does not exist or is invalid

Reason:  The 'Executable Path' field has a value but the path portion of the specified
value is not valid or does not exist on the Pro Cloud Server machine.

The specified Port is a
duplicate of
[duplicate_plugin_name]

Reason:  The 'Port' field has been assigned a Port number, but it is the same as a
Port being used by another Integration Data Provider identified by the name
[duplicate_plugin_name].

Integration Data Provider messages

There are certain error messages that could display during the definition of an Integration Data Provider; most are self
explanatory. This table describes the most common error messages.

Error Message Description

Please enter a value for
[field_names].  An
Integration Provider cannot
be saved without all
mandatory fields being
assigned a value.

Reason:  To minimize the chance of defining an invalid Data Provider, the
application ensures that all mandatory fields are given a value.  [field_names]
represents a placeholder for a comma separated list of field names that are empty.

Ports need to be unique
across all Providers, the
port value of [new_port]
has already been used by
[other_provider]

Reason:  A Port number has been defined for the current Data Provider, however
the value is a duplicate of another provider's Port.

The specified execution
path for the provider does
not exist or is invalid,
[full_path]

Reason: The 'Execution Path' for the data provider has been assigned a value, but
either the path or filename, or both, cannot be found on the local machine.
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The specified Port is a
duplicate of the Integration
Server

Reason:   A Port number has been defined for the current Data Provider, but the
value is a duplicate of the Port used by the Integration Server.

Failed to rename config file
[old_filename] to
[new_filename]

Reason:  When the user changes the config filename of an existing Data Provider,
the Cloud Server must rename the old filename to the new one. This message will
be shown if the rename task is not successful, (which can occur if the file is in use
by another process) and in this case manual intervention is the only way to resolve
this issue.

Prefixes need to be unique
across all Providers, the
prefix value of
[new_prefix] has already
been used by
[other_provider]

Reason:   A Prefix has been defined for the current Data Provider, but the value is a
duplicate of the prefix used by another provider.

Config filenames need to
be unique across all
Providers, the config
filename of [new_filename]
has already been used by
[other_provider]

Reason:   A Config filename has been defined for the current Data Provider, but the
value is a duplicate of the config filename used by another provider.

General Troubleshooting

This table provides general advice to help identify and resolve common issues with the Integration component of the Pro
Cloud Server.

Problem Description

Problem:  After making changes to the Integration definitions of the Server or Data Providers, the Enterprise
Architect users do not notice any differences.

Solution:  After changing the Integration configuration, was the Pro Cloud Server restarted?  If not, restart the Pro
Cloud Server.

Problem:  A newly configured Integration Data Provider is not listed in the navigation breadcrumb of Enterprise
Architect (after the Pro Cloud Server has been restarted).

Solution: Confirm that the currently open model has a Binding entry for the Data Provider. For details, see the
'Bindings' field in the Data Providers table of the Integration Plug-ins Help topic.

Problem:  Selecting items within the Integration navigation breadcrumb of Enterprise Architect seem to have no
effect.

Solution:  It is possible that errors (or warnings) are occurring that are logged to the System Output window,
therefore make sure the System Output window is displayed while using the Integration window.

Problem: General errors seem to be occurring, however no useful information is shown in the System Output
Window.

Solution:  Each Integration Data Provider has the capability to write detailed entries to a log file; to ensure that the
most detailed information is written, change the log level for the Data Provider to SYSTEM (restart the Pro Cloud
Server) and then retry the same action in Enterprise Architect. Then review the Data Provider's log file; that is, in
C:\Program Files (x86)\Sparx Systems\Pro Cloud Server\SBPI\Logs, on the Pro Cloud Server.
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Visibility Levels

The 'Visibility Levels' feature within Enterprise Architect provides the ability to restrict access to certain sections of a
model. Only models hosted by a Pro Cloud Server are able to make use of this feature. Visibility Levels are implemented
by taking advantage of the Row Level Security feature included in Oracle 8+ and Microsoft SQL Server 2016 (onwards).

Row Level Security is a security feature that controls what rows of data an individual database user can access.
Traditional database security only provides the ability to control the permissions of a user at the table level; that is, can
they read, write or delete data in a particular table? Since Row Level Security functionality is implemented by the
database, it is impossible for users to bypass security implemented at the application level, by writing their own scripts or
database queries. The database ensures that users can only view and update data they are authorized to access.

Given that Row Level Security is implemented by the database, most of the configuration for Enterprise Architect and
the Pro Cloud Server to support it is performed directly in the database without needing to change the application code
base, which means there is less to go wrong from an application perspective.

Database / Application Users

It is important to understand the distinction between database users and application users. The introduction states that
visibility levels are based on Database User permissions. In the Sparx Systems Pro Cloud Server environment, each
Database Manager is defined with all of its connection details (including the user ID and password) to a given database.
It is the database user, the user identified in the connection details, that visibility levels are based on.

This concept is not to be confused with Enterprise Architect model users; that is, the user ID/password that is entered
when accessing a security-enabled model. This is an application user.

Note: Enterprise Architect's model security is not mandatory, whereas all DBMSs require a database user to be defined
in order to access data within the database.

How it works

In addition to their normal permissions, database users are granted access to one or more visibility levels. A new column,
VIS_LVL (Visibility Level), is added to 24 critical tables within the Enterprise Architect database. This column stores
the visibility level that is required to view or update the corresponding record.

For each of the 24 tables, a security policy is defined that ensures each database user only sees records that their assigned
visibility level is authorized to view.

Database triggers are then used to maintain the value of the VIS_LVL columns in all tables for all child objects and
elements. For example, setting the visibility level of a Package in Enterprise Architect's Browser window will update the
selected Package and all of its children to the entered visibility level.

Note: The base scripts supplied by Sparx Systems support 20 'levels' of security (that is, 1 to 20); however, this can
easily be adjusted by manually changing the number of rows that are inserted into the T_VISIBILITYLEVELS table at
the beginning of the script. Level 0 is a special case, representing the default value; it implies that all database users
(even those without an assigned visibility level) can view or update records of this level.

The Drawback

As with most things, enabling Visibility Levels entails a cost when compared to the same model without Visibility
Levels being enabled.  Row Level Security in both SQL Server and Oracle imposes extra processing on the database
server each time data is selected. The impact of this extra processing on database performance is difficult to estimate, as
it depends on the type and amount of data being selected. Enterprise Architect's support of Visibility Levels has been
designed with efficiency in mind; however, the performance will inevitably be reduced when Visibility Levels are
enabled.
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Configure

The Sparx Systems Pro Cloud Server product is installed using a standard Microsoft Windows Installer package that
includes a number of optional components. One of these components is Visibility Levels, which is installed by default
into the C:\Program Files (x86)\Sparx Systems\Pro Cloud Server\VisibilityLevels\ folder (assuming a 64bit machine is
being used).  If necessary, you can change the install location of the Visibility Levels files.

Requirements

In order to use Visibility Levels you must have:

A licensed Pro Cloud Server·

An Oracle 8+ or SQL Server 2016+  -based Enterprise Architect model/repository that uses the EA1220 schema·
definition

An SQL-based management console tool that supports the execution of SQL scripts·

Enterprise Architect build 14.0 or later·

Enterprise Architect Ultimate Edition for assignment of Visibility Levels on a Package·

What is in the Package?

The Visibility Levels folder consists of a number of SQL script files that will either apply or remove the required
database changes to an Enterprise Architect model so that it can support the DBMS's native Row Level Security feature.

The implementation of Row Level Security in Oracle is completely different to the implementation in SQL Server. While
the end result behaves the same way, the physical objects that are needed by each DBMS are sufficiently different for
each to need its own creation script.

Task Script

Apply Visibility Level
changes to Oracle model

EASchema_VL_Updates_Oracle_1220.sql - Oracle SQL script that will update an
existing Enterprise Architect Oracle-based repository so that it supports Visibility
Levels, by creating a set of  functions, procedures, policies, triggers and columns.

Apply Visibility Level
changes to SQL Server
model

EASchema_VL_Updates_SQLServer_1220.sql - SQLServer-specific SQL script
that will update an existing Enterprise Architect MS SQL Server-based repository
so that it supports Visibility Levels, by creating a set of  functions, procedures,
policies, triggers, roles and columns.

Remove Visibility Level
changes from Oracle model

EASchema_VL_Removal_Oracle_1220.sql - Oracle SQL script that will remove
the functions, procedures, policies, triggers, roles and additional columns that were
added to support Enterprise Architect's Visibility Levels.

Note: All basic Enterprise Architect modeling data will remain unchanged by the
removal script.

Remove Visibility Level
changes from SQL Server
model

EASchema_VL_Removal_SQLServer_1220.sql - SQLServer SQL script that will
remove the functions, policies, triggers, roles and additional columns that were
added to support Enterprise Architect's Visibility Levels.

Note: All basic Enterprise Architect modeling data will remain unchanged by the
removal script.
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How to execute

In order for an Enterprise Architect model to support Visibility Levels, the appropriate update script must be executed on
that model's database. The script is standard SQL, so any tool can be used; however, you must connect using an ID with
owner privileges because updates will be made to the physical schema.

Script Execution for Oracle

Identify the Enterprise Architect model database to which to apply Visibility Levels.1.

Ask all users to log out of the model.2.

(Optional step) Physically stop any further user access to the database; for example, disconnect the server from the3.
network.

Perform a complete backup of the database.4.

Open your SQL console of choice and connect to the database as the owner.5.

Load the Oracle script ('EASchema_RLS_Updates_Oracle_1220.sql') into the console.6.

Review the comments at the top of the script, in particular the section that outlines the tasks that must be performed7.
before you run the script.

Make the required adjustments to the script for your environment/preferences.8.

Execute the script.9.

Follow the set of instructions documented at the top of the script, in the 'Do the following AFTER running this10.
script' section.

Perform a second complete backup of the database, as a restore point.11.

Define the Database Managers in the Pro Cloud Server (refer to the Defining Visibility Level Aware Database12.
Managers table in the Visibility Levels User Guide).

(Optional step) If Step 3 was performed, re-enable regular user access to the database.13.

Open Enterprise Architect Ultimate edition, connect to the Pro Cloud model with the highest Visibility Level (as14.
defined in step 12) and set the Visibility Levels on all Packages to their required values.

Script Execution for MS SQL Server

Identify the Enterprise Architect model database to which to apply Visibility Levels.1.

Ask all users to log out of the model.2.

(Optional step) Physically stop any further user access to the database; for example, disconnect the server from the3.
network.

Perform a complete backup of the database.4.

Open your SQL console of choice and connect to the database as the owner.5.

Load the SQL script ('EASchema_RLS_Updates_SQLServer_1220.sql').6.

Review the comments at the top of the script, in particular the section that outlines the tasks that must be performed7.
before you run the script.

Make the required adjustments to the script for your environment/preferences.8.

Execute the script.9.

Follow the set of instructions documented at the top of the script, in the 'Do the following AFTER running this10.
script' section.

Perform a second complete backup of the database, as a restore point.11.
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Define the Database Managers in the Pro Cloud Server (refer to the Defining Visibility Aware Database Managers12.
table in the Visibility Levels User Guide).

(Optional step) If Step 3 was performed, re-enable regular user access to the database.13.

Open Enterprise Architect Ultimate edition, connect to the Pro Cloud model with highest Visibility Level (as14.
defined in step 12) and set the Visibility Levels on all Packages to their required values.
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User Guide

The functionality of the Visibility Levels feature is primarily restricted to System Administrator users in Enterprise
Architect, in order to set up and configure models to limit access to certain Packages in a model. Generally, users will
not be aware of Visibility Levels; they simply will not see certain Packages in the model.

Defining Visibility Level Aware Database Managers

For the most part, the process of defining Database Managers in the Sparx Systems Pro Cloud Server Configuration
Client is the same as the process for non Visibility Level Database Managers. These are the exceptions:

DBMS Discussion

Orac
le

All Oracle connections require a 'DefaultSchema={schema_name};' option manually added to the
connection string, where {schema_name} is the physical name of the schema that owns the Enterprise
Architect tables. For example:

    Provider=OraOLEDB.Oracle.1;Password=pass;Persist Security Info=True;User ID=user1;Data
Source=ORA_SN;DefaultSchema=owner_user;

In a typical Oracle connection to an Enterprise Architect model the 'User ID' option is both the owner of
the tables and the user credentials that are being used to access the data. However, in a model using the
Visibility Levels feature these options are different, so the 'DefaultSchema' option has been added to
define the table owner.

Micr
osoft
SQL
Serv
er

All SQL Server connections require an 'Alias' field value that uniquely identifies the Database Manager
on the current server. The 'Alias' value is the name by which Enterprise Architect users know the model.

In previous versions of the Pro Cloud Server, the Database Manager 'Alias' for SQL Server-based
connections was automatically determined by the database name, which meant that each SQL Server
database could only ever have one Database Manager defined in the Pro Cloud Server. Now with the use
of the 'Alias' field a single database can have an unlimited number of Database Managers defined.

Enabling the Extended OLSC Interface on a Database Manager

In order for the Pro Cloud Server to allow the use of Visibility Levels in a model the 'Enable Pro Features (OSLC,
WebEA and Integration)' option must be selected. This is achieved by opening the Sparx Systems Pro Cloud Server
Configuration Client application (SSProCloudClient.exe) connecting to the appropriate server. You then select the
Database Manager in the list and click on the Configure button. On the resulting Configure Database Manager screen
select the 'Enable Pro Features (OSLC, WebEA and Integration)' checkbox.

Visibility Level Administration

When the Ultimate edition of Enterprise Architect is used to connect to a model that has Visibility Levels configured,
there is an additional menu item, 'Set Visibility Level...'  available under the 'Package Control' context menu of each
Package object in the Browser window.

If your model has security enabled, then all application users that require access to the 'Set Visibility Level...' menu item
will need to be allocated the 'Visibility Level Admin' or 'Administer Database' security permission, using standard
Enterprise Architect permission assignment.
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Set a Package's Visibility Level

From within the Ultimate edition of Enterprise Architect, the Visibility Level of a Package can be set using the Browser
window context menu item 'Package Control | Set Visibility Level...'.

This menu item will only be available in models that have been set up for Visibility Levels, are being accessed via a Pro
Cloud server connection and where the user has an Ultimate License.

Once a Visibility Level has been set on a Package, that Package and all of its children can be viewed, accessed and
updated only by users with the corresponding access level.

To remove a visibility level from a Package (and all its children), simply set the Visibility Level back to unrestricted.

Visibility Levels users can apply

Users can only set the Visibility Levels on Packages to levels the current database user has access to. For example, an
Enterprise Architect client connected to a Cloud connection that uses a database user that has been assigned levels 3 & 4
can update the Visibility Level of any Package to the levels unrestricted, 3 or 4.
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Troubleshooting

'Set Visibility Level' menu is not available

The 'Set Visibility Level' menu item can be hidden from users for a number of reasons:

You are not connecting to the model via a Cloud connection·

You are not using Enterprise Architect release 14 (or above)·

You are not using the Ultimate edition of Enterprise Architect·

The Cloud Server you are connected to has an expired license and is now operating as the free edition·

The model you are connecting to is NOT Oracle or MS SQL Server based·

The model in the Cloud Server you are connecting to is not configured with the 'Enable Pro Features (OSLC,·
WebEA and Integration)' option

The model you are connecting to has not been configured/adjusted for Visibility Levels (that is, the update script has·
not been run against the database)

The currently logged on application user has not been granted access to the 'Visibility Level Admin' Enterprise·
Architect security permission
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Floating License Server

The Sparx Systems Key Store server has been available for many years, providing users of Enterprise Architect with the
ability to manage their floating licenses. Up until version 2.1 of Pro Cloud Server, Floating License functionality was
only offered as an independent Microsoft Windows service. Now it is integrated with the Pro Cloud Server, and users
only have to install, configure and maintain one Microsoft Windows Service for all their Enterprise Architect needs.
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Install and Configure

The Sparx Systems Pro Cloud Server product is installed using a standard Microsoft Windows Installer package that
includes a number of components. The Floating License Server is included in the main 'Pro Cloud Services' component.
It is possible to change the install location of the Pro Cloud Server; however this document assumes the default install
location of  C:\Program Files (x86)\Sparx Systems\Pro Cloud Server\  (assuming a 64 bit machine is being used).

Important: All communications to the Pro Cloud's Floating License Server are performed via HTTPS; therefore, to use
the Pro Cloud Server's Floating License Server functionality at least one Port has to be configured to use the HTTPS
protocol, and a valid certificate/private key file must be defined in the Pro Cloud Server's Services folder. See the
Self-Signed SSL Certificates Help topic for more details.

The main Pro Cloud Server's configuration file (SSProCloud.config) defines two settings related to the Floating License
Server: FLOATLIC_PATH and  FLOATLIC_CONFIG.

The FLOATLIC_PATH option defines the path and file name of the Key Store file; by default this is:

     %SERVICE_PATH%\sskeys.dat

"%SERVICE_PATH%" is replaced with the physical path of the 'Services' folder (that is, 'C:\Program Files (x86)\Sparx
Systems\Pro Cloud Server\Service').

The FLOATLIC_CONFIG option defines the path and file name of the Key Store group file; by default this is:

     %SERVICE_PATH%\ssflsgroup.config

Floating License Server Group Configuration File

The Pro Cloud Server's Floating License Server component installs a configuration file called ssflsgroup.config into the
Service folder (C:\Program Files (x86)\Sparx Systems\Pro Cloud Server\Service\ssflsgroup.config). This file defines
'groups' of users that can obtain Licenses from the Floating License Server, and also controls which Enterprise Architect
Product Licenses each group can use.

A group is identified by a group name and a set of credentials (user ID and password) that will be used to securely
communicate with the Floating License Server over HTTPS.

The Floating License Server's configuration file will typically consist of multiple group definitions; each group definition
must be defined as shown:

GROUP

         Name=human_resources

         UserName={user name}

         Password={password}

         IsManager=false

         ENTITLEMENT

                  Product=UltimateSuite

                  Academic=false

                  Limit=10

         END ENTITLEMENT

         ENTITLEMENT

                  :

         END ENTITLEMENT

END GROUP
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Group Definition Properties

A Group definition begins when the token GROUP is encountered on a new line, and extends until the token END
GROUP is found on a new line.

Property Description

Name The common name of the Floating License group.

UserName Required.  Specifies the User ID for the Floating License Group.

Password Required.  Specifies the Password for the Floating License Group.

StartDate Optional.  Used in combination with the EndDate property to define the date range
within which the Group can be used.

EndDate Optional.  Used in combination with the StartDate property to define the date range
within which the Group can be used.

Entitlement - Section Each Group can define multiple Entitlements. An Entitlement definition begins
when the token ENTITLEMENT is encountered on a new line, and extends until
the token END ENTITLEMENT is found on a new line.

Each Entitlement definition accepts each of these sub-properties:

Product={Product Code}  - The product that this entitlement gives this group·
access to

Academic={true or false}  - Determines if this entitlement applies to the·
academic edition of the specified Product

Limit={number} - Optionally defines the maximum number of Product keys·
available to this group

The valid Product codes are:

Professional·

Corporate·

UnifiedSuite·

UltimateSuite·

BPSimExecution·

EclipseIntegration·

MDGCodeAnalysis·

MDGDDS·

MDGDoors·

MDGLinkEclipse·

MDGLinkVS·

MDGRealTime·

MDGSysML·

MDGTogaf·

MDGUPDM·

MDGZachman·

OfficeIntegration·

RaQuest·

TCSEIntegration·
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TCSESuite·

VSIntegration·

IsManager Optional. Specifies whether members of this group are permitted to perform
management operations (such as add/remove keys) on the keystore.

Default Value:  false

Configuration Changes

Changes to the Pro Cloud Server's Floating License Group file can be made while the Pro Cloud Server is running,
without the need to restart it.  The Floating License Server component will detects the last modified time, if the
configuration file has changed since it was last read the entire content of the file is re-read.
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Floating License Configuration Client

Administration of License keys that are stored in the Pro Cloud Server's Floating License Server is managed by a
Windows application installed in the Client folder (C:\Program Files (x86)\Sparx Systems\Pro Cloud
Server\Client\SSFloatLicClient.exe).

When the Floating License Configuration Client application is first started it will attempt to open a connection to the
most recent Floating License Server or keystore. If this is the first time running the Configuration Client, you will be
automatically prompted for the connection details of a Floating License Server.  See  the Floating License Server 
Connections Help topic for more details

The Floating License Configuration Client is capable of connecting and administering multiple Floating License Servers
and Shared KeyStores at any given time.  The Floating License Servers 'Key Stores' list (in the upper left of the screen)
will display each store that the Configuration Client has a connection to.

The Floating License Configuration Client application is capable of performing actions that can be broadly classified into
two different areas:

Floating License Server-based actions, including:·
     -  Floating License Server Connections
     -  Set Shared Key Lease Periods
     -  Migrate Shared Keys between Stores

Key-based actions; selecting a connected store from the 'Key Store' list will enable you to maintain the keys assigned·
to that store, using these functions:
     -  Add Shared Keys
     -  Release Shared Keys
     -  Delete Shared Keys
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Floating License Server Connections

The top left corner of the 'Floating License Configuration Client' screen displays a list of connected Floating License
Servers and Shared Keystores.  Each entry in the list can be one of three different types of store:

Floating License Server based  (prefix: https://)1.

Shared KeyStore or network based  (prefix: ssks://)2.

File based3.

The type of store can be determined by the connection's prefix (or lack of it); the network and file based keystore types
are historical, from earlier versions of the Floating License Server.

Floating License Server actions can be performed by selecting a Floating License Server/KeyStore item in the list and
then selecting a menu item from the 'File' menu, or by simply right-clicking on an item in the list; the menu options are as
shown:

Create...

Selecting the 'Create...' option helps you to create a new file-based keystore.

Link to...

Selecting the 'Link to...' option will display a prompt for the connection details of an existing Floating License Server (or
key store) to be added to the list of connected stores.
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Unlink

Selecting the 'Unlink' menu option while a Floating License Server is selected in the 'Key Stores' list will release the
Floating License Configuration Client's connection to that store and remove it from the list.

Delete

Selecting the 'Delete' menu option while a file-based Key Store is selected in the 'Key Store' list will physically and
permanently delete the file used to store the keys. This option is not available if the selected Keystore is either a Floating
License Server or shared network KeyStore.

Migrate to...

Selecting the 'Migrate to...' menu option while a file-based Key Store is selected in the Floating License Server 'Key
Store' list will allow the migration of keys from one store to another.  This option is not available if the selected store is
either a Floating License Server or shared network KeyStore-based.  See the Migrate Shared Keys between Stores Help
topic for more details.

Options...

Selecting the 'Options' menu option will display the 'Options' screen for the selected Floating License Server. See the Set 
Shared Key Lease Periods Help topic for more details
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Set Shared Key Lease Periods

Normally, in an environment that requires licenses to be shared, an Enterprise Architect user 'releases' the license they
have 'leased' immediate upon closing the application.  However, in an environment where Enterprise Architect users
work offline for periods of time (for example, using laptops) this type of configuration would not allow an offline user to
open Enterprise Architect once they have disconnected from the main network.

For this reason a Floating License Server / Key Store can be configured to have a longer retention period.

To administer the lease period of a Floating License Server / Key Store, select a store from the list and then select the
'Options' menu option. The 'Keystore Options' dialog is then shown.

Key leases expire after

This pair of fields determine how long a user can retain a key even if they log off Enterprise Architect. Typically you
would set this for the period that a user is unable to access the keystore, if they intend to work in Enterprise Architect
during that period. The setting is overridden by the 'Auto checkin' field, if it is enabled.

Type in the number of units of time, and then click on the drop-down arrow and select the appropriate unit.

Auto checkin

If users need to keep a key checked out when closing Enterprise Architect (for example, if a laptop user needs to keep
using the Enterprise Architect license for X days while not having access to the keystore server) then this option should
be disabled.

However, for the most efficient sharing of keys this option should normally be left enabled. When enabled, if a user
closes Enterprise Architect then their license key is automatically returned to the keystore (regardless of the lease expiry
setting).
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Migrate Shared Keys between Stores

To make best use of your upgraded Pro Cloud Server application, you might want to upgrade from a legacy file-based
keystore or network based keystore to the Pro Cloud Server Floating License Server. This process effectively removes all
keys from the original keystore, leaving it empty, and places the keys into the Floating License Server.

To migrate shared keys from other keystores, you must first define a connection to each source keystore, using the 'Link
to' context menu option in the 'Key Stores' list. Then, making sure the source keystore is selected in the list, select the
'Migrate to...' context menu option.

The 'Migrate Keystore File' screen displays:

Click on the  button on the right of the 'Destination' field, and browse for the details of the Pro Cloud Server Floating
License Server into which the shared keys are to be transferred. Click on the OK button to migrate the shared keys from
the source into the destination Floating License Server.
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Add Shared Keys

To add shared keys to a Key Store, select the Floating License Server / Key Store in the 'Key Store' list, and then select
'Key | Add...' from the header menu.

Alternatively, right-click on the 'Keys contained in this store' list and select 'Add...'.

Type in the floating key and click on the OK button.
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Release Shared Keys

It is usually not necessary to manually release a shared key from a workstation, as this happens automatically if:

The keystore's 'Auto checkin' option has been enabled and you close all running instances of Enterprise Architect on·
your workstation

The lease on the key expires·

However, if further users want to access Enterprise Architect and there is some technical anomaly that has prevented the
return of a key, you can manually release the key using the Sparx Systems Floating License Configuration Client.

To release a key from its active association with a particular workstation, click on the key in the 'Keys contained in this
store' list, and then select the 'Key | Release' header menu option.

(Alternatively, click on the 'Release Key' icon in the toolbar, or right-click on the key and select the 'Release' context
menu option.)
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Delete Shared Keys

To delete a key from the selected Floating License Server /  Key Store, open the Floating License Configuration Client,
click on the key in the 'Keys contained in this store' list, and then select the 'Key | Delete' header menu option.

(Alternatively, click on the Delete Key icon in the toolbar, or right-click on the key and select the 'Delete' context menu
option.)
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Troubleshooting

If users experience a problem with the Pro Cloud Server's Floating License Server, the error message will either be
displayed on the screen for errors related to the Floating License Configuration Client, or written to the Pro Cloud
Server's log file when an error occurs within the Pro Cloud Server. This topic provides a list of common Floating
License-related errors that could occur. Each entry describes the situation that has occurred and provides guidance on
how to correct the error.

Configuration-related Floating License Server errors

Issue Comments

EA Users are not able to
connect to a Floating
License Group

Enterprise Architect users cannot connect to a defined Floating License Group,
even when the entered details exactly match the definition.

Possible reasons:

The Pro Cloud Server configuration file does not contain a valid PCS license·
key, therefore all Pro Cloud features will be disabled

If an entitlement in the Floating License Group file is defined with an invalid·
Enterprise Architect product, the entire Group will be disabled; check the Pro
Cloud Server's log file for error messages - the invalid product will be
mentioned by name and line number

The Key Store connection
screen in EA does not
include HTTPS option

In order for Enterprise Architect to connect to the Pro Cloud Server's Key Store, a
protocol of HTTPS is required for secure communications.

Possible reasons:

A version prior to Enterprise Architect version 14 is in use·

The Key Store connection
screen in EA cannot
perform a successful 'Test'

Your client is not able to communicate with a Pro Cloud Server using the supplied
details.

Possible reasons:

Pro Cloud Server is not installed·

Pro Cloud Server is not running·

Pro Cloud Server is not listening on the expected Port using HTTPS·

There is no network connectivity between the client and server·

A firewall is limiting communications between the client and server·

Errors while using Floating License Configuration Client

Issue Comments

Could not open keystore at
[FilePath]. The file does
not exist and could not be
created

The service was unable to open the key store file specified by the
FLOATLIC_PATH property in the Pro Cloud Server configuration file
(SSProCloud.config).

Ensure that this path exists, and the user account that the Pro Cloud Server
Windows Service is running under has the necessary permissions to read and write
to the specified file.
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The Floating License
Configuration Client is not
able to connect

The machine running the Floating License Configuration Client is not able to
communicate with a Floating License Server using the supplied details.

Possible reasons:

Pro Cloud Server is not installed·

Pro Cloud Server is not running·

Pro Cloud Server is not listening on the expected Port using HTTPS·

There is no network connectivity between the client and server·

A firewall is limiting communications between the client and server·

The Pro Cloud Server configuration file does not contain a valid PCS license·
key, therefore all Pro Cloud features are disabled, including the Floating
License Server

The entered user credentials do not match any of the defined Floating License·
Groups in 'ssflsgroup.config'

The user credentials for the entered Floating License Group have not been·
defined as 'IsManager=true'

If an entitlement in the Floating License Group file is defined with an invalid·
Enterprise Architect product, the entire Group will be disabled; check the Pro
Cloud Server's log file for error messages - the invalid product will be
mentioned by name and line number

Could not open keystore,
no keystore file specified

No file path was specified in the property in the configuration file.

Type a file path into the FLOATLIC_PATH configuration property that the user
account the Pro Cloud Server Windows Service is running under can read and write
to.

Invalid or missing keystore
file - Keystore file cannot
be opened by this version
of the service or the file has
been corrupted

The keystore file specified by the configuration property FLOATLIC_PATH is
either incompatible with the current version of the Floating License Server, or has
somehow been corrupted on the file system.

Restore the key store file specified in the configuration property
FLOATLIC_PATH from a recent backup, or contact Sparx Systems Support for
assistance.

Key file has been moved The key store file specified by the configuration property FLOATLIC_PATH is
locked to the serial number of the hard drive it is created on. If the key store file is
moved from this hard drive, then other Floating License Servers are unable to open
it.

If the key store file has been moved, restore the file to its initial location. Certain
RAID configurations can affect how the hard drive's serial number is presented to
the Floating License Server. Thus, it is recommended that you house the key store
file on a non-RAID drive, wherever possible.

Errors while using Enterprise Architect and the Floating License Server

Issue Comments

Checkout Failure: There
are no more available keys
for this product in the key
store

Keys for this product exist; however, they are all checked out to other users.

If this error is frequently reported, consider limiting the use of the product across
your enterprise or purchasing more keys to meet the demand for the product.
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Checkout Failure: The key
store does not contain any
keys for this product

This keystore does not contain keys for the requested product. Keys for the product
might have been provided by the keystore in the past, but have since been removed.

Uninstall the product and return any shared keys on the client machine.

Checkin Failure: Key not
found in keystore.

The key being checked in has either been deleted since it was checked out, or was
checked out from another keystore.

Ensure that users return any shared keys to the key store they were leased from
before swapping Floating License Servers / key stores.
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Additional Functionality Using the Cloud

Even without a license, the Pro Cloud Server provides the facility of connecting to models over a secure http connections
(HTTPS). It also makes it possible to use these additional facilities on or within your models:

OSLC Requirements Management·

Reusable Asset Service (RAS)·

Scheduled Tasks·

OSLC Requirements Management

OSLC is an initiative to provide easier integration between Requirement Management tools. It uses HTTP to list, add,
modify and delete requirements. The service provider definition to direct any OSLC client to is:

     <protocol>://<server>:<port>/<model_name>/oslc/sp/

For example, if you were connecting to a server running on your own machine using the default settings, the connection
would be:

     http://localhost:804/model/oslc/sp/

Note, this is available in even an unlicensed Pro Cloud Server installation. The licensed Pro Cloud Server provides the
OSLC RESTful API ("OSLC Architecture Management v2.0") which offers much greater access to data in your Pro
Cloud models.

Reusable Asset Service (RAS)

The RAS portion of the Cloud Server helps you to define Packages that can be used in any model. When a Package is
requested, Enterprise Architect and the Cloud Server will track cross-Package dependencies and make available
everything required by that Package.

Scheduled Tasks

The Cloud Server includes optional support for running time-based updates to data. Currently, this is applied to updating
a Time Series chart automatically to provide a dynamic view of how a model is changing over time. You can set different
time scales for these updates, such as daily, weekly or monthly.

Notes

This facility is available through the Corporate, Unified or Ultimate editions·
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Reuseable Asset Service (RAS)

Within a large organization, groups of users can be separated by geographical distance and be on different networks.
This can make it difficult to share common data, standards and modeling structures, without the complexity of using
external Version Control tools or manually distributing XMI files between projects. Enterprise Architect has a Reusable
Asset Service (RAS) that provides a simple and convenient mechanism for modelers to distribute or download reusable
model structures, information, corporate directives and standards. The shared repository is accessible via a Cloud
connection, making it accessible for distributed teams. The person who sets up the reusable data can retain governance of
the resource or asset, whilst users of the service can easily review the currency of the information and download the
latest versions into their models or file folders.

The RAS gives distributed teams convenient access to a single 'source of truth' for shared data, including project
milestones, architectural frameworks and industry standards.

Reusable Assets

Reusable Assets consist of:

Packages containing elements, diagrams and structures (as drawn from any point within the Browser window), and·

Files in a range of text, code and graphic formats, including .eap files·

An asset can be, for example:

A common Class library or framework·

The Baselines for a set of Packages of the whole model·

A set of common Requirements or Use Cases·

A draft specification document·

Marketing collateral·

Storage Structure and Use

Reusable Assets are held in a remote registry, accessed through a Cloud connection. The registry contains any number of
Storages, which can either be left unprotected for any user to create, or change-restricted by an Administrator password.
Each Storage can contain any number of Asset Packages holding modeling structures, and files containing textual or
graphical information and data. When a user creates a Storage, they can protect the contents from being updated in the
Registry or downloaded into a model, using password protection defined by that user.

For each Package, the RAS automatically identifies the:

Version of the Package held in the registry·

Diagrams and elements (including child Package elements) contained by the Asset Package·

Dependencies on parent Packages of any external elements that the Asset Package references·

Dependencies on MDG Technologies·

Any user, regardless of password protection, can freely browse and identify the contents of a Package held in a Storage -
including displaying the diagrams - without importing the material into a model. A user that has imported an Asset
Package into their model can compare their model Package against any version of the Asset Package, to check for and
assess any differences between them.

Notes

The Reusable Asset Service is available in the Corporate, Unified and Ultimate editions of Enterprise Architect·
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Connect to the Asset Service

The Reusable Asset Service provides model structures and documents to you from one or more registries on remote
systems. You access these registries through a Cloud connection to the appropriate server. The connection details should
be provided to you by your System Administrator or Reusable Asset Service Administrator.

Access

Ribbon Publish > Model Exchange > Reusable Assets

Connect to Assets
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Option Detail

Registry This field normally defaults to the last-used registry name. If the field is empty, or

if you want to switch to a different registry, click on the  button to the right of
the field.

The 'Cloud Connection' dialog displays.

Using the information provided by your administrator, type in the server name,
URL and the name of the model hosting the registry data. For example, if you
wanted to download the UBL Frameworks into your model, you would specify the
server 'sparxcloud.com' and the model name 'modelpatterns'.

If advised by your Administrator, type in the user name and password for the
server.

Click on the OK button; the 'Registry' field now shows the server name.

Storage If there is more than one Storage available in the Registry, this field defaults to the
first listed in the Registry.

To check for or select other Storages, click on the drop-down arrow at the right of
the field. Click on the Storage to review. For example, if you were downloading
UBL frameworks, you would select 'UBL' in the list.

The 'Registry Browser' tab displays the Packages registered in the selected Storage.

Notes

The Reusable Asset Service is available in the Corporate, Unified and Ultimate editions of Enterprise Architect·
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Browse Assets

When you select a Storage in the Reusable Asset Service, the 'Registry Browser' tab immediately displays a list of the
Packages registered in that Storage. You can review and use these Packages using the context menu and buttons on the
tab.

You can review the properties and contents of the selected Package in the Storage, and access any files in the Storage,
using the tabs in the lower half of the Reusable Asset Service view, underneath the 'Registry Browser' tab.

If you have left the Registry Browser open for a while and there is a possibility that the Registry has been changed, you

can click on the  icon in the Reusable Asset Service toolbar to refresh the Browser with the latest contents of the
Registry.

Access

Ribbon Publish > Model Exchange > Reusable Assets > Registry Browser

Review Assets

Option Detail

Toggle Filter Bar Right-click on the column headings and select this option to show or hide the Filter
Bar on the display.

<filter bar fields> Type in the appropriate characters to list only Packages that have that string of
characters in the values in the corresponding column.

Package This column shows the name of the Packages held in the selected Storage.

Version This column defaults to the most recent version of each Package held in the
selected Storage.

You can click on the drop-down arrow at the end of a field and select a different
version of the corresponding Package, if any have been registered.

Last Registered This column shows the date and time at which the currently-listed version of each
Package was registered.

Registered By This column shows the user name of the person who registered the currently-listed
version of each Package.

Import Click on a Package name and click on this button to begin to import either the
Package alone or the Package and its dependent structures into your model.

You can perform the same action by right-clicking on the Package name and
selecting the 'Import from Registry' menu option.

If the Package from the Registry already exists in your model, it is deleted and
replaced by this import.

For a:
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'Learning Center Library' Storage, the 'Download Library' dialog displays·

'Reference Data Library' Storage, the 'Import Reference Data' dialog displays·

'Source Code Library' Storage, the 'Save As' dialog displays·

Compare with Package in
Model

If you have previously imported a Package from the Registry into your model, you
can right-click on the Package name in the 'Registry Browser' tab and select this
option to compare the imported Package with the Registry version, and show any
differences.

The system automatically selects the model Package from the Browser window.

Find in Project Browser If you have previously imported a Package from the Registry into your model, you
can right-click on the Package name in the Registry Browser and select this option
to highlight the corresponding Package in the Browser window.

Notes

Some of the other options available on the Registry Browser are used to set up assets in the Registry·

If the Storage is password-protected, a prompt for you to enter a password displays when you select to perform an·
operation on the data; in this situation, you need the 'Read-only' password to process the information from the
Storage, and the 'All-access' password to change the information in the Storage

The 'Registry Browser' tab will be empty for a 'Learning Center Library', 'Reference Data Library' or 'Source Code·
Library' type Storage - the contents of these types of Storage will be available in the 'Storage Files' tab of the
Reusable Asset Service view
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Asset Properties

When you select a Storage and a Package in the 'Registry Browser' tab, the first four tabs in the lower half of the
Reusable Asset Service view are updated with information from the Package. The 'Asset Properties' tab is a read-only
view of the properties of the selected Package itself.

Access

Open the Reusable Asset Service window using one of the methods outlined here.

Select a Package, then click on the 'Asset Properties' tab to display properties for that Package.

Ribbon Publish > Model Exchange > Reusable Assets

Review Package Properties

Field Detail

Package Displays the name of the selected Package.

GUID Displays the Global Unique Identifier of the Package.

Version Displays the version reference (such as 1.1 or Beta) of the Package.

Author Displays the user ID of the person who created the Package (the Package Author).

Created Displays the date and time at which the selected version of the Package was created
(that is, registered) in the Registry.

Modified Displays the date and time at which the selected version of the Package was last
modified (that is, re-registered) in the Registry.

Comments Displays any comment recorded against the Package when it was registered in the
Storage.

Notes Displays the notes recorded against the Package when it was registered in the
Storage.

Notes

The 'Asset Properties' tab will be empty for a 'Learning Center Library', 'Reference Data Library' and 'Source Code·
Library' type Storage
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Package Contents

When you select a Storage and a Package in the 'Registry Browser', the first four tabs in the lower half of the Reusable
Asset Service view are updated with information from the Package. The 'Contents' tab lists the diagrams and elements
(including child Packages) held in the selected Package, listing the two types of object separately. You can organize the
information within a column into alphabetical or reverse-alphabetical order for ease of reference, and use the Filter bar to
filter the display to show only items with values containing specific characters or digits.

Access

Open the Reusable Asset Service window using one of the methods outlined here.

Select a Package, then click on the 'Contents' tab, to display the contents of that Package.

Ribbon Publish > Model Exchange > Reusable Assets

Review Package Contents

Option Detail

Content Type Click on this button to toggle between listing the Package diagrams first and listing
the Package elements first.

Toggle Filter Bar Right-click on the column headings and select this option to show or hide the Filter
Bar on the display.

<filter bar fields> Type in the appropriate characters to list only elements and diagrams that have that
string of characters in the values in the corresponding column.

Content Type: Diagram

Content Type: Element

These are the headers for the two types of object listed in this tab.

Click on the appropriate expansion box to hide or show the list of diagrams or
elements under the heading.

Name Displays the name of the element or diagram available in the Package.

Type Displays the type of the element or diagram, such as UseCase or Use Case diagram.

GUID Displays the Global Unique Identifier of the element or diagram.

Content Type Displays the object type of the item - Element or Diagram.

Find in Project Browser Right-click on an element or diagram line and select this option to see if the
element or diagram also exists in your model and, if it does, to highlight it in the
Browser window.

View Diagram Right-click on a diagram name and select this option to display the diagram within
a labeled frame, as an image in a separate window. The image is displayed at the
default zoom level for the model.
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Alternatively, to view the diagram, double-click on the diagram name.

Notes

The 'Contents' tab will be empty for a 'Learning Center Library', 'Reference Data Library' or 'Source Code Library'·
type Storage
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Package Dependencies

A Package held as an asset in the Reusable Asset Service registry might contain elements and diagrams that have
relationships with objects in other Packages. The Packages containing these 'external' objects will also have been added
to the Registry to support the first Package, and will be listed in the 'Registry Browser' tab along with other (unrelated)
Packages. You can establish whether the selected Package in the 'Registry Browser' tab has links to other Packages in the
Registry, and which they are, by reviewing the 'Dependency' tab.

Package A depends on Package B if any of these constructs (or their Tagged Values) in Package A references elements
in Package B:

Elements·

Attributes·

Operations·

Operation Parameters·

Diagrams·

Connectors·

Access

Open the Reusable Asset Service window using one of the methods outlined here.

Select a Package, then click on the 'Dependency' tab, to display a list of Dependencies for that Package.

Ribbon Publish > Model Exchange > Reusable Assets

Check Package Dependencies

Option Detail

Package Displays the name of the related Package.

Version Displays the latest registered version of the related Package that has links to the
selected Package.

GUID Displays the Global Unique Identifier of the related Package.

Find in Project Browser Right-click on the 'Package' line and select this option to see if the Package also
exists in your model and, if it does, to highlight it in the Browser window.

Notes

If one Package depends on another, and that second Package itself depends on another Package, both the second and·
third Packages are shown in the 'Dependency' tab

The 'Dependency' tab will be empty for a 'Learning Center Library', 'Reference Data Library' or 'Source Code·
Library' type Storage
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Package Technologies

It is possible that the asset Package in the Registry is associated with one or more Technologies, especially if the Package
comes from a model developed as an extension or customization of the UML. You can check whether an asset Package
has any associated Technologies, and what they are, by viewing the 'Technology' tab of the Reusable Asset Service view.

Access

Open the Reusable Asset Service window using one of the methods outlined here.

Select a Package, then click on the 'Technology' tab, to display a list of Technologies required to support that Package.

Ribbon Publish > Model Exchange > Reusable Assets

Review Technologies

Option Detail

Name Displays the name of the Technology as recorded in the Registry.

Version Displays the required version of the Technology to support the asset Package,
available through the Registry.

ID Displays the unique identifier of the Technology.

Type Identifies whether the Technology is system-supplied and built in to Enterprise
Architect (such as BPMN 2.0 or ArcGIS), or user-defined.

A user-defined technology can be introduced from an external source or developed
by a user within the system.

Registry Status Indicates whether the Technology file is:

Available - the Technology file is registered in the current Storage, or·

Unavailable:·
     -  The Technology file is not registered in the Storage, or
     -  The Technology is a built-in Technology and is already integrated
         with your system, or must be purchased under license, or
     -  The Technology is available from a URL and can be downloaded
         from that URL

Import Technology If your local system does not have one of the Available Technologies, you can
quickly import it from the Registry.

Right-click on the Technology name and select the 'Import Technology' option.1.

A prompt displays for you to confirm the import to your system; click on the2.
Yes button.

A message displays to confirm that the Technology has been imported; click on3.
the OK button.

You might have to restart Enterprise Architect to activate the Technology.

Other than the remote Technologies, you cannot import a Technology flagged as
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'Unavailable'. You can import a remote Technology from its URL site.

Notes

You can also import Available Technologies from the registry as part of the process of importing the asset Package·

If the Storage is password protected, a prompt to enter your password displays (this can be a Read-Only or a·
Complete Access password) after you confirm that you want to import the Technology; you cannot import the
Technology without this password

The 'Technology' tab will be empty for a 'Learning Center Library', 'Reference Data Library' or 'Source Code·
Library' type Storage
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Storage Files

The 'Storage Files' tab of the Reusable Asset Service view simply lists the files that have been uploaded to the specified
Storage. The files can be of any type, uploaded from any directory on any system connected to the registry. Typically
they would be document or graphics files that provide standards, guidelines or design information on a model structure.
The tab displays the file name and extension, and a comment on the nature or purpose of the file.

Files held in the Registry are compressed, so to view the contents you download them onto your local system.

Access

Open the Reusable Asset Service window using one of the methods outlined here.

Select a Package, then click on the 'Storage Files' tab to display a list of files associated with the Package, that are
available for download.

Ribbon Publish > Model Exchange > Reusable Assets

Review files in Model Package type Storage

On the 'Storage Files' tab, check the 'Comments' field against each file that interests you.

To view the contents of a file, right-click on the file name and select the 'Import From Registry' option. The 'Save As'
browser displays, through which you select the directory into which to copy the file.

Click on the Open button. The file is copied into the selected location, from which you can open it.

Review files in Learning Center/Reference Data/Source Code Library type Storage

On the 'Storage Files' tab, check the 'Comments' field against each file that interests you.

To import and install a Library file, right-click on the file name and select the 'Import From Registry' option. One of
these dialogs will display:

'Download Libraries' dialog for a 'Learning Center' type Storage·

'Import Reference Data' dialog for a 'Reference Data Library' type Storage·

'Save As' dialog for a 'Source Code Library' type Storage·

'Learning Center Library', 'Reference Data Library' and 'Source Code Library' type Storages do not contain any Assets.
Therefore, clicking on the:

'Import' button in the Registry Browser will import and install a Library file from the Storage·

'Delete' button in the Registry Browser will delete all Library files in the Storage·

Notes

If the Storage is password-protected, the system prompts you to enter a password before you begin importing a file·
from the Storage; in this case you require either a 'Read-Only' or a 'Complete Access' password

(c) Sparx Systems 2019 Page 436 of 654 Created with Enterprise Architect



Model Repository - Model Repository 20 January, 2020

Add Review Comments

For any Model Package in the Storage, you can add individual review comments on any aspect of the Package. These
comments provide a permanent record on the Package - once they have been saved they cannot be edited or deleted.
Each comment is attributed to the ID of the user who entered it, and is date stamped.

Note that the Review tab is present for a Learning Center Library Storage, Reference Data Library Storage, and Source
Code Library Storage; however, the tab and panel are disabled and review comments cannot be entered for these storage
types

Access

Open the Reusable Asset Service window using one of the methods outlined here.

Select a Registry, Model Storage and Package, then click on the 'Review' tab to display a list of comments associated
with the Package, and a panel for entering further comments.

Ribbon Publish > Model Exchange > Reusable Assets

Actions

Action Description

Review Existing
Comments

If there appears to be a longer comment than can be shown in the 'Review' tab, click
on it. The full text displays in the 'Comments' field in the lower panel.

Add a New Comment Click on the New button and start typing your comment on the Package in the
'Comments' field. You can delete and edit text as you type.

When you have finished writing your comment, click on the Save button. Your
comment, preceded by your user ID and the current date, is displayed in the
'Review' panel.

Once you have saved your comment, you cannot edit or delete it.
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Compare an Asset to the Model

If you are developing a Package in your model against a standard structure, or using common elements from the
Reusable Asset Service, you can check that your model conforms to the standard or incorporates any changes to the
common elements, by performing a comparison between the Asset Package and your model.

Access

Open the Reusable Asset Service view using one of the methods outlined here.

Select a Package, then right-click on the Package and choose 'Compare with Package in Model'.

Ribbon Publish > Model Exchange > Reusable Assets

Compare Asset Package and Model

A prompt displays for you to confirm the comparison. Click on the Yes button.

The Baseline Comparison view displays, showing the element hierarchy in which differences have been detected
between the Package in the model and the asset Package in the Registry (as the Baseline).

All facilities of the standard Baseline Comparison are available, including the ability to 'roll back' differences so that the
element or Package in the model matches the Registry.

Notes

If the Storage is password-protected, the system prompts you to enter a password before you begin comparing·
information in the Storage and in the model; in this case you require either a Read-Only or a Complete Access
password
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Import an Asset into the Model

The Reusable Asset Service provides common or standard information and data that you can import into your local
model. The unit that you import is a selected version of the Asset Package; you can also, optionally, import:

Other Packages on which the selected Asset Package depends, and/or·

Available Technologies that support full use of the model structures in the Asset Package·

The Asset Package (with, if selected, any needed Packages) is imported into the currently-selected model Package in the
Browser window, unless the Asset Package already exists anywhere else in the Project. In this case, the system locates
the existing Package and overwrites it with the imported Asset Package.

Access

Open the Reusable Asset Service window, using one of the methods outlined here.

On the 'Registry Browser' tab, either;

Select an Asset Package and click on the Import button, or·

Right-click on an Asset Package and select the 'Import from Registry' option·

Ribbon Publish > Model Exchange > Reusable Assets

Import Asset Package

Before selecting an Asset Package to import into your model, click on the 'Version' drop-down arrow and select the
appropriate version of the Package to import.

When you select to import an Asset Package into your model, a short menu displays from which you select to import:

The Package alone or·

The Package with the related Packages on which it is dependent·

A prompt then displays for you to confirm the import, and to warn you that if the Package already exists in the model, it
will be overwritten by the import. Click on the Yes button to continue, or the No button to cancel the import.

If the Storage is password protected, after you confirm the import a prompt displays for your 'Read-Only' or
'Complete-Access' password; enter this and click on the OK button.

The 'Import from Registry' dialog displays, followed by confirmation that the import of the Package or Packages is
complete. Click on the OK button.

If the Package depends on Technologies

If the Technologies associated with an Asset Package are not already on your system and/or enabled in your model,
during the display of the 'Import from Registry' dialog the 'Import Technology From Registry' dialog also displays.
Process this dialog as described.

Option Detail

Name Displays the name of the Technology as recorded in the Registry.

The checkbox against each name is selected by default. If you want to import one
technology but not another, deselect the checkbox of the technology to ignore.
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Version Displays the required version of the Technology to support the Asset Package,
available through the Registry.

Registry Status Indicates whether the Technology file is:

Available - the Technology file is registered in the current Storage, or·

Unavailable - for one of these reasons:·
     -  The Technology file is not registered in the Storage, or
     -  The Technology is a built-in Technology and is already integrated with
your system, or must
         be purchased under license, or
     -  The Technology is available from a URL and can be downloaded from
that URL

Model Status Indicates whether the Technology is already in your model and disabled.

(If the Technology is in your model and enabled, there is no need to import it and it
is not listed in the dialog.)

OK Click on this button to import and/or enable the selected Technology or
Technologies in your system.

A status message displays to indicate that the Package and Technologies have been
imported and the Technologies enabled. You might have to restart Enterprise
Architect for the Technologies to take full effect.

Click on the OK button to clear the message.

In the Browser window, the Package has been added to the model with (if selected)
the Packages on which it is dependent.

Import Library

The Reusable Asset Service provides the ability to store Library files that you can import into your local model. The type
of Library file available in a Storage will depend on the Storage type. When you import and install a Library from a:

Learning Center Library storage, it will be available for use on all Enterprise Architect models in this system·

Reference Data Library storage, it will be installed into the current model·

Source Code Library storage, it will be saved in the specified location in the file system·

Library from a Learning Center Library storage. Either:

Click on the Import button to open the 'Download Libraries' dialog, showing all the Library files in this storage as·
selected, or

Right-click on a Library file in the 'Storage Files' tab and select the 'Import from Registry' option to open the·
'Download Libraries' dialog showing that specific Library file as selected

Library from a Reference Data Library storage. Either:

Click on the Import button to open the 'Import Reference Data' dialog, showing all the reference data in that Library·
file as selected, or

Right-click on a Library file in the 'Storage Files' tab and select the 'Import from Registry' option to open the 'Import·
Reference Data' dialog, showing all the reference data in that Library file as selected

Library from a Source Code Library storage. Either:

Click on the Import button to open the 'Save As' dialog and select a location in the file system to save the imported·
Library to, or

Right-click on a Library file in the 'Storage Files' tab and select the 'Import from Registry' option to open the 'Save·
As' dialog, then select a location in the file system to save the imported Library to
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If the Storage is password protected, a prompt for you to enter your 'Read-Only or 'Complete-Access' password displays.
Enter the password and click on the OK button.

Notes

You can also import Technologies separately from the Package that is dependent on them, using the 'Technology' tab·
of the Reusable Asset Service view

'Learning Center Library', 'Reference Data Library' and 'Source Code Library' type Storages do not contain any·
Asset Packages
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Search Registry

After you have set up your Storages in the Reusable Asset Service Registry and registered Asset Packages in them, you
can search the Registry to locate modeling items such as Packages, elements and diagrams using their names or Global
Unique Identifiers (GUIDs).

Access

Ribbon Publish > Model Exchange > Reusable Assets

Search Registry for Asset Package Contents

Step Action

1
Click on the  icon in the Reusable Asset Service toolbar.

The 'Search Registry' dialog displays.

2 In the 'Property' field, select:

'GUID' if you intend to search the Registry for a modeling item based on its Global Unique Identifier·

'Name' if you intend to search the Registry for a modeling item based on its name·

3 In the 'Term' field, type in the GUID or name of the modeling item.

Note the interpretation of this field is case-sensitive.

4 In the 'Item' section, select the modeling item to search for; that is, Package, element and/or diagram.

5 Click on the Search button to search the Registry for the selected modeling item(s) and to display the
results, if any, in the 'Results' section.

6 The 'Results' section displays the results of the search, showing these details:
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Storage - the name of the Storage in the Registry that has the modeling item·

Owner - the name of the Asset Package that contains the modeling item·

Name - the name of the modeling item·

Type - the Enterprise Architect type of the modeling item·

GUID - the Global Unique Identifier of the modeling item·

Notes :

The search results will be grouped by modeling item·

The group Nested Package represents all those Packages (that satisfy the search criteria and) that are·
a part of another registered Package

7 Select an entry in the 'Results' section and click on the OK button to open the Storage (containing the
modeling item) in the Registry Browser and close this dialog.

You will be prompted for a password if the Storage is password protected; enter the 'Complete Access' or
'Read-Only Access' password and click on the OK button to view the Storage contents.
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Set Up Registry Password

As a System Administrator, you can password-protect the Registry server to prevent users from modifying the Registry;
that is, restrict users from performing top-level activities such as creating, modifying and deleting Storages. Once you
have set password protection, only those users who have a valid Administrator password can modify the Registry.

You can also change the password at regular intervals, for added security.

Access

In order to set the Registry Administrator password:

In Enterprise Architect, open the Cloud model that is designated as the RAS Registry·

Open the RAS window (Publish > Model Exchange > Reusable Assets)·

The Set Administrator Password button is displayed next to the 'Registry' field·

Click on this button to display the 'Set Administrator Password' dialog·
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Set the Administrator Password

Option Detail

Enter old password Disabled if no password exists for the Registry server.

If the server has a current password, type it in to this field.

New password Type in the new Administrator password.

Retype new Type in the new Administrator password, for confirmation.

OK Click on this button to set the password and close the dialog.

Cancel Click on this button to abort the changes and close the dialog.

Notes

To remove password protection from the Registry server, complete the 'Enter old password' field but leave the 'New·
password' and 'Retype new' fields blank

If a Storage has a 'Complete Access' password, then you can use either the Administrator password or the 'Complete·
Access' password to modify the Storage
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Set Up the Asset Service

The process of setting up assets and files in the Reusable Asset Service has a number of simple stages, typically:

Identify the Registry·

Create the Storages, including copying an existing Storage as a template for a new one·

Set password protection on each Storage·

Register the Asset Packages and Storage Files, and update them as necessary·

Access

Ribbon Publish > Model Exchange > Reusable Assets

Identify Registry

The Registry server holds the Storages of the Reusable Asset Service. It will have been previously configured by your
system administrator, to be accessed through a Cloud Connection. Your system administrator will provide the connection
details for you to use.

In the Reusable Asset Service view, click on the  button to the right of the 'Registry' field. The 'Cloud Connection'
dialog displays.

Using the information provided by your administrator, type in the server name, URL and the name of the model hosting
the registry data. If advised by your administrator, also type in the user name and password for the server.

Click on the OK button; the 'Registry' field now shows the server name.

Create Storages

A Storage is a container within the Registry, holding related assets and files. There can be several Storages in the
Registry, to support the different areas of work or purposes that your organization might define.

Step Action

1
Click on the  icon in the Reusable Asset Service toolbar.

2 If necessary, enter the Administration password that enables update access to the Registry. Click on the
OK button.

The 'New Storage' dialog displays.

3 In the 'Name' field, type a name that indicates the purpose or content of the Storage.

4 In the 'Content' field, select:

'Model Package' if the Storage should contain Asset Packages and/or Files·

'Learning Center Library' if the Storage should contain only Enterprise Architect Learning Center·
Library files - this Storage can be populated only with Library files and not with Asset Packages

'Reference Data Library' if the Storage should contain only Enterprise Architect Reference Data·

(c) Sparx Systems 2019 Page 446 of 654 Created with Enterprise Architect



Model Repository - Model Repository 20 January, 2020

Library files - this Storage can be populated only with Library files and not with Asset Packages

'Source Code Library' if the Storage should contain only Source Code Library files - this Storage can·
be populated only with Library files and not with Asset Packages

5 If you have selected 'Model Package' in the 'Content' field, then in the 'Status' field select:

'Draft' if you intend to make significant changes to the content of the Storage, such as populating it·
with assets and/or files; you can also overwrite existing Packages or files in the Storage

'Complete' if the Storage is ready for use; you cannot overwrite any Packages or files in the Storage,·
although you can delete Packages and files and add new ones

You can modify a 'Model Package' Storage at a later time, and change this 'Status' setting (see the Change
Storage Details section in this topic ).

Storage whose Content is 'Learning Center Library', 'Reference Data Library' or 'Source Code Library'
will always be of 'Draft' Status - you can overwrite existing Library files in these Storages.

6 If you want to set Storage Access passwords on this Storage, click on the checkbox against one or both
password types, and provide and confirm the 'Complete Access' and/or 'Read-Only Access' passwords (see
the Password Protection section in this topic).

7 Click on the OK button.

A prompt displays for you to confirm the creation of the Storage, with the type of access you have set on
the Storage.

8 Click on the Yes button.

A confirmation message displays; click on the OK button.

The name of the new Storage displays in the 'Storage' field.

Password Protection

The Registry can be protected by a Registry password, so that only the Administrator can create and modify Storages. If
no Registry password is set, a second level of password protection can be applied.

The owner of a Storage can apply password protection to restrict users in processing and modifying the contents of the
Storage either intentionally or unintentionally. Password protection can be applied at two levels:

Complete Access - users enter their password and can modify or delete the Storage itself, and within the Storage can·
register, update and delete Packages and files in the Registry, view Packages and import assets into their models

Read-Only Access - users enter their password and can import assets into their models·

You set the 'Complete Access' password before you set the 'Read-Only Access' password.

If password protection is set and a user has no password, they can only view the contents of the Storage. If no password
protection is set, all users can freely access and modify the Storage and its contents.

You set the passwords on each Storage as you create that Storage, using the 'New Storage' dialog. Once the Storage has
been created, you can change or remove an existing password using the 'Modify Storage Access' dialog, but you cannot
add a password.

If a Storage is password protected, the system displays a prompt for the password when the user begins to:

Change or delete a password on the Storage·

Copy the Storage to create a new Storage·

Delete the Storage·

Register a Package or file in the Storage·

Import a Package, file or Technology from the Storage·
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Delete a Package or file from the Storage·

Compare an Asset Package with a Package in the model·

The system displays the password prompt when any of those operations is performed for the first time after the user:

Connects to a Registry·

Reloads the Registry Browser·

Selects a Storage in the 'Storage' field in the Reusable Asset Services view·

If the user enters the correct password and therefore establishes their credentials, the system does not display a password
prompt again for any valid operation that user performs until they:

Select a different Storage in the 'Storage' field in the Reusable Asset Services view or·

Reload the Registry Browser from the Registry·

Register Assets and Files

Whilst a Storage exists and, if the Storage is under password protection, you have the 'Complete Access' password, you
can register Packages from a model and files from your system as assets in that Storage. If the Asset Package was
developed using one or more MDG Technologies, you can optionally register those technologies in the Storage as well.

See the Register New Assets Help topic.

Copy Storages

It is possible to copy a Storage as the basis for creating another Storage, for example if you want to use the same set of
assets in the context of larger set for a different department, work area or development phase.

Note: It is not possible to change the 'Content' of a Storage nor is it possible to change 'Status' of a 'Learning Center
Library', 'Reference Data Library' or 'Source Code Library' Storage.

Step Action

1 In the 'Storage' field, select the Storage to be copied.

2
Click on the  icon in the Reusable Asset Service toolbar.

3 If necessary, enter the Administrator password or your 'Complete Access' password and click on the OK
button.

The 'Save Storage As' dialog displays.

4 In the 'Name' field, type a name that indicates the purpose or content of the new Storage.

5 If 'Model Package' is selected in the 'Content' field, then in the 'Status' field select:

'Draft' if you intend to make significant changes to the content of the Storage, such as populating it·
with assets and/or files; you can overwrite existing Packages or files in the Storage

'Complete' if the Storage is ready for use; you cannot overwrite any Packages or files in the Storage,·
although you can delete Packages and files and add new ones

You can modify a 'Model Package' Storage at a later time, and change this 'Status' setting (see the Change
Storage Details section in this topic )

6 If you want to set Storage Access Passwords on this Storage, click on the checkbox against one or both
password types, and provide and confirm the 'Complete Access' and/or 'Read-Only Access' passwords.
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7 Click on the OK button.

A prompt displays for you to confirm the creation of the Storage, with the type of access you have set on
the Storage.

8 Click on the Yes button.

A confirmation message displays; click on the OK button.

The name of the new Storage displays in the 'Storage' field.

Change Storage Details

After you have set up a Storage, you can update it at a later stage to:

Change the status of a 'Model Package' Storage·

Change one or both of the existing 'Complete Access' and 'Read-Only' Access passwords·

Delete one or both of the passwords·

It is not possible to add a password where one has not previously been set.

You cannot change or delete passwords unless you have the 'Complete Access' password yourself.

Note: It is not possible to change the 'Content' of a Storage nor is it possible to change 'Status' of a 'Learning Center
Library', 'Reference Data Library' or 'Source Code Library' Storage.

Step Action

1 On the Reusable Asset Service view, in the 'Storage' field click on the drop-down arrow and select the
Storage to update.

2
Click on the  icon in the Reusable Asset Service view toolbar.

3 If necessary, enter the Administrator password or your 'Complete Access' password and click on the OK
button.

The 'Modify Storage Access' dialog displays.

4 If 'Model Package' is selected in the 'Content' field, then in the 'Status' field select:

'Complete' if the Storage has now been set up and is ready for use; you cannot overwrite any·
Packages or files in the Storage, although you can delete them and add new Packages and files

'Draft' if you intend to make significant changes to the content of the Storage; you can overwrite·
existing Packages or files

5 The 'Action' field defaults to 'None', to indicate no changes to the passwords. If you are changing or
deleting the passwords, click on the drop-down field and select:

'Change Password' to enable both password type fields ready for editing·

'Remove Storage Access Password' to simply delete the 'Complete Access' password altogether·

'Remove Read-Only Access Password' to simply delete the 'Read-Only Access' password altogether·

6 If you have selected the 'Change Password' option, select the appropriate password checkbox or both
checkboxes, and type in the new password(s). Re-type the password(s) in the 'Confirm Password' field(s).

7 Click on the OK button to save your changes and close the 'Modify Storage Access' dialog.
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Delete a Storage

If a Storage has been created by mistake, or is no longer necessary in the Registry, you can delete it and its entire
contents of Package and files in one action.

Step Action

1 On the Reusable Asset Service view, in the 'Storage' field click on the drop-down arrow and select the
Storage to delete.

2
Click on the  icon in the Reusable Asset Service view toolbar.

A prompt displays to confirm the deletion.

3 Click on the Yes button.

If necessary, enter the Adminstrator password or your 'Complete Access' password and click on the OK
button.

A message displays to confirm that the Storage has been deleted.

4 Click on the OK button to clear the message.

The Storage and its contents are cleared from the Registry.
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Register New Assets

After you have set up your Storages in the Reusable Asset Service Registry, you can register assets in them. The assets
include:

Packages of modeling structures of your model, shown in the Browser window; these Packages can include·
diagrams and subordinate Packages

Any Packages containing model components on which the primary Asset Packages depend·

Any MDG Technologies that you used in developing the Asset Packages, and that you decide to register with the·
Packages

Any text or graphics files you want to make available to your corporate community; these files are compressed·
before being added to the Storage

You register the first three items together. You can register files in the Storage during that same process, or separately.

You can register separate versions of the same Package. If you register a Package that already exists in the Registry
under the same version reference, and the Storage has 'Draft' status, the existing version is overwritten. If you register the
same Package with a different version number or reference, it is registered separately and users can access both versions
of the Package from the Registry.

'Learning Center Library', 'Reference Data Library' and 'Source Code Library' type Storages cannot contain Packages of
modeling structures - they can contain only Library files, which will appear in the 'Storage Files' tab. A Library file is:

A zipped file containing Enterprise Architect-specific Learning Center files for the 'Learning Center Library' Storage·
type

An XML file containing Enterprise Architect-specific reference data XML files for the 'Reference Data Library'·
Storage type

A zipped file containing source code files for the 'Source Code Library' Storage type·

Once registered, the Library file will be available in the 'Storage Files' tab of the Reusable Asset Service view.

Access

Ribbon Publish > Model Exchange > Reusable Assets

Register Package as Asset

Step Action

1 In the Reusable Asset Service view, select the appropriate Registry and Storage.

2 In the Browser window, click on the Package to register as an Asset.

3 On the 'Registry Browser' tab, click on the Register button.

If the Storage is password protected, a prompt displays for your 'Complete Access' password. Type this in
and click on the OK button.

4 The 'Register Package(s)' dialog displays, showing the:

Name and type of the Storage·

Name and status of the selected Package (the status at this point being 'Pending')·
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The name, GUID and current version of the selected Package; you can type a different version·
number or text string if necessary

If there is a version of the Package already in the Registry, and the Storage has 'Draft' status, you can
either:

Overwrite the registered Package with an update of that version, or·

Add the updated Package as another Asset under a different version number; in this case, the·
'Packages to Register' panel shows the version number, registration date and comments on the latest
version of the Asset Package

You cannot overwrite an existing Package if the Storage has 'Complete' status. In this case, add the
Package under a different version number.

5 In the 'Comments' field type a short comment and, in the 'Notes' field, a longer explanation of the Package
being registered.

6 Click on the Check Dependency button and resolve the dependencies of the Package.

At the end of this process, the selected Package has the status 'Ready' (for registration).

7 You can, at this point, also register files as assets of the Storage. See Step 4 of the next table, Register File
as Asset.

However, if you prefer you can follow the complete procedure separate from registering Packages.

8 Click on the Register button.

A prompt displays to confirm registering the Package. Click on the Yes button.

If the same version of the selected Package already exists in the Registry (if the Storage is a 'Draft') a
prompt displays to confirm overwriting it. Click on the Yes button.

A progress dialog displays. If the Package does not have any associated MDG Technologies, a message
displays confirming that Package registration is complete. Go to step 10.

9 If the Package has one or more associated MDG Technologies, the 'Register MDG Technology' dialog
displays, listing the Technologies and prompting you to register (OK) or ignore all of them.

If you want to register some Technologies but not others, click on those you do not want to register, and
click on the Remove button for each one in turn.

Click on the OK button or Ignore button.

A message displays confirming that Package and Technology registration is complete.

Notes:

If a remote Technology is removed from registration (that is, the Technology is not registered along·
with the Package), the registered Package will refer to this Technology at its URL
When importing the Package from Registry, the system will import this remote Technology from its
URL (if the remote Technology is not already available in the importing model)

If a remote Technology is registered with the Package being registered, the system will store a copy·
of the Technology file in the Registry
When importing the Package from Registry, the system will import the Technology stored in the
Registry and will not import it from its URL (if the remote Technology is not already available in the
importing model)

10 Click on the OK button.

The 'Registry Browser' tab is updated with the newly-added details of the Package and any dependent
Packages. You can review the details on the tabs on the lower half of the Reusable Asset Service view.
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Register File as Asset

Step Action

1 In the Reusable Asset Service view, select the appropriate Registry and Storage.

2 On the 'Registry Browser' tab, click on the Register button.

If the Storage is password-protected, a prompt displays for your 'Complete Access' password. Type this in
and click on the OK button.

The 'Register Package(s)' dialog displays.

3 If any Packages are listed in the 'Packages to Register' panel, and you do not want to re-register them,
clear the checkbox against each Package name.

4 Click on the Additional Files button.

The 'Select Additional Files' dialog displays.

5 Click on the Add button.

A 'Select' screen displays, on which you browse for and click on the required file. You can only select one
file at a time on this browser.

6 Click on the Open button.

The 'Add Comment' dialog displays.

7 Type a brief comment on the nature or purpose of the file in the Registry, and click on the OK button.

Focus returns to the 'Select Additional Files' dialog, which now lists the selected file.

8 Repeat steps 5-7 for each Asset file to register.

When you have finished, click on the OK button.

The 'Register Package(s)' dialog redisplays.

9 Click on the Register button.

A prompt displays to confirm registration of the files.

10 Click on the Yes button.

A 'Progress' dialog displays while the files are registered, followed by a message confirming that the
(Package and) File registration is complete.

11 Click on the OK button to clear the message, and to return focus to the Reusable Asset Service view.

You can review the files on the 'Storage Files' tab in the lower half of the view.

Register Learning Center Library

Step Action

1 In the Reusable Asset Service view, select the appropriate Registry and 'Learning Center Library' Storage.
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2 On the 'Registry Browser' tab, click on the Register button.

If the Storage is password protected, a prompt displays for your 'Complete Access' password. Type this in
and click on the OK button.

3 The 'Register Learning Center Library' dialog displays.

Click on the  button next to the 'File' field and select the Library file.

Type in a short comment on the Library being registered, in the 'Comments' field.

4 Click on the Register button.

A prompt displays to confirm registering the Library file. Click on the Yes button.

If the same Library file already exists in the Registry, a prompt displays to confirm overwriting it. Click
on the Yes button.

A progress dialog displays followed by a message confirming that Library registration is complete.

5 Click on the OK button.

The 'Storage Files' tab in the lower half of the Reusable Asset Server view is updated with the
newly-added Library file.

Register Reference Data Library

Step Action

1 In the Reusable Asset Service view, select the appropriate Registry and 'Reference Data Library' Storage.

2 On the 'Registry Browser' tab, click on the Register button.

If the Storage is password protected, a prompt displays for your 'Complete Access' password. Type this in
and click on the OK button.

3 The 'Register Reference Data Library' dialog displays.

Press the  button next to the 'File' field and select :

From File System – to select an existing Reference Data XML file from the file system·

From Model – to open the 'Export Reference Data' dialog for selecting categories that will be·
registered as the Reference Data Library once the Register button is clicked and a name is entered in
the 'Enter Reference Data File Name 'dialog

Type in a short comment for the Library being registered in the 'Comments' field.

4 Click on the Register button.

A prompt displays to confirm registering the Library file. Click on the Yes button.

If the same Library file already exists in the Registry, a prompt displays to confirm overwriting it. Click
on the Yes button.

A progress dialog displays followed by a message confirming that Library registration is complete.

5 Click on the OK button.

The 'Storage Files' tab in the lower half of the Reusable Asset Server view is updated with the
newly-added Library file.

(c) Sparx Systems 2019 Page 454 of 654 Created with Enterprise Architect



Model Repository - Model Repository 20 January, 2020

Register Source Code Library

Step Action

1 In the Reusable Asset Service view, select the appropriate Registry and 'Source Code Library' Storage.

2 On the 'Registry Browser' tab, click on the Register button.

If the Storage is password protected, a prompt displays for your 'Complete Access' password. Type this in
and click on the OK button.

3 The 'Register Source Code Library' dialog displays.

Select the Library file by pressing the  button next to the 'File' field.

Type in a short comment for the Library being registered, in the 'Comments' field.

4 Click on the Register button.

A prompt displays to confirm registering the Library file. Click on the Yes button.

If the same Library file already exists in the Registry a prompt displays to confirm overwriting it. Click on
the Yes button.

A progress dialog displays, followed by a message confirming that Library registration is complete.

5 Click on the OK button.

The 'Storage Files' tab in the lower half of the Reusable Asset Server view is updated with the
newly-added Library file.
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Check Package Dependencies

As you register a Package in the Reusable Asset Service, the system provides a check on whether that Package is
dependent on any external content; that is, whether it links to any modeling component held in Packages other than its
own child Packages. You can perform three types of dependency check:

Complete, which will consider Package A to be dependent on Package B if Package A contains any element,·
attribute, operation, operation parameter, diagram or connector (or their Tagged Values) that references elements in
Package B

Normative, which is the same as a Complete Dependency Check except that it will not treat as a dependency for·
Package A any element from Package B that is added as a link on a diagram in Package A

Package Dependency/Import, where only those Packages that are the target of a Dependency/Package Import·
connector from Package A will be treated as dependent Packages for Package A

You perform this dependency check as an integral part of the Asset Registration process (specifically, at step 6 of the
Register Package as Asset process). The check automatically identifies, firstly, the Packages directly needed by the Asset
Package, and then any Packages needed by those initial Packages, and so on until the needed Packages are not dependent
on any other.

In practice, such dependency chains are likely to be quite short. If you know that the original Asset Package is dependent
on two other Packages, one of which is subordinate to the other, you can simplify the process further by selecting the
Parent or Ancestor Package first and thus avoid the extra steps of selecting the two Packages separately.

Access

Open the Reusable Asset Service window, using one of the methods outlined here.

Ribbon Publish > Model Exchange > Reusable Assets : Register

Check Package Dependencies

Step Action

1 Select the appropriate Registry, Storage and version of the model Package to register, and provide any
appropriate comments or notes.

2 Click on the Check Dependency button.

If there are no Packages on which the Asset Package depends, the system sets that Package to 'Ready'. Go
to step 6.

The 'Select Needed Package: <dependent package name>' dialog displays, showing the model hierarchy
containing the Packages needed by the Asset Package. Each needed Package has a selected checkbox
against it.

If you know that a needed Package is a child or grandchild of another needed Package, click on the
checkbox next to the 'higher' Package name so that the child is validated as part of the parent. In this
example, if the Asset Package has dependencies on both External factors and Location, click on the
'External factors' checkbox to register both dependencies as External factors.
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If the needed Package is already registered in the Registry, it is indicated by a globe icon:

In this case, select the 'Use latest version of selected package in Registry (if available)' checkbox to link to
the registered version. For such Packages, no further dependency check is performed and, on the 'Register
Package(s)' dialog, the Package's Status is set to 'Ready'.

3 Click on the OK button.

The 'Register Package(s)' dialog updates to show the initial 'Asset Package status' as 'Ready', and to list
the needed Packages each with the status of 'Pending'.

4 Click on the Check Dependency button again.

If there are no Packages on which the needed Package depends, the system sets that Package to 'Ready'
and sets the focus on the next Pending Package. If there are no more Pending Packages, go to step 6.

If the needed Package is dependent on other Packages, the 'Select Needed Package: <dependent package
name>' dialog displays again, showing the model hierarchy containing those Packages, each with a
selected checkbox next to it. As in step 2, you can select a 'higher' Package if appropriate.

5 Click on the OK button.

The 'Register Package(s)' dialog updates to show the first needed Package status as 'Ready', and to list any
further needed Packages with the status of 'Pending.

6 If there are further needed Packages in the chain, repeat step 4. The system automatically identifies them
and lists them for validation as in step 5.

Otherwise the system sets the final needed Package status to 'Ready' and you can continue to register files
and MDG Technologies.

Notes

A Package with status 'Pending' cannot be registered; only Packages with status 'Ready' can be registered·

If you are certain that there are no parent-child relationships between the needed Packages, you can work through·
these steps quickly by just clicking on the Check Dependency button and OK button alternately until all Packages in
the Package to Register list have the status Ready

The system does not allow you to register an Asset Package that has dependencies on its own parent or grandparent·
Package; such dependencies would cause the Asset Package to be registered twice - by itself and as part of the
parent Package - creating the risk of differences developing between the two instances
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Update an Asset

Over time, you might need to revise the contents of the Registry. Such updates can include:

Registering additional Asset Packages and files·

Registering a new version of an Asset Package·

Registering a new edition of a Storage file·

Registering new Libraries·

Deleting an Asset Package·

Deleting a Storage file·

Deleting a Library·

Changing the details of a Storage·

Deleting an entire Storage and the assets and files within it·

Access

Ribbon Publish > Model Exchange > Reusable Assets > Registry Browser

Update Tasks

Task Detail

Register new Asset
Packages and Storage files

You can add further Asset Packages and files to a Storage at any time.

Register a new version of
an Asset Package

You register a new version of an Asset Package as if it were a new Asset. In the
'Current Version' field on the 'Register Package(s)' dialog, you type a different
number or reference to that assigned to the currently-registered Asset.

You can overwrite an existing Asset Package under the same version number only
if the Storage has 'Draft' status. If the Storage has 'Complete' status, you cannot
overwrite the existing Asset Package under the same version number. To replace
the current version, you must delete the Asset from the Storage and register the
Package again.

Delete Asset Package from
Storage

Click on the Package name in the 'Registry Browser' tab and either:

Click on the Delete button or·

Right-click and select the 'Delete From Registry' menu option·

In either case a short submenu displays, prompting you to select to delete:

The Asset Package only, or·

The Asset Package and the Packages on which it is directly or indirectly·
dependant

When you select the appropriate option, a prompt displays for you to confirm the
deletion.

Click on the Yes button. A message displays to confirm that the Package has been
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deleted from the Registry, and the name of the Package is removed from the
'Registry Browser' tab.

If the Storage is password-protected, the system prompts you to enter a 'Complete
Access' password before it begins deleting the Package(s).

If any of the registered Packages depend on the Package being deleted, the system
displays the names of these Packages and prompts for confirmation before deleting
each Package.

Register a new version of a
Storage File

You register a new version of a Storage file as if it were a new file under a different
file name.

You can overwrite an existing file under the same file name only if the Storage has
'Draft' status. If the Storage has 'Complete' status, you cannot overwrite the existing
file. To replace the current version, you must delete the file from the Storage and
register the file again.

Delete Storage Files from
Storage

On the 'Storage Files' tab, right-click on the file name and select the 'Delete From
Registry' option. A prompt displays for you to confirm the deletion.

Click on the Yes button. A status message confirms the deletion, the file is removed
from the Registry and the file name is removed from the 'Storage Files' tab.

If the Storage is password-protected, the system prompts you to enter a 'Complete
Access' password before it begins deleting the file.

Register a new Library File You can add further Library files to a Storage at any time.

When you register a Library file, the file name and location will be used as the
unique identifier for the file. You can overwrite this Library file in the Registry by
registering a file with the same name and from the same file system location.

Delete Library Files from
Storage

To delete all Library files in Storage, click on the Delete button in the 'Registry
Browser' tab.

To delete a particular Library file, right-click on the Library file name in the
'Storage Files' tab and select the 'Delete From Registry' option.

A prompt displays for you to confirm the deletion. Click on the Yes button. A status
message confirms the deletion, each Library file is removed from the Registry and
each Library file name is removed from the 'Storage Files' tab.

If the Storage is password-protected, the system prompts you to enter a 'Complete
Access' password before it begins deleting the Library file(s).

Change Storage Details This task is as documented for setting up the Registry. Note that whilst you can
copy a Storage as a new Storage, you cannot transfer assets directly between
existing Storages.

Delete a Storage and its
contents

This task is as documented for setting up the Registry. Note that whilst you can
copy a Storage as a new Storage, you cannot transfer assets directly between
existing Storages.

Refresh Registry Browser If there is a possibility that another user has updated the Registry while you have

had it open, click on the  icon in the Reusable Asset Service toolbar to refresh
your display from the latest updates to the Registry.
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Pro Cloud Server Troubleshooting

Browser Test

For a simple check that the Pro Cloud Server is operating on the specified Ports defined in the configuration file, you can
enter this address into a web browser:

     <protocol>://<machineName>:<port>

For example, using the default settings on the machine with Pro Cloud Server installed:

     http://localhost:804/

Or

     https://sparxcloud.com

If the Port is enabled this message is returned:

     Sparx Systems Pro Cloud Server vX.X.XX

     Congratulations, your server is now ready to host your models. Connect through the configuration client to add or
remove models.

If this message is not displayed, confirm the server name and Port, check for other services listening on the specified
Port, check the server log file for error messages, and check any firewalls between the client and the server to confirm
there is connectivity and that the relevant Port(s) are open.

Errors shown in Enterprise Architect System Output

Error Message Meaning

Http Status Code: 503
Service Unavailable

Indicates that the Pro Cloud Service is not running on the Server.

Check you have the correct Server Name and Port·

Check that the 'Sparx Systems Professional Cloud' Service is currently running·
on the server

HTTP Status 401 Access
Denied

Indicates a failure to authenticate with the server.

With the built-in web server, this error will occur if an invalid username or
password was provided, or no username or password were provided.

HTTP Status 403 Indicates an attempt to access a model that is marked on the server as 'Require
authenticated and secure connection'.

This might indicate that you are connecting using an http protocol instead of https,
or that the Port you are using is not providing authentication to the model you are
connecting to.

Check that you are using https.

Check with the system administrator that the security authentication option is
pointing to a model with security enabled.

If the model in question had user security enabled after the 'Require authenticated
and secure connection' option was enabled in the Pro Cloud Server get the system
administrator to turn off and then back on again the 'Require authenticated and
secure connection' option, making sure to save the Database Manager each time.
This will reset the internal flag that Pro Cloud Server retains so that it can validate
user credentials.
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HTTP Status 500 Unable to
connect to service

The connection is not being accepted.

Check the server name·

Check the firewall settings on the client and server·

Check the Ports the server is listening on·

The database manager for
this database was shut
down

Enterprise Architect established a connection to a Pro Cloud Server, and requested
to connect to a known repository, but the repository is currently disabled.

Ask your system administrator to check the 'Enabled' option for the database
manager in question.

There is no database
manager configured for the
requested repository

Enterprise Architect established a connection to a Pro Cloud Server, but the model
name requested does not match any defined database on the server.

When accessing the model using the Enterprise Architect Cloud Connection screen,
ensure that the Model Name entered matches the Alias that is shown in the Pro
Cloud ServerConfiguration Client.

Unable to connect to
Database

Enterprise Architect established a connection to a Pro Cloud Server and requested
to connect to a known repository; however, when the server attempted to open a
connection to the database using the supplied details, it failed.

Note: Whenever this error occurs, a Warning-level message that contains more
detailed information will be written to the Pro Cloud Server logs.

If the repository is:

Using ODBC, ask your System Administrator to check that an ODBC·
connection is defined as a System DSN (and not a User DSN) on the server,
that all connection parameters are correct, and that the database username and
password have been saved into the ODBC DSN or the connection string

Oracle, ask your System Administrator to verify that the user name and·
password were saved with the connection string and that all other options in the
connection are correct

SQL Server connecting via OLE DB and Windows authentication, ask your·
System Administrator to verify that the user name the Pro Cloud Server service
is running and has been granted permission to the SQL Server database (at a
minimum it will need the roles db_datareader and db_datawriter) and that all
other options in the connection are correct

SQL Server connecting via OLE DB and SQLServer authentication, ask your·
System Administrator to verify that the defined user name has been granted
permission to the SQL Server database (at a minimum it will need the roles
db_datareader and db_datawriter), that the option to save the password with the
connection string was enabled, and that all other options in the connection are
correct

12007 - The server name or
address could not be
resolved

Indicates the server name (or IP address) is incorrect.

Check that the server name is correct·

Attempt the Browser Test described at the start of this topic·

12029 - A connection with
the server could not be
established

This could indicate that the Pro Cloud Server is not installed, the Service is not
running, or an incorrect Port was entered.

Confirm the Pro Cloud Server is installed·

Check that the 'Sparx Systems Professional Cloud' Service is running·

Check that you entered a valid Port (i.e. it should match one defined in the·
Configuration Client)

Attempt the Browser Test described at the start of this topic·
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After Reinstall Enterprise
Architect no longer works

Your environment was working correctly, then you updated to the latest version of
the Pro Cloud Server and now Enterprise Architect clients are not able to connect to
your Cloud models.

During the reinstall process the Pro Cloud Server installer actually uninstalls the
original version and then installs the new one.  As a result of this the Firewall
exception that is automatically added by the installer is removed and re-created.
The problem with this is if someone manually adjusted the Firewall exception (after
the original install) any manually changes are lost when the installer re-creates the
Firewall exception. One method of stopping this from occurring in the future is to
create a completely new firewall exception (with a different name) that is a copy of
the one created by the installer, and make any manual changes to that exception.

Reading Server Logs

As mentioned previously, the Sparx Systems Pro Cloud Server is a Windows Services application, and as such it needs to
conform to some basic rules. When it comes to troubleshooting the most important rule for Windows Services is that
they can be run independently of user input/interaction and as such do not contain screens/GUI of any kind.  For this
reason the Sparx Systems Pro Cloud Server writes any potential message to Log files.

The Pro Cloud Server configuration file contains a number of settings that control where, how many and how large log
files can be.  By default the Pro Cloud Server will save all log files to a \Logs\ folder under \Services\ (C:\Program Files
(x86)\Sparx Systems\Pro Cloud Server\Service\Logs), and it will keep up to three files.  A new file will be created
whenever the Cloud Service is started or whenever the maximum file size if reached.  Filename
'SSProCloudServerLog-1.log' will always be the most recent log file and each time a new file is created the older ones
are renamed by increasing the number. For example, SSProCloudServerLog-2.log is renamed to
SSProCloudServerLog-3.log.

The configuration file also contains a setting that controls the level of logging that is performed; see the logging related
options in the Extended Server Properties Help topic for more details.  When troubleshooting, it is recommended that the
Pro Cloud Server LOG_LEVEL property be set to the highest level, SYSTEM.

Each log entry will consist of the Time, Log Level and Message; if an error occurs the Message will normally contain a
description of the problem and from this description the appropriate action can be undertaken.

Log Message Explanation

Each time new Log file is created the Pro Cloud Server will write out a summary of
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Log File Header the main settings; this information is particularly useful if you are requesting
support from Sparx Systems.

Started database managers When a Pro Cloud Server is initially started, and the Log Level is set to INFO (or
lower) it will log out a summary of each configured model that includes the
connection string of the model.

     [INFO]: Added database manager - ConnectionStr:  'eaexample ---
Connect=Provider=MSDASQL.1;...

If the Log level is lower than INFO, additional log entries will be written for each
model; for example:

     [SYSTEM]: SUCCESS Started database manager
firebird:anonymous@eaexample

House keeping The Pro Cloud Server performs regular 'house keeping' tasks, the frequency of
which is controlled by the AUDIT_TIME_PERIOD setting in the Pro Cloud Server
configuration file.

When the log level is set to INFO, each time house keeping is performed the Pro
Cloud Server will log out a summary of connections for each defined database
manager and report how many are currently available, the maximum number used
concurrently, and the total number of uses since the last audit.

      [AUDIT] firebird:anonymous@eaexample        | Free:   0 | Max Active:   3 |
Acquisitions:    192 |

Normally these entries can be ignored as they are purely reference information
only.

Open Port list When a Pro Cloud Server is initially started, and the Log Level is set to SYSTEM,
it will log out a success message for each configured Port, which includes the
management Port (803) and any http/https Ports. You should see a line such as:

     [SYSTEM] SUCCESS Bound and listening on port 804.

If the log file is missing any lines, or if the message doesn't read 'SUCCESS' this
might indicate a problem with the server Port.

A common error here is:

     Unable to create secure server on port 443.

Possible causes of this are:

Certificate/Private Key file not found at C:\Program Files (x86)\Sparx·
Systems\Pro Cloud Server\Service\server.pem

The server.pem file does not contain a valid certificate and private key·

Certificate Authority file not found or invalid at C:\Program Files (x86)\Sparx·
Systems\Pro Cloud Server\Service\cacert.pem

Unable to connect to
database

During general operations, the Pro Cloud Server will write entries to its log file,
which include any failed attempts to open a model. This will generally not occur
until a user attempts to connect to the database. Errors that can occur here include:

     REQUEST_CONNECT FAIL. Error (5): Unable to connect to database

This means that the server attempted to open a connect but it failed. If you see this
message, review the list of potential reasons outlined in the Errors shown in
Enterprise Architect System Output table.
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Change Management

As a repository is developed it will become the data store for valuable organizational information assets, and it is
imperative that this data is protected and maintained. Enterprise Architect has sophisticated tools to ensure the
information is protected, including full integration with all the leading Version Control Systems, Baselines that are
snapshots of your model that can be taken at important milestones, and Auditing that can track the finest changes to a
model. A Project Transfer function helps you to make backups of models without involving information technology
personnel. There are also Model Validation and Project Integrity Checkers to ensure the repository is maintained with a
clean bill of health, and a powerful role based Security System to ensure users can collaborate easily.

Facilities

Facility Detail

Version Control of
Packages

Enterprise Architect Model Version Control helps you to:

Coordinate sharing of Packages between users, with either read-only access or·
update access, ensuring that work on different areas of the model is
coordinated and synchronous rather than conflicting

Save and retrieve a history of changes to Packages·

To use Version Control in Enterprise Architect, you require a third-party
source-code control application such as:

Subversion·

CVS·

MS Team Foundation Server (TFS), or·

Any other Version Control product that complies with the Microsoft Common·
Source Code Control standard

Tracking Changes Enterprise Architect provides two separate but complementary facilities for
tracking changes to data across the project:

Auditing of model changes·

Baselining and differencing to capture and roll back changes·

Project Data Transfer Enterprise Architect enables you to transfer project data between project data
repositories either for:

Sections of the project (XMI and CSV) or·

The whole project, row by row, table by table (in the Corporate, Unified and·
Ultimate editions of Enterprise Architect)
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Version Control

Within Enterprise Architect, you can manage changes to and revisions of your projects by placing individual model
Packages, view nodes or root nodes under Version Control. This provides numerous key facilities, including:

Saving a history of changes to Packages·

The ability to retrieve previous revisions of Packages·

Propagating model updates between team members·

Coordinating the sharing of Packages between team members·

You apply Version Control through a third-party source-code control application that manages access to and stores
revisions of the controlled Packages. Once the Version Control software has been installed and configured, you must
define a Version Control Configuration within your project. You can then use Version Control to manage changes to the
Packages of your model.

Notes

Sparx Systems strongly urge you not to manipulate Version Controlled Package files outside of Enterprise Architect;·
it is possible to leave the Package files in a state that Enterprise Architect cannot recognize

Database replication should not be combined with Version Controlled Packages·

If the Packages under Version Control contain any alternative images and those images are subject to frequent·
change, you can set the 'Export alternate images' option on the 'Preferences' dialog to export the images to the
Version Control repository when you check in the Packages; if the images are not subject to frequent change, do not
select this option and instead use 'Export/Import Reference Data' to manage alternative images
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Introduction

Enterprise Architect's Version Control integration provides several key facilities, including:

Saving a history of changes made to your model's Packages·

Retrieving previous revisions of Packages·

Propagating model updates between team members·

Coordinating the sharing of Packages between team members·

The steps involved in setting up a Version Control environment and applying Version Control to an Enterprise Architect
project that is to be accessed by a number of users, are summarized in the Help topic Applying Version Control in a 
Team Environment.

There are a number of factors to consider when setting up and using Version Control in your model development.

Factors to consider

Factor Detail

System Requirements and
Configuration

You apply Version Control through a third-party source-code control application
that manages access to and stores revisions of the controlled Packages.

Typically the configuration consists of:

A server component that manages a Version Control repository, and·

Client components on the workstations, that manage local working copies of·
controlled files

Enterprise Architect uses the client component to communicate with the server. A
Version Control client must be installed on every machine where you run
Enterprise Architect and want to access your Version Control system.

Version Control Usage There are two main ways in which projects can be deployed:

Centralized Shared Model·

Distributed Private Models·

Version control is employed in the same way for both scenarios; however, when
using Private Model deployment you have the additional facility of propagating
model updates throughout the team.

Version Control can also be used to share standard Packages between different
projects.

Team Deployment Consider the process of setting up a Version Control environment and applying
Version Control to a project to be accessed by a number of users.

Version Control Basics Enterprise Architect enforces serialized editing of Version Controlled Packages,
using the lock-modify-unlock mode of operation.

Applying Version Control
to Models

Using Version Control consists of placing individual model Packages under
Version Control, rather than Version Controlling the project as a whole.

Version Control and
Project Reference Data

To share changes in reference data between users in a version-controlled project
deployed as multiple private models, you periodically export the reference data
from the model where the changes were made, and import it into the other models
maintained by the team.

(c) Sparx Systems 2019 Page 466 of 654 Created with Enterprise Architect

http://www.sparxsystems.com/enterprise_architect_user_guide/15.1/model_repository/applying_version_control_in_te.html
http://www.sparxsystems.com/enterprise_architect_user_guide/15.1/model_repository/applying_version_control_in_te.html


Model Repository - Model Repository 20 January, 2020

Offline Version Control You can prevent the system from attempting to make any Version Control
connections by choosing to Work Offline before loading a model.

If Enterprise Architect is unable to connect a Version Control Configuration for any
reason, it displays warning messages to notify you and provides 'offline' Version
Control functionality for all Packages associated with the failed connection.

Notes

Packages under Version Control are identified in the Browser window by icons that indicate the current status of the·
Package
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Version Control Usage

The Version Control facility can be used in many different ways, although these roughly fall into one of four types of use
as discussed here.

Usage

Type Details

Single Shared model Users share a model stored in a central project file or DBMS repository. In this
configuration you can view changes to other users' Packages without explicitly
having to check them out, by simply refreshing your view of the model.

Version control is used to:

Archive successive versions of your work to date·

Maintain Package revision history·

Recover from unwanted changes or accidental deletions, through an 'undo'·
facility

Regulate access to Packages·

Multiple Private models One model is created by a single user who configures it for Version Control. The
model file is then distributed to other users, with each user storing their own private
copy of the model.

Version Control is used to:

Propagate changes to the model, throughout the team·

Archive successive versions of your work to date·

Maintain Package revision history·

Recover from unwanted changes or accidental deletions, through an 'undo'·
facility

Regulate access to Packages·

Shared Packages Individual users create separate models but share one or more Packages:

Users share Packages through Version Control·

Standard Packages A company might have a standard set of read-only Packages that are broadly
shared:

Individual users retrieve Packages with the Get Package menu option·
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Version Control of Model Data

When applying Version Control in Enterprise Architect, you place individual model Packages under Version Control,
and not the project as a whole.

All Enterprise Architect models are stored in databases - even the .eap file is an MS Jet database. In simple terms, the
project file is a single entity of binary data. Being binary data, the project file would require the use of the
lock-modify-unlock model of Version Control, which would mean that only a single user at a time could work on any
given (Version Controlled) model. Therefore, it is not practical to apply Version Control to the database (.eap file) as a
whole; this can also create problems for you in that:

Most Version Control systems mark their controlled files as read only, unless they are specifically checked-out to·
you

The .eap file is an MS Jet database, and Enterprise Architect must be able to open this file for read/write access·
when you load your model; if the model is read-only, the system displays an error message and fails to load the
model

Version Controlling Packages in your Model

To overcome these limitations, Enterprise Architect exports discrete units of the model - the Packages - as XMI Package
files, and it is these XMI files, not the project file, that are placed under Version Control. The XMI file format used by
Enterprise Architect dictates that they too be treated as binary files - therefore it is not possible to merge the XMI files
either; however, by splitting the model into much smaller parts, many users can work on separate parts of the model
simultaneously.

Version Controlled Nested Packages

Version Controlled nested Packages result in much smaller XMI files being exported, as the parent Packages' XMI files
do not contain any content for the Version Controlled child Packages.

Version Control of nested Packages, together with a model structure of small individual Packages, provides greater scope
for multiple users to work concurrently, as individual users are locking much smaller parts of the model.
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Version Control and Reference Data

Reference data is data that is used across a model or project; it is not Package-specific. Version Control operates at
Package level, and therefore does not capture changes in reference data. Where Version Control is used in a multiple
private model set up, changes in reference data are not brought into the model when Packages are updated from Version
Control.

In a Shared Model environment, all users are accessing the same project reference data. Changes in reference data can be
shared between users in a Version Controlled project deployed as multiple private models, by periodically exporting the
reference data from the model where the changes were made, and importing it into the other models maintained by the
team.

Reference data is exported and imported as an XMI file, which contains whatever types of reference data you want to
transfer. You can place your project reference data under Version Control by exporting the data as an XMI file and apply
Version Control to that file using your Version Control software external to Enterprise Architect.
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Version Controlling Packages

Enterprise Architect implements Version Control of your model by exporting Package data from the project database to
XMI Package files, which are placed under Version Control in the source-code control application. The XMI file format
cannot be merged in the same way as ordinary text files can be merged, which is why Enterprise Architect must enforce
serialized editing of Version Controlled Packages, as discussed here.

The Lock-Modify-Unlock Solution

Many Version Control systems use a lock-modify-unlock model to address the problem of different authors in a shared
source overwriting each other's work. In this model, the Version Control repository allows only one person to change a
file at a time, and access is managed using locks.

Harry must lock a file before he can begin making changes to it. If Harry has locked a file, Sally cannot also lock it, and
therefore cannot make any changes to that file. All she can do is read the file, and wait for Harry to finish his changes
and release the lock. After Harry unlocks the file, Sally can take her turn in locking and editing the file.

The Copy-Modify-Merge Solution

Subversion, CVS and a number of other Version Control systems use a copy-modify-merge model as an alternative to
locking. In this model, each user's client contacts the project repository and creates a personal working copy - a local
reflection of the repository's files and directories. Users then work simultaneously and independently, modifying their
private copies. In due course, the private copies are merged together into a new, final version. The Version Control
system often assists with the merging, but ultimately a person is responsible for making it happen correctly.

When Locking is Necessary

While the lock-modify-unlock model is generally considered a hindrance to collaboration, there are still times when
locking is necessary.

The copy-modify-merge model is based on the assumption that files are contextually merge-able: that is, that the files in
the repository are line-based text files (such as program source code). However, for files with binary formats, such as
artwork or sound, it is often impossible to merge conflicting changes. In these situations, it really is necessary for users to
take strict turns in changing the file. Without serialized access, some users end up wasting time on changes that are
ultimately overwritten.
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Applying Version Control in a Team Environment

This is a summary of the process of setting up a Version Control environment and applying Version Control to a project
to be accessed by a number of users.

Version Control - Process Overview

Step Action

1 Install your Version Control product.

2 Create a Version Control repository.

3 Create a Version Control project to be used with your Enterprise Architect project.

4 Check-out a working copy of the Version Control project (a module, project or folder within the Version
Control system) into a local folder.

You must do this for every team member that is accessing the Version Controlled Packages, whether you
are using a single shared model or each team member stores his own private copy of the model.

5 Before attempting to access the new Version Control environment from within Enterprise Architect, you
should first verify that it functions correctly when used outside of Enterprise Architect.

6 Within Enterprise Architect, define a Version Control configuration to provide access to the working copy
files.

The name of the Version Control configuration must be the same across all machines throughout a team.
That is, all Version Control access to a given Package must be through Version Control configurations
with the same name, across all models and all users.

The easiest way to perform this step (throughout the team) is to have one user set up Version Control on
the model and then share that model with the rest of the team.

In Shared Model deployment, all users connect to a single instance of the model database, so the·
model is shared automatically

In Private Model deployment, it is easiest to distribute copies of the original model (after Version·
Control has been set up) to all other members of the team

Whenever you open a model (Private or Shared) that uses a Version Control configuration that is not yet
defined on your workstation, a prompt displays to complete the definition for that configuration. This
typically means specifying the local working copy directory and perhaps choosing the Version Control
project associated with this Enterprise Architect project.

Once this has been done, the Version Controlled Packages that already exist in the model are ready for
use.

7 Configure Packages within the Enterprise Architect model for Version Control. That is, apply Version
Control to individual Packages.

8 Check-out and check-in Packages as required.

Notes
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It is possible to use multiple Version Control Configurations within the same model; different Packages can still use·
different Version Control Configurations within the model, as long as any given Package is always accessed via the
same Version Control Configuration
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Version Control Nested Packages

When you save a Package to the Version Control system, only stub information is exported for any nested Packages.
This protects information in a nested Package from being inadvertently over-written by a top level Package.

Operations on Nested Packages

Operation Detail

Checking Out When you check out a Package, you do not modify or delete nested Packages; only
the top level Package is modified.

As a consequence of this behavior, if you check out or get a Version Controlled
Package with nested Packages that are not already in your model, you see stubs in
the model for the nested Packages only.

Get All Latest If you select the 'Get All Latest' option from the Version Control menu, any new
stubs are populated from the Version Control system.

Importing Models You can populate a large and complex model, by 'getting' only the root Packages,
then using 'Get All Latest' to recursively iterate through the attached and nested
Packages.

This is a powerful and efficient means of managing your project and simplifies
handling very large models, even in a distributed environment.

The 'Import a Model Branch' option combines the procedure steps into a single
operation.

Notes

It is recommended that, when sharing a Version Controlled model, you do not mix versions of Enterprise Architect·
later than version 4.5 with earlier versions; if this is necessary it is best to go to the 'Version Control Settings' dialog
and deselect the 'Save nested version controlled packages to stubs only' checkbox, setting Enterprise Architect to the
pre-version 4.5 behavior (for the current model only)
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Add Connectors To Locked Elements

Generally, when working in a diagram containing locked elements, you cannot add a connector to a locked element.
However, this depends on the lock status of the source and target elements (or more precisely, the lock status of the
parent Packages of the source and target elements, when the source and target element are held in different Packages).
There are scenarios in which a connector can be created on a locked element.

Lock Scenarios

Element Status Add Connectors

Source unlocked, target
unlocked

Yes, any kind of connector can be added

Source unlocked, target
locked

Yes, except for Composition connectors

Source locked, target
unlocked

No, except for Composition connectors

Source locked, target
locked

No, prohibited for all connectors

Notes

A connector can be added if its source is unlocked - you are modifying what the source can see·

The exception is Composition connectors, where the target (the parent) must be unlocked - you are modifying the·
parent by adding children
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Browser Window Indicators

Packages under Version Control are identified in the Browser window by icons that indicate the current status of the
Package.

Indicators

Icon Indicates that

This Package is Version Controlled and not checked out to you.

You cannot edit the Package (until you check out the Package yourself).

This Package is Version Controlled and checked out to you.

You can edit the Package.

This Package is Version Controlled, but you checked it out whilst not connected to
the Version Control server.

You can edit the Package but there could be version conflicts when you check the
Package in again.

This Package is controlled and is represented by an XMI file in the file
management system, but it is not under Version Control.

You can edit this Package.
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Offline Version Control

When loading a model that uses Version Control, Enterprise Architect normally initializes a connection to the Version
Control system for each Version Control configuration defined in the model. If Enterprise Architect is unable to connect
a Version Control configuration for any reason, it displays warning messages to notify you and provides offline Version
Control functionality for all Packages associated with the failed connection.

You can prevent Enterprise Architect from starting to make any Version Control connections, by selecting to work
offline before loading your model.

Access

Ribbon Configure > Version Control > Work Offline

Working Offline

Concept Discussion

Choosing to Work Offline Selecting to work offline is useful if you know beforehand that Enterprise Architect
cannot connect to your Version Control system. For example: If you are working on
a laptop computer that is disconnected from your network, on an Enterprise
Architect model that uses a large number of Version Control configurations, you
can select to work offline before you load the model to avoid all the error messages
that the system would normally display as each Version Control connection attempt
failed.

You can switch between working offline and working online at any time, either
before or after a model is loaded, by toggling the 'Work Offline' menu option.
Enterprise Architect disconnects or reconnects Version Control (depending on the
connection availability) according to your selection.

Using Version Control
Whilst Disconnected From
the Version Control Server

Enterprise Architect 'remembers' the status of a model’s Version Controlled
Packages. Packages that were checked out to you prior to disconnecting from the
server are still shown as checked out to you, even though you are no longer
connected to the server. You can still edit these Packages as you normally would.

Packages that were not checked out to you prior to disconnecting from the server
are shown as Version Controlled and locked. You cannot edit these Packages until
you check them out.

Offline Check Out You can 'check-out' and edit a Version Controlled Package even when your
machine is disconnected from the Version Control server. In this example, the
colored 'figure 8' icon for DFD indicates that you have checked it out whilst off
line.

(The gray 'figure 8' icon shown against Logical View indicates that you have
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checked out a Version Controlled Package on line.)

You should be aware that the Version Control system, and therefore other users,
have no way of knowing that you have 'checked-out' a Package whilst offline. It is
not possible to merge changes to an XMI file that result from two users editing the
same Package at the same time. If an offline checkout leads to two people editing
the same Package at the same time, when the changes are brought back online the
first-saved set of changes is lost.

Checking In a Package
That Was Checked Out
Offline

Once you reconnect your system to the Version Control server, if the Package you
checked out offline is not currently checked out by another user, you can check in
that Package. However, before Enterprise Architect checks in the Package, it
compares the local working copy of the Package file with the latest revision in the
repository. (These Package files remain unchanged in your work area until
Enterprise Architect exports the Package again before checking in.) If the
repository version remains unchanged from when you last updated your local copy,
Enterprise Architect exports and checks in your Package without further prompting.

On the other hand, if the repository now contains a file that has changed since you
last updated your local copy, checking in your Package would overwrite those
changes. Enterprise Architect displays a message warning you of the pending data
loss and giving you the opportunity to abort the check in. At this point, you must
decide whether to discard your own changes, using the 'Undo Check Out'
command, or continue with your check in and overwrite the changes that have been
committed to the repository since you last updated your local copy from the
repository.

You can use the 'File Properties' command to determine who checked in the last
changes to this Package. This might help you to discover what changes have been
uploaded and decide whose changes take precedence.

Update Before You
Disconnect

Whenever you are connected to the Version Control server, you are always working
with the latest version of a Package. This is because you cannot modify a Package
until you check it out from Version Control, and checking it out loads the latest
revision from the repository into your model.

This cannot happen when you are disconnected from the Version Control server.
You are working on whatever versions you have on your machine, dating back to
the last time you updated your local copy of each Version Controlled Package. So,
if you are planning to work on a model whilst disconnected from Version Control,
it is a very good idea to make sure that you have the latest versions of all Packages
before you disconnect. The 'Get All Latest' option makes this a simple task.
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Version Control Branching

Currently, Enterprise Architect does not support Version Control Branching.

Work-arounds to achieve similar results might be possible for certain version-control products; contact Sparx Support for
advice.

Contacts

User Type Contact via

Registered users https://sparxsystems.com/registered/reg_support.html

Trial users support@sparxsystems.com
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Version Control Product Setup

To control and maintain the different revisions of your project Packages, Enterprise Architect uses third-party Version
Control products. Once your Version Control product is installed and a suitable environment has been created, Enterprise
Architect can use that environment to control your project's Packages.

Typically, Version Control products consist of:

A server component·

A client component·

Enterprise Architect integrates with the Version Control client components for Subversion, CVS and MS Team
Foundation Server command line clients, as well as for products having API clients that comply with the MS SCCI
specification.

Version Control System Components

Component Detail

Version Control Server The server component maintains the controlled files in their many revisions, in a
central repository.

The server component is usually located on a server machine that is accessible to all
team members who are using Version Control.

Server Configuration The steps for configuring a Version Control server are, broadly:

Install the software·

Create a repository·

Create Version Control projects (or modules or folders for use with specific·
projects)

Configure user IDs and passwords·

For details on configuring any particular Version Control server, consult the
appropriate documentation provided with the Version Control product.

Version Control Client The client component manages the working copies of the controlled files,
submitting files to or retrieving files from the server as required.

A Version Control client must be installed on every machine on which you run
Enterprise Architect and want to access your Version Control system.

Client Configuration The steps for configuring a Version Control client are, broadly:

Install the software·

Create a new directory for use as a local working copy folder·

Log in to the Version Control server·

Associate the working copy folder with its corresponding server repository·
folder

For details on setting up a product-specific Version Control environment for use
with Enterprise Architect, click on the appropriate link in the next column.
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System Requirements

Enterprise Architect is a Windows-based application and requires a Windows-based Version Control client for
integration. It is independent of the Version Control server component and the platform on which that runs.

Version Control Product Requirements

Product Detail

Subversion Subversion is free, open source software.

Subversion server components are available to run on a wide range of different
hardware and operating systems.

Enterprise Architect is not affected by your choice of server components, but
requires Subversion's Windows-based command line client for integration.

There are many graphical user interface clients available for use with Subversion,
such as TortoiseSVN; this type of client cannot be used directly for integration with
Enterprise Architect, but can be very useful in preparing a working Subversion
environment for use by Enterprise Architect.

Binary Packages are available for download from:

http://subversion.apache.org/packages.html·

Subversion documentation is available from:

http://svnbook.red-bean.com/nightly/en/index.html·

Concurrent Versions
System (CVS)

CVS is free, open source software.

CVS server components are available to run on a wide range of different hardware
and operating systems.

Enterprise Architect is not affected by your choice of server components, but
requires CVS's Windows-based command line client for integration.

There are many graphical user interface clients available for use with CVS, such as
TortoiseCVS; this type of client cannot be used directly for integration with
Enterprise Architect, but can be very useful in preparing a working CVS
environment for use by Enterprise Architect.

The software is available for download from:

http://www.nongnu.org/cvs/·

CVS documentation is available from:

http://cvsbook.red-bean.com/cvsbook.html·

Microsoft Team
Foundation Server

Enterprise Architect is able to use either the:

Command line client for TFS, or·

MS TFS-SCC client·

Your choice of client affects how you specify your Version Control Configuration.

MS TFS-SCC clients are available for download from Microsoft's web pages.  (Run
an Internet search for 'TFS MSSCCI'.)

Common Source Code
Control (SCC)-compatible
products

Any Version Control product that provides a client that complies with the Microsoft
Common Source Code Control standard, version 1.1 or higher, can be integrated
with Enterprise Architect.

These products are SCC-compatible and are known to successfully integrate with

(c) Sparx Systems 2019 Page 481 of 654 Created with Enterprise Architect

http://subversion.apache.org/packages.html
http://svnbook.red-bean.com/nightly/en/index.html
http://www.nongnu.org/cvs/
http://cvsbook.red-bean.com/cvsbook.html


Model Repository - Model Repository 20 January, 2020

Enterprise Architect:

Accurev·

ClearCase·

MS Visual Source Safe·

MS TFS-SCC·

MKS Source Integrity·

Perforce·

Source Offsite·

Snapshot CM·

Products that do not appear in this list should still integrate successfully with
Enterprise Architect, if there is a client available for that product that complies with
the MS SCC API specification.
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Create a Subversion Environment

You can use Subversion as a Version Control provider for Enterprise Architect. The first step in doing this is for a
Subversion administrator to install and configure the appropriate software. A number of basic tasks are performed in
creating an operational Subversion environment, and useful tools are available for performing some of these tasks.

Tasks in Creating a Subversion Environment

Task Detail

Install server components Executable files for Subversion can be obtained from the Apache Software
Foundation.

Subversion server components are available to run on a wide range of different
hardware and operating systems; Enterprise Architect is not affected by your choice
of server components.

VisualSVN is a package that can greatly simplify the installation, configuration and
management of your Subversion server.

Create a repository Please consult the official Subversion documentation.

Create Subversion users Please consult the official Subversion documentation.

Create a new repository
sub-tree

It is good practice to create a new repository sub-tree in Subversion for each new
Enterprise Architect model being added to Version Control with Subversion. Users
should create a new local working copy from the sub-tree to be used with that
model.

TortoiseSVN can greatly simplify the process of creating new repository sub-trees.

Install client components Executable files for Subversion can be obtained from the Apache Software
Foundation.

Create a working copy
folder

A working copy folder must exist on each users' machine, for Enterprise Architect
to use when exporting and importing the Version Controlled Package files. It is this
folder that is specified as the Local Project Path, when defining your Version
Control Configurations.

The working copy folder is the 'sandbox' where you modify the controlled files. The
working copy folder is usually associated with a folder that exists within the
Version Control repository. In Subversion, to create a local working copy you
perform an initial check-out of a folder from the Subversion repository; this
downloads a copy of the folder and its contents, to create your local working copy.

TortoiseSVN can greatly simplify the initial check out of a working copy folder.

Setting up Subversion
under Wine/CrossOver

The process of setting up and using Subversion with Enterprise Architect under
Wine is almost identical to the process when running natively under Windows,
apart from minor differences in installing the Subversion client and performing the
initial check out of the working copy folder.

Notes
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Enterprise Architect relies on exclusive file locking when applying Version Control to its Packages; file locking was·
not introduced into Subversion until version 1.2, therefore Enterprise Architect does not work with Subversion
releases earlier than Subversion 1.2

Enterprise Architect can only communicate with the Subversion server using the Subversion command line client·
svn.exe
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Create a new Repository Sub-tree

When you set up Subversion as your Version Control tool, it is good practice to create a new repository sub-tree in
Subversion for each new Enterprise Architect model. The sub-tree can be used to control the Package files for your
model.

Create a new sub-tree in the Subversion Repository

Step Action

1 Use Windows Explorer to create a temporary directory on your PC file system, to be imported into the
Subversion repository as a new repository sub-tree. The directory would have this structure:

2 Open a Windows command prompt, navigate to tempDir and issue the Subversion command import.

For example:

     C:\Documents and Settings\user> cd \tempDir

     C:\tempDir> svn import . https://host.example.com:8443/repos/

     --message "Repository Initialization"

3 On your PC, delete the temporary directory structure (tempDir) and all its contents.

Notes

After the import is finished, the original tree is not converted into a Subversion working copy; you should delete the·
temporary structure and check out a fresh working copy of the tree

The process can also be performed using TortoiseSVN's Repository Browser, which provides commands for simply·
creating new folders directly in the repository
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Create a Local Working Copy

In order to use Subversion to provide Version Control of the Packages in a model, you need to prepare a functional SVN
working copy folder that can be accessed through an Enterprise Architect Version Control configuration within that
model.

Create a Subversion working copy folder

Step Action

1 Choose or create a suitable directory on your system in which to create your Subversion working copy.

2 Open a command prompt window and navigate to the directory you have selected. For example:

     C:\> mkdir mySVNWorkSpace

     C:\> mkdir mySVNWorkSpace/myEAModelName

     C:\> cd mySVNWorkSpace/myEAModelName

3 Perform the initial check out from the Subversion repository, specifying the repository folder and local
working copy folder, as well as your user name and password. For example:

     C:\> svn checkout "https://myserver:8443/svn/repos_folder

     "C:\mySVNWorkSpace/myEAModelName"

     --username myUserName

     --password myPassword

(By specifying your Subversion username and password, you ensure that they are correctly cached by
Subversion and available for use by Enterprise Architect.)

If you specify the HTTPS protocol when performing the initial Subversion check out, a prompt displays to
accept a security certificate; in this instance, press the P key to permanently accept the certificate.

The nominated local folder is configured as a Subversion working copy folder.

Any files already existing in the repository folder are downloaded to the working copy folder as working
copy files.

4 Verify that your Subversion environment functions correctly.

Notes

It is important that Subversion caches your username and password, so that it never has to prompt for user input; a·
check-out operation might not request authentication, and if it does not you should perform an action that does
request authentication, such as adding and committing a dummy test file

The process can also be performed using TortoiseSVN's Checkout command (which provides options to browse·
when specifying both your repository folder and your local folder); when prompted for authentication details by
TortoiseSVN, make sure you place a check against the 'Save Authentication Data' option
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Verify the SVN Workspace

After creating the Subversion local working copy to hold the working copies of your Package files, you can verify that it
functions correctly before attempting to use it with Enterprise Architect. You need to be able to add files to Subversion,
lock the files and commit changes to those files.

Verify correct operation of a Subversion working copy folder

Step Action

1 Use Windows to open a command prompt window.

2 Select the directory you specified as the working copy, in the Subversion checkout command when
preparing the SVN workspace. For example:

     C:\> cd mySVNWorkSpace

3 Create a test file, such as Test.txt, containing the text Subversion Test. For example:

     C:\> echo Subversion Test > Test.txt

4 Execute each of these Subversion commands:

svn add Test.txt·

svn commit -m"Commit comment" Test.txt·

svn update Test.txt·

svn lock Test.txt·

Use your preferred editor to modify the file and save the changes·

svn commit -m"Second commit comment" Test.txt·

The commands should execute without any errors and without prompting the user for any extra input.

Notes

Your environment must be set up such that you can perform these operations without ever being prompted for user·
ID or password; for further information, please see the Caching Client Credentials topic in the official Subversion
documentation
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Subversion Under Wine-Crossover

If you want to set up and use Subversion with Enterprise Architect under Wine, the process is almost identical to the
process for setting up and using the systems under Windows. When running Enterprise Architect under Wine or
CrossOver, you still use a Windows-based Subversion command line client.

There are some minor differences in the way you prepare the Subversion working environment, specifically in the way
you install your Subversion client and the way you check out a working copy folder from the Subversion repository.

System Requirements

Sparx Systems has tested the use of Enterprise Architect with Subversion under Wine 1.2, on macOS 10.4 and 10.6.2,
and on Ubuntu 10.04. All tests were passed.

When using Wine 1.2 on the Ubuntu 9.10 platform, Sparx Systems was able to use the svn: and file: protocols to
communicate with the SVN server; but not the https: protocol.

Installing a Subversion Client

Wine is able to install applications from either a Windows .exe file, or a .msi installer file.

Place the installer for your Windows Subversion client in a convenient location on the native file system, then open a
Wine console window from within Enterprise Architect and run the installer from within the Wine console. Your
Subversion installation can then access the same C: drive and folders that Enterprise Architect is accessing.

(c) Sparx Systems 2019 Page 488 of 654 Created with Enterprise Architect



Model Repository - Model Repository 20 January, 2020

Preparing a Subversion Environment Under Wine

Under Wine, you can install Subversion from either a Windows .exe file, or a .msi file. By performing your Subversion
installation and initial check out from a Wine console window opened from within Enterprise Architect, you have access
to the same C: drive and folders that Enterprise Architect is accessing.

Set up Subversion for use with Enterprise Architect, running under Wine

Step Action

1 Start Enterprise Architect.

You do not have to load a project at this point.

2 From the 'Start' ribbon, select 'Desktop > Preferences > Toolbars...

The 'Customize' dialog is opened.

Select the 'Tools' tab, then click on the  icon.

A new, blank entry is opened on the 'Tools' tab of the 'Customize' dialog.

3 Define the new menu item entry:

In the newly-opened 'Menu contents' field, type the name 'Wine Console'·

In the 'Command' field, type 'wineconsole'·

In the 'Arguments' field, type 'cmd'·

Leave the 'Initial directory' field blank·

4 Click on the Close button.

The 'Customize' dialog closes.

5 Select the ribbon option: 'Configure > User Tools > Wine Console'.

A Wine console window opens.

6 Type 'C:' and press the Enter key.

The Wine console switches to the C: drive.

7 Issue the command to install your Subversion client. For example:

     C:\>/Installers/Subversion-client-1.9.5.win32.exe

To install from a .msi file, use Wine's msiexec utility. For example:

     C:\>msiexec /i  "Installers\Slik-Subversion-1.9.7-win32.msi"

Installation of the Subversion command line client begins.

8 Create a folder to serve as the working copy folder to be used by Enterprise Architect. For example:

     C:\>mkdir C:\VC_workspaces\SVN_workcopy

9 Issue the command to perform the initial checkout from the Subversion repository, specifying the
repository folder, working copy folder, username and password. For example:

     C:\>svn checkout "https://myServer:8443/svn/repos_folder"

            "C:\VC_workspaces\SVN_workcopy "
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            --username myUserName

            --password myPassword

(After specifying your Subversion username and password, they are correctly cached by Subversion and
are available for use by Enterprise Architect.)

If the HTTPS protocol is specified when performing the initial Subversion check out, you are prompted to
accept a security certificate; in this instance, press the P key to permanently accept the certificate.

The nominated local folder is configured as a Subversion working copy folder. Any files already existing
in the repository folder are downloaded to the working copy folder as working copy files.

10 Type 'Exit' and press the Enter key.

The Wine console window closes.

You are now ready to load a project in Enterprise Architect and apply Version Control to it, using the
normal Windows-based procedures.

Notes

You should copy the installer for your Windows Subversion client to a convenient location on the native file system,·
so that you can easily refer to it from within the Wine console window in step 7
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TortoiseSVN

TortoiseSVN is a Windows shell extension for Subversion; it provides icon overlays in Windows Explorer that are useful
as a tool for observing the status of your Subversion controlled files. You can also use it to create your repository
sub-trees and check out local working copies from within Windows Explorer, using simple menu commands.

You can download TortoiseSVN from http://tortoisesvn.net/downloads.html.

Notes

Enterprise Architect can only communicate with the Subversion server using the Subversion command line client·
svn.exe
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Create a TFS Environment

You can use Microsoft Team Foundation Server (TFS) as a Version Control provider for Enterprise Architect. The first
step in doing this is for a TFS administrator to install and configure the TFS server and client applications. A number of
basic tasks are performed in creating an operational TFS environment.

Tasks in Creating a TFS Environment

Task Detail

Obtain and install TFS Enterprise Architect uses the TFS command line client to integrate TFS Version
Control.

The TFS command line client is normally available as part of your Visual Studio
installation.

Choose a TFS project It is good practice to create a new TFS project, or least a new Source Control
Folder within a project, for each Enterprise Architect project being added to
Version Control with TFS.

If you have a single Enterprise Architect project that contains many different
models (for example, a DBMS hosted project with multiple model root nodes), you
might choose to create a new TFS project for each separate model.

For further information, please consult your TFS product documentation.

Create a TFS workspace A working copy folder must exist on each users' machine, for Enterprise Architect
to use when exporting and importing the Version Controlled Package files. It is this
folder that is specified as the Local Project Path, when defining your Version
Control Configurations.

The working copy folder is the 'sandbox' where you modify the controlled files. The
working copy folder is usually associated with a folder that exists within the
Version Control repository. In TFS, the TFS workspace is used to map a local
working folder on your PC to a Source Control Folder within a TFS project.

TFS 2012 and VS 2012 (and later versions) feature a new type of workspace called
'local' workspaces. Do not attempt to use TFS 'local' workspaces with Enterprise
Architect. You must use only 'server' workspaces for Enterprise Architect Version
Control, as 'local' workspaces do not support the application of checkout locks to
files. Enterprise Architect relies on the presence of checkout locks to ensure that
Packages can only be checked out exclusively and that a given Package is not
already checked-out in some other project (for instance, in a Private Model
deployment). This is necessary because it is not practical to merge the XMI
Package files that Enterprise Architect uses for Version Control.

A single TFS workspace can map many different local folders, each one to a
separate Source Control Folder. In this case, TFS can take a long time to work
through and update the files in all of those folders, and the system might appear to
'freeze' whilst it waits for TFS to hand back program control.

You can avoid this if you keep your Version Controlled Package files in a folder
that is separate from other artifacts, such as source code files, creating a separate
work space to use just for your Package files, or creating and mapping a separate
folder for Package files within an existing workspace.

Configure exclusive
check-outs

The XMI format files used for the Version Control of Enterprise Architect's
Packages can not be merged as if they were ordinary text files. Therefore,
Enterprise Architect must enforce serialized editing of its Version Controlled
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Packages. As a consequence, it is important that TFS is configured to use 'exclusive
checkouts' for XML files.

Verify the TFS Workspace Enterprise Architect uses the TFS command line client to checkin and checkout
files from the TFS repository. After creating the TFS workspace, it is important to
verify that the command line client can be used to add, check-in and check-out files
residing in the working copy folder that is mapped through this workspace.

Notes

TFS can also be used with an SCC client; the MS TFS-SCC client is available for download from Microsoft's web·
site

MDG Integration for Visual Studio 2005 or 2008 enhances TFS support by providing access to, for example, work·
items and bugs within both Enterprise Architect and the MDG Integration product

(c) Sparx Systems 2019 Page 493 of 654 Created with Enterprise Architect



Model Repository - Model Repository 20 January, 2020

TFS Workspaces

In order to use TFS to provide Version Control of the Packages in a model, you prepare a functional TFS workspace that
can be accessed through an Enterprise Architect Version Control configuration within that model. You use the TFS
workspace to map a local working folder on your PC to a Source Control Folder within a TFS project repository.

It is assumed that have TFS 2013 open and a TFS Team Project already exists for you to use in Version Control of the
Packages of your Enterprise Architect project. You can create the TFS workspace through MS Visual Studio.

TFS 2013 and later versions support the use of Local workspaces. However, Local workspaces do not support the
application of checkout locks. For this reason, Sparx Systems strongly advises against the use of Local workspaces when
Version Controlling your Enterprise Architect Package files. Using Local workspaces carries a high risk of merge
conflicts when checking in, which would almost certainly result in loss of data or a corrupted model database.

Map a local folder to a TFS Source Control Folder

Step Action

1 Connect to your TFS server.

From the TFS main menu, choose 'View | Team Explorer'.

In the Team Explorer toolbar, click on the Connect to Team Projects button (fourth from left, with a
power plug icon).

The 'Team Explorer Connect' page displays.

2 Click on the link 'Select Team Projects...'

The 'Connect to Team Foundation Server' dialog displays.

3 Click on the appropriate Team Foundation Server, Team Project Collection and Team Project, then click
on the Connect button.

4 Click on the Home page of the Team Explorer, and then on the Source Control Explorer button.

The Source Control Explorer view displays.

5 In the Source Control Explorer, click on the drop-down arrow in the 'Workspace' field in the toolbar, then
click on 'Workspaces' at the bottom of the list.

The 'Manage Workspaces' dialog displays.

6 Click on the Add button.

The 'Add Workspace' dialog displays.

7 Click on the Advanced button.

A number of new fields display on the dialog.

8 Type in an appropriate name for the new workspace and, if required, type in a comment.

9 Set the 'Location' field to 'Server'. This setting is important.

This setting is not available in TFS 2010 and earlier releases, where all workspaces are Server based.

10 Click in the Source Control Folder column, then click on the Browse button to select a Source Control
Folder.

Select the Source Control folder (in the Team Project) to use for controlling Enterprise Architect
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Packages.

11 Click on the Browse button in the 'Local Folder' column and create a new local folder.

This is the working copy folder into which Enterprise Architect exports the Package files.

12 Click on the OK button.

The new workspace is created and saved.

The 'Add Workspace' dialog closes.

13 Click on the OK button.

The 'Manage Workspaces' dialog closes.

Notes

The local folder referenced in step 11 is the Working Copy Path that should be specified when defining an·
Enterprise Architect Version Control Configuration to use this TFS workspace
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TFS Exclusive Check Outs

The XMI format files used for the Version Control of Enterprise Architect's Packages can not be merged as ordinary text
files can. Therefore Enterprise Architect must enforce serialized editing of its Version Controlled Packages, and it is
important that Team Foundation Server is configured to use 'exclusive checkouts' for XML files. Otherwise, TFS can
return file statuses that make it look as if the Package file is not checked-out by another user when indeed it is.

You set exclusive checkouts in the TFS workspace through MS Visual Studio.

Configure TFS to enforce exclusive check outs for XML files

Step Action

1 Using Visual Studio, from the main menu select 'View | Team Explorer'.

2 In the 'Team Explorer' pane, right-click on the TFS Server name that is controlling the Enterprise
Architect Package files, then from the context menu select 'Team Foundation Server Settings | Source
Control File Types'.

3 Select the entry for XML files (or create an entry if necessary) then click on the Edit button.

4 Deselect the 'Enable file merging and multiple check out' checkbox.
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Verify the TFS Workspace

Enterprise Architect will be using the TFS command line client to commit file updates from the local working copy
folder into the TFS repository. After creating the TFS workspace that maps your local working copy folder to a TFS
repository folder, it is good practice to verify that the TFS workspace functions correctly before attempting to use it with
Enterprise Architect. You need to be able to add files to TFS, place a check-out lock on the files and check-in changes to
those files.

Verify correct operation of a TFS Workspace

Step Action

1 Use Windows to open a command prompt window.

2 Select the directory you specified as the local working copy folder when creating the TFS workspace.

For example:

     C:\> cd  myTFSWorkingCopyFolder

3 Create a test file, such as Test.xml, containing the text 'my TFS Test'. For example:

     C:\> echo my TFS Test > Test.xml

(The filename extension '.xml' is used because the TFS server should have been configured to allow
exclusive checkouts for XML files.)

4 Using the command line client, execute each of these TFS commands:

tf.exe add Test.xml·

tf.exe checkin Test.xml /override:"Manual check in." /comment:"a message"·

tf.exe checkout /lock:checkout Test.xml·

Use your preferred editor to modify the file and save the changes.

tf.exe checkin Test.xml /override:"Manual check in."  /comment:"a message"·

tf.exe get . /recursive·

Notes

All of the commands in step 4 should execute without any errors; in particular, you should be able to apply a·
checkout lock when checking out the file

If the checkout command reports any errors, you might have to reconfigure the TFS workspace as a server based·
workspace, or you might have to configure the TFS Server to use 'exclusive checkouts' for XML files
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Create a CVS Environment

You can use Concurrent Versions System (CVS) as a Version Control provider for Enterprise Architect. The first step in
doing this is for a CVS administrator to install and configure the appropriate software. A number of basic tasks are
performed in creating an operational CVS environment, and useful tools are available for performing some of these
tasks.

Tasks in Creating a CVS Environment

Task Detail

Install server components Executable files for CVS can be obtained from March Hare Software.

CVS server components are available to run on a wide range of different hardware
and operating systems; Enterprise Architect is not affected by your choice of server
components.

Create a repository Please consult the official CVS documentation.

Create CVS users Please consult the official CVS documentation.

Create a new repository
module

It is recommended good practice to create a new repository module in CVS for each
new Enterprise Architect model being added to Version Control with CVS. Users
should create a new local working copy folder from the module to be used with that
model.

A repository module represents a project, or a set of related files in the repository.

TortoiseCVS can greatly simplify the process of creating new repository sub-trees.

Install client components Executable files for CVS can be obtained from March Hare Software.

Enterprise Architect is a Windows based application - it requires a Windows based
CVS command line client for integration.

Create a working copy
folder

A working copy folder must exist on each users' machine, for Enterprise Architect
to use when exporting and importing the Version Controlled Package files. It is this
folder that is specified as the Local Project Path, when defining your Version
Control Configurations.

The working copy folder is the 'sandbox' where you modify the controlled files. The
working copy folder is usually associated with a folder that exists within the
Version Control repository. In CVS, to create a local working copy you perform an
initial check-out of a folder from the CVS repository; this downloads a copy of the
folder and its contents, to create your local working copy.

TortoiseCVS can greatly simplify the initial check out of a working copy folder.

Setting up CVS under
Wine/CrossOver

The process of setting up and using CVS with Enterprise Architect under Wine is
almost identical to the process when running natively under Windows, apart from
minor differences in installing the CVS client and performing the initial checkout of
the working copy folder.

Notes
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If you do not already use CVS for Version Control, you should consider using Subversion instead; Subversion's·
client-server protocols provide a broader range of possibilities for connecting to remote servers, with easier set up of
secure connections

TortoiseCVS is a Windows shell extension; Enterprise Architect cannot use TortoiseCVS as its client, it must use·
the CVS command line client
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Prepare a CVS Local Workspace

In order to use CVS to provide Version Control of the Packages in a model, you need to prepare a functional CVS
working copy folder that can be accessed through an Enterprise Architect Version Control configuration within that
model.

Prepare a CVS Working Copy Folder

Step Action

1 Ask your System Administrator to install CVS and create a remote repository, with a module that you can
use to control your Enterprise Architect Package files.

Your administrator must create a username and password for you before you can make a connection.

2 Select or create a suitable directory to use as your CVS working copy directory.

3 Open a command prompt window and navigate to your CVS working copy directory. For example:

     C:\> mkdir myCVSWorkSpace

     C:\> cd myCVSWorkSpace

4 Log in to the remote CVS repository. For example:

     C:\myCVSWorkSpace> cvs -d:pserver:myUserID@ServerName:/reposPath login

Replace myUserID with your CVS username, replace ServerName with the name of your CVS server and
replace reposPath with the path to the repository on the server.

A prompt for a password displays.

5 Enter your password.

You are logged in to the CVS server.

6 Perform the initial checkout of the CVS repository module, into the local working copy directory. For
example:

     C:\myCVSWorkSpace> cvs -d:pserver:myUserID@ServerName:/reposPath checkout moduleName

(Replace moduleName with the name of the repository module that you want to check out.)

A subdirectory is created in your current working directory, with the same name as the module being
checked out.

Any files already existing in the repository module are downloaded to the working copy folder as working
copy files.

7 Verify that your CVS environment functions correctly.

Notes

Much of the process can also be performed (more simply) using the TortoiseCVS command 'Make New Module'·
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Verify the CVS Workspace

After creating the CVS local working copy to hold the working copies of your Package files, you can verify that it
functions correctly before attempting to use it with Enterprise Architect. You need to be able to add files to CVS, and
commit changes to those files. You also need to be able to register as an editor of the file and retrieve the list of currently
registered editors.

Verify correct operation of a CVS working copy folder

Step Action

1 Use Windows to open a command prompt window.

2 Select the directory you specified as the working copy in the cvs checkout command, when preparing the
CVS workspace. For example:

     C:\> cd myCVSWorkSpace

3 Create a test file, such as Test.txt, containing the text CVS Test. For example:

     C:\> echo CVS Test > Test.txt

4 Execute these CVS commands:

cvs add Test.txt·

cvs commit -m"Commit comment" Test.txt·

cvs update Test.txt·

cvs edit Test.txt·

cvs editors Test.txt·

The commands should execute without any errors and without prompting the user for any extra input.

The editors command should produce output that resembles this:

     Test1.txt myUserID Tue Aug 9 10:08:43 2009 GMT myComputer

     C:\myCVSWorkSpace\moduleName

5 Take note of the userID that follows the filename.

Enterprise Architect must find and use this user ID when you create your Version Control configuration.

Notes

Your environment must be set up such that you can perform these operations without ever being prompted for input,·
such as user ID or password
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TortoiseCVS

TortoiseCVS is a Windows shell extension for CVS; it provides icon overlays in Windows Explorer that are useful as a
tool for observing the status of your CVS controlled files. You can also use it to create your repository modules and
check out local working copies from within Windows Explorer using simple menu commands.

You can download TortoiseCVS from: http://www.tortoisecvs.org.

Notes

Enterprise Architect must use the CVS command line client to communicate with the CVS server; it cannot use·
TortoiseCVS
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Create an SCC Environment

You can use a Microsoft Common Source Code Control (SCC) compatible product as a Version Control provider for
Enterprise Architect. The first step in doing this is for an administrator to install and configure the server and client
applications. A number of basic tasks are performed in creating an operational SCC-based environment.

Tasks in Creating an SCC Environment

Task Detail

Install and configure your
chosen Version Control
product

A Version Control server component is typically installed on a dedicated server
machine. All Enterprise Architect users who require access to Version Control must
be able to connect to the server machine.

After installing the Version Control software, the administrator should also create
Version Control user IDs for all users who require access to Version Control.

For further information, consult the product documentation for your particular
Version Control product.

Create a new SCC project It is good practice to create a new SCC Version Control project, or least a new
folder within a project, for each Enterprise Architect project being added to Version
Control with SCC.

If you have a single Enterprise Architect project that contains many different
models (for example, a DBMS hosted project with multiple model root nodes), you
might choose to create a new SCC Version Control project for each separate model.

For further information, consult the product documentation for your particular
Version Control product.

Configure your SCC
project to support exclusive
check-outs for .XML files

The XMI-format files used for the Version Control of Enterprise Architect
Packages can not be merged in the same way as ordinary text files can. Therefore,
Enterprise Architect must enforce serialized editing of its Version Controlled
Packages. As a consequence, it is important that your Version Control application is
configured to use 'exclusive checkouts' for XML files.

Create a local working
copy folder

A working copy folder must exist on each users' machine, for Enterprise Architect
to use when exporting and importing the Version Controlled Package files. It is this
folder that is specified as the Local Project Path, when defining your Version
Control Configurations.

The working copy folder is the 'sandbox' where you modify the controlled files. The
working copy folder is usually associated with a folder that exists within the
Version Control repository. Your Version Control product provides some means by
which you associate a working copy folder with a repository folder.

For further information, consult the documentation for your particular Version
Control product.

Notes

When installing the client component software on users' PCs, check that the SCC client is also installed, as it might·
not be a part of the default installation
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Upgrade at Enterprise Architect Version 4.5, Under SCC
Version Control

If you are working in Enterprise Architect release 4.5 or later and you open an SCC Version Controlled project that was
created under a release earlier than 4.5, you must identify the SCC connection with a new unique ID. You can assign a
name to the existing SCC configuration or associate the project with another configuration that has previously been
assigned a unique ID.

By having a unique ID for each Version Control configuration, you can assign a configuration quickly and efficiently
using configurations that have been created previously for other Version Controlled repositories. This enables you to
configure the many Packages to use an existing Version Control repository; this can apply to Packages created for more
than just one model enabling a great deal of flexibility.

Upgrade an existing SCC Version Controlled project created before release 4.5, in
Enterprise Architect release 4.5 or later

Step Action

1 Open the project that has an SCC Version Control configuration created in Enterprise Architect earlier
than version 4.5.

The 'Select or Create Unique ID for Version Control' dialog automatically displays.

2 On the dialog, either create an ID for an existing configuration or choose a previously created one from
the 'Unique ID' drop-down list.

3 The existing SCC configuration is the initial value, represented by SCC-XXXXX; this number is not
especially meaningful, therefore it is recommended that the configuration be given a meaningful name.

4 You can associate the Version Controlled Package with a previously-defined configuration by selecting an
existing configuration from the 'Unique ID' drop-down list (if one exists).

5 After you have assigned the unique ID, click on the OK button to load the model.
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Version Control Set Up

Once you or an Administrator have installed and configured the Version Control product software, to start using Version
Control you must first define a Version Control configuration within your project in Enterprise Architect, to be used to
control the Packages in the project. You can define any number of Version Control configurations in a single model, but
any given Package is associated with only one configuration.

Access

Ribbon Configure > Version Control > Project-VC

Context Menu Right-click on Package > Package Control > Version Control Settings

Define Version Control Configuration

Step Action

1 On the 'Version Control Settings' dialog, click on the New button.

2 In the 'Unique ID' field, type a suitable configuration name.

3 Select the Type of Version Control product you are connecting to, by clicking on the corresponding radio
button.

4 At this point, the middle section of the dialog changes to display a collection of fields specific to the type
of Version Control configuration you are defining.

Enter details relating to the Version Control workspace that this configuration is to use.

5 Click on the Save button. The new configuration is added to the Defined Configurations list.

6 If you want to create another Version Control configuration, return to step 1.

When you have finished defining your Version Control configurations, click on the Close button.

Notes

Version Control Configuration details are stored in the user's Windows Registry settings, but each project stores a·
list of the configurations it uses, so that Version Control connections can be initialized as the project is being loaded

If you are using the Corporate or extended editions of Enterprise Architect with security enabled, the administrator·
must also set up access permissions to configure and use Version Control
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Re-use an Existing Configuration

Once a Version Control configuration has been defined for use in one project, it is possible to re-use that configuration in
other projects to provide access to:

An already existing Version Control environment (a working copy directory and its associated repository that is·
already in use)

Version Controlled Packages that were created (and Version Controlled) in another project·

Access

Ribbon Configure > Version Control > Project-VC

Context Menu Browser window | right-click on Package | Package Control | Version Control
Settings

Select existing configuration

Step Action

1 On the 'Version Control Settings' dialog, click on the New button.

The various fields on the dialog are cleared, ready for data entry.

2 In the 'Unique ID' field, click on the drop-down arrow and select one of the previously-defined Version
Control configurations.

The details of the selected configuration are displayed in the dialog.

3 Click on the Save button.

The configuration details are saved and are ready for use in the current project.
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Version Control Settings

Defining Version Control settings within Enterprise Architect should only be performed after you have successfully
created the Version Control environment that you intend to use to control your Package files. If you have not yet done so,
please refer to the Help topic Applying Version Control in a Team Environment for a summary of what is required.

To set up a Version Control configuration on your model, or update an existing Version Control configuration, you
define a number of settings that control how the status of your model is communicated to your Version Control system.
You define these settings using the 'Version Control Settings' dialog.

Access

Ribbon Configure > Version Control > Project-VC

Context Menu Right-click on Package > Package Control > Version Control Settings

Configuration Options

Option Action

This model is private Select to specify that this model database is to be accessed by just a single user

(Private Model).

Leave unselected (the default) or deselect to specify that the database is to be
accessed by multiple concurrent users (Shared Model).

If in doubt, use the default setting.

Save nested Version
Controlled Packages to
stubs only

Select to specify that the exported XMI file for a Version Controlled Package will
contain Package stubs (place holders) for nested Version Controlled child Packages
(recommended).

Deselect to specify that the exported XMI file will contain the full content of nested
Version Controlled child Packages.

For all packages, create
placeholders for external
references

Select to force all XMI 1.1 imports across the model to exclude incoming
relationships and instead create external references.

If the 'Create placeholders for missing External References during XMI 1.1/2.1
Import' checkbox is not selected in the XML Specifications options for a user, this
field overrides that setting.

Unique ID Specify a name that uniquely identifies the configuration. Either:

Type a name to identify a new configuration, or·

Click on the drop-down arrow and select the name of a configuration·
previously defined in a different project (if any exist)

Type Click on the appropriate radio button for the type of Version Control system you
are associating with this configuration.

The middle section of the dialog changes to display a collection of fields relating to
the type of Version Control configuration you are defining.
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Set the type to SCC for:

MS Visual Source Safe·

Rational Clear Case·

Perforce·

AccuRev·

Any other SCC-compatible clients·

For any other product that you are using, select the type that matches the product -
CVS, Subversion or TFS.

New Click on this button to clear the fields and create a new Version Control
configuration.

Save Click on this button to save the details of a new or updated configuration.

Delete Click on an entry in the Defined Configurations list and click this button to remove
the definition of the selected configuration from this model.

Defined Configurations Review a list of configurations that are in use in the current model.

In future, do not prompt for
incomplete configurations

Select to specify that the user is not prompted to complete the definition of
configurations that are not fully specified (the default).

Deselect to prompt the user to complete configurations that are not fully defined.

Close Close the 'Version Control Settings' dialog.

Help Display this Help topic.

Notes

It is important that, for any given Version Controlled Package file, any user accessing that file from any model uses·
Version Control configurations having the same Unique ID

When you first open a model that was created by another user and that uses Version Control, the Version Control·
configuration(s) used by that model do not yet exist in your Windows registry settings; you have to complete the
definitions of those configurations before you can use Version Control in that project

If User Security is enabled, you must have 'Configure Version Control' permission to set up Version Control options·
for the current model

It is possible to use multiple Version Control configurations in the same model·
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SCC Settings

When you are setting up your Version Control configurations on the 'Version Control Settings' dialog, and you set the
configuration type to 'SCC', the dialog presents a set of fields specific to SCC-based configurations. You can then define
details such as:

The working copy folder to be used with the configuration·

The details necessary to connect to the SCC Version Control system·

You set the Version Control configuration type to SCC for version Control providers such as:

MS Visual Source Safe·

Rational Clear Case·

Perforce·

AccuRev·

Any other SCC-compatible clients·

Access

Ribbon Configure > Version Control > Project-VC : Type: SCC

Context Menu Right-click on Package > Package Control > Version Control Settings: Type: SCC

Settings

Option Action

Local Project Path Displays the full path of the folder that contains the local (working) copies of the
XMI Package files.

This field is read-only; its value can only be set through use of the Select Path
button.

Select Path Click on this button to choose the Local Project Path, by opening a file browser
dialog and navigating through the file system to the appropriate folder.

After you choose the appropriate folder path, the 'Select SCC Provider' dialog·
displays, listing all SCC providers that are installed on the current workstation;
choose the SCC provider to use and click on the OK button

At this point, the SCC client opens its own dialog to prompt you for·
information; SCC products implement this functionality in varied ways, but
typically you are prompted to log in to the Version Control system, then
prompted to choose the SCC project to use and possibly a (server) folder
contained within that project

At the conclusion of this process, all of the SCC details should be filled in; you·
can then save the definition by clicking on the Save button on the 'Version
Control Settings' dialog

Current User Displays the user name used to log on to the Version Control system that is
accessed through this configuration.

(c) Sparx Systems 2019 Page 510 of 654 Created with Enterprise Architect



Model Repository - Model Repository 20 January, 2020

This field is read-only; the value it displays is retrieved from the SCC client.

SCC Provider Displays the name of the SCC provider.

This field is read-only; the value it displays is retrieved from the SCC client.

SCC Project Displays the name of the SCC Project that this configuration attaches to.

This field is read-only; the value it displays is retrieved from the SCC client.

Notes

You define the SCC-specific details as part of the broader process of setting up a Version Control Configuration on·
the 'Version Control Settings' dialog
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CVS Settings

When you are setting up your Version Control configurations on the 'Version Control Settings' dialog, and you set the
configuration type to CVS, the dialog presents a set of fields specific to CVS-based configurations. You can then define
details such as:

The working copy folder to be used with the configuration·

The path to the CVS command line client·

Access

Ribbon Configure > Version Control > Project-VC : Type: CVS

Context Menu Right-click on Package > Package Control > Version Control Settings: Type: CVS

Settings

Option Action

Working Copy Path Displays the full path of the folder that contains the local (working) copies of the
XMI Package files.

This field is read-only; its value can only be set through use of the Select Path
button.

Select Path Click on this button to choose the working copy path, by opening a file browser
dialog and navigating through the file system to the appropriate folder.

Current User This field is read-only; its value is retrieved from a file named CVS\Root, located
in the folder selected using the Select Path button.

CVS Exe Path Displays the full path of the CVS command line client executable file.

This field is read-only; its value can only be set through use of the Select Path
button.

Select Path Click on this button to specify the path to the CVS command line client, by opening
a file browser dialog and navigating through the file system to locate the
appropriate file.

VC Time-Out Value Specify the amount of time that Enterprise Architect waits for a CVS command to
complete; if the command does not complete within the allowed time, the system
displays a Time-out error message, detailing the command that failed to complete.

This single time-out value is applied to all Version Control Configurations (of types
SVN, TFS and CVS) that the user accesses from this workstation.

Notes
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When connecting to a remote CVS repository, the 'Current User' field should display the user name used to log into·
that repository; if this does not happen, it indicates that Enterprise Architect cannot extract the user name from the
file ...\WorkingCopyPath\CVS\Root and the configuration does not work correctly

You define the CVS-specific details as part of the broader process of setting up a Version Control configuration on·
the 'Version Control Settings' dialog
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SVN Settings

When you are setting up your Version Control configurations on the 'Version Control Settings' dialog, and you set the
configuration type to 'Subversion', the dialog presents a set of fields specific to Subversion-based configurations. You
can then define details such as:

The working copy folder to be used with the configuration·

The path to the Subversion command line client·

Access

Ribbon Configure > Version Control > Project-VC : Type: Subversion

Context Menu Right-click on Package > Package Control > Version Control Settings: Type:
Subversion

Settings

Option Action

Working Copy Path Displays the full path of the folder that contains the local (working) copies of the
XMI Package files.

This field is read-only; its value can only be set through use of the Select Path
button.

Select Path Click on this button to choose the Working Copy Path, by opening a file browser
dialog and navigating through the file system to the appropriate folder.

Subversion Exe Path Displays the full path of the Subversion command line client executable file.

This field is read-only; its value can only be set through use of the associated Select
Path button.

Select Path Click on this button to specify the path to the Subversion command line client, by
opening a file browser dialog and navigating through the file system to locate the
appropriate file.

VC Time-Out Value Specify the amount of time that Enterprise Architect should wait for a Subversion
command to complete; if the command does not complete within the allowed time,
the system displays a Time-out error message, detailing the command that failed to
complete.

This single time-out value is applied to all Version Control Configurations (of types
SVN, TFS and CVS) that the user accesses from this workstation.

Notes
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You define the Subversion-specific details as part of the broader process of setting up a Version Control·
configuration on the 'Version Control Settings' dialog
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TFS Settings

When you are setting up your Version Control configurations on the 'Version Control Settings' dialog, and you set the
configuration type to 'TFS', the dialog presents a set of fields specific to TFS-based configurations. You can then define
details such as:

The working copy folder to be used with the configuration·

The user name and password to log in to the TFS server·

The path to the TFS command line client·

Access

Ribbon Configure > Version Control > Project-VC: Type: TFS

Context Menu Right-click on Package > Package Control > Version Control Settings: Type: TFS

Settings

Option Action

Working Copy Path Displays the full path of the folder that contains the local (working) copies of the
XMI Package files.

This field is read-only; its value can only be set through use of the associated Select
Path button.

Select Path Click on this button to choose the Working Copy Path. The file browser dialog
opens, through which you navigate through the file system to the appropriate folder.

Server Name Displays the name of the TFS Server that is associated with the working copy
folder specified in the 'Working Copy Path' field.

This field is read-only; Enterprise Architect retrieves the value it displays by
querying the TFS client.

Workspace Name Displays the name of the TFS Workspace that is associated with the working copy
folder specified in the 'Working Copy Path' field.

This field is read-only; Enterprise Architect retrieves the value it displays by
querying the TFS client.

User Name Type in the user name with which to log into the TFS Server.

Password Type in the password with which to log into the TFS Server.

Display Name TFS 2013 and later releases use a Display Name to report on who owns a checkout
lock on a file. TFS 2010 uses AccountID when reporting lock owners and so does
not require a Display Name.

If using TFS 2013, type in your TFS Display Name as shown in the User column of
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the Visual Studio Source Control Explorer when you checkout a file.

Checkout Locks Required This checkbox defaults to selected.

TFS 2013 supports the use of Local workspaces, but these do not support checkout
locks. If you want to use TFS Local workspaces (not recommended), you must
deselect this checkbox. Otherwise, leave the checkbox selected.

It is recommended that all workspaces used for Version Controlling Enterprise
Architect Package files are set as 'Server' workspaces.

TFS Exe Path Displays the full path of the TFS command line client executable file.

This field is read-only; its value can only be set through use of the associated Select
Path button.

Select Path Click on this button to specify the path to the TFS command line client.

The file browser dialog opens, through which you navigate through the file system
to the appropriate folder.

VC Time-Out Value Type in the number of seconds that Enterprise Architect should wait for a TFS
command to complete; if a command does not complete within this allowed time,
the system displays a Time-out error message, detailing the command that failed to
complete.

This single time-out value is applied to all Version Control configurations (of types
SVN, TFS and CVS) that the user accesses from this workstation.

Notes

If you automatically log in to TFS through a path external to Enterprise Architect (for example, through MS·
Integrated Security), you can leave the 'User Name' and 'Password' fields blank

If the 'Password' field is blank, Enterprise Architect retrieves your Windows username and uses that value when·
determining whether a Package file is checked out to you or to another user

TFS Version Control can also be accessed using the TFS MSSCCI client; to make use of the TFS MSSCCI client,·
please define an SCC based Version Control configuration

You define the TFS-specific details as part of the broader process of setting up a Version Control configuration on·
the 'Version Control Settings' dialog
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Use Version Control

Once your Version Control product is installed and you have created a suitable environment, Enterprise Architect can
make use of that environment to control the Packages in your project. Version Control provides a range of facilities, as
outlined in this table.

Facilities

Facility Detail

Define Version Control
Settings

Version Control Configurations are used by Enterprise Architect to communicate
with your Version Control system.

You define one or more Version Control configurations in your project and then use
those configurations to control the Packages in your project.

Configure a Package To put a Package under Version Control you mark the Package as a controlled
Package, specify the Version Control configuration to control it, and associate an
XMI file with the Package.

Check In a Model Branch Checks in all Packages involved in a particular unit of work, as a single operation.

Checking-in updates the reference version of a Package or group of Packages in the
model.

Check Out a Model Branch Checks out all Packages within a selected model branch as a single operation, so
that you can update modeling objects within them.

Check In a Package Checks in the Package currently selected in the Browser window.

Checking-in updates the reference version of a Package or group of Packages in the
model.

Check Out a Package Checks out the Version Controlled Package currently selected in the Browser
window, so that you can update modeling objects within it.

Undo Check Out of a
Package

Reverses the check-out of a Package, discarding any modifications that have been
made by restoring the Package content to the latest revision held in Version
Control.

Import a Package From
Version Control

Retrieves Packages from Version Control that have been created by other users, or
by you in another model, and imports them into your current model.

Apply Version Control to a
Model Branch

Applies Version Control to all Packages within the selected model branch, in a
single operation.

In this context, a model branch is a Package in the Browser window, and all of the
Packages contained within it.

Export a Version
Controlled Model Branch

Exports Version Control information about the root Package of a model branch, that
is used to simplify the process of exporting and importing a hierarchy of Packages
from one model to another.

Import a Model Branch
From Version Control

Uses Enterprise Architect's Model Branch files, of which there are few, to retrieve
information about the root Package file and to import the model branch.
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Model branch files can simplify the process of exporting and importing a hierarchy
of Packages from one model to another.

View Package Revision
History

Displays the change history of Version Controlled Packages.

You can also check out a prior revision of the Package for editing, effectively
rolling-back to a prior revision of the Package.

Validate Package
Configurations

You can test the validity of the Version Control settings associated with each
Version Controlled Package within your current model.

Resynchronize the Status
of Version Controlled
Packages

Re-synchronizes the Version Control status of Packages within your project with
the status reported by your Version Control provider.

Notes

Database replication should not be combined with Version Controlled Packages·

If the Packages under Version Control contain any alternative images, you can export the images to the Version·
Control repository when you check in the Packages, by setting the 'Export alternate images' option on the
'Preferences' dialog
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Configure Controlled Package

Once your Version Control application is set up and you have Version Control configurations in place, you can place the
individual Packages in your model under Version Control. To put a Package under Version Control, you:

Flag the Package as a controlled Package·

Specify the Version Control configuration to control it and·

Associate an XMI file with the Package·

You can then export and import the Package data to and from the file and issue commands to the Version Control
system.

Access

Ribbon Configure > Version Control > Package-VC

Keyboard Shortcuts Ctrl+Alt+P

Apply Version Control to a single Package

Step Action

1 Click on the 'Control Package' checkbox to select it, indicating that this Package is to be controlled.

2 Click on the 'Version Control' drop-down arrow and select the Version Control configuration to be used to
control this Package.

3 The 'XMI Filename' field displays a default filename for the Package export file, based on the Package
name.

Optionally, modify the filename. Either:

Type a new name, or·

Click on the  button to open a file selection dialog·

The target file must be located within the working copy folder of the selected Version Control
configuration, or one of its sub-folders.

4 The 'Version ID' field defaults to '1.0'.

Optionally, change this to a different version number.

5 The 'Owner' field defaults to your user name.

Optionally, type or select the name of the user who actually owns the Package.

6 Click on the OK button.

The 'Add Package to Version Control' dialog displays.

7 Optionally, clear the 'Keep checked out' checkbox.
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After applying Version Control, the Package either remains checked-out for editing, or is checked-in and
locked against editing, depending on this setting.

8 Click on the OK button.

The 'Add Comment' dialog displays.

9 Optionally, add any further comments to the default comment.

Enterprise Architect provides a default comment that includes the current date & time.

10 Click on the OK button.

The current Package is exported to the nominated XMI file, which is then committed to Version Control.
The Package icon in the Browser window is updated to reflect the Package's Version Control status.

Notes

If you are using the Corporate or extended editions of Enterprise Architect with security enabled, these features are·
only available to users who have been granted permission to configure and use Version Control
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Apply Version Control To Branches

It is possible to apply Version Control to all Packages within a selected model branch, in a single operation. In this
context, a model branch is a Package that is currently selected in the Browser window, and all of the Packages contained
within it.

Access

Context Menu Browser window | right-click on Package | Package Control | Add Branch to
Version Control

Apply Version Control to all Packages within a selected model branch

Step Action

1 On the 'Apply VC to Branch' dialog, click on the drop-down arrow in the 'Version Control Configuration'
field and select the configuration to use.

2 Optionally, tick the checkbox 'Export as Model Branch'.

Once the Version Control operation is complete a Model Branch file (.EAB file) is created for this branch.

3 Click on the OK button.

The system creates a number of sub-folders within the Version Control working copy folder, then exports
all of the Packages within the selected model branch. The system generates filenames for the XMI files,
based on the Package GUIDs.

Notes

The Version Control configuration to be used in this operation must be defined within the model before selecting·
this command

When invoked on the model root node, this command applies Version Control to every Package within the model·
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Package Version Control Options

When you have set up a Package for Version Control, you gain access to a range of Version Control operations that can
be performed on that Package, such as:

Open the dialog for working with baselines of the Package·

Check-in and check-out single Packages or a selected hierarchy of Packages·

Update Packages to the latest revision from the Version Control repository·

Inspect the revision history or properties of the XMI file associated with a Package·

Revert a Package to a previous revision·

Compare the current model content of a Package, against the latest revision of the Package in Version Control·

Import and export hierarchies of Packages (model branches) to and from the model, through the Version Control·
system

Synchronize the status of a Package, with the Version Control system·

Access

Context Menu Right-click on Version Controlled Package > Package Control

Options

Option Action

Check In Branch Check-in Packages contained in the currently selected model branch (that is, the
selected Package and all of its child Packages).

The 'Select Packages to Check In' dialog lists all Version Controlled Packages
within that branch that are checked out to you; you can then select Packages in the
displayed list, to be submitted for check-in.

You can also choose to keep the Packages checked-out after committing a new
revision to Version Control.

Check Out Branch Recursively check out all Packages contained within the currently selected model
branch (that is, the selected Package and all of its child Packages) that are Version
Controlled and checked-in.

Check In Commit a new revision of the currently selected Package to the Version Control
repository and lock the Package against further editing.

Only available for Packages that you have checked-out yourself.

Check Out Synchronize the currently selected Package with the latest revision from the
Version Control repository and unlock the Package to allow editing.

Only available for Packages that are not already checked-out (and whose associated
Package file is not checked-out).

Undo Check Out Restore the selected Package to the latest revision in the Version Control repository
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and lock the Package against further editing.

Put Latest Commit a new revision of the currently selected Package to the Version Control
system, while keeping the Package checked-out.

This is equivalent to checking a Package in and immediately checking it back out
again.

Only available for Packages that you have checked-out yourself.

Get Latest Synchronize the currently selected Package with the latest revision from the
Version Control repository.

Available only for Packages that are checked in.

Get All Latest Updates all of the Version Controlled Packages in the project, to the latest revision
retrieved from Version Control.

Only updates Packages that are currently checked in.

Once the latest revisions are retrieved, the system scans all the controlled Packages
and fixes any missing cross-references by comparing the Package with its XMI 1.1
file.

If the cross-reference information in the XMI does not match the model, the system
updates the model with the information from the XMI and records this update in the
System Output window.

You can roll back such updates by selecting the entry in the System Output window
and using the context menu option 'Rollback Update' (or 'Rollback Selected
Updates' if multiple entries are selected).

Closing the model clears the entries in the System Output window·

An entry in the System Output window is also cleared as and when you·
roll-back the update for it

Scan XMI and Reconcile
Model

Scan the Package XMI files associated with each of the project's controlled
Packages and restore any diagram objects or cross-references that are detected as
missing from the project.

This function is useful in team environments where each user maintains their own
private copy of the model database (that is, multiple private project files) and model
updates are propagated through the use of controlled Packages. It provides no
benefit when the model is hosted in a single shared database that is accessed by all
team members.

Each controlled Package is compared with its associated XMI file and, if the
cross-reference information in the model does not match the XMI, the system
updates the model with the information from the XMI and records the update in the
System Output window.

You can roll back such updates by right-clicking on the entry in the System Output
window and selecting the 'Rollback Update' option (or 'Rollback Selected Updates'
if multiple entries are selected).

Closing the model clears the entries in the System Output window; an entry in the
window is also cleared as and when you roll-back the update for it.

This functionality is invoked automatically as part of the 'Get All Latest' operation.

When working in an environment that uses a Private Model deployment and your
model contains a significant number of cross-Package references, it is
recommended that you invoke 'Scan XMI and Reconcile Model' from time to time,
following the re-importation of controlled Packages - for example, after using 'Get
Latest' to update a number of Packages - or after performing a number of Package
check-outs.

As a general rule, avoid running 'Scan XMI and Reconcile Model' while you have
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uncommitted changes in your model; generally, you:

Check-out a number of Packages·

Invoke 'Scan XMI and Reconcile Model'·

Make your modifications·

Commit any outstanding changes before you check-out more Packages and run·
'Scan XMI and Reconcile Model' again

File Properties Display Version Control properties pertaining to the XMI export file associated
with the currently selected Package; this also identifies who has checked out the
Package.

File History Display change history information for the currently selected Package.

Revert to or check-out a prior revision of the Package.

Compare with Controlled
Version

Compare the currently selected Package with the latest revision of its associated
XMI file retrieved from Version Control.

Add Branch to Version
Control

Apply Version Control to all Packages within a selected model branch, in a single
operation.

In this context, a model branch is a Package that is currently selected in the
Browser window, and all of the Packages contained within it.

Export as Model Branch Export a newly created model branch from your own private copy of a model.

Import a Model Branch Retrieve a model branch and import it into either the source model or another
model.

Get Package Access Packages in the Version Control repository that are not currently available
in your model.

Re-synch Status With VC
Provider

Update the Version Control status value recorded for the selected Package in the
project to match the value reported by the Version Control provider, without
performing an XMI import or export.

Use this function when the Package's Version Control status recorded in your
project is out of synchrony with the Version Control status reported by your
Version Control provider.

Version Control Settings Display the 'Version Control Settings' dialog.

Notes

You set up Version Control using options from the project 'Version Control' submenu·

If the selected Package is not under Version Control, a different set of options is available·

If a Version Control configuration has not been defined for the model, no options for using Version Control are·
available, only the options for configuring Version Control
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Check Out a Package

When you need to work on a Version Controlled Package, you check it out. The local XMI file associated with the
Package is then checked-out from Version Control. No other user can check out the Package to make changes to it until it
has been checked in again.

Access

Context Menu Right-click on Package > Package Control > Check Out

Keyboard Shortcuts Ctrl+Alt+L

Check out a single Package

The Package file is imported into your model, and the 'Package' icon is updated to reflect the change in the Package's
Version Control status.

When working in a Private Model, if the system detects that the Package content in the model is already up to date with
the latest revision of the Package file retrieved from Version Control, then the 'Import Package' dialog displays first. This
dialog is not displayed for a Shared Model.

These options are available:

Force Reload From XMI - reload the Package from XMI regardless of whether it is up to date or not·

Accept current Package - select to skip the process of re-importing the Package from XMI·

Refresh model view - select to refresh the Browser window and diagrams, by reloading the Package content from the·
project database

Always use these settings - when selected, if you subsequently check out a Package that is found to be up to date, the·
same settings are applied again without displaying the dialog

Notes

If you check out a Version Controlled Package whilst offline, the 'Package' icon has a red figure 8 in front of it·

If you have selected the 'Always use these settings' checkbox and you want to reconfigure the 'Import Package'·
dialog, press the Ctrl key whilst you select the 'Package Control | Check Out' context menu option; the dialog
displays and you can change the settings
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Undo Check Out of a Package

If you check out a Package and then decide not to proceed, you can undo the check-out and discard any modifications
that have been made, by restoring the Package content to the latest revision held in Version Control. The Package returns
to a checked-in state and subsequently can be checked out by any user, including yourself if, for example, you need to
reverse incorrect changes before checking the Package out and starting again.

Access

Context Menu Right-click on Package > Package Control > Undo Check Out

Undo check out of a selected Package

A confirmation dialog displays; click on the OK button.

The latest revision of the Package is retrieved from Version Control and re-imported into your model. The icon against
the Package in the Browser window is updated to reflect the change in the Package's Version Control status.
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Check In a Package

When you have finished working on the contents of a Package under Version Control, and you want to return it to the
model for other users to see, you check it in.

Access

Context Menu Right-click on Package > Package Control > Check In

Keyboard Shortcuts Ctrl+Alt+S

Check in a single Package

Step Action

1 The selected Package is exported and the 'Add Comment' dialog displays. A default comment is provided
that contains the current date and time.

Optionally, modify the default check-in comment

2 Click OK.

The Package file is checked-in to Version Control and the Package icon is updated to reflect the change in
Version Control status.
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Check Out a Model Branch

If you need to check out a number of related Packages involved in a particular unit of work, to update the contents, you
can do so in a single operation by checking out the whole model branch that contains them.

Access

Context Menu Right-click on Package > Package Control > Check Out Branch

Check out a sub-tree of model Packages

Step Action

1 The selected root-node Package and all of its contained sub-Packages are recursively checked out.

Any Packages that cannot be checked-out are listed in a message box, with a brief description of the
problem; for example: The Package is already checked out by user 'Fred'.

2 When Project Security is enabled in Lock to Edit mode, Enterprise Architect prompts you to apply a User
Lock throughout the selected model branch before proceeding.
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Check In a Model Branch

If you need to check in a number of related Packages involved in a particular unit of work, and that you have updated,
you can do so in a single operation by checking in the whole model branch that contains them. You can also commit new
revisions of the affected Packages as you complete milestones, whilst keeping the Packages checked-out for further
editing.

Access

Context Menu Right-click on Package > Package Control > Check In Branch

Check in Packages from within a model branch

Step Action

1 The 'Select Packages to Check-in' dialog lists all Version Controlled and checked-out Packages within the
selected model branch. By default, the entire list is selected.

Optionally:

Click an individual Package to select just that Package·

Ctrl+click on an individual Package to add or remove it from the selection·

Shift+click on a range of Packages to select them·

Click on the All button to select all listed Packages·

Click on the None button to clear the selection·

2 Optionally, you can commit into Version Control a new revision of all selected Packages, while keeping
those Packages checked out for further editing. To do this, select the 'Keep packages checked-out after
committing new revision' checkbox.

3 Click on the OK button.

The 'Add Comment' dialog displays. A default comment is provided that contains the current date and
time. This comment is applied to all Packages that are checked in.

4 Optionally, modify the default check-in comment.

5 Click on the OK button.

The selected Packages are exported and checked-in. The Package icons are updated to reflect any change
in Version Control status. If you opted to keep Packages checked out, there is no change in status.
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Update to the Latest Revision of Selected Package

When you are part of a team working in a Distributed Model environment, you will want to periodically update your
model with the changes that other team members have committed into Version Control. You can transfer the other users'
updates from Version Control into the selected Package in the Browser window.

Access

Context Menu Right-click on Package > Package Control > Get Latest

Update Package to latest revision

The local XMI file associated with the Package is updated to the latest revision from Version Control. The XMI file is
imported into your model database, updating the Package in your model.

When working in a Private Model, if the system detects that the Package content in the model is already up to date with
the latest revision of the Package file retrieved from Version Control, then the 'Import Package' dialog displays first. This
dialog is not displayed for a Shared Model.

These options are available:

'Force Reload From XMI' - reload the Package from XMI regardless of whether it is up to date or not·

'Accept current Package' - select to skip the process of re-importing the Package from XMI·

'Refresh model view' - select to refresh the Browser window and diagrams, by reloading the Package content from·
the project database

'Always use these settings' - when selected, if you subsequently check out a Package that is found to be up to date,·
the same settings are applied again without displaying the dialog

Notes

The 'Get Latest' command is disabled for any Package that is checked-out (to anybody) in the currently loaded·
project

When using a Shared Model environment, where all users are connected to a single model database, you should·
reload the Package from the database, rather than using the 'Get Latest' command

If you have selected the 'Always use these settings' checkbox and you want to reconfigure the 'Import Package'·
dialog, press the Ctrl key whilst you select the 'Package Control | Get Latest' context menu option; the dialog
displays and you can change the settings
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Update to the Latest Revision of All Packages

When you are part of a team working in a Distributed Model environment, you will want to periodically update your
model with the changes that other team members have committed into Version Control. You can transfer the other users'
updates to all Version Controlled Packages into the currently loaded project.

Access

Context Menu Right-click on Package > Package Control > Get All Latest

Update all Packages in project to latest revision retrieved from Version Control

All the local XMI files for all the Version Control configurations used in the project are updated to the latest revision
from Version Control. The system then scans the Packages in the model, to determine which ones are up to date and
which are not, compared to the latest revisions of the associated Package files.

A prompt displays, providing these import options for Packages that are up to date:

Import changed files only·

Always import·

Prompt for each file·

Click on the OK button. The Version Controlled Packages in your project are updated according to the option you
selected; if you chose the 'Prompt for each file' option, a prompt displays to confirm import of each file.

Notes

There is no need to re-import Packages that are already up to date - re-importing Packages first deletes them from·
the project and then re-imports them from the XMI file, which is time consuming as well as unnecessary; we
strongly recommend using the default option 'Import changed files only'

The 'Get All Latest' command does not update any Package that is checked-out (to anybody) in the currently loaded·
project; otherwise, any changes not yet committed to Version Control would be discarded

When using a Shared Model environment, where all users are connected to a single model database, the information·
in the model database is always the same as, or ahead of, what is committed into Version Control; in this situation,
the Get All Latest command will simply refresh your view of the model database, by reloading diagrams or
reloading Package content in the Browser window
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Include Other Users' Packages

Other users might be developing Packages in their own models that you could use in your model, or you might have
other models containing Packages that you want to use in the current model. Unless you are sharing an SQL database or
project file, those Packages are not automatically available to you. However, if the Packages have been placed into
Version Control, you can import them into your model as children of one of your model's Packages.

Access

Context Menu Right-click on Package > Package Control > Get Package

Import Packages from Version Control into current model

Step Action

1 On the 'Get Shared File' dialog, click on the drop-down arrow of the 'Version Control Configuration' field
and select the Version Control configuration associated with the Package to retrieve.

The file list is populated with the names of files available through that configuration, for retrieval and
import into your model.

2 Click on the Package file to import into your model and click on the OK button.

The Package file is imported as a new child Package, under the parent Package you selected.

Notes

You must have access to the Package files through the Version Control system and you must define a Version·
Control configuration through which to access those files

The Version Control configuration must use the same unique ID that was originally used to add the Package to·
Version Control

XMI Package files associated with Packages that are already part of your project, are NOT included in the list of·
files available for import
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Export Controlled Model Branch

Applying Version Control to a model can result in many XMI files being placed under Version Control. It might then be
hard to locate and import the file corresponding to the root of a particular model branch. Using Model Branch Files (.eab
files) overcomes this problem by making it easier to export and import Package hierarchies from one model to another.

You could export a newly created model branch from your own private copy of a model so that, for example:

Another user can import that branch into their own private copy of the same model·

It can be imported for inclusion as a common branch in a number of different models·

Access

Context Menu Right-click on Package > Package Control > Export as Model Branch

Create a Model Branch File to represent a Package hierarchy stored in Version
Control

Step Action

1 On the 'Export as Model Branch' dialog, in the 'EAB Filename' field, type a name for your Model Branch
File.

Alternatively, click on the  button and browse for the file location.

Note that the Package name is supplied as a default.

2 Click on the OK button.

A branch file is created to represent the selected Package. The branch file is committed to Version Control
using the same Version Control configuration that controls the Package you selected.

Notes

You can specify any file name, including sub-folder names, as long as the file is contained in or below the working·
folder of your Version Control configuration

The facility is only enabled for Packages that are already under Version Control·
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Import Controlled Model Branch

Applying Version Control to a model can result in many XMI files being placed under Version Control. It could then be
hard to locate and import the file corresponding to the root of a particular model branch, if you want to:

Retrieve a model branch created by another user in a private copy of a model, to import it into your own private·
copy of the same model

Retrieve a model branch that is common in many models, for inclusion in a new model·

Model Branch Files overcome this problem by simplifying the retrieval of Package hierarchies for use in other models.
You use Enterprise Architect's Model Branch Files, of which there are few, to retrieve information about the root
Package file - such as the name and type of the Version Control configuration for the selected Package, and the relative
filename of the Version Controlled XMI file associated with the Package. The system then uses this information to
import the branch into your model.

Prerequisites

Before you begin, you must have:

An operational Version Control environment that can be accessed by Enterprise Architect, and·

All of the Version Controlled Package files and the model branch file associated with the model branch to import, in·
a valid and accessible working copy folder

Access

Context Menu Right-click on target Package for import > Package Control > Import a Model
Branch

Import a Model Branch

Step Action

1 On the 'Import VC Model Branch' dialog, either:

Use the lower portion of the dialog to select a model branch file (this is the simpler option if the·
associated Version Control configuration has already been saved in the current model; continue to
step 2)
OR

Click on the Find a Model Branch (.EAB) file button (this option is useful when you have not yet·
defined the Version Control configuration that is associated with the model branch to be imported;
see the Manually Locating Model Branch Files topic)

2 Click on the drop-down arrow in the 'Select a Version Control Configuration' field and select a
configuration.

A list of .eab files controlled by that configuration is displayed in the 'Select a Model Branch (.EAB) file'
list.

3 Select the Model Branch File you need, then click on the OK button.

(c) Sparx Systems 2019 Page 535 of 654 Created with Enterprise Architect



Model Repository - Model Repository 20 January, 2020

The system imports the root Package specified in the Model Branch File and recursively imports and
populates all the sub-Packages contained in the root Package.

Notes

The Import a Model Branch command is only enabled for Packages that you (the current user) are able to edit, as the·
imported model branch is inserted into the model under your selected Package
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Manually Locating Model Branch Files

When importing a Model Branch File from Version Control, you might not have the associated Version Control
configuration saved in the model that is receiving the import. In this situation, it is simpler to manually browse the file
system to locate the Model Branch File (.eab) and let Enterprise Architect derive the details of the configuration from the
branch file you select.

Prerequisites

Before you begin, you must have:

An operational Version Control environment that can be accessed by Enterprise Architect, and·

All of the Version Controlled Package files and the model branch file associated with the model branch to import, in·
a valid and accessible working copy folder

Access

Context Menu Right-click on target Package for import > Package Control > Import a Model
Branch : Find a Model Branch (.EAB) file

Locate the Model Branch File

Step Action

1 Access the 'Import VC Model Branch' dialog, then browse for and select the Model Branch File that
represents the model branch to import.

2 Click on the Open button.

If the Version Control configuration referenced by the file is fully defined within the current model, the
import commences at this point.

Otherwise, Enterprise Architect displays a dialog prompting you to complete the required configuration.

3 Click 'Yes' to proceed with completing the definition of the Version Control configuration.

The 'Version Control Settings' dialog is displayed.

4 Complete the definition of the configuration.

(Typically this involves simply specifying the working copy folder.)

5 Click on the Save button.

The configuration details are saved.

The import of the model branch proceeds.
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Notes

The Import a Model Branch command is only enabled for Packages that you (the current user) are able to edit, as the·
imported model branch is inserted into the model under your selected Package
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Review Package History

It is possible to review the change history of Version Controlled Packages by examining previous revisions. If necessary,
you can check out one of these earlier revisions of a Package for editing, effectively rolling-back to that prior revision of
the Package.

Access

Context Menu Right-click on Package > Package Control > File History

Review change history of a version-controlled Package

Step Action

1 For Version Control environments using Subversion, CVS or TFS command line clients, the 'File Version
History' dialog displays.

Click on a revision number in the 'Revisions' field, to select that revision and view its log entry.

For Version Control environments using SCC based clients, your particular product opens its own 'File
Version History' dialog.

2 On the 'File Version History' dialog, you can optionally click on either:

Check Out - the selected revision of the Package file is retrieved from Version Control and imported·
into your model as a Package that is checked out for editing; you can subsequently check in this
revision as a new HEAD revision, effectively allowing you to revert the Package to a prior revision
or

Retrieve - the selected revision of the Package file is retrieved from Version Control and imported·
into your model, but the Package remains flagged as checked-in and cannot be modified;
subsequently checking out the Package updates it to the latest revision before it is unlocked for
editing

Notes

If the selected Package was already checked out in the current model, the Retrieve and Check Out buttons are·
disabled

If the selected Package contains any sub-Package that is already checked-out in the current model, a warning will be·
displayed and the retrieval or check-out will not go ahead

If you check out a prior revision of a Package, but do not want to commit it as a new revision, right-click on the·
Package and select Package Control | Undo Check Out
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Review Package History - SCC Client

It is possible to review the change history of Version Controlled Packages by examining previous revisions. If necessary,
you can check out one of these earlier revisions of a Package for editing, effectively rolling-back to that prior revision of
the Package. The process for reviewing the change history of Packages configured for Version Control with an SCC
client (including products such as Visual Source Safe, TFS-SCC, ClearCase, Perforce, AccuRev and MKS Source
Integrity) differs from that for Subversion, CVS or TFS command line clients.

Access

Context Menu Right-click on Package > Package Control > File History

Review change history of a version-controlled Package (SCC client)

Step Action

1 The change history mechanism offered by the third party SCC provider displays.

To import a prior revision of the Package into your model, use the 'SCC History' dialog to retrieve the
revision, then close the dialog.

2 The SCC client notifies Enterprise Architect that a different revision has been retrieved. A prompt then
displays, asking whether you want to check-out the prior revision.

3 Optionally, click on either:

Yes, to check out the prior revision - the selected revision of the Package file is retrieved from·
Version Control and imported into your model as a Package that is checked out for editing; you can
subsequently check in this revision as a new HEAD revision, effectively reverting the Package to the
prior revision
OR

No, to import the prior revision as read-only - the selected revision of the Package file is retrieved·
from Version Control and imported into your model, but the Package remains flagged as checked-in
and cannot be modified; subsequently checking out the Package updates it to the latest revision before
it is unlocked for editing

Notes

If the selected Package was already checked out in the current model, the system does not proceed with retrieving a·
prior revision

If you check out a prior revision of the Package, but do not want to commit it as a new revision, right-click on the·
Package and select 'Package Control | Undo Check Out'
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Retrieve Prior Revision - SCC Client

Depending on your Version Control product, retrieving a prior revision of a controlled Package can involve a number of
prompts regarding overwriting the current local copy.

This example details retrieval of a prior revision from a TFS-SCC Version Control configuration.

Access

Context Menu Right-click on Package > Package Control > File History

Example Procedure - retrieve prior revision, TFS-SCC client

Step Action

1 Display the 'TFS File History' dialog.

2 Click on the Get button.

The TFS-SCC client displays the 'Resolve Conflicts' dialog.

This dialog offers the 'Automerge All XML Package files' option. DO NOT select this option.

It is important to prevent any merging of Enterprise Architect's XML Package files.

3 Click on the Resolve button.

The TFS-SCC client displays the 'Resolve writeable file conflict' dialog.

4 Select the 'Overwrite local file/folder' option.

The existing working copy of the Package file is overwritten by the prior revision retrieved from Version
Control.

5 Click the OK button.

The TFS-SCC client redisplays the 'Resolve writeable file conflict' dialog; it should now show no
conflicts.

6 Click on the Close button.

The TFS-SCC client redisplays the 'File History' dialog.

7 Click on the Close button.

Enterprise Architect displays a prompt, asking whether to check-out the prior revision.

8 Click on the:

Yes button to check-out the prior revision·

No button to retrieve a read-only version of the Package, that is NOT checked-out and is NOT·
editable
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Validate Package Configurations

Having defined the Version Control settings for your current model, you can test the validity of those settings associated
with each Version Controlled Package within the model.

Access

Ribbon Configure > Version Control > Check Configuration

Validate Version Control settings

Step Action

1 The validation process scans the model database and verifies that the Version Control configuration
associated with each Version Controlled Package is fully specified in the current model. It also queries the
corresponding Version Control provider to find the status of the Package file associated with each Version
Controlled Package.

The results of the validation process are sent to the System Output window.

2 Open the 'Version Control Settings' dialog to complete the definition of any invalid or missing Version
Control configurations.

3 Click on an error message in the System Output window to highlight the corresponding Package in the
Browser window.

4 Right-click a Package node and select 'Package Control | Configure Package' to open the 'Package Control
Options' dialog.

Correct any problems with the Version Control details for the Package.

Correct any problems with the Package's associated XMI file.
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Resynchronize the Status of Version Controlled Packages

It is possible to update the Version Control status of Packages within your project to re-synchronize with the status
reported by your Version Control provider. This can be useful if you are creating copies of your project, where checking
in a Package from one copy of the model leaves the Package in the second copy of the model with an out-of-date Version
Control status.

For a given Package, the re-synchronization process queries the corresponding Version Control provider to find the
status of the Package file associated with the Version Controlled Package. If necessary, the process then updates the
Package flags within the model database, to synchronize the Package status recorded in the model with the value
reported by the Version Control provider.

Access

Ribbon Configure > Version Control > Re-Synch Status (applies to all Packages in model)

Context Menu Right-click on Package > Package Control > Re-synch Status With VC Provider
(applies to single Package only)

Resynchronize Version Control status

Step Action

1 The results of the re-synchronization process are sent to the System Output window.

2 Double-click on any result message to select, in the Browser window, the corresponding Package.

Notes

This process does not cause any Package data to be either exported from your model to the associated Package file,·
or imported from a Package file into your model's Package data

If a Package has been checked-out and modified with Enterprise Architect, but your Version Control provider·
reports the Package file as checked-in, running this process marks the Package within Enterprise Architect as being
checked-in, without exporting and committing the pending changes; subsequently checking-out the Package imports
the latest revision of the Package file from Version Control, effectively discarding the uncommitted modifications
from the model

Similarly, if a Package file is checked-out to you in your local working copy folder, but not in the Enterprise·
Architect model, running this process marks the Package within the model as checked-out, but it does not import the
associated Package file from the Version Control system; consequently, it is possible to check-in a Package from
Enterprise Architect that is potentially out of date, compared to the latest revision of the Package file within the
Version Control system
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Auditing

Auditing is a project-level feature that model administrators can use to record model changes in Enterprise Architect.
After switching Auditing on, you can view information on changes such as:

Who changed an element·

How many elements they changed·

When they changed the data·

What the previous values were, and·

What type of elements they changed·

Auditing does not record changes to:

Document Templates·

Model Documents·

Baselines or·

Profiles·

We provide a Quickstart procedure to help you enable Auditing and see it in action, from which point you can explore a
number of set-up options and display features.

Features

Feature Detail

The Audit View To view what has been recorded by the audit, use the Audit View, which provides
an interface to everything recorded by Auditing.

If security is enabled, you must have Audit View permission to display data in the
Audit View.

Model Views You can also obtain a snapshot of selected items in the model, using the Model
View facility.

In the Corporate, Unified or Ultimate editions of Enterprise Architect, you can use
this facility to automatically generate a snapshot at intervals and, if there are
changes in the items collected by the defined search, to trigger a notification to you
of such changes.

This helps you to monitor workflow and other events of concern to you.

Document Report You can generate a document report that includes the audit history information for
the selected element or Package, by choosing the basic + audit template.

Audit History Using Auditing, you can track changes to an element or connector over time.

However, enabling Auditing also enables an 'Audit History' tab in the System
Output window, which summarizes all changes made to the selected element or
connector.

Performance Issues By enabling Auditing on a project, you increase the time taken for most actions.

For most modeling tasks, this increase is insignificant; however, there are some
instances where the difference is more substantial.
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Notes

The Auditing facility is available in the Corporate, Unified and Ultimate editions·

Warning - If your site runs separate editions of Enterprise Architect, when Auditing is turned on in a project any·
Professional edition users are locked out of the project; to restore access, turn Auditing off in the project from the
Corporate, Unified or Ultimate edition instance of Enterprise Architect

(c) Sparx Systems 2019 Page 546 of 654 Created with Enterprise Architect



Model Repository - Model Repository 20 January, 2020

Auditing Quickstart

It is very simple to enable Auditing and see it in action.

Access

Ribbon Configure > Model > Audit : Audit Settings

Enable Auditing

Step Action

1 In the 'Audit View', click on the Audit Settings button.

The 'Audit Settings' dialog displays.

2 Select the 'Enable Auditing' checkbox.

3 Click on the OK button to close the 'Audit Settings' dialog.

4 Close the 'Audit View' dialog.

5 Change and save your project.

Add a new Package·

Add a new Class·

Add a new connector·

Change the name of an element·

Delete an element·

6 Open the Audit View again and click on the Refresh (or Load) button to display a record of the changes
you have made.
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Auditing Settings

Using the 'Audit Settings' dialog, you can change what is recorded by the Auditing facility and:

Define the areas of processing in Enterprise Architect to audit·

Administer your audit records·

Indicate the kinds of model object for which changes are to be recorded·

Configure Auditing to record changes to only certain types of element·

Access

Ribbon Configure > Model > Audit : Audit Settings

Configure Settings

Option Action

Enable Auditing Select this checkbox to turn the Auditing facility on.

Audit XMI Import Select this checkbox to record changes arising from XMI importing in the audit.

As Version Control uses XMI, you must select this option to record changes from
checking out Packages.

Audit XMI Export Select this checkbox to record changes arising from XMI exporting in the audit.

As Version Control uses XMI, you must select this option to record changes from
checking out Packages.

Audit Reverse Engineering Select this checkbox to record changes arising from reverse engineering in the
audit.

Use Database Timestamp Select this checkbox to use the database server's timestamp instead of each user's
local timestamp; this improves security.

This option is not available for project files.

Clear Logs Click on this button to permanently delete all log data from the current project; use
the Save Logs button first, to save the audit records outside the project.

The system prompts you to specify whether to clear items logged over a specific
period of time.

Click on the No button to clear all log items currently held in the database·

Click on the Yes button to display the 'Time Filter' dialog, on which you select·
a standard time period or define your own

This function can be accessed through the Automation Interface.

Save Logs Click on this button to save a copy of the logged audit items currently held in the
project. These items remain in the project; you can use the Clear Logs button to
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remove them.

The system prompts you to specify whether to save items logged over a specific
period of time.

Click on the No button to save all log items currently held in the database·

Click on the Yes button to display the 'Time Filter' dialog, on which you select·
a standard time period or define your own

This function can be accessed through the Automation Interface.

Load Logs Click on this button to load a previously saved set of logs back into the project. A
browser displays through which you select the log file to reload.

If the same record exists in both project and log file, that record is not reloaded.

Core Select this radio button to record changes to elements (including attributes and
operations), Packages, connectors and some model-level information.

Standard Select this radio button to record the same changes as for the Core option, plus
changes to some of the 'housekeeping' data for diagrams - Name, Author, Version,
Stereotype, Notes and Date Modified.

You can check for changes to diagram content and structure using the Baseline
facility for reviewing visual changes to diagrams.

Extended Select this radio button to record the same changes as for the 'Standard' option, plus
changes to project security.

Debug Select this radio button to record the same changes as for the 'Extended' option plus
changes to any database tables. Some of the auditing information will not be visible
unless the Audit View mode is set to 'Raw'.

Maintenance Select this radio button to audit changes to maintenance elements only; that is:

Package (element)·

Requirement·

Feature·

Use Case·

Actor·

Note·

Issue and·

Change·

Core Structural Select this radio button to audit changes to maintenance elements plus certain
structural elements; that is:

Package (structure)·

Class·

Interface·

Signal·

Node·

Component·

Artifact·

Part·

Port and·

(c) Sparx Systems 2019 Page 549 of 654 Created with Enterprise Architect



Model Repository - Model Repository 20 January, 2020

Device·

All Select this radio button to audit changes to all types of element.

Custom Select this radio button to audit changes to element types that you specify.

The Customize button is made available; click on this button to display a list of
element types, and select the checkbox against each element type to include in the
audit (or click on the Select All button to select every element type).

Click on the OK button to save the selection.

Notes

As the number of records increases, the performance of the Audit View reduces; it is recommended that audit·
records that are not regularly required are saved to file, then cleared from the project, to help ensure high
performance

Connectors are audited when they are connected to an element that is included in the Audit Options·

If security is enabled, you must have Audit View permission to turn Auditing on, and Audit Settings permission to·
change the audit settings
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The Audit View

The Audit View provides an interface to the information that has been recorded by auditing.

Access

Ribbon Configure > Model > Audit

Sections of the Audit View

The Audit View is divided into three main areas:

Section Description

View controls The view controls provide a variety of settings for controlling auditing and the
display of audit records.

Audit tree The audit tree displays the log items that have been recorded by auditing.

What is displayed in the tree is affected by the view controls, such as:

Sorting·

Filter (by time)·

Mode·

Auditing settings (what was actually recorded)·

If synchronizing with the Browser window, it is also affected by the Package,
diagram or element you have selected.

In the audit tree:

The green tick indicates a creation·

The yellow pencil indicates an edit·

The red cross indicates a deletion·

Right-clicking an element in the audit tree (such as MyClass) displays a context
menu that enables you to locate the selected element in:

The Browser window·

Any diagrams in which it exists·

Record display The record display is in two parts: the identity of the selected change, and the actual
change made.

The data in the record display is determined by the view controls and mode and, if
synchronizing with the Browser window, by the Package, diagram or element you
have selected.
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Identity

The identity of a change consists of:

The Windows username of the user that made the change; if security is·
enabled, the name is of the format WindowsUsername(SecurityUser)

When the change was made·

The path of the change; for example: Class Class1 - Attribute Att1 - Attribute·
Constraint Constraint

Changes

Changes are displayed in a table format, showing the:

Property (or data item) name·

Its original value before the change and·

Its value after the change·

If you double-click on an item in the list of changes (or right-click and select the
'Show Differences' option) the Difference window displays:

This shows the specific changes that have been made, highlighting the edited,
created, deleted or formatted characters.

Changes to the format of text in the element, made through the element 'Properties'
dialog, are not apparent in the initial table; they are visible in the Difference
window, identified by HTML formatting tags.

Notes

If security is enabled, you must have Audit View permission to display data in the Audit View·
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Audit View Controls

The Audit View controls provide a variety of settings for controlling auditing and the display of audit records.

Options

Option Action

Load or Refresh Click to reload the Audit Tree, updated with any new audit results.

Search Click to search through log items for a particular area - you can search by Name,
Type or GUID.

The items are loaded and filtered with the current Sort By, Time Filter and Mode
settings.

If you refresh the Audit View, you must run the search again.

Audit Settings Click to open the 'Audit Settings' dialog.

Sort-by Select the appropriate radio button for the required display setting:

Type - changes are grouped under element type (such as Class or·
Requirement), and then grouped under the changed element

User - changes are grouped under user name, each with the number of changes·
for that user

Under each user name, changes are grouped as for the Type sort

Filter By Date/Time Select to enable the Filter Settings button, to filter the audit results by time period.

Changes that occur outside the selected filter period are not shown in the Audit
View.

Filter Settings Click to display the 'Time Filter' dialog, to set the filter time period:

Today - to display changes occurring today·

Previous Hour - to display changes occurring in the last 60 minutes·

Previous 24 Hours - to display changes occurring in the last 24 hours·

Previous Week - to display changes occurring in the last 7 days·

Previous 30 Days - to display changes occurring in the last 30 days·

Previous Year - to display changes occurring in the last 365 days·
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Custom - to define your own time period, using the From and To fields·

The six pre-configured time periods automatically update when you click on the
Refresh button; custom periods are static and do not automatically update.

If you have set a filter period, and you deselect the 'Filter By Date/Time' checkbox,
the period remains set; the custom time period, too, is retained so that you can
re-use it or modify it later if required.

Status Text Read to see which:

Mode has been selected and·

Time filter is being applied to the data·

Mode Click to display a menu of options to change the mode of the Audit View.

Select:

'Standard' - to automatically synchronize with the Browser window; where·
changes have been made, the Audit View reflects your selection from the
Browser window - if you click on:
     -  An element, the Audit View displays the history for that element
     -  A Package, the Audit View displays the history for that Package
        and its immediate children (but not the contents of nested Packages)
     -  A diagram, the Audit View displays the history for that diagram and
        its contents (which could be drawn from a wide area of the Project
        Browser)

'Advanced' - to load large sets of log items independent of the Browser·
window; in this mode, a special Audit Settings group can be displayed in the
Audit Tree, which records:
     -  When Auditing has been enabled and disabled
     -  Who made the change
     -  The date and time of the change
     -  Changes to the Audit Settings
     -  When Audit Operations are executed
     -  Security changes (which can be browsed in the same way as
        other changes)

'Deleted' - to display only deleted records, but otherwise data is shown as in·
'Advanced' mode; records can be sorted by element type or by user as required

'Raw' - to display all audit records in chronological order without sorting,·
enabling you to see a progression of changes; this can be especially useful in
determining date-time inconsistencies
Any search and filtering you define still apply, enabling you to view all of
today’s changes in order, or all changes for a particular element in order, or
both
Additional database information is displayed; this additional information might
be insignificant or only in machine-readable format
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Audit History Tab

When Auditing is turned on, an 'Audit History' tab is enabled in the System Output window. The tab shows a history of
changes to whichever element or connector you have selected in the:

Current diagram·

Browser window·

Audit View, or·

Package Browser·

As you select different elements or connectors, the 'Audit History' tab automatically updates to reflect your current
selection. For each change made to the element or connector, the tab shows:

Who made the change·

When the change was made·

Where the change was made·

The value of the characteristic before the change·

The value of the characteristic after the change·

Access

Ribbon Start > Desktop > Design > System Output > Audit History

Notes

To see this tab, you must have the Audit View open; the tab continues to display if you subsequently close the Audit·
View

If security is enabled, you must have Audit View permission to display data on the 'Audit History' tab·
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Auditing Performance Issues

Enabling auditing on a project increases the time taken for most actions.

For most modeling tasks, this increase is insignificant; however, there are some situations where the difference is more
substantial.

Operation Delays

Operation Detail

Large Deletions Deleting large Packages or Package structures, or large numbers of elements, takes
significantly longer with auditing on.

You might disable auditing before performing such a deletion.

XMI Imports Importing XMI takes longer with auditing enabled.

A project-level option is provided for disabling auditing of XMI Imports.

Reverse Engineering Reverse engineering code takes longer with auditing enabled.

A project-level option is provided for disabling auditing of reverse engineering.

Replication You cannot remove replication from a model with Auditing enabled.

If you have to remove replication, disable Auditing and - if prompted to do so -
allow Enterprise Architect to roll back the database version; you can then remove
replication.
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Audit View Performance Issues

The Audit View can cause slow performance, generally because of the volume of records it has to process.

Considerations and Responses

Consideration Detail

Navigating the Browser
window Within Auditing is
Slow

Try setting the time filter to a period in the immediate past, such as 'Today',
'Previous 24 Hours' or 'Previous Week'; this time period updates each time you
open or refresh the Audit View.

Save log items outside the project with the Save Logs button; if you then clear the
logs you have just saved, the load time of the Audit View is reduced.

You can reload logs into the project at any time, using the Load Logs button.

The Audit View is Slow in
Loading and Changing
Modes

Try setting the time filter to a period in the immediate past, such as 'Today',
'Previous 24 Hours' or 'Previous Week'; this time period updates each time you
open or refresh the Audit View.

Save log items outside the project with the Save Logs button; if you then clear the
logs you have just saved, the load time of the Audit View is reduced.

You can reload logs into the project at any time, using the Load Logs button.

Navigating the Audit Tree
is Slow

Close the 'Audit History' tab in the System Output window
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Package Baselines

Enterprise Architect includes tools to help you manage and review changes to your models over time. These tools apply
the concepts of Baselines, Differencing and Merges.

You use Baselines, Differencing and Merges essentially to compare two snapshots of a specific part of your project, to
capture the differences between them and either roll back or incorporate selected changes or all changes.

Baselines

Enterprise Architect provides a facility to create a Baseline or 'snapshot' of the contents of a selected Package and its
child Packages at a particular point in time; this enables you to later compare that branch of the model at that time with
the current state of the branch.

Baselines are stored in the same XML format as is used for Version Control, but are stored in compressed format either
within the project or in a Reusable Asset Service Registry.

You can also have parallel copies of parts of your model for team development, and create Baselines within each copy to
merge changes into the project master.

Differencing

Differencing (Diff, or Compare) helps you to explore the differences between:

The current state of a specific part of your project, and·

Previous or parallel versions captured in a Baseline or an XMI 1.1 file held in the file management system·

Merges

Once Differencing is complete, you can merge information from the Baseline into the current project; it is not possible to
go the other way.

You can:

Merge information manually, change by change·

Merge information automatically by electing to merge in all changes in one batch procedure·

Revert completely to the original Baseline by importing the stored XMI directly·

Merge information and elements from a Baseline in a different project, making it possible to keep multiple versions·
of a single model in synch

The merge options are available through the toolbar, context menus and the keyboard on the 'Compare Utility' view,
which shows the results of a comparison.

Visual differences in diagrams

Changes to a model might include:

Adding or removing elements and connectors on a diagram, or·

Changing the position of elements or the overall layout of a diagram·

You might believe that a diagram has changed, and select to compare it with a baseline using a ribbon option.
Alternatively, you might perform a baseline comparison on a Package or a model and select from the comparison output
any diagrams that are flagged as changed.
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Notes

Package Baseline facilities are available in the Corporate, Unified and Ultimate editions of Enterprise Architect·

The Enterprise Architect Corporate, Unified and Ultimate editions provide another facility, Auditing, which you can·
switch on to perform continuous monitoring of changes across the project; you can dovetail your use of each facility
to meet the range of your change management requirements

If a Package under Version Control forms part of a Baseline, and that Package is checked in to the model, you·
cannot merge the original data from the Baseline into that Package

You can also obtain a snapshot of selected items in the model, using the Model Views facility; this facility enables·
you to automatically generate the snapshot at intervals and, if there are changes in the items collected by the defined
search, to trigger a notification to you of such changes, which enables you to monitor workflow and other events of
concern to you

If security is enabled you must have 'Baselines - Manage' permission to create, import and delete Baselines, and·
'Baselines - Restore' permission to merge data from a Baseline; security permissions are not required to select an
existing Baseline and perform a comparison with the model
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Baselines

Enterprise Architect provides a facility to 'Baseline' (snapshot) a model branch at a particular point in time for later
comparison with the current Package state.

Baselines

Baseline comparison is most useful for determining the changes made to the model during development compared to a
Baseline saved at a crucial point - for example the completion of a phase or version iteration.

More than one Baseline can be stored against a single Enterprise Architect Package.

Baselines are particularly useful during Requirements Management to check for changes, additions and deletions that
have occurred since the start of the current work phase; knowing how a model has changed is an important part of
managing change and the overall development process.

By default, Baselines are stored within the model in compressed XML format; you can save a Baseline to an external
XML file for storage or archive, or for distributing to other users working on models derived from a master project.

Alternatively, you can store Baselines in a Reusable Asset Service Registry. To do this, open the 'Baseline' page in the
'Manage Project Options' dialog to configure the Cloud connection to the Registry and select or create the Storage that
stores the Baselines for all the Packages in the model.

Baselines are generally used in conjunction with the Compare utility.

Scenario

A typical scenario for using Baselines would be:

Create the base model branch to a sufficient point to create a Baseline (checkpoint); create and store the Baseline as·
Version 0.1a

As work continues on development, managers and developers can check the current model branch against the·
Baseline for important modifications, additions and deletions; the Compare utility can be invoked from the 'Baseline'
dialog or 'Reusable Asset Service - Baseline' view to check the current model branch against the stored version

As required, minor Baselines can be created to check recent progress; these 'temporary Baselines' are useful for·
managing change when a lot of work is being done and it is important to only see what has changed in, for example,
the last 24 hours

At sign-off or the move to a new version/phase, a major Baseline can be created to capture the new state of the model.

Minor Baselines created earlier can be deleted if required to save space.

Considerations

Baselines are based on the GUID or unique ID of a particular Package:

Enterprise Architect checks for that ID as the root element within the XML document being used as a Baseline·

When you export a Package to XML, the Package you export is the root element; likewise when you create a·
Baseline, the current Package is the root Package of the XML Baseline

When you save information in a Version Control system, the current Version Controlled Package is again the root·
Package of the document

It is not useful to create a Baseline by importing an XMI Package file created by Version Controlling a Package that·
itself contains Version Controlled child Packages; that type of XMI Package file contains stubs for the child
Packages, not full information on the child Packages and elements

If a Package under Version Control forms part of a Baseline, and that Package is checked in to the model, you·
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cannot merge the original data from the Baseline into that Package

XML files must be in the same format used by the Baseline engine - currently the UML 1.3 XMI 1.1 format (plus
Enterprise Architect extensions), which contains all the information necessary to reconstruct a UML model, even a UML
2.x model

Notes

The Baseline facility is available in the Corporate, Unified and Ultimate editions of Enterprise Architect·

The Compare utility is available in the Professional edition of Enterprise Architect, as well as in the Corporate and·
extended editions
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Manage Baselines in Model

Enterprise Architect provides a range of facilities for working with and managing Baselines stored in the model.

Access

Ribbon Design > Model > Manage > Manage Baselines

Keyboard Shortcuts Ctrl+Alt+B

Baseline Management

Create, select and process Baselines using the 'Package Baselines' dialog.

Option Action

Current Baselines For
Package: <Name>

Review the Baselines for the current model branch, listed by version reference with
the highest alphabetical/numerical value at the top.

If an entry is longer than the display area, a horizontal scroll bar displays at the
bottom of the panel; use this to scroll to the text that is not shown.

Show Differences Run the Compare utility on the selected Baseline and the current model branch or
diagram, to display the differences between the two.

Restore to Baseline Completely restore the model branch from the selected Baseline.

New Baseline Create a new Baseline.

Delete Selected Delete the selected Baseline.

Load Other Baselines Display a drop-down menu that enables you to load Baselines from another model,
in either a project file or a DBMS repository.

For project files, a browser displays; locate the required project file·

For DBMS repositories, the Windows 'Data Link Properties' dialog displays;·
select the data provider and click on the OK button to display the 'Select Data
Source' dialog, from which you select the required project

In either case, the Connected To: message at the bottom of the 'Package Baselines'
dialog changes to the name of the alternative model.

To return the dialog to the original project, select the third option on the drop down
list: 'Load From Selected Package'.

Import File Import an XML 1.1 file from the file system as a new Baseline for this current
model branch.

Export File Export the selected Baseline to an XML file.

Compare Model to File Compare the selected model branch with an XML 1.1 file in the file management
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system; a browser displays, which you use to locate the file.

Options Set filters to make the comparison more specific.

Notes

Package Baseline facilities are available in the Corporate, Unified and Ultimate editions of Enterprise Architect·
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Manage Baselines in Reusable Asset Service Registry

Baselines are by default stored in the repository, so when you create a Baseline of a Requirements Package at a given
milestone, for example, the 'snapshot' would by default be stored in the same model as the Requirements. This is
expedient and sufficient for small, isolated project teams, but for larger teams and endeavors Enterprise Architect
provides some powerful mechanisms to store the Baselines as reusable and universally accessible snapshots available to
any project or organizational team, anywhere in the world.  This is particularly useful in this age of innovation and
agility, where geographically independent teams need to share information and reuse existing assets at Internet speed.
The facility uses the Reusable Asset Server (RAS), which is Cloud-based (including on the home premises) and provides
sophisticated mechanisms to manage these valuable corporate assets.

All of the original Baseline features are still available, with many additional features added while making the snapshots
available to a much wider audience, including other teams and departments, customers, partners, consultants, testers and
more, all protected by robust industry standard security. Baselines stored in the RAS are more transparent and
searchable, making it easier to understand and work with the content they contain.

Enterprise Architect provides a range of facilities for working with and managing Baselines stored in a Reusable Asset
Service Registry, using the 'Reusable Asset Service - Baseline' view. When you open this view, the 'Baseline Browser'
tab immediately displays a list of the Baselines available for the Package that is currently selected in the Browser
window. You can review and use these Baselines using the context menu and buttons on the tab.

You can review the contents of the selected Baseline using the tabs in the lower half of the 'Reusable Asset Service -
Baseline' view, underneath the 'Baseline Browser' tab.

If you have left the 'Baseline Browser' open for a while, there is a possibility that the contents of the Storage in Registry

might have changed. Click on the  icon in the 'Reusable Asset Service - Baseline' toolbar to refresh the Browser with
the latest contents of the Storage.
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Note: To store Baselines in a Reusable Asset Service Registry, select the 'Baseline' page in the 'Manage Project Options'
dialog and configure the Cloud connection to the Registry, then select or create the Storage in which to store all the
Baselines for the Packages in the model.

Access

Ribbon Design > Model > Manage > Manage Baselines

Keyboard Shortcuts Ctrl+Alt+B

Baseline Management

Create, select and process Baselines using the 'Reusable Asset Service - Baseline' view.

Option Action

Registry Displays the Registry name, as specified on the 'Baseline' page of the 'Manage
Project Options' dialog.

Storage Displays the Storage name, as defined on the 'Baseline' page of the 'Manage Project
Options' dialog.

Package Displays the name of the Package currently selected in the Browser window.

Find Other Packages Click on this button to open the 'Reusable Asset Services' view, displaying the
Storage and its full contents; that is, all Packages with Baselines, and any other
Packages held in the Storage.

Baseline Browser Lists the Baselines, if any, for the current Package. The Baselines are listed by
version - with the highest alphabetical or numerical value at the top.

When you select a Baseline in the Browser, details of the Baseline are displayed in
the tabs beneath the 'Baseline Browser' tab.

Note: You can right-click on the column headings and select the 'Toggle Filter Bar'
option to show or hide the Filter Bar on the display. If you show the Filter Bar, type
in the appropriate characters to list only those Baselines that have that string of
characters in the value in the corresponding column.

New Click on this button to create a new Baseline.

Note: You can also click on the  icon in the 'Reusable Asset Service - Baseline'
toolbar to create a new Baseline.

Compare Click on this button to run the Compare utility on the selected Baseline and the
current Package, to display any differences between the two. The results of the
comparison are displayed on the 'Comparison Utility' view.

Note:

You can also run the Compare utility by:

Clicking on the  icon in the 'Reusable Asset Service - Baseline' toolbar or·
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Right-clicking on the Baseline name and selecting the 'Compare' context menu·
option

Restore Click on this button to completely restore the Package in the model from the
selected Baseline.

Note:

You can also restore the Package from the selected Baseline by:

Clicking on the  icon in the 'Reusable Asset Service - Baseline' toolbar·

Right-clicking on the Baseline name and selecting the 'Restore' context menu·
option

Run Compare after Restore Check this option to automatically run the Compare utility once the Package is
completely restored from the selected Baseline.

Notes

The Package Baseline facilities are available in the Corporate, Unified and Ultimate editions of Enterprise Architect·

Reusable Asset Service Registry details must be configured in the 'Baseline' page of the 'Manage Project Options'·
dialog

If a 'Read-Only Access' password is entered for the Storage in the 'Baseline' page of the 'Manage Project Options'·
dialog, you will not be able to create new Baselines in the 'Reusable Asset Service - Baseline' view as the 'New'
button will be disabled

If security is enabled, you must have 'Baselines - Restore model' permission to restore a Package from the selected·
Baseline
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Baseline Contents

In the 'Reusable Asset Service - Baseline' view, when you select a Baseline in the 'Baseline Browser' tab, the three tabs
in the lower half of the view are updated with information on the Baseline. The 'Contents' tab lists the diagrams and
elements (including any child Packages) held in the selected Baseline, listing the two types of object separately. You can
organize the information within a column into alphabetical or reverse-alphabetical order for ease of reference, and use
the Filter bar to filter the display to show only items with values containing specific characters or digits.

Access

Open the 'Reusable Asset Service - Baseline' view using one of the methods outlined here.

Select a Baseline in the 'Baseline Browser' tab, then click on the 'Contents' tab to display the contents of that Baseline.

Ribbon Design > Model > Manage > Manage Baselines

Keyboard Shortcuts Ctrl+Alt+B

Review Baseline Contents

Option Detail

Content Type Click on this button to toggle between listing the Baseline diagrams first and listing
the Baseline elements first.

Toggle Filter Bar Right-click on the column headings and select this option to show or hide the Filter
Bar on the display.

<filter bar fields> Type in the appropriate characters to list only elements and diagrams that have that
string of characters in the values in the corresponding column.

Content Type: Diagram

Content Type: Element

These are the headers for the two types of object listed in this tab.

Click on the appropriate white or black arrow head to hide or show the list of
diagrams or elements under the heading.

Name Displays the name of the element or diagram available in the Baseline.

Type Displays the type of the element or diagram, such as Use Case or Use Case
diagram.

GUID Displays the Global Unique Identifier of the element or diagram.

Content Type Displays the object type of the item - Element or Diagram.

Find in Project Browser Right-click on an element or diagram line and select this option to see if the
element or diagram also exists in your model and, if it does, to highlight it in the
Browser window.

Right-click on a diagram name and select this option to display the diagram within
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View Diagram a labeled frame, as an image.

Alternatively, double-click on the diagram name.
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Baseline Dependencies

When you select a Baseline on the 'Baseline Browser' tab, the three tabs in the lower half of the 'Reusable Asset Service -
Baseline' view are updated with information from the Baseline. A Package might contain elements and diagrams that
have relationships with objects in other Packages. When you generate a Baseline for that Package,  the name and Global
Unique Identifier (GUID) of each Package containing these 'external' objects will be stored along with the Baseline and
displayed in the 'Dependency' tab.

Note that Package A depends on Package B if any of these constructs (or their Tagged Values) in Package A reference
elements in Package B:

Elements·

Attributes·

Operations·

Operation Parameters·

Diagrams·

Connectors·

Access

Open the 'Reusable Asset Service - Baseline' view using one of the methods outlined here.

Select a Baseline on the 'Baseline Browser' tab, then click on the 'Dependency' tab to display a list of dependencies for
that Baseline.

Ribbon Design > Model > Manage > Manage Baselines

Keyboard Shortcuts Ctrl+Alt+B

Check Baseline Dependencies

Option Detail

Package Displays the name of the related Package.

GUID Displays the Global Unique Identifier of the related Package.

Find in Registry Right-click on the 'Package' line and select this option to see if the Package exists in
the Registry.

Selecting this option will :

Open the 'Reusable Asset Service' view·

Connect to the Registry and load the Storage that is currently selected in the·
'Reusable Asset Service - Baseline' view

Open the 'Search Registry' dialog·

Search for the selected Package using its GUID and display the results of the·
search, if any

Find in Project Browser Right-click on the 'Package' line and select this option to see if the Package also
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exists in your model and, if it does, to highlight it in the Browser window.

Copy Package Name to
Clipboard

Right-click on the 'Package' line and select this option to copy the Package name to
the clipboard.

Copy Package GUID to
Clipboard

Right-click on the 'Package' line and select this option to copy the Package GUID
to the clipboard.

Notes

The Name and Global Unique Identifier (GUID) of a Package containing 'external' objects will not be stored with·
the Baselines if the option 'Check Package dependency when creating Baseline' is disabled on the 'Baseline' page of
the 'Manage Project Options' dialog
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Add Review Comments

When you select a Baseline on the 'Baseline Browser' tab, the three tabs in the lower half of the 'Reusable Asset Service -
Baseline' view are updated with information from the Baseline. For any Baseline, you can add individual review
comments on any aspect of the Baseline. These comments provide a permanent record on the Baseline - once they have
been saved they cannot be edited or deleted.  Each comment is attributed to the ID of the user who entered it, and is date
stamped.

Access

Open the 'Reusable Asset Service - Baseline' view using one of the methods outlined here.

Select a Baseline on the 'Baseline Browser' tab, then click on the 'Review' tab to display the review comments of that
Baseline.

Ribbon Design > Model > Manage > Manage Baselines

Keyboard Shortcuts Ctrl+Alt+B

Actions

Action Detail

Review Existing
Comments

If there appears to be a longer comment than can be shown in the 'Review' tab, click
on it. The full text displays in the 'Comments' field in the lower panel.

Create Comments Click on the New button and start typing your comment on the Package in the
'Comments' field. You can delete and edit text as you type.

When you have finished writing your comment, click on the Save button. Your
comment, preceded by your user ID and the current date, is displayed in the
'Review' panel.

Once you have saved your comment, you cannot edit or delete it.
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Create Baselines

This topic details the basics of creating new Baselines of model Packages. You can create Baselines in the model (using
the 'Baselines' dialog) or in a Reusable Asset Service Registry (using the 'Reusable Asset Service - Baseline' view). The
appropriate screen displays by default according to whether the 'Store Package Baselines in a Reusable Asset Service
Registry' checkbox is selected on the 'Baselines' page of the 'Manage Project Options' dialog.

Access

Select a Package in the Browser window, then open the appropriate screen for the storage system using one of the
methods outlined here.

Ribbon Design > Model > Manage > Manage Baselines : 'Baselines' dialog : New Baseline
(or)

Design > Model > Manage > Manage Baselines : 'Reusable Asset Service -
Baseline' view : New

Keyboard Shortcuts Ctrl+Alt+B : 'Baselines' dialog > New Baseline (or)

Ctrl+Alt+B : 'Reusable Asset Service - Baseline' view : New

Create a new baseline

Field Action

Name Display the Package name of the currently selected model branch.

Version Type a unique version reference for this Baseline, which can consist of any
alphanumeric characters.

The 'Package Baselines' dialog sorts the Baselines according to the value of this
field.

Include sub-packages Include the entire sub-Package hierarchy of this branch in the Baseline; this option
defaults to selected.

If you deselect the checkbox, only the immediate contents (XMI stubs) of the
Package are included in the Baseline.

Note Edit the default current time and date to any other value.

The field is a single-line entry, for display on the 'Package Baselines' dialog (a
one-line-per-entry list).

OK Click to create a new Baseline and return to the 'Package Baselines' dialog.

Notes

Package Baseline facilities are available in the Corporate, Unified and Ultimate editions of Enterprise Architect·
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The Compare Utility (Diff)

Enterprise Architect has a comprehensive and powerful built-in Compare (diff) utility, which enables you to:

Explore what has changed within a model over time·

Explore how previous versions of a model branch differ from what is currently in the model·

Perform a full model comparison by exporting all of Model A to XMI, then using 'Compare Model to File' from·
within the current model (Model B)

Comparing and checking model development at various points in the process is an important aspect of managing change
and development, monitoring what is being modified and ensuring the development and design process is on track.

Using the Compare Utility you can:

Compare a model branch in Enterprise Architect with a Baseline created using the Baseline functionality (Corporate,·
Unified and Ultimate editions)

Compare a model branch in Enterprise Architect with a  Baseline stored in a different model·

Compare a model branch in Enterprise Architect with an XML 1.1 file created previously using the Enterprise·
Architect XML export facility (user selects file)

Compare a model branch in Enterprise Architect with the current version-controlled XMI 1.1 file as created when·
using Version Control in Enterprise Architect (file automatically selected)

Access

Select a Package in the Browser window, then open the 'Baselines' dialog or 'Reusable Asset Service - Baseline' view
(depending on whether Baselines are stored in model or in a Registry) using one of the methods outlined here.

Ribbon Publish > Model Exchange > Package Control > Compare Package to XMI

Design > Model > Manage > Manage Baselines : Show Differences ('Baselines'
dialog)

Design > Model > Manage > Manage Baselines : Compare ('Reusable Asset
Service - Baseline' view)

Keyboard Shortcuts Ctrl+Alt+B : Show Differences ('Baselines' dialog)

Ctrl+Alt+B  : Compare ('Reusable Asset Service - Baseline' view)

Differencing With Baselines

As a Baseline contains all information about elements and connections for a Package at a point in time, it can be used
within Enterprise Architect to track changes to model elements over time.

The Differencing engine first builds a representation of the current Package in memory, based on what is currently in the
model.

It then compares this with the stored Baseline, highlighting changes, new elements, missing elements and elements that
have been moved to other Packages.

It is possible to filter the resultant output to display only one particular kind of change: for example, additions to the
model.

If a Baseline has been created to ignore child Package content, a comparison between that Baseline and the model does
not include any child Package content in the model.

See the example provided in the Example Comparison Help topic.
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Notes

This utility is available in the Professional, Corporate, Unified and Ultimate editions of Enterprise Architect·

You cannot compare the current model with an XMI 2.1 file; the utility can only compare with an XMI 1.1 file·
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Compare Options

You use the 'Baseline Compare Options' dialog to refine the output of the Compare utility when it compares the current
model with a Baseline.

To display the dialog, either:

Click on the Options button on the 'Package Baselines' dialog, or·

Click on the 'Compare Options' icon in the 'Compare Utility' view toolbar·

If the 'Compare Utility' view shows the results of a Baseline comparison, when you click on the OK button the display
refreshes to refine the information according to the options you have selected.

Options

Option Action

Always Expand to
Differences

Always display the list of elements fully expanded to show changes.

If you deselect the checkbox, when the 'Compare Utility' view is first opened it lists
the Package contents to element level, and you expand each element as required to
show the changed items.

For large branches of the model, it is better to leave the checkbox unselected.

Show Elements that are List elements that:

Have been changed since the Baseline was created·

Are in the Baseline only (that is, have been deleted from the model since the·
Baseline was created)

Are in the model only (that is, have been created since the Baseline was·
created)

Have not changed since the Baseline was created (you might generally leave·
this checkbox unselected)

Suppress these Changes Exclude:

Changes to diagrams·

Changes to the 'Date Modified' field for an item·

Changes to the 'Date Created' field for an item·

Child items of a deleted item·

Changes to advanced properties (defaults to selected)·

Baseline Diagram Compare
Option

Select the checkbox to always open the first parent Package for which there is a
Baseline, when you select the diagram for comparison from the Browser window.

Notes

Package Baseline facilities are available in the Corporate, Unified and Ultimate editions of Enterprise Architect·
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Example Comparison

This diagram shows the result of a comparison between a Package (Log in/out Use Cases) in the current project and that
Package in a Baseline captured at an earlier date.

The results of the comparison are displayed on the 'Comparison Utility' view.

Review Changes

Aspect Description

Interpretation A hierarchy of model elements is displayed in the left-hand pane.

From the triangle-based icons and the highlighted lines on the report, it is clearly
visible which items in the hierarchy have, since the Baseline was captured, been:

Changed·

Deleted from the model (in the Baseline only)·

Added to the model (in the Model only) or·

Switched to different Packages (changes in the Parent Package property)·

If you click on an item in the left hand pane, the right-hand pane displays a table of
properties showing the values of those properties in the current model and in the
Baseline.

For each property where there is a difference between the model and the Baseline,
the row is highlighted.

The 'Compare Utility' view enables you to perform operations (such as merging or
rolling back changes) on the reported information, using the toolbar, context menu
and keyboard.

Increase Level of Detail The right panel of the 'Compare Utility' view might, for some fields, display only
part of the value.

It might also not be immediately obvious what a change is.

In either case, you can double-click on the property to display full details and to
highlight the exact differences; this example shows the highlighted changes to the
'Name' property.
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Notes

The Compare utility is available in the Professional, Corporate, Unified and Ultimate editions of Enterprise·
Architect
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Compare Utility View Options

The 'Comparison Utility' view enables you to perform operations on the reported information, using the toolbar, context
menu, 'Merge' dialog and certain keyboard keys.

The toolbar is at the top of the left-hand panel; the icons operate either on the comparison as a whole or on the·
currently-selected item in the left hand panel of the 'Comparison Utility' view

Each item in the hierarchy has a context menu, which you display by right-clicking on the item; the options·
displayed depend on the level of the item in the hierarchy

The 'Merge' dialog enables you to specify which changes to roll back in the model from the baseline·

You can use a selection of keyboard keys to move up and down the hierarchy, or to roll back changes·

Toolbar Options

Option Action

Refresh Re-run the comparison to refresh the current display.

Merge To Model Merge the values of the currently-selected item in the Baseline back into the model.

Next Change Highlight the next changed item (this skips Moved items).

Previous Change Highlight the previously-changed item.

Expand All Fully expand the selected item.

Collapse All Collapse the changed items in the selected item.

Expand To Changed Items Expand the selected item to show changed items only (in the event that you have
selected to also show unchanged items in the comparison).

Find in Project Browser Highlight the item in the Browser window.

Log To XML Log the changes to an XML file.

A browser displays, on which you specify the file name and location.

Compare Options Display the 'Baseline Compare Options' dialog.

Manage Package Baselines Re-display the 'Package Baselines' dialog or 'Reusable Asset Service - Baseline'
view, as appropriate.

Help Display the Help topic Package Baselines.

Context Menu Options
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Option Action

Merge from Baseline

Add from Baseline

Restore the item in the model to the Baseline state, or restore a deleted item from
the Baseline.

Delete from Model Remove a recently-created item from the model.

Merge From Baseline (with
Options)

(For the root node of the hierarchy on the 'Compare Utility' view.)

Display the 'Merge' dialog, which you can use to specify options for rolling back
the whole model branch to the Baseline state.

Refresh (Object-level items.)

Re-run the comparison to refresh the current display.

Find in Project Browser Locate and highlight the item in the Browser window.

Open Baseline Diagram
Compare

(For a diagram listed in the comparison.)

Display the Baseline Diagram Compare window, showing differences in diagram
content and layout.

Expand All Fully expand the selected item.

Expand To Changed Items Expand the selected item to show changed items only.

Collapse All Collapse the changed items in the selected item.

Log To XML Log the changes to an XML file.

A browser displays, on which you specify the file name and location.

Baseline Compare Options Display the 'Baseline Compare Options' dialog.

Merge Dialog Options

Option Action

Changed Restore all changed items in the model branch to the Baseline state.

In Baseline Only Restore all deleted items to the model branch from the Baseline.

In Model Only Remove all recently-created items from the model branch.

Moved Restore all moved items to their original locations, as identified in the Baseline.

Full Restore from XMI Completely restore the model branch to the version held in the Baseline XMI 1.1
file, (using the 'XMI Import' function).

(This option automatically selects all the other options)
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Keyboard Keys

Ctrl+ ↓ - expand and highlight the next changed item·

Ctrl+ ↑ - expand and highlight the previous changed item·

Ctrl+ ← - undo the changes for a selected item (roll back to the Baseline values)·
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Check Visual Changes to Diagrams

The Baseline Diagram Compare feature is a quick and easy way to visually compare a current diagram with an earlier
version from a saved Baseline, and highlight any elements in the diagram that have been added, deleted, resized or
moved.

You can then review these changes and optionally roll back individual changes if needed to their previous state from the
Baseline.

The changes are identified on the 'Baseline Diagram Compare' dialog and on the diagram itself.

Access

Select the diagram to be checked, then apply one of these access methods:

Ribbon Layout > Diagram > Options > Compare to Baseline (on an open diagram)

Design > Diagram > Manage > Compare to Baseline (on an open diagram)

Other Perform a comparison of a Package and Baseline (see the The Compare Utility1.
(Diff) Help topic).

Locate the diagram in the results on the 'Baseline Comparison' view.2.

Right-click on the diagram name and select the 'Compare to Baseline' option to3.
display the 'Baseline Diagram Compare' dialog and to open the diagram (refer
to the Results section).

Multiple Owner Packages

When you create a Baseline, it can be for a Package that contains one or more levels of child Package, and you might
create Baselines for the Package(s) at each level. If the diagram you are checking is at a lower level in the hierarchy,
there might therefore be a number of Baselines that contain information on the diagram, perhaps taken at different times
and capturing different changes to the diagram.

When you open the diagram before performing the check, and select one of the direct ribbon access paths, if the diagram
is referenced in multiple Baselines you might be required to select the Package from which to use a Baseline, on the
'Load Baselines from Package' dialog.

(c) Sparx Systems 2019 Page 582 of 654 Created with Enterprise Architect



Model Repository - Model Repository 20 January, 2020

The 'Load Baselines from Package' dialog provides the facility to compare the diagram with one of a broader range of
Baselines than just those from the diagram's immediate parent.

This dialog displays if you have NOT selected the 'Always open first parent with a Baseline' checkbox on either:

The 'Load Baselines from Package' dialog itself or·

The 'Baseline Compare Options' dialog·

Selecting or deselecting the option in one location also selects or deselects it in the other.

Click on the required Package, and click on the OK button. In this case, or if the dialog did not display at all (the
checkboxes were selected), the 'Baselines dialog displays.

Processing

Click on the required Baseline and on the Show Differences button. The 'Baseline Diagram Compare' dialog displays.
Refer to the Results section and the Options table.

Results

The 'Baseline Diagram Compare' dialog shows the elements that have been changed on the diagram, and what kind of
change was made (examine the 'Status' field).
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As you select elements on the dialog, images are shown on the diagram itself to indicate where the changed element was
and what kind of change it underwent.

Options

Option Detail

Select (click on) name of
element

The 'Status' column indicates whether the element has been:

Moved or re-sized (Changed)·

Deleted from the diagram (Baseline only)·

Added to the diagram since the Baseline was captured (Model only), or·

Deleted from its parent external Package, and there is no record in the current·
Baseline (because the Baseline is only for the current diagram's parent
Package)
This diagram-linked element has been deleted from the model. The element
might be found in a different baseline either in a parent Package baseline or a
different Package baseline outside of the current Package. If the external
referenced element is restored to the model, the visual comparison will be able
to resolve the missing diagram object in the current baseline.

When an item is selected, the corresponding element on the diagram is highlighted
as shown:

Deleted from the diagram·

Added to the diagram·

Resized or moved to a new position·

(c) Sparx Systems 2019 Page 584 of 654 Created with Enterprise Architect



Model Repository - Model Repository 20 January, 2020

A deleted external element on the diagram·

The highlighted element on the diagram is marked with a colored dot, as shown, to
indicate that it is in focus.

Position the diagram to
show the selected element

To scroll the diagram so that you can see the original (Baseline) position of an
element, double-click on the item in the list.

To scroll the diagram so that you can see the current (model) position of the
element, press and hold Ctrl while you double-click on the item.

Leave the changes in the
item as they are

Ensure that the checkbox against the item is not selected.

Click on the OK button.

Roll the changes back to
the Baseline position

Click on the checkbox against each required item (or click on the Check All button
to select every item).

The 'Action' column displays the action required to roll each element's relationship
to the diagram back to the Baseline relationship, and on the diagram the selected
elements are represented as shown:

This deleted element will be restored·

This added element will be removed·

This resized/repositioned element will be put back in its original position·

This element from another Package, deleted from the diagram, cannot be·
restored from this Baseline

The comparison automatically shows a blue direction arrow for each reposition or
resize that has been checked. For a heavily edited diagram this might be confusing.
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However, you can hide the arrow for all elements except the one currently in focus;
to do this:

Deselect the 'Visually link new and old position for checked items' checkbox·

To roll back the changes for all items for which a checkbox is selected:

Click on the Apply button·

Notes

Diagram Baseline facilities are available in the Corporate, Unified and Ultimate editions of Enterprise Architect·
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Compare Projects

A number of operations can make changes to your project that you either want to monitor carefully or not have at all.
Such events include:

Recovering from a database crash·

Restoring a backup·

Performing a Project Data Transfer·

Importing from XMI, and·

Deleting model elements·

You might have made a copy of the original project or the purpose of the operation is to generate a copy, in which case
you can compare the size and row counts of the 'before' and 'after' copies as a convenient 'sanity check'. The copies can
be on different platforms; you have options to:

Compare a project file to another project file·

Compare a project file to a DBMS-based repository·

Compare two DBMS repositories·

The comparison examines the number of project rows in each database, producing a report indicating the total records in
each and the difference in record count between the two. If discrepancies are found, you must investigate further
manually. The comparison does not examine the actual data in the tables.

Access

Ribbon Configure > Model > Integrity > Project Compare

Compare two projects

Step Action

1 On the 'Project Compare' dialog, select the radio button for the database types of the two projects you
want to compare:

File to File·

DBMS to File·

File to DBMS·

DBMS to DBMS·

2 In the 'Source Project' and 'Target Project' fields, type the name or connection string for the source and
target projects to compare.

3 Click on the Compare Projects button.

The results of the comparison display in the panel at the bottom of the dialog.

4 If you want to print the results of the comparison, click on the Print List button.
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Project Maintenance

The repository is an important data store that must be maintained to ensure that it is running efficiently and that the
information it contains has integrity. Enterprise Architect has built-in features that allow you to keep the repository in
good health. These include tools to maintain the database itself, such as Repair and Compact functions (for file based
repositories), and a series of tools to manage the data and models, such as model validation and data integrity checks.
Reference data can be imported and exported from the repository, and can be shared between repositories, ensuring
consistency. The Browser window allows repositories to be refactored easily by dragging and dropping Packages,
elements, features and diagrams to new locations. The Element Discussion and Team Library features allow the model to
be critically analyzed and reviewed.

Facilities

Facility Detail

Check the integrity of the
data in a project

If you have a failed XMI import, network crash or other unforeseen event that could
disrupt the integrity of information in the model, it is recommended that you run a
Project Integrity Check.

Reset Auto Increment
Columns in Tables

XMI Import/Export can affect the table auto increment column values and push
them towards their maximum allowed value; you can re-sequence the columns to
avoid this problem.

Upgrade an old project to
enable use of new features

The structure of Enterprise Architect project files is occasionally changed to
support more features; when this happens, existing project files must be upgraded
to the new format to ensure correct operation and to take advantage of all the new
features.

Rename a project If you want to rename an Enterprise Architect file-based project, you can do so
through Windows Explorer.

Compact a project As with many relational database products .EAP/.EAPX files do not physically
release allocated space after data is deleted, therefore from time to time it can be
beneficial to perform a 'compact', to reduce the physical size of the project file.

Repair a project if it did not
close properly

If a .EAP/.EAPX project has not been closed properly, such as during system or
network outages, it is possible that the project will reports inconsistencies errors the
next time it is opened.  To resolve such issues a 'Repair' can be performed to correct
any potential problems.

Notes

You can only rename, compact and repair models created as .EAP/.EAPX files with Enterprise Architect.  While·
most DBMS products provide similar functionality, they typically require an elevated level of permissions and
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therefore usually performed by your Database Administrator (DBA).
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Check Project Data Integrity

If you have a failed XMI import, network crash or other unforeseen event that disrupts the integrity of information in the
model, it is recommended that you run the Project Integrity Check function to check that your project data is structurally
complete.

You can select a variety of items to check. The integrity check examines all database records and ensures there are no
'orphaned' records or inaccurate or unset identifiers. This function does NOT check UML conformance, only the data
relationships and repository structure.

You can run the integrity checker first in report mode to discover if anything should be corrected, and then run it again in
'recover/clean' mode.

When Enterprise Architect 'cleans' the model, it attempts to recover lost Packages and elements, and generates a new
Package at the model root level called _recovered_. Check through any elements that are found and, if required, drag
them back to where they belong. If they are not required, delete them.

Access

Ribbon Configure > Model > Integrity > Project Integrity

Check the data integrity of your project

Step Action

1 Open the project.

2 Select the 'Project Integrity Check' menu option.

The 'Project Integrity Check' dialog displays.

3 Select the checkbox for each check to run:

Package Structure·

Object Structure·

Object Features·

All GUIDs·

Cross References·

Connectors·

UML 2.0 Migration·

4 Select either:

The 'Report Only' option to just view a report on the state of your model, or·

The 'Recover/Clean' option to recover and clean your project; before selecting this option, back up·
your project file first

5 To write a log of the integrity check, click on the Save Results button and select a log file.

6 Click on the Go button to run the check.
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If you want to display the resulting information in a more readable layout, you can resize the dialog and
its columns.

UML 2.0 Migration

The UML 2.0 Migration check enables you to migrate the project from UML 1.3 semantics to UML 2.0 semantics. The
migration process currently converts activities that are invocations of operations into called operation actions as per the
UML 2.0 specification.

The UML 2.0 Migration option is an exclusive process that does not enable any of the other checks to be selected. When
you click on the Go button to perform the migration, a prompt displays for you to confirm the operation.

Notes

In the Corporate, Unified and Ultimate editions of Enterprise Architect, if security is enabled you must have 'Check·
Data Integrity' permission to perform a data integrity check
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Reset Table Auto Increment or Identity Columns

This topic explains possible impacts of XML Export/Import on table auto increment columns, and how to re-sequence
the columns whose value approaches the maximum value allowed.

Impacts

Impact Due To Impact

XML Export/Import XML Export/Import can cause gaps in the numbering sequence of auto increment
columns.

Each XML Import deletes rows from several tables; the import then adds rows
starting from the largest previous value of the auto increment column.

Repeated XML imports can result in the value of the auto increment approaching
the maximum value of the database datatype; for example, SQL Server's int
datatype has a maximum value of 2,147,483,647.

Replication Large auto increment values can also arise where the project originated as an EAP
replica or design master.

The Jet engine assigns random values for auto increment columns with each XML
Import into the project.

These random values can approach the maximum range of the repository data type,
which could present a problem when the EAP project is transferred to a repository.

Access

Ribbon Configure > Model > Integrity > Reset IDs

Re-sequence auto increment columns

Step Action

1 Open the project.

2 Select the 'Reset IDs' menu option.

A dialog displays listing all non-empty tables that contain an auto increment or identity column.

The 'Rows' column shows the number of rows in the table·

The 'Maximum ID' column shows the current maximum value of the auto increment column·

The 'Action' column shows either 'No Action' or 'Reset', depending on how close the column value is·
to the datatype's maximum

Tables requiring a reset are automatically selected in the list.
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3 Click on the Go button to reset the auto increment column values.

Notes

Connection to the project must be via a direct connection; IDs cannot be reset while the connection to the repository·
is via Pro Cloud Server

Project Auditing must be disabled before IDs can be reset·

MySQL repositories will require re-starting of the MySQL server so that the reset auto increment columns start from·
the reset value

While strict not necessary, Sparx System would recommend that this task is performed when all users are not·
actively using the Project

Sparx System recommend that a backup of the Project should be done both before and after performing a Reset of·
Table Auto Increment columns

In the Corporate, Unified and Ultimate editions of Enterprise Architect, if security is enabled you must have 'Check·
Data Integrity' permission to reset IDs
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Upgrade a Project

The structure of Enterprise Architect project files is occasionally changed to support more features. In such cases, the
project might have to be upgraded. Upgrading to the new file structure is a simple and quick process that brings your
project to the current level to:

Ensure correct operation and·

Support all the latest Enterprise Architect features·

Initial Check

When you load a project that was created in an earlier release of Enterprise Architect (for example, an archived project)
using a recent release of Enterprise Architect, the system determines whether the project should be upgraded and, if the
upgrade is necessary, displays the Upgrade Wizard.

The Upgrade Project Wizard

The Upgrade Project Wizard takes you through the upgrade process and:

Advises you of the necessity to upgrade·

Advises you to back up the current project; it is essential to back up before any changes are made·

Checks which upgrade path is required·

Guides you through the steps to perform the upgrade·

Opens the newly converted project·

Notes

If you are using replication in your models, and the upgrade wizard detects that the project you are opening is a·
replica and not a Design Master, a different upgrade path is required

Once upgraded, the project cannot be opened with the version of Enterprise Architect in which it was created·
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Upgrade Replicas

Models that have replication features added might have to be upgraded differently from regular projects.

If the model is a Design Master (the root model of all other replicas) then you can upgrade the model to suit the·
current version of Enterprise Architect; after upgrading a Design Master you should re-create the replicas, rather
than synchronizing

If the model is not a Design Master, you must first remove the replication features, then upgrade the project in the·
normal manner; the Upgrade Wizard guides you through the steps
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Run SQL Patches

Occasionally, Sparx Systems might release a patch to correct a model fault.

The patch generally checks how many records are to be updated, and reports on what is to be done.

Access

Ribbon Configure > Model > Integrity > Run Patch

Run SQL Patch

1 Open Enterprise Architect and load the Project that requires the patch applied.

2 Select the 'Run Patch' option.

The 'Run Patch' dialog displays.

3 Click the Browse button and select the supplied patch file (*.XML) in the file browser.

Upon loading the select file, the Description will then be loaded with the explanation of what action the
patch will perform.

4 Click the Run button to apply the patch to the current Project.
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Rename a Project

If you want to rename a project, you can only do so at the Windows file system level, using Windows Explorer.

Rename an Enterprise Architect project file

Step Action

1 If you have the project open, close it.

2 Ensure no other users have the file open.

3 Open Windows Explorer and navigate to the project.

4 Rename the project file using Windows Explorer.

5 You should keep the file extension to preserve compatibility with the default project type, as installed in
the registry at installation time.
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Compact a Project

After a period of time, through general use, a project .eap file might occupy more disc space than necessary. You can
move the project to a local drive and compact the file to recover the unused space.

Access

Ribbon Configure > Model > Integrity > Manage .EAPX/.EAP File > Compact
.EAPX/.EAP File

Compact a project

Step Action

1 If you have the project open, shut it down.

2 Ensure no other users have the file open.

3 Select the 'Compact .EAPX/.EAP File...' menu option.

4 Follow the on-screen instructions to complete the process.

Notes

Always compact projects on a local drive, never on a network drive·

In the Corporate, Unified and Ultimate editions of Enterprise Architect, if security is enabled you must have·
Administer Database permission to compact a project
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Repair a Project

If a project has not been closed properly, such as during system or network outages or on poor network connections, on
rare occasions the .eap file does not re-open correctly. A message displays informing you the project is of an
unrecognized database format or is not a database file. In such cases, you can move the project file to a local drive and
repair it.

Access

Ribbon Configure > Model > Integrity > Manage .EAPX/.EAP File > Repair .EAPX/.EAP
File

Repair a project that was not closed properly

Step Action

1 Ensure that all users are logged off the project you are attempting to repair.

2 Copy the project file to a local drive on your workstation.

3 In Enterprise Architect, select 'Start > Desktop > Preferences > Preferences' to display the 'Preferences'
dialog.

On the 'General' page, deselect the 'Use Jet 4.0 - requires restart' checkbox.

4 Close and restart Enterprise Architect - you do not need to open any model, including the one you are
repairing.

5 Select the 'Repair .EAPX/.EAP File...' menu option, and follow the on-screen instructions.

6 Once you have repaired the project, it is recommended that you perform a data integrity check.

Notes

Always repair projects on a local drive, never on a network drive·

The 'Compact a Project' option can also repair corrupt .eap files·

In the Corporate, Unified and Ultimate editions of Enterprise Architect, if security is enabled you must have·
'Administer Database' permission to repair a project
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Reference Data

Reference data is used in Enterprise Architect to provide meta-information for the modeler, and is often seen in drop
down lists and selection boxes. It includes such things as status codes, requirement types, model authors and more.

For convenience, Enterprise Architect comes pre-configured with useful reference data, but it is best practice to review
this existing data when setting up a project and either replace or edit it to ensure it is appropriate for the project.

There are a number of different types of reference data, some of which apply at a repository level - such as status codes
and authors - and some that is more technical in nature, such as code engineering and database datatypes.

The reference data can be copied between repositories by exporting it from one repository and importing it into another;
this mechanism can save time and ensure consistency between repositories.

Project reference data can be entered and edited through the 'Configure > Reference Data' ribbon panel, and includes:

Stereotypes·

Tagged Value Types·

Cardinalities·

People·

General Types·

Project Indicators·

Estimation Factors·

Datatypes·

Notes

In the Corporate, Unified and Ultimate editions of Enterprise Architect, if security is enabled you must have·
'Manage Reference Data - Update' permission to update and delete reference items
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UML Types

Using the 'UML Types' dialog you can configure stereotypes, Tagged Value types and the cardinality list for your
project. In more detail, you can:

Add, modify and delete stereotypes·

Customize stereotypes' appearance·

Update Shape Scripts and metafiles associated with stereotypes·

Create and modify Tagged Values·

Define cardinality rules·

Access

Ribbon Configure > Reference Data > UML Types
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Stereotype Settings

Enterprise Architect has an extensive set of Standard Stereotypes that you can apply to any UML construct. Using the
'Stereotypes' tab of the 'UML Types' dialog, a Technical Developer can also customize the stereotypes for your project
by adding, modifying and deleting them. For information on customizing stereotypes, see the Custom Stereotypes Help
Topic.

Stereotypes can be modified to make use of metafiles (image files) or customized colors, or to make use of the Enterprise
Architect Shape Scripts to make new object shapes to determine the shape and dimensions of the object.

Access

Ribbon Configure > Reference Data > UML Types

Manage Stereotypes

Option Action

Stereotype Type in the name of the new stereotype, or click on an existing stereotype in the list
in the right-hand panel.

Group name For a stereotype that applies to an element feature (an attribute or operation) type in
a name under which to group the features that have the stereotype. This is shown on
diagrams in the attributes or operations compartment of the element.

If you do not provide a group name, the label in the feature compartment defaults to
the stereotype name.

Base Class Click on the drop-down arrow and select an object type, so that the stereotyped
object will inherit the base characteristics from that existing object type.

Notes Type in any notes concerning the stereotype (and not the objects to which the
stereotype is to be applied).

None Select this radio button to use the default object appearance.

Metafile Select this radio button to use an image file for the appearance of the stereotyped
object.

Shape Script Select this radio button to apply a custom shape to the stereotyped object, which
you define using the Enterprise Architect Shape Scripting language.

Assign Click on this button to select or define the associated metafile or Shape Script to be
applied to the stereotyped object.

Remove Click on this button to remove the associated metafile or Shape Script from the
stereotype.

Fill Click on the drop-down arrow and select a default color for the background of the
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object.

This color will be applied to all occurrences of any object to which the stereotype
has been applied; if the color is subsequently changed, the change is immediately
applied to all occurrences of any object to which the stereotype was applied (as for
changes to any other property of the stereotype).

However, on elements created with the stereotype, the default color might be
overridden by other color definitions of a higher priority that have been applied to
the element, such as the 'Alternative Appearance' dialog (F4) definition.

Border Click on the drop-down arrow and select a default color for the object border.

Font Click on the drop-down arrow and select a default color for the stereotype font.

Reset Click on this button to reset the stereotyped object appearance definition to the
default object appearance.

Preview Provides a visual representation of the stereotyped object definition.

New Click on this button to clear the dialog fields so that you can define another
stereotype.

Save Click on this button to save the stereotype definition and add it to the list of current
stereotypes.

Delete Click on this button to immediately remove the selected stereotype from the list of
defined stereotypes.
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Shape Editor

A Technology Developer can use the Shape Editor to specify custom shapes via a scripting language; that is, to create
Shape Scripts. These custom shapes are drawn instead of the standard UML notation. Each script is associated with a
particular Stereotype, and is drawn for every element of that stereotype.

Access

Ribbon Configure > Reference Data > UML Types > Stereotypes > [select or specify a
stereotype] : Shape Script : Assign

Reference

Option Action

Format The format in which the script is written.

Import Opens a Windows browser dialog, allowing for a script file to be loaded.

Export Opens a Windows browser dialog, allowing for a script file to be saved.

Edit window The area in which a script can be written.

Preview of main A visual representation of the compiled script. Nothing displays until the Refresh
button is clicked.

Next Shape If a composite shape is defined within the Edit Window, clicking on the Next Shape
button pages through the components of the shape.

Refresh Parses your script and produces a visual example of the shape in the Preview of
main window.

OK Exit from the Shape Editor; don't forget to save your scripts from the 'Stereotype'
tab.

Notes

Shape Scripts adopt the same color gradient settings as normal elements, as defined in the 'Standard Colors' page of·
the 'Preferences' dialog

If an element's appearance is modified by a Shape Script, many of the 'Advanced' context menu options for that·
element are disabled

Once you have finishing writing your Shape Script, click on the OK button; to save the Shape Script you must click·
on the 'Stereotypes' tab
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Tagged Value Types

Tagged Values are used in a variety of places within Enterprise Architect to specify additional information about an
element or connector. The 'Tagged Value Types' tab of the 'UML Types' dialog enables a Technology Developer to
rapidly create Tagged Values, using a range of predefined structured Tagged Values to create structured tags that adhere
to a specific format. For example, for model features that use the predefined tag Boolean you can use the 'Tags' tab of the
Properties window to assign a value of True or False and no other value.

You can also add default Tagged Value names and create predefined reference data Tagged Value types and custom
masked Tagged Value types.

Any Tagged Value names created display in the drop-down lists of Tagged Value names in the 'Tagged Value' dialogs
for elements, operations and attributes.

Access

Ribbon Configure > Reference Data > UML Types > Tagged Value Types

Create a Tagged Value Type

Field Action

Tag Name Type the new name of the Tagged Value.

Description Type a description of the Tagged Value.

Detail Type any additional information necessary.

New Click to begin creating a new Tagged Value.

Save Click to save the details of a Tagged Value.

Delete Click to delete a Tagged Value from the Defined Tag Types list.

Defined Tag Types A list of previously defined Tagged Values.

Notes

You can transport these Tagged Value Type definitions between models, using the 'Configure > Model > Transfer >·
Export Reference Data' and 'Import Reference Data' ribbon options; Tagged Value Types are exported as Property
Types
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Cardinality

The 'Cardinality Values' tab of the 'UML Types' dialog enables you to add, modify and delete values in the default
cardinality list.

The cardinality values are used to define the multiplicity of source and target elements in relationships. This is the range
of instances of the role that can be active in the relationship; for example, one employee can be assigned to tasks; for the
target role you define the range of instances (such as tasks) the employee could be assigned to.

The cardinality values are also used to define the multiplicity of a Classifying element; that is, the number of instances of
the element that can exist. For example, the Class element 'Building Walls' might have a multiplicity of 2..n, meaning
that at least two walls must exist (to support the roof) but there can be many walls if the building design required it.

The values have these formats:

*, or 0..* - zero, one or many instances·

0..n - zero or up to n instances, but no more than n·

n - exactly n instances·

n..* - n, or more than n instances.·

Access

Ribbon Configure > Reference Data > UML Types > Cardinality Values

Reference

Field Action

Cardinality Type the new name of the Cardinality Value.

New Type a description of the Cardinality Value.

Save Saves the Cardinality value and adds it to the Cardinality List.

Delete Deletes a Cardinality value from the Cardinality List.

Cardinality List A list of already defined Cardinality values.

Notes

You can transport these cardinality values between models, using the 'Configure > Model > Transfer > Export·
Reference Data' and 'Import Reference Data' ribbon options
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People

In your project, you can set up and configure the people and stakeholders involved in and relevant to this model; that is:

Maintain Authors involved within a project·

Define role types that are captured within Enterprise Architect·

Record information on project resources·

Capture client details associated with the current model·

Access

Ribbon Configure > Reference Data > Model Types > People
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Project Authors

You can define the people who are working on a project, such as the authors of specific elements.

Access

Ribbon Configure > Reference Data > Model Types > People > Project Author(s)

Notes

If you enter multiple names, Enterprise Architect adds them separately and in alphabetical order to the 'Defined·
Authors' list; if you then click on one of these names, Enterprise Architect displays that name only in the 'Name(s)'
field

If you type in a role, this is not added to the roles on the 'Project Roles' tab·

You can transport these author definitions between models, using the 'Configure > Model > Transfer > Export·
Reference Data' and 'Import Reference Data' ribbon options

Reference

Field Action

Name(s) Type the name of the person registered as a Project Author.

If you are using a Windows Active Directory, you can select names from the

directory; click on the  button to display the 'Select Users' dialog.

You can also type a list of names separated by semi-colons; this enables you to
define a group of people sharing a role, such as a team of Developers, Testers or
Analysts.

Do not leave any spaces between the names and the semicolons.

Role (Mandatory) Enter the role the Project Author plays in the project (such as
Designer, Analyst, or Architect).

You can type a role name or click on the drop-down arrow and select a role defined
through the 'Project Roles' tab.

Notes Type any additional notes concerning the Project Author.

New Add further Authors.

Save Add the new Author to the Defined Authors list.

Delete Removes an Author from the Defined Authors list.

Defined Authors Review the Project Authors already defined.

(c) Sparx Systems 2019 Page 610 of 654 Created with Enterprise Architect



Model Repository - Model Repository 20 January, 2020

(c) Sparx Systems 2019 Page 611 of 654 Created with Enterprise Architect



Model Repository - Model Repository 20 January, 2020

Select Users

If your company is using a Windows Active Directory, you can select the Project Author names from the local or
corporate-wide directory.

Access

Ribbon
Configure > Reference Data > Model Types > People > Project Author(s) : 

Reference

Field Action

Object Types... Opens the 'Object Types' dialog, which provides a choice of object types that can be
used.

Locations... Defines the root location from which to begin a search.

Check Names Matches object names listed in the Enter the object names to select section.

Enter the object names to
select

Specify object names to search for.

Advanced... Opens the 'Advanced' dialog to provide further search options.

For more information on this dialog, please refer to Windows Help and Support.

Use to

Select Project Authors from Windows Active Directory·

Notes

Multiple Entries can be typed into the 'Enter the object names to select' section; ensure that objects are separated by·
semicolons (for example: Name01; Name02)
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Project Roles

People associated with a project play a role in analysis, design or implementation, such as Application Analyst,
Architect, Developer and Project Manager. Project roles define the activities that resources can undertake.

Access

Ribbon Configure > Reference Data > Model Types > People > Project Roles

Reference

Field Action

Role Type or select the name of the role.

Description Type a description of the role.

Notes Type any additional information related to the role.

New Add further Roles.

Save Add the new role to the Defined Roles list.

Delete Removes a role from the Defined Role list.

Defined Roles Review the Project Roles already defined.

The 'Defined Roles' list is available for selection for any element in the model; for
example, you can select roles on the 'Project Authors' page of the 'People' dialog,
and the Resource Allocation window.

You can also specify other roles on these dialogs, but such roles are not added to
the 'Defined Roles' list.

Use to

Define role types that are captured within Enterprise Architect·

Notes

Deleting a role has no effect on any Project Author definition having this role; the deleted role becomes a simple text·
entry in the Project Author definition

You can transport these role definitions between models, using the 'Configure > Model > Transfer > Export·
Reference Data' and 'Import Reference Data' ribbon options
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Project Resources

Resources are, for example, project authors, analysts, programmers and architects. That is, anyone who might work on
the system over time, either adding to the model or programming and designing elements of the system outside
Enterprise Architect.

Access

Ribbon Configure > Reference Data > Model Types > People > Project Resources

Reference

Field Action

Name Type or select the name of the person listed as a resource.

The resource name is available for use in Resource Management.

Organization Type the name of the organization employing the resource.

Role(s) Type or select the role the resource plays in the project (for example, Designer,
Analyst, Architect).

Phone 1, Phone 2, Mobile,
Fax

Type the contact telephone numbers for the resource.

Email Type the email address for the resource.

Notes Type any additional notes on the resource.

Available Resources Review resources that have already been defined.

New Add further resources.

Save Add a new resource to the Available Resource list.

Delete Delete a resource from the Available Resources list.

Use to

Record information on project resources·

Notes
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You can transport these resource definitions between models, using the 'Configure > Model > Transfer > Export·
Reference Data' and 'Import Reference Data' ribbon options

(c) Sparx Systems 2019 Page 616 of 654 Created with Enterprise Architect



Model Repository - Model Repository 20 January, 2020

Project Clients

Project clients are the eventual owners of the software system.

Access

Ribbon Configure > Reference Data > Model Types > People > Project Clients

Reference

Field Action

Name Type or select the name of the client.

Organization Type the name of the organization that employs the client.

Role(s) Type the role the client plays in the project (for example, Manager, Sponsor).

Phone 1, Phone 2, Mobile,
Fax

Type the contact telephone numbers for the client.

Email Type the email address of the client.

Notes Type any additional notes on the client.

Defined Clients Review clients that have already been defined.

New Add details of further clients.

Save Add a new client to the Defined Client list.

Delete Delete a client record from the Defined Client list.

Use to

Capture client details associated with the current model·

Notes

You can transport these client definitions between models, using the 'Configure > Model > Transfer > Export·
Reference Data' and 'Import Reference Data' ribbon options
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General Types

When you create or edit the properties of an element, you define the type or status of the property by selecting from a
drop-down list that initially contains system-provided values. You can add to or replace any of these system values with
your own customized values. The properties you can customize are:

Status·

Constraint·

Constraint Status·

Difficulty·

Priority·

Test Status·

Requirement·

Scenario·

Maintenance Status·

Each of these can be separately managed through the 'General Types' dialog.

Access

Ribbon Configure > Reference Data > Model Types > General Types
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Status Types

In an element 'Properties' definition, the status of the element in the development management process is defined in the
element 'Status' field. You can select the appropriate value from a drop-down list, which initially contains the system
values:

Approved·

Implemented·

Mandatory·

Proposed and·

Validated·

You can add to or replace any of these values with your own custom values. You can also assign a color band to each
status type, and define the types of element that can display those colors.

Access

Ribbon Layout > Diagram > Appearance > Configure Status Colors, or

Configure > Reference Data > Model Types > General Types > Status

Customize Element Status Types

Option Description

Status Type the name of the status.

Description Type a short description of the status.

Status Type Color Using the drop-down arrow, select a color to be applied to the current status type.

Preview Displays a visual representation of an element with the selected status type color.

Restore Default Restore the status type color to its default setting.

Applies to... By default, status colors only apply to Requirement, Issue and Change elements.
You might decide to also apply these colors to other UML elements, such as Use
Cases or Classes.

To do this, click on the Applies to ... button and, in the 'Applied Status Colors' list,
select the checkbox against each element type to which to apply the status colors.

New Clear the dialog fields to create a new status.

Save Save the status, and add it to the Type list.

Delete Remove the currently selected status from the Type list.
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Type Lists the current status types and descriptions for each status.

Notes

To display status colors on your diagrams, you must select the 'Show status colors on diagrams' checkbox on the·
'Objects' page of the 'Preferences' dialog

You can transport the status types (and the colors assigned to status types) between models, using the 'Configure >·
Model > Transfer > Export Reference Data' and 'Import Reference Data' ribbon options

Requirement, Feature, Issue and Change elements have a status color compartment, whereas the status color for·
other elements is applied to the element shadow; to show the element shadows (and hence the status colors), select
the 'Element Shadows on' checkbox on the 'Diagram Appearance' page of the 'Preferences' dialog
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Constraint Types

In an element 'Properties' definition, each constraint on the element is defined by type in the 'Constraint' field. You can
select the appropriate value from a drop-down list, which initially contains the system values:

Invariant·

Post-condition·

Pre-condition·

Process and·

OCL·

You can add to or replace any of these values with your own custom values.

Access

Ribbon Configure > Reference Data > Model Types > General Types > Constraint

Customize Constraint Types

Option Description

Constraint Type the name of the constraint to define.

Description Type a brief description of the constraint.

Note Type any further details concerning the constraint.

New Clear the fields to define a new constraint.

Save Save the constraint definition and add it to the Defined Constraint Types list.

Delete Remove the currently selected constraint from the Defined Constraint Types list.

Defined Constraint Types Lists the currently-defined constraint types and their descriptions.

Notes

You can transport customized constraint types between models, using the 'Configure > Model > Transfer > Export·
Reference Data' and 'Import Reference Data' ribbon options
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Constraint Status Types

In an element 'Properties' definition, each constraint's status in the development process is defined in the constraint
'Status' field. You can select the appropriate value from a drop-down list, which initially contains the system values:

Implemented·

Build·

Validated·

Approved·

Mandatory and·

Proposed·

You can add to or replace any of these values with your own custom values.

Access

Ribbon Configure > Reference Data > Model Types > General Types > Constraint·
Status Types

Customize Constraint Status Types

Option Description

Status
Type the name of the constraint status to define.

Make Default
To make the selected constraint status the default for all constraint 'Status' fields,
select the checkbox.

New
Clear the fields to define a new constraint status.

Save
Save the constraint status definition and add it to the Type list.

Delete
Remove the currently selected constraint status from the Type list.

Type
Lists the currently available constraint status types.

Move the selected constraint type higher or lower in the Type list.

This defines the ordering used in the Status drop down combo boxes, and in sorting
any report or list when the Constraint Status Type is used as the sort-by property.

Sort Alphabetically
Reorganize the entries in the Type list into alphabetical order.

Restore Defaults
Remove all customized constraint status values and restore the system defaults.
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Notes

You can transport customized constraint status types between models, using the 'Configure > Model > Transfer >·
Export Reference Data' and 'Import Reference Data' ribbon options
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Difficulty Types

Developing a particular element might be a simple task or more complex. In the element Properties definition, the level
of difficult of developing that element is defined in the 'Difficulty' field. You can select the appropriate value from a
drop-down list, which initially contains the system values 'High', 'Medium' and 'Low'. You can add to or replace any of
these values with your own custom values.

Access

Ribbon Configure > Reference Data > Model Types > General Types > Difficulty

Customize Difficulty Types

Option Description

Difficulty
Type the name of the Difficulty to define.

Make Default
To make the selected Difficulty the default for all 'Difficulty' fields, select the
checkbox.

New
Clear the fields to define a new Difficulty type.

Save
Save the Difficulty definition and add it to the Type list.

Delete
Remove the currently selected Difficulty from the Type list.

Type
Lists the currently available Difficulty types.

Move the selected type higher or lower in the 'Type' list.

This defines the ordering used in the 'Difficulty' drop down combo boxes, and in
sorting any report or list when the Difficulty type is used as the sort-by property.

For example: you have several Change elements on a diagram, and you select
'Diagram View'; then you sort on the 'Difficulty' column. The 'Diagram View'
entries are grouped by difficulty, in the order you defined in this 'Type' field.

Sort Alphabetically
Reorganize the entries in the Type list into alphabetical order.

Restore Defaults
Remove all customized Difficulty values and restore High, Medium and Low.

Notes

You can transport customized Difficulty types between models, using the 'Configure > Model > Transfer > Export·
Reference Data' and 'Import Reference Data' ribbon options
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Priority Types

In an element Properties definition, the priority of developing that element is defined in the 'Priority' field. You can select
the appropriate value from a drop-down list, which initially contains the system values 'High', 'Medium' and 'Low'. You
can add to or replace any of these values with your own custom values.

Access

Ribbon Configure > Reference Data > Model Types > General Types > Priority

Customize Priority Types

Option Description

Priority
Type the name of the Priority to define.

Make Default
To make the selected Priority the default for all 'Priority' fields, select the checkbox.

New
Clear the fields to define a new Priority.

Save
Save the Priority definition and add it to the Type list.

Delete
Remove the currently selected Priority from the Type list.

Type
Lists the currently available Priority types.

Move the selected type higher or lower in the 'Type' list.

This defines the ordering used in the 'Priority' drop down combo boxes, and in
sorting any report or list when the Priority type is used as the sort-by property.

For example: you have several Change elements on a diagram, and you select
'Diagram View'; then you sort on the 'Priority' column. The 'Diagram View' entries
are grouped by priority, in the order you defined in this 'Type' field.

Sort Alphabetically
Reorganize the entries in the Type list into alphabetical order.

Restore Defaults
Remove all customized Priority values and restore High, Medium and Low.

Notes

You can transport customized Priority types between models, using the 'Configure > Model > Transfer > Export·
Reference Data' and 'Import Reference Data' ribbon options
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Test Status Types

All tests defined in the Testing window and 'Test Details' dialog have a status value to show what point in the testing
cycle the test has reached. The system values you can select from the test 'Status' field are:

Not Run·

Pass·

Fail·

Deferred and·

Canceled·

You can add to or replace any of these values with your own custom values.

Access

Ribbon Configure > Reference Data > Model Types > General Types > Test Status

Customize Test Status Types

Option Description

Status
Type the name of the Test status to define.

Make Default
To make the selected test status the default for all test 'Status' fields, select the
checkbox.

New
Clear the fields to define a new Test status.

Save
Save the Test status definition and add it to the Type list.

Delete
Remove the currently selected Test status from the Type list.

Type
Lists the currently available Test status types.

Move the selected type higher or lower in the 'Type' list.

This defines the ordering used in the test 'Status' drop down combo boxes, and in
sorting any report or list when the Test Status Type is used as the sort-by property.

For example: you have run several tests on a Package, and you run a Test Details
report; then you sort on the 'Status' column. The report entries are grouped by test
status, in the order you defined in this 'Type' field.

Sort Alphabetically
Reorganize the entries in the Type list into alphabetical order.

Restore Defaults
Remove all customized Test status values and restore the system defaults.
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Notes

You can transport customized Test status types between models, using the 'Configure > Model > Transfer > Export·
Reference Data' and 'Import Reference Data' ribbon options
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Requirement Types

In a Requirement definition, the requirement is categorized according to type or function, in the 'Type' field of the
Requirement 'Properties' dialog. This helps to maintain a single set of typed requirements. You can select the appropriate
'Type' value from a drop-down list, which initially contains the system values:

Display·

Functional·

Performance·

Printing·

Report·

Testing and·

Validate·

You can add to or replace any of these types with your own customized values.

Access

Ribbon Configure > Reference Data > Model Types > General Types > Requirement

Customize Requirement Types

Option Description

Requirement Type the name of the requirement.

Description Type a short description of the requirement.

Weight Type a weighting to apply to the requirement type.

New Clears the dialog fields so that you can define a new requirement type.

Save Saves the requirement type details and adds it to the Defined Requirement Types
list.

Delete Deletes a selected requirement type from the Defined Requirement Types list.

Defined Requirement
Types

Lists the currently available requirement types.

Notes

You can transport these requirement types between models, using the 'Configure > Model > Transfer > Export·
Reference Data' and 'Import Reference Data' ribbon options
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Scenario Types

In the Scenario definitions for an element each scenario is of a specific type, which you define in the 'Type' field on the
'Scenario' page of the 'Properties' dialog. You can select the appropriate value from a drop-down list, which initially
contains the system values:

Exception·

Alternate and·

Basic Path·

You can add to or replace any of these system types with your own customized values.

Access

Ribbon Configure > Reference Data > Model Types > General Types > Scenario

Customize Scenario Types

Option Description

Scenario Type Type the name of the scenario type.

Description Type a short description of the scenario type.

Weight Type a value for the weighting to apply to the scenario type.

Notes Type any additional information to describe the scenario type.

New Clears the dialog fields so that you can define a new Scenario type.

Save Saves the scenario type and adds it to the Defined Scenario Types list.

Delete Deletes a selected scenario type from the Defined Scenario Types list.

Defined Scenario Types Lists the currently available scenario types to offer in the drop-down list of a
'Scenario Type' field.

Notes

You can transport customized scenario types between models, using the 'Configure > Model > Transfer > Export·
Reference Data' and 'Import Reference Data' ribbon options
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Maintenance Status Types

Model Maintenance items such as Changes, Issues, Defects and Tasks pass through a series of stages whereby each item
is raised, assessed, approved, worked on, reviewed and completed. As an item passes through each stage, it can be
assigned a Status from this system-provided list:

Active·

Complete·

Deferred·

Merged·

New (the initial default status)·

No Action·

Paused·

Rejected·

Rework·

Verified·

The Maintenance Status values are defined on the 'Maintenance Status' page of the 'General Types' dialog. You can add
to or replace any of these values with your own custom values.

Access

Ribbon Configure > Reference Data > Model Types > General Types > Maintenance Status

Customize Maintenance Status Types

Option Description

New
Click on this button to clear the fields to define a new Maintenance status.

Maintenance
Type the name of the Maintenance status to define.

Make Default
To make the selected status the default for all Maintenance item 'Status' fields,
select the checkbox.

Save
Save the Maintenance status item and add it to the 'Type' list.

Delete
Remove the currently selected Maintenance status from the 'Type' list.

Type
Lists the currently available Test status types.

Move the selected type higher or lower in the 'Type' list.

This defines the ordering used in the Maintenance 'Status' drop down combo boxes,
and in sorting any report or list when the Maintenance Status Type is used as the
sort-by property.
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For example: you have set up a number of Change items on a Package, and you run
a report on the Change items; then you sort on the 'Status' column. The report
entries are grouped by status, in the order you defined in the 'Type' list.

Sort Alphabetically
Reorganize the entries in the 'Type' list into alphabetical order.

Restore Defaults
Remove all customized Maintenance status values and restore the system defaults.

Notes

You can transport customized Maintenance status types between models, using the 'Configure > Model > Transfer >·
Export Reference Data' and 'Import Reference Data' ribbon options
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Metrics and Estimation

TCF values, EFC values and Default Hour Rate for a project are controlled from the 'Estimation Factors' dialog.

Risk, metric and effort types for a project are controlled from the 'Project Indicators' dialog.

For further information on these see the Project Management and Project Resources topics, or specifically:

Technical Complexity Factors·

Environment Complexity Factors·

Default Hours·

Effort Types·

Metric Types·

Risk Types·
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Maintenance

Within your project, you can set up Maintenance types that determine the base Problem Types to be used within the
model.

Access

Ribbon Configure > Reference Data > Model Types > Maintenance
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Problem Types

NOT CURRENTLY USED

For the maintenance and change control screens, you can use the 'Maintenance' dialog to set the base Problem Types that
are handled. Examples are hardware-related issues, performance problems, software bugs and network problems.

Access

Ribbon Configure > Reference Data > Model Types > Maintenance > Problem Types

Define Problem Types

Field Action

Problem Type Type in the name of the problem type.

Description Type a short description of the problem type.

Weight Provide a weighting to apply to the problem type.

Note Type any additional information on the problem type.

Defined Types Displays all of the pre-defined and saved problem types.

New Click on this button to clear the dialog fields so that you can add a new problem
type.

Save Click on this button to save the scenario details and add it to the 'Defined Types'
list.

Delete Click on this button to delete a selected scenario from the 'Defined Types' list.

Notes

You can transport these problem types between models, using the 'Configure > Model > Transfer > Export·
Reference Data' and 'Import Reference Data' ribbon options

You transport the problem types together with test types as a Maintenance Types file·
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Testing Types

You can use the 'Test Types' tab of the 'Maintenance' dialog to add testing types to the basic set that comes with
Enterprise Architect. Typical test types are load tests, regression tests and standard tests.

Access

Ribbon Configure > Reference Data > Model Types > Maintenance > Test Types

Reference

Field Action

Test Type Type the name of the test type.

Description Type a short description of the test type.

Weight Type a weighting to apply to the test type.

Note Type any additional information on the test type.

Defined Types Displays all of the pre-defined and saved test types.

New Add a new test type.

Save Saves the scenario details and adds it to the 'Defined Types' list.

Delete Deletes a selected scenario from the 'Defined Types' list.

Notes

You can transport these test types between models, using the 'Configure > Model > Transfer > Export Reference·
Data' and 'Import Reference Data' ribbon options

You can either export the test types together with the default problem types, as a Maintenance Types file, or·
separately as a Test Types file
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Data Types

Different programming languages support different inbuilt data types. It is possible for you to manage and extend this set
of inbuilt data types for a standard programming language, as well as define new programming languages for use within
Enterprise Architect.

Access

Ribbon Configure > Reference Data > Settings > Coding Datatypes   or

Develop > Preferences > Options > Configure Code Engineering Datatypes

Programming Language Datatype Options

Option Description

Product Name Click on the drop-down arrow and select the name of the programming language.

Add Product Click on this button to display a prompt for the name of a new programming
language.

Type the name and click on the OK button.

Datatype Type the language-specific name of the datatype.

Common Type Type the common (or generic) name of the datatype; for example, the Java boolean
datatype has a common datatype Boolean.

New Click on this button to clear the fields to create a new datatype.

Save Click on this button to save the newly created or updated datatype.

Delete Click on this button to delete the selected datatype.

You can delete your own custom data types, but you cannot delete any of the
predefined data types.

Defined Datatypes for
Programming Languages

Review the list of datatypes for the selected language, and click on any that you
want to edit or delete. The details for the selected datatype display in the dialog
fields.

Notes

You do not need to set the options in the 'Size' panel·

Once you have defined at least one datatype for a new language, that language name is added to the drop-down list·
for the 'Language' fields in the 'Programming Languages Datatypes' dialog, in the Code Template Editor, and in the
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'Properties' dialog for each Class element within the model

You can transport these data types between models, using the 'Configure > Model > Transfer > Export Reference·
Data' and 'Import Reference Data' ribbon options

In the Corporate, Unified and Ultimate editions of Enterprise Architect, if security is enabled you must have·
'Configure Datatypes' permission to update and delete data types
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Resources Window

The Resources window is a repository of project-standard and re-usable document generation templates, MDG
Technologies, Relationship Matrix profiles, commonly-used model elements, stylesheets, UML Profiles and Patterns.
The window provides facilities for creating and modifying these structures and facilities and, in some cases, for applying
the facility to the current model directly from the window.

Access

Ribbon Start > Desktop > Share > Resources

Explore > Portals > Windows > Explore > Resources

Configure > Reference Data > Resources

Keyboard Shortcuts Alt+6

Resources available through the Resources window

Notes

In the Corporate, Unified and Ultimate editions of Enterprise Architect, if security is enabled you must have·
'Configure Resources' permission to maintain Resources window items

For a number of folders in the Resources window, the right-click context menu also offers a 'Help' option that, when·
you select it, displays a brief description of the folder

Resource Description

Document Generation The Document Generation folder holds a number of sub-folders, each of which
provides the facilities for generating a particular type of document or report from
your model.

System Templates - this sub-folder itself has sub-folders containing·
system-defined report templates, Fragments, Cover Pages, Style Sheets and
Table of Contents definitions
You can right-click on these template names and select options to display the
template contents or to copy the template as the basis of a user-defined
template that you work on in the Document Template Editor, under a different
name; you can also select the 'Override' option to create a copy of the system
template as a user template with the same name

User Templates - this sub-folder also has sub-folders for report templates,·
Fragments, Cover Pages, Style Sheets and Tables of Contents, but these are the
templates that you have created yourself using the Document Template Editor,
either as new or by copying and editing another template
You can right-click on these template names and select options to create,
delete, rename, modify, move or copy a user-defined template; you have
additional options to mark a report template as a Fragment, or a Fragment as a
report template, if they are suitable for this reclassification
You can also 'drag and drop' user-defined templates between user-defined
groups, and between these groups and the appropriate standard 'type' folders;
for example, from 'DavidCover' to 'Cover Pages'

Technology Templates - if you have loaded an MDG Technology containing·
document templates, those are also listed under the Technology name
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Web Style Templates - this sub-folder contains the HTML style templates that·
you have created as alternatives to the system-supplied <default> template
To create a new template, right-click on the folder name and select the 'Create
HTML template' option, and provide a template name; this opens the HTML
and CSS Style Editor, in which you create the template from HTML fragments
You can right-click on the template names and select options to delete the
template or modify the template contents

Defined Documents - this folder holds the Resource documents (report·
specifications) you have created in the Document Report Generator; you can
right-click on the document name to generate documents individually or as a
batch, open the generated document, or delete the report specification

Linked Document Templates - this folder holds the non-standard Linked·
Document templates, either user-defined or supplied with each MDG
Technology enabled on the system; you can edit or delete any of these existing
templates, or create new ones from scratch or by copying an existing template,
including the system-provided Linked Document templates
You can also re-assign the templates to different template groups, either
another of the existing groups or a new one that you create as part of the
assignment

Legacy Templates - if you are, or have been, using the original (legacy)·
Enterprise Architect report generator, this sub-folder contains the report
templates that you use to generate the documents
You can continue to create, modify, use and delete legacy style templates, but
it is recommended that you switch to the later report generator

MDG Technologies The MDG Technologies folder lists the MDG Technologies that have been
imported directly into the Resources window. Each technology extends the
modeling capabilities and facilities of Enterprise Architect.

You can import Technologies into your project by right-clicking on the MDG
Technologies folder and selecting the 'Import Technology' menu option. The
'Import MDG Technology' dialog then gives you the option to import the
Technology to:

'User', for your individual use; the Technology is imported into the·
%APPDATA% folder and is not listed in the Resources window

'Model', for all project users to access; the Technology is imported into the·
Resources window

If you have any MDG Technologies in the folder, each has its own subfolder
containing the Profiles, Patterns and code modules used in the Technology. You
can right-click on these and select options to delete the Technology, review the
Patterns or Profiles, or invoke the code modules.

If you remove the Technology, it is removed from the Resources window, the
'MDG Technologies' dialog, and the model.

Consider the fact that some MDG Technologies can be large and might impose
some delays on the workstation as they load each time a user connects to the model.

Model Patterns The Model Patterns folder holds Model Patterns that have been imported into the
model from external sources, including those developed within your own
organization. Each Pattern XML file will have a matching .rtf file to explain the
Pattern to users. Model Patterns generate modeling structures (Packages, diagrams
and elements) within your model.

Matrix Profiles The Matrix Profiles folder contains a list of Relationship Matrix Profiles that you or
your team members have created using the Relationship Matrix or Specification
Manager. You simply double-click on a Matrix Profile name to quickly open the
Relationship Matrix under the settings defined in the Profile.
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Favorites The Favorites folder provides a shortcut to each commonly-used element that you
have added to the folder, so that you can quickly and easily locate the elements and
add them to diagrams.

Stylesheets The Stylesheets folder contains XSL stylesheets that you or your team members
have imported into the model. These XSL stylesheets support the optional step of
converting XMI files exported from the model into alternative formats such as
HTML, XSL or source code. Stylesheets imported here are then available in the
drop-down lists on the 'XML Export' dialog and the 'Generate GML Application
Schema' dialog.

Combined with UML Profiles, this is a powerful means of extending Enterprise
Architect to generate almost any content required.

To import a stylesheet:

Right-click on the folder name and select the 'Import Stylesheet' option.1.

Locate and select the stylesheet file in the browser, and click on the Open2.
button.

Provide a reference name for the file, and click on the OK button.3.

Once the stylesheet is in the folder, you can select context menu options to reload it
(if it has been changed at the source) or delete it.

UML Profiles A Profile is a source of modified or extended element and connector types that you
have developed from the UML base types. You can import each new Profile into
this folder, and then create elements and connectors of the new types by dragging
the icons from the Profile onto a diagram.

Once you have Profiles in the folder, you can select options for arranging them in
order of name or type, viewing a Profile description, or deleting a Profile.

It is possible to synchronize the Tagged Values and constraints for any elements
created from a Profile element in the Resources window.

Importing and applying Profiles through the Resources window is no longer
recommended; from Enterprise Architect release 7.0. it is recommended that you
load and apply Profiles as components of MDG Technologies.

Patterns The Patterns folder is a folder of Design Patterns that you or your team members
have imported into the model. A Pattern captures complex new elements and
features that you can drag into a diagram without having to retype or reconfigure
each element.

Within the folder, the Patterns are grouped by type. Once you have Patterns within
a group, you can select options to delete a selected Pattern or all Patterns in the
group, view a Pattern's details, or apply a Pattern to an empty diagram.
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Favorites

If you have any elements that you or your team use frequently - such as the list of Actors in a system - you can add them
to the Favorites folder in the Resources window, and use that as the source for conveniently dragging and dropping
instances of or links to these elements into other diagrams. This makes it much easier to locate and use the elements as
you create and manage your model.

Access

Ribbon Start > Desktop > Share > Resources > Favorites, or

Explore > Portals > Windows > Explore > Resources > Favorites, or

Configure > Reference Data > Resources > Favorites

Keyboard Shortcuts Alt+6 | Favorites

Actions on the Favorites Folder

Action Detail

Add an element to the
Favorites Folder

In a diagram, right-click on the element to add·

From the context menu select the 'Find | Add to Favorites' option·

Switch to the Resources window and expand the Favorites folder; the added·
element is listed within its element-type category (such as Class)

You add elements to the Favorites folder individually.

Delete an element from the
Favorites Folder

Right-click on the element within the Favorites folder in the Resources·
window

From the context menu select the 'Delete Favorite' option·

A confirmation prompt displays; click on the Yes button·

View Properties of an
element in the Favorites
Folder

Select and right-click on the element in the folder·

From the context menu, select the 'Element Properties' option; the element·
'Properties' dialog displays

Notes

When you have had the Favorites folder open for some time and other users might have been adding to it, right-click·
on the folder name and select the 'Refresh Favorites' option to update your view of the folder with the new contents
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Sharing Reference Data

You can conveniently update your models with reference data (including Glossary and Issue information) by exporting
the data to and importing the data from .XML files to (for example):

Copy glossaries from one model to another·

Add additional profiles by merging new stereotypes into the model·

Update reference data from files supplied by Sparx Systems as a maintenance release·

Copy resources, clients and so on from one model to another·

You import data into the model automatically or manually from a reference data .XML file, exported from another model
or an iteration of the current model.

Alternatively if your repository is MySQL, MS SQL Server or Oracle it is possible to configure your repository to use
the Reference Data defined in another repository (on the same server), see Linking Reference Data for details.
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Import Reference Data

It is possible to import reference data into your model from an .XML file that was exported from another model or from
an iteration of the current model, either:

Manually, whenever you know there is new or changed data to apply, or·

Automatically whenever the model is reloaded into Enterprise Architect (if the file has changed since the previous·
import)

The automatic import checks if the source file has changed since the last import; if the file has not changed, the import
does not proceed. If the file has changed, the changed data is imported; however, you can configure the system to display
a prompt for you to allow or cancel the import.

Access

Ribbon Configure > Model > Transfer > Import Reference Data > Import File

Configure > Model > Transfer > Import Reference Data > Shared File

Import reference data manually (Import File)

Step Action

1 On the 'Import Reference Data' dialog, click on the 'Import File' tab and on the Select File button, then
select the filename to import data from.

This would be an XML file produced by the Enterprise Architect Data Exporter.

2 If you have selected a valid file, a list of available tables to import displays in the 'Select Datasets to
Import' panel.

3 Click on one or more of the tables to import.

Press Ctrl or Shift to click on multiple tables.

4 Click on the Import button to start the process.

A message displays when the import is complete; generally the process is quite fast.

Import reference data automatically (Shared File)

Step Action

1 On the 'Import Reference Data' dialog, click on the 'Shared File' tab.

2 If you are changing an existing configuration to import from a different XML file, click on the Clear
button to clear the dialog fields.
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3 Click on the Select File button and browse for the filename to import data from.

This would be an XML file produced by the Enterprise Architect Data Exporter.

4 If you have entered the name of a valid file, a list of tables to import displays in the 'Datasets in File'
panel.

Click on one or more of the tables to import. Press Ctrl or Shift as you click on multiple tables.

5 If you prefer to control whether or not the automatic import takes place, select the 'Always prompt before
import' checkbox.

6 Click on the Import button to import the reference data now, and to enable the automatic check and import
for subsequent reloads.

Notes

Concerning General Types data:

For Statuses, Constraints, Requirements and Scenarios, the imported data is merged with the existing data; if a·
record already exists it is updated to the new values, and if the record does not exist, a new record is added - records
are never deleted

For Constraint Status Types, Difficulty, Test Status and Priority, the complete existing list is replaced by the·
imported list

Concerning Calendar events and event types, Team Library configurations, Patterns and Gap Matrix Profiles:

The imported data is merged with the existing data; if a record already exists it is updated to the new values, and if·
the record does not exist, a new record is added - records are never deleted

Concerning Images in Microsoft SQL Server Repositories:

Importing images as reference data into a SQLServer repository is not supported when connected via Pro Cloud·
Server

To import images as reference data you must have additional MS SQL Server permissions, so that you can perform·
'Set Identity On/Off' commands; the role of db_ddladmin provides the required permissions; however, this approach
might not be allowed in your environment, so discuss this requirement with your DBA to find an appropriate
solution
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Export Reference Data

When you have a complete project set up, with fully defined project data, it is possible to capture either selected
categories or all categories of that data, and export it to a single XML file. You can then review the data, and import it to
another project or tool so that you do not have to define it all again. The exported data includes all instances of the
selected data type in the project; for example, all defined cardinality values, or all Document Style Templates.

Access

Ribbon Configure > Model > Transfer > Export Reference Data

Select and Export Reference Data

Step Action

1 On the 'Export Reference Data' dialog, click on the '+' box against each table group you want to expand.

2 Select the checkbox against each table or table group to export.

If you select the top-level, group-name checkbox, all tables in that group are selected for export.

3 Click on the Export button.

4 When prompted to do so, enter a valid file name with a .XML extension.

5 Click on the Save and OK buttons.

This exports the data to the file; you can use any text or XML viewer to examine the file.

Notes

You can resize the 'Export Reference Data' dialog; drag the dialog edges to the size you need·

If there are no instances of a selected data type in the project, the export does not generate any output for that data·
type in the XML file

Currently, Standard Complexity Types cannot be directly edited and are therefore effectively standard for all·
models; they can be listed using the Predefined Reference Data Tagged Value type ComplexityTypes
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Linking Reference Data

If you have a number of projects that use the same reference data, you can use a central repository containing all
common data and configure the other repositories to link directly to this data. This data includes system resources such
as Security Users and Groups, Permissions, Scripts, Glossary terms or Data Types.  Sharing common data between
repositories makes it possible for teams working on multiple projects to leverage a common and consistent set of system
resources, thereby promoting or enforcing common usage and standards.

Sharing common data can be applied to both existing and new projects, however each individual repository can be
configured to use as much of the common data as is deemed necessary.

The ability to link to common data in a central repository uses the native features provided by the various Database
Management System (DBMS), MySQL, SQL Server and Oracle.  Meaning that it is configured at the database level. The
benefit of this is that Enterprise Architect will function normally without needing any modifications in order to access
the data, in fact it is not even aware that the common data is physically located in another repository.

Access

Ribbon Configure > Model > Transfer > Shared Repository

Configure a Repository to use shared data

The 'Shared Repository' screen provides an Administrator the ability to generate a SQL script that can be run on the
current repository's database and configure it to share common data of a centralized repository.  The generated script is
tailored based on user selection and the DBMS of the current repository.

The process to configure the current repository to share a centralized repository's data, is:

Step Action

1
In 'Script File' field, enter the complete filename and path of the script, or click on the  button and
search for it.

2 In the 'External Repository' field enter the database name of the centralized repository.  Enterprise
Architect will only continue if the entered database name exists on the Database Server hosting the
Current Repository.

3 Select which Table Group(s) will be shared, as explained in the following table.

4 Click the Generate button to create the script and save it to the specified location.

5 Open the SQL console of your choice and execute the generated SQL script.  Since the schema of the
database is being updated an elevated level of permissions are required to execute these statements.

Select Table Groups
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There are approximately 30 tables that can be potentially shared between repositories, the 'Shared Repository' screen
organizes these tables into logical Groups.  While some Table Groups only contain 1 table, others contain multiple.

You can select all Table Groups or as many as is appropriate for the current repository.

Option Action

Security Users and Groups This group of tables contains a number of tables that define the Model Users, the
Security Groups and the Security Groups each Model User belongs to.

Security Permissions This group of tables contains the security permissions that are assigned to each
Model User and Security Group.  While at first glance it may seem strange that the
Security User and Group does not include Security Permissions, it was a deliberate
decision to keep these two separate because it provides a greater level of flexibility.

People This group of tables contains the definition of all people/resources in the repository.

Glossary This group contains the Glossary table that defines the glossary terms for the
repository.

Types This group of tables contains the definition of reference types that are typically
used to populate drop down lists within Enterprise Architect's screens.  Types like
Complexity, Constraints, Effort, Problem, Property, Risk, etc.

Complexity Factors This group of tables contains the definition of complexity factors, like ECF and
TCF.

Scripts This group contains the Script table that defines all custom JSScript, JavaScript and
VBScript.

Data Types This group contains the Data Types table that defines both the data types for all
code languages and DBMSs.

How it works

The scripts generated by this screen work by renaming each Enterprise Architect Table that has been selected and then
creating a Synonym (or View) that references the centralized database's table of the same name.

Consider the example that the current repository/database called EA1 should be configured to share EAMAIN's
T_GLOSSARY table.

The script will:

- renamed table EA1.T_GLOSSARY to EA1.T_GLOSSARY_BAK

- create a new synonym (or view) call EA1.T_GLOSSARY that references EAMAIN.T_GLOSSARY

Both Microsoft SQL Server and Oracle support database Synonyms, which are  a mechanism that provides an alternative
name for another database object, in the case of shared data the other database object is a table in another database.
MySQL does not support Synonyms, however a View can be used to achieve the same behavior.

Removing Shared data
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As described in the 'How it works' section, since the scripts generated by this screen simply rename the original tables by
appending "_BAK" to their names, it is a relative easy process to rename (or delete) the synonym (or view) and then
rename the table back its original name.

Notes

Enterprise Architect can only generate Shared Repository scripts for  MySQL, SQL Server and Oracle based DBMS·
repositories

In order to share common data all repositories must use the same DBMS and must be on the same network,·
preferable on the same database server (for performance reasons).  ie if the central repository is MySQL then all
repositories wishing to use the common data must be MySQL and have direct network access

The Shared Repository screen cannot be opened while the current connection is using a Cloud connection.  The main·
reason for this is that Cloud based connections do not provide the necessary database information needed to generate
a working SQL script.  However, once the script has been generated (while connected with a direct ODBC
connection) and then executed, Cloud based connections will read shared data the same as their direct connection
counter-parts.
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Shared Security Reference Data

When deciding which Table Groups each individual repository should share of the centralized repository the Security
related tables should be carefully considered, and the decisions based on a number of factors:

how are users going to be validated?  via an external Single Sign-On (SSO) mechanism (like OpenID or Windows·
NTLM) or a simple User ID and password stored within the Enterprise Architect repository?

should all repositories share the same list of users?·

should user passwords be synchronized across all repositories?·

do all users have the same permissions across all repositories?·

There are two Shared Table Groups related to Security:  1) 'Security Users and Groups' and  2) 'Security Permissions',
whether a repository should be configured to share either or both of these Table Groups depends on the environment.
Consider the following scenarios:

Scenario 1. All repositories have the same users, and all Users have the same permissions within the Repositories; the
individual repository should share both Table Groups: 'Security Users and Groups' and 'Security Permissions' from the
centralized repository.  The user list and permissions will need to be managed within the centralized repository.

Scenario 2. All repositories have the same users, but the Users have different permissions across the Repositories; the
individual repository should share the Table Groups: 'Security Users and Groups' from the centralized repository.  The
user list will need to be managed within the centralized repository while the user permissions will need to be managed
within the individual repositories.

With each of the above scenarios it is still a requirement that the passwords for Users are maintain within the individual
repositories, the only way to avoid this is to implement SSO authentication or to use Pro Cloud Server's Global
Authentication.

Authentication via SSO

When using an SSO authentication mechanism, Enterprise Architect is no longer responsible for determining if the
entered user credentials are valid, instead it is OpenID or Windows NTLM that validates the user credentials and advises
Enterprise Architect that the given user is valid.  Enterprise Architect then uses the supplied UserID to determine what
features are available within the current repository.  This requires that the complete list of Users is defined within the
repository, however if each individual repository is configured to share the Security related reference data the list of
Users (and their permissions) can be defined and managed in the centralized repository.

Authentication via Global Authentication

It's possible to configure the Ports of the Pro Cloud Server to use a 'Global' repository for  authentication purposes.
When this option is set the initial log in process uses the 'Global' repository to validate the supplied user credentials, once
those credentials have been confirmed any further security related queries use the information saved in the current
repository.  The benefit of this configuration means that each repository has the ability for the same user to have different
permissions in each repository.  However the downside is that the security user definitions must be manually kept
up-to-date in each repository.

Using Shared Repository data (as described in the topic Link Reference Data to a Shared Repository) it is possible to
remove the duplicated data by choosing certain Table Groups to shared and the remaining to be stored locally, the exact
configure will depend on the individual environment.
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